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Copyright Notice and License Agreement

The Retrospect documentation and program are copyrighted, with all rights reserved to Dantz 
Development Corporation. Your rights are subject to the limitations and restrictions imposed by 
international and U.S. copyright laws. Please note that you may not use, copy, modify, or transfer the 
program or documentation or any copy thereof, except as expressly provided in the license agreement.

The accompanying computer program(s) (“Software”) is licensed, not sold, to you by Dantz 
Development Corporation (“Dantz”) for use under the terms of the license agreement shown in the 
Software’s executable installer.

By installing, copying, or otherwise using the Software you agree that you have read the license, that 
you are bound by its terms, and that it is the only agreement between you and Dantz regarding the 
program and documentation.

 Patents

U.S. Patents 5,150,473 and 5,966,730. Other patents pending.

Trademarks

Retrospect® and DiskFit Pro® are registered trademarks and DiskFit Direct™, Backup Server™, 
EasyScript™, IncrementalPLUS™, Lessr™, Piton™, Scheduler™, SmartSet™, and StorageSet™ are 
common law trademarks of Dantz Development Corporation. All other marks are the properties of 
their respective owners.

Disclaimer of Warranty and Limited Warranty on Media

For a period of thirty (30) days after you obtain a copy of the Software (the “Media Warranty 
Period”), Dantz warrants that the media on which the Software is provided to you will be free of 
defects in materials and workmanship. Dantz will, at its own expense and as its sole obligation and 
your exclusive remedy for any breach of this warranty, replace any defective media returned to Dantz 
within the Media Warranty Period. This warranty does not apply to damages resulting from misuse, 
abuse, or neglect. This warranty will not apply to you if you have downloaded the Software from 
Dantz web site. 

EXCEPT FOR THE EXPRESS WARRANTY STATED IN THIS SECTION, THE SOFTWARE IS 
PROVIDED “AS IS.” DANTZ DISCLAIMS ALL OTHER WARRANTES, WHETHER EXPRESS, 
IMPLIED, OR STATUTORY, REGARDING THE SOFTWARE AND THE DOCUMENTATION, 
INCLUDING ANY WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR 
PURPOSE, TITLE, AND NON-INFRINGEMENT OF THIRD-PARTY RIGHTS. 

IN NO EVENT WILL DANTZ BE LIABLE TO YOU FOR ANY CONSEQUENTIAL, 
INCIDENTAL, SPECIAL, EXEMPLARY OR INDIRECT DAMAGES (INCLUDING DAMAGES 
FOR LOSS OF BUSINESS PROFITS, BUSINESS INTERRUPTION, LOSS OF BUSINESS 
INFORMATION, AND THE LIKE) ARISING OUT OF OR RELATING TO THE USE OF OR 
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INABILITY TO USE THE SOFTWARE OR THE DOCUMENTATION EVEN IF DANTZ KNEW 
OR SHOULD HAVE KNOWN OF THE POSSIBILITY OF SUCH DAMAGES. 

DANTZ’S TOTAL CUMULATIVE LIABILITY ARISING FROM OR RELATING TO THIS 
AGREEMENT, THE SOFTWARE, OR THE DOUMENTATION, WHETHER BASED IN TORT, 
CONTRACT, OR OTHERWISE WILL NOT EXCEED THE AMOUNT OF FEES YOU HAVE 
PAID FOR THE SOFTWARE. THESE LIMITATIONS OF LIABILITY WILL BE GIVEN FULL 
EFFECT EVEN IF THE WARRANTY PROVIDED ABOVE IS DEEMED INEFFECTIVE. 

THE WARRANTY AND REMEDIES SET FORTH ABOVE ARE EXCLUSIVE AND IN LIEU OF 
ALL OTHERS, ORAL OR WRITTEN, EXPRESS OR IMPLIED. No Dantz Development dealer, 
agent, or employee is authorized to make any modification, extension, or addition to this warranty. 
Some states do not allow exclusion or limitation of implied warranties or liability for incidental or 
consequential damages, so the above limitation or exclusion may not apply to you. This warranty 
gives you specific legal rights, and you may also have other rights which vary from state to state.
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. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

C H A P T E R    1
G E T T I N G  S T A R T E D

• O V E R V I E W  O F  R E T R O S P E C T

• R E Q U I R E M E N T S

• I N S T A L L I N G  R E T R O S P E C T

• U S I N G  R E T R O S P E C T

• Q U I C K  S T A R T

This chapter defines the hardware and system requirements necessary to use Retrospect, 
then explains how to install or upgrade the Retrospect software. It also provides a basic 
overview of how to use Retrospect. Retrospect Client requirements and installation are 
described in Chapter 6 • Network Backup.

The Quick Start section walks you through two backups and a simple restore.
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OVERVIEW OF RETROSPECT
Designed for use in small and mid-sized busi-
nesses, Retrospect Workgroup and Retrospect 
Server provide thorough, fast backups, and 
100%-accurate restores of file servers, desk-
tops, and notebook computers. Retrospect 
Desktop delivers the proven capabilities of 
Dantz’s enterprise-class products to the home 
and small business user. The Retrospect product 
line protects against loss due to viruses, newly 
installed software, user error, damaged hard-
ware, hardware upgrades, hackers, and lost or 

stolen computers. The industry leader in data 
protection for more than a decade, Dantz has re-
ceived numerous awards and protects millions 
of computers worldwide. 

Which Edition is Right for You?
There are three editions of Retrospect available. 
Depending on the needs of your organization, 
one of these editions is right for you. The fol-
lowing table lists some Retrospect features and 
shows which editions they are available with.

Feature Retrospect 
Desktop

Retrospect 
Workgroup

Retrospect 
Server

Back up the 
Local 
Computer

A single computer running Mac 
OS X 10.1.5 or later, including 
Mac OS X Panther

x x x

A single computer running Mac 
OS X Server 10.1.5 through Mac 
OS X Server 10.3 or later

x x

Back up 
Networked 
Clients

Network client licenses included 
at no additional cost

2 20 100

Mac OS 7.1 or later, Mac OS X 
10.1.5 through Mac OS X Pan-
ther, Windows XP, Windows 
2000 Professional, Windows NT 
4.0 Workstation, Windows 
95/98/Me

x x x

Red Hat Linux (versions 6.2, 7.1, 
7.2, 7.3, 8, and 9)

x x x

Mac OS X Server 10.1.5 or later, 
including Mac OS X Server 10.3 
or later

x

Backup 
Devices

Tape drives, hard drives, remov-
able drives, CD/DVD, FTP server

x x x

Tape autoloaders and libraries x x

Client Additional client licenses (100, 
50, 10, 5, 1)

Optional Optional Optional
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REQUIREMENTS
In order to run and use Retrospect, there are cer-
tain minimum hardware, OS, and memory 
requirements. Requirements for client comput-
ers are detailed in Chapter 6 • Network Backup.

Backup Computer
The backup computer is the machine on which 
you install and run Retrospect. It must meet the 
following minimum requirements:

• Macintosh G3 or better.

• Mac OS X version 10.1.5 or later.
• Retrospect Desktop: A minimum of 128 MB 

RAM (256 MB recommended).
• Retrospect Workgroup and Server: A 

minimum of 256 MB RAM (512 MB 
recommended).

• Hard disk drive with a minimum of 200 MB 
free space.

• If you are going to use clients, you must have 
networking hardware and cabling, 
functioning with the TCP/IP protocol, 
connected or routed to the network on which 
the backup computer operates.

Backup Device
Retrospect requires a supported backup device 
to use as the destination for your backups. You 
can back up to a tape drive or library, CD/DVD 
disc drive, FireWire or USB hard disk, or a re-
movable disk drive such as Zip, Jaz, SuperDisk, 
DVD-RAM, or MO. 

NOTE: If you do not have a backup device, you 
can still back up to the Internet. However, you 
need the appropriate networking hardware and a 
valid TCP/IP configuration. You also need an 
account on an FTP server.
See Chapter 3 • Hardware for more information 
on backup devices.

INSTALLING RETROSPECT
To install Retrospect:
1.  Save all unsaved documents in other running 
application programs.
2.  Insert the Retrospect CD in the computer’s 
CD/DVD drive and double-click Install 
Retrospect.
3.  Enter an administrator level user name and 
password in the Authenticate window, then 
click OK.

4.  Follow the installer program’s instructions.

Upgrading from Previous Versions of 
Retrospect
If you already have Retrospect 4.0 or later in-
stalled on the backup computer, you may have 
to take some additional steps to maintain your 
preferences, scripts, and schedules. 

NOTE: If you are using a version of Retrospect 
older than 4.0 you will have to recreate your 
scripts, schedules, etc.
If you installed Retrospect on a different backup 
computer and want to maintain your preferenc-
es, scripts and schedules, see “Moving 
Retrospect” on page 162.

NOTE: This version of Retrospect runs on Mac 
OS X only, whereas previous versions could run 
on Mac OS 9.

Upgrading from Retrospect 5.x
When you launch the current version of 
Retrospect, it automatically finds and uses your 
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old preferences, as long as they are in the de-
fault location.

NOTE: For Mac OS X, the default location is: 
/Library/Preferences/Retrospect. For Mac OS 
9, the default location is: System Folder: 
Preferences:Retrospect.

Upgrading from Retrospect 4.x
When you launch the current version of 
Retrospect for the first time, and you provide 
the administrator login and password for au-
thentication under Mac OS X, the configuration 
update dialog appears. 

Click the Import button to copy your logged-in 
clients, custom selectors, old scripts, schedules, 
and preferences for use with the current version 
of Retrospect.

WARNING: If you click the Use Default 
button, you will not be able to access Retrospect 
4.x’s logged-in clients, custom selectors, 
preferences, scripts, schedules, subvolume 
definitions, and the like. You must then 
reconfigure these with the new version of 
Retrospect.

Removing Old Files After Upgrading
Once you have Retrospect up and running and 
you are confident with it, you can remove the 
old Retrospect application from your computer. 
Do not remove your backup set catalog files. It 
is a good idea to store your catalogs in the same 
folder as Retrospect.

Installing Retrospect Clients
Installation of Retrospect Clients is described in 
Chapter 6 • Network Backup, which starts on 
page 91.

USING RETROSPECT
The main way you interact with Retrospect is 
through the Retrospect Directory (see page 13). 
It includes tabs to navigate between different 

categories of commands, which you invoke by 
clicking buttons.

Starting Retrospect
To start Retrospect, double-click the Retrospect 
application icon.

Retrospect requires an administrator login and 
password in order to back up and restore all the 
files on the backup computer. When prompted, 
enter an administrator user name and password.

If you don’t want to always require authentica-
tion, see “Security Preferences” on page 160.

The first time you run the program, Retrospect 
asks you to enter your name, organization, and 
license code. Enter this information, then click 
OK.

At the registration screen prompt, click one of 
the following buttons:

• Already Registered, if you have already 
registered your copy of Retrospect.

• Register Now, if you have not registered 
your copy of Retrospect and you would like 
to do so. Enter the pertinent data in the fields 
then click Print or E-mail. To e-mail your 
information to Dantz, your computer must 
be configured properly for Internet e-mail. If 
you cannot e-mail your registration, then 
print it out and send it by mail or fax.

• Register Later, if you want to go straight to 
Retrospect and start using the product.
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Exiting Retrospect
To exit Retrospect choose Quit Retrospect from 
the Retrospect menu. If you created any scripts 
that are scheduled to run in Retrospect’s look 
ahead time (12 hours by default), Retrospect 
displays details about the operation before 
quitting.

See “Schedule Preferences” on page 160 for 
more information on specifying the look ahead 
time.

The Retrospect Directory
When you start Retrospect, the program dis-
plays its main window, the Retrospect 
Directory.

You can access all areas of Retrospect by click-
ing the various tabs and buttons in the 
Directory.

Each tab includes a brief summary of its con-
tents, along with buttons for performing 
specific tasks. Next to each button is a descrip-
tion of its function.

QUICK START
This section introduces you to Retrospect’s ba-
sic backup and restore operations and walks you 
through two simple backups and a restore. Be-
fore you begin, make sure your computer is 
connected to a supported backup device and 
that you have storage media to use with the 
device.

Part I: Quick Backup
1.  Start Retrospect. 
2.  Click the Immediate tab, then click the 
Backup button. 
If this is your first backup, the Volume 
Selection window displays.

This window is used to select what you want to 
back up, i.e. the source volume. The window’s 
scrolling area lists all the volumes available, 
including local volumes and logged in clients. 
For this Quick Start tutorial, you’ll be backing 
up your local computer.
3.  Click on the name of your startup disk to 
select it.
4.  Click OK.
If this is your first backup, the Backup Set 
Creation window displays. If this is not your 
first backup, click the New button to bring up 
the Backup Set Creation window.

A backup set is Dantz’s term for a group of one 
or more disks, tapes, CD/DVD discs, or a file or 
an FTP site that serve as the destination for a 
backup. Individual pieces of media (for 
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example, discs, disks, tapes, or cartridges) are 
members of a backup set.
5.  Select the type of backup media you want to 
use for this backup set; either tapes, CD/DVD 
discs, or removable disks. If you have only a 
single hard disk rather than a dedicated backup 
device, choose File to create a file backup set.
NOTE:  Do not choose the Internet backup set 
type, which requires more instruction than this 
Quick Start can provide.
6.  Enter a name for the backup set in the Name 
field, or just leave the default name.
For this tutorial, you can ignore the security and 
data storage options.
NOTE: For tape backup sets, hardware data 
compression is allowed by default.
7.  Click the New button. 
8.  Choose a location to store the backup set 
catalog, then click Save.
The catalog is a file containing an index or table 
of contents of the files on the backup media of a 
backup set. The catalog lets you view the 
contents of a backup set without requiring 
access to the backup set media.
WARNING: Do not save the catalog on a 
removable cartridge disk that will be used as a 
backup destination. Retrospect needs to access 
the catalog on a readily accessible volume, 
preferably the local hard disk.
NOTE: With a file backup set, the file you save 
here serves as both the catalog and the 
repository of backed-up files. Save it on your 
designated backup drive.
Retrospect displays the Backup Set Selection 
window, which lists available backup sets. The 
new backup set is automatically highlighted, so 
you do not have to select it.

9.  Click the OK button.
The Immediate Backup summary window 
displays.

Take a moment to look at the various parts of 
this window, including the source volume you 
chose and the destination backup set you 
created. 
10. Click Preview to scan the source volume 
and display its files.
By default, all files and folders on the volume 
are marked for backup. You can also mark and 
unmark files and folders manually.
11. Close the Preview window.
 The summary window now lists the number 
and total size of the files to be backed up.
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The top of the window should say “Ready to 
Execute.” If it doesn’t, Retrospect indicates 
what else is needed before it can execute the 
backup.
12. Click the Backup button. 
For tape, CD/DVD, and removable disk backup 
sets, the media request window displays.

The media request window for a tape backup set.

NOTE: This window does not appear for file 
backup sets, in which case Retrospect 
immediately begins the backup operation.
13. Choose a new piece of media for the backup.
WARNING: Use only a blank disk, tape, or 
CD/DVD disc, or one with unwanted data, 
because any files on it will be permanently 
removed.
If you do not have a new or erased disk, tape, or 
disc in the backup drive, put one in. Select it in 
the window and click Proceed. 
Retrospect displays a progress window while it 
backs up your files. Depending on your backup 
device capacity and the size of the files being 
backed up, Retrospect may request more media. 
When it is done, the following window 
displays.

Congratulations on completing your first 
backup!

Part II: Quick Backup of New and 
Changed Files
In the first part of the Quick Start tutorial, you 
backed up your entire hard disk. The files and 
folders on this disk are constantly changing 
however. New files get added and old ones get 
modified or deleted. In order to keep you back-
ups current, you need to back up on a regular 
basis.

In the second part of this tutorial, you will create 
some new files and perform the same backup 
operation you performed in Part I. You’ll see 
how Retrospect intelligently copies only those 
files that are new or changed since the first 
backup. Dantz refers to this as Incremental-
PLUS backup.

1.  If you haven’t done so already, quit 
Retrospect. 
2.  Make duplicates of some files on your hard 
disk.
NOTE: Make sure the names are different from 
the originals. 
3.  Place these files in the Documents folder of 
the hard disk you just backed up.
4.  Start Retrospect and click the Backup 
button. 
Retrospect displays the immediate backup 
summary window because it already has the 
necessary information from your first backup.
5.  Click Preview, then close the window that 
appears and look at the files chosen 
information.
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Retrospect compares all the files on the source 
volume to all the files that already exist in the 
backup set (i.e., the files you backed up in Part 
I of this tutorial). If a file already exists in the 
backup set and has not changed, Retrospect 
does not need to copy it. 
The number of files that you created or 
modified is listed to the right of “Need to copy.”
6.  Click Backup. 
7.  Close the execution window when the 
backup is complete. 
Congratulations on your first IncrementalPLUS 
backup.

Part III: Quick Restore
The best reason to back up on a regular basis is 
so that you’ll be able to restore files or an entire 
computer if files are lost or damaged. This part 
of the tutorial walks you through a simple re-
store. For more details on restoring, see 
“Restore” on page 51 and Chapter 7 • Disaster 
Recovery.

Before you begin delete some or all of the dupli-
cate files you created in Part II of this tutorial.

1.  Open Retrospect and click Restore.
2.  Choose “Restore files from a backup” and 
click OK.

3.  In the Restore from Backup window, click 
the backup set to which you backed up earlier.
Retrospect automatically selects the first 
Snapshot in the bottom portion of the window.

Every time you run a backup, Retrospect creates 
a Snapshot, which is basically a list of all files 
and folders on the source volume at the time of 
the backup. Using Snapshots, you can restore 
files from any point in time.
4.  Click OK.
The Destination Selection window displays.

5.  Click on the name of your startup disk to 
select it as the volume to which you will restore. 
Make sure the pop-up menu is set to Retrieve 
Files & Folders.
WARNING: Restoring may destroy data on the 
destination if you set this pop-up to Restore 
Entire Disk or Replace Corresponding Files.
6.  Click OK. 
Retrospect matches your Snapshot to the files in 
your backup set, then displays the summary 
window.
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Check over the various parts of this window. 
Make sure the destination volume is correct and 
you are copying files and folders to a new 
folder. Note that no files are currently selected, 
which is why the summary says the operation is 
“Not ready to execute.”
7.  Click Files Chosen.
8.  To restore the files you deleted at the 
beginning of this tutorial, find these files and 
mark them for retrieval.
The files should be in the Documents folder. 
For each file, click its icon, then click the Mark 
button. (Or, as a shortcut, just double-click a file 
to mark it.) Marked files have check marks next 
to them.

The upper right corner of the window shows the 
number and size of the files you have marked.
9.  When you have marked your files, close the 
window.

The Files Chosen section in the restore 
summary window includes information about 
the files you marked and the destination 
volume.
10. Click Restore.
11. Close the execution window when the 
restore is complete. 
Browse your hard disk and you’ll see that 
Retrospect made a new folder with the same 
name as your backup set. Inside that folder you 
will find the files you restored. 

Congratulations on your first restore.
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• B A C K U P  S E T S  A N D  T H E I R  C O M P O N E N T S

• B A C K U P  A C T I O N S

• C A T A L O G  F I L E S

• S N A P S H O T S

• R E T R O S P E C T  A N D  C L I E N T S

• B A C K U P  S E R V E R

This chapter describes Retrospect’s fundamental concepts. This manual and the program 
itself repeatedly refer to these basic ideas. Understanding these fundamentals is important 
and useful but not essential. Dantz designed Retrospect to be powerful and feature-packed, 
yet very easy to use for basic operations.
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HOW RETROSPECT WORKS
Retrospect uses an archival method of backup 
that ensures backed up files are not deleted or 
written over until you request it. That way they 
stay on the disk, tape, CD/DVD disc, or wher-
ever you stored them, indefinitely. This ensures 
that your files are available if you ever need to 
restore them.

This is an important benefit of Retrospect not 
found in “disk mirroring” software used for 
backups. For example, lets say you have been 
working on an important document every day 
for the past month and you discover you have 
been making terrible mistakes for the past week. 
If you have been backing up every day with 
Retrospect, you’re not limited to restoring from 
the most recent backup, rather you can retrieve 
a version of the file from a week ago (or any 
point in time it was backed up).

Retrospect uses a catalog file (usually stored on 
your hard disk) to keep track of the different 
generations of modified files in a backup set. 
The catalog lets you quickly search for files 
without having to actually search the backup 
media itself.

Retrospect provides a number of ways to pro-
tect and restore your data. There are two basic 
categories of operations you can perform with 
Retrospect: immediate operations and automat-
ed operations. 

For example, if you launch Retrospect, click the 
Immediate tab, then click Backup, you have 
taken the first steps in creating an immediate 
operation. If you make a script to do the same 
backup on a specific schedule, that is consid-
ered an automated operation.

Immediate Operations are discussed in detail in 
Chapter 4 • Immediate Operations. The process 
of creating scripts is described in Chapter 5 • 
Automated Operations.

All of the operations in Retrospect, whether im-
mediate or scripted, require a source and a 
destination. For a backup, the source is general-
ly a hard drive or a folder on a hard drive 
(Retrospect calls these volumes and subvol-
umes respectively). The destination is generally 
a backup set stored on backup media (disks, 
tapes, CDs, etc.).

Immediate/Automated Operation Source Destination

Backup Volume(s) Backup Set(s)

Duplicate Volume Volume

Archive Volume(s) Backup Set

Transfer Backup Set(s) Backup Set

Restore Snapshot Volume
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Volumes, backup sets, Snapshots, and the vari-
ous types of immediate and automated 
operations are all discussed in greater detail 
elsewhere.

INCREMENTALPLUS
Retrospect uses patented technology to perform 
IncrementalPLUS backups. IncrementalPLUS 
intelligently copies only files that are new or 
have changed since the previous backup to the 
same backup set. You don’t have to specify 
whether you want a “full” or “incremental” 
backup. Retrospect, by default, copies only the 
files it hasn’t already backed up to the destina-
tion backup set.

BACKUP SETS AND THEIR 
COMPONENTS
The basic building block of Retrospect is the 
backup set, which is a set of one or more disks, 
tapes, or discs, or a file or FTP site. Individual 
pieces of media (for example, discs, disks, 
tapes, or cartridges) are members of a backup 
set.

You can back up as many source volumes as 
you like to a single backup set. For example, 
you could have a single backup set as the back-
up destination for your computer’s internal hard 
disk, your external hard disk, a file server, and a 
co-worker’s hard disk on a computer with in-
stalled Retrospect Client software.

When a disk, tape, or CD/DVD fills with data, 
Retrospect asks for a new one. It uses any avail-
able (that is, in the drive) new or erased media. 
If the media has the name Retrospect is looking 
for, Retrospect will erase and re-use it. To re-
duce the danger of unintentionally destroying 
data, Retrospect will never automatically use a 
medium with the wrong name if it has data on it.

Retrospect uses a catalog file, an index of the 
files and folders contained in a backup set, to 
keep track of files and media, so you never have 
to think about which files are on which disks, 
tapes, or CD/DVDs. See “Catalog Files” on 
page 24 for more information.

Tape Backup Sets
A tape backup set uses tapes from a tape device 
such as a DAT drive, Travan drive, AIT drive, 
VXA drive, DLT drive, or LTO drive. Files are 
backed up to the tapes and the catalog is usually 
saved on the hard disk of the computer doing the 
backup. Chapter 3 • Hardware provides more 
detailed information on tape drives.

CD/DVD Backup Sets
A CD/DVD backup set uses recordable or re-
writable discs with CD-R, CD-RW, DVD-R, 
DVD-RW, or DVD+RW drives. Files are 
backed up to the discs and the catalog is usually 
saved on the hard disk of the computer doing the 
backup. Chapter 3 • Hardware provides more 
detailed information on recordable disc drives.

Dantz uses the term “recordable disc,” or sim-
ply “disc,” to refer to a recordable or rewritable 
disc to be used in a CD-R, CD-RW, DVD-R, 
DVD-RW, or DVD+RW drive. These drives all 
work nearly the same with Retrospect, though 
they may use different media. The difference is 
that data on “R” discs cannot be erased, while 
“RW” discs can be erased in rewritable drives 
and reused by Retrospect. Rewritable discs are, 
of course, recordable, so they are included in the 
term “recordable discs.”

NOTE: You cannot use a CD-ROM or DVD-
ROM drive to restore from a CD/DVD backup 
set. Though the ability to write is not needed 
during restoring, a CD-ROM or DVD-ROM 
drive cannot recognize the Retrospect backup 
set format, which can only be read by a 
Retrospect-supported drive.
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Removable Disk Backup Sets
A removable disk backup set uses ejectable me-
dia which appears on the Macintosh desktop, 
such as Zip, Jaz, SuperDisk, DVD-RAM, or 
MO, as well as USB and FireWire hard disks. 
Backups can span multiple removable disks or 
hard disks.

Files are backed up to the disks and the catalog 
is usually saved on the hard disk of the comput-
er doing the backup. Chapter 3 • Hardware 
provides more detailed information on remov-
able media drives.

File Backup Sets
A file backup set combines the catalog and 
backed-up files into a single file stored on a vol-
ume. This volume can be any volume that 
mounts on the Macintosh desktop, such as a 
hard disk, file server or shared disk, or remov-
able cartridge. 

Unlike the other types of backup sets, which re-
quire media dedicated only to backups, you can 
store a file backup set right alongside other files 
on a volume used for other purposes.

A file backup set can be no larger than the vol-
ume on which it is stored. You can decrease the 
amount of space used by a file backup set by us-
ing Retrospect’s data compression option. The 
size of a file backup set is also limited by the file 
system, or the disk format.

Retrospect may, without notice, separate the 
catalog from a file backup set into a new file. It 
does this when a single file’s resource fork is 
likely to exceed the operating system’s 16 MB 
limit, which happens with a large number of 
files in the backup set. 

You can also manually separate a file backup 
set catalog from the file by using the backup set 
configuration window. See “Configuring Back-
up Sets” on page 153.

NOTE: If a file backup set is split, keep the two 
files within the same folder and do not rename 
either file.

Internet Backup Sets
An Internet backup set uses space on an FTP 
site that is on your office’s Intranet or on the In-
ternet. Files are backed up using the available 
space on the host FTP server via TCP/IP and the 
catalog is usually saved on the hard disk of the 
computer doing the backup.

Internet backup sets offer a way to store data 
without tapes, disks, or discs, and also provide 
an easy way to store backups off-site. This pro-
vides additional protection in the event of theft, 
fire, or other disaster at your workplace.

In most respects, an Internet backup set is like 
any other type of backup set. To use an Internet 
backup set, you must have an account with 
write privileges on an FTP site, or its server 
must allow anonymous use. And, of course, you 
must have a connection to the FTP site, such as 
an Ethernet network or a modem.

WARNING: With an FTP site connected to the 
Internet, anyone with access privileges to your 
FTP site could copy or tamper with your backup 
set contents. For added security, consider using 
encryption to keep your backup set contents 
private.
The connection speed and the amount of space 
available to you on the FTP site will affect back-
ups to Internet backup sets so you must plan 
accordingly. If you do not have enough time or 
space to back up all your files, you will have to 
make a smaller selection of files to back up. For 
example, the relatively slow speed of your In-
ternet connection may limit you to backing up 
only critical files, whereas a faster network may 
allow you to completely back up your hard disk. 
Limited space on the FTP site may also limit 
you to backing up smaller files or fewer files, 
whereas unlimited space allows you to back up 
everything, even large files. Retrospect’s soft-
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ware compression is a useful option when 
connection speed or disk space is limited.

BACKUP ACTIONS
The main purpose of performing a backup is to 
copy files into a backup set. For backup opera-
tions, you can instruct Retrospect to copy files 
using one of three different types of backup ac-
tions. Each backup action has its own method 
for determining which files are backed up and 
controlling the backup set media on which they 
are stored.

Retrospect’s default backup action, normal, 
performs efficient IncrementalPLUS backups 
without any extra effort on your part.

“Backup Strategies” on page 134, offers several 
backup strategies that use normal, recycle, and 
new media backup actions. Study these strate-
gies to learn how to maximize backup safety 
and effectiveness by alternating among backup 
sets and rotating media off site.

Normal Backups
A normal backup, as its name suggests, is the 
best action to use in most situations. It is an In-
crementalPLUS backup, which saves time and 
media space by not copying files that already 
exist in a backup set. A normal backup copies 
only files which are new or newly modified 
since the last backup to the same backup set.

During a normal backup, Retrospect compares 
the list of files selected to be backed up against 
the list of files in the destination backup set’s 
catalog, then copies only those files that are not 
already present on the backup set’s media. 
When a normal backup is done to a new backup 
set, there are no files in the backup set, so every-
thing selected from the source is backed up.

Normal Backup Example
A user creates a new backup set and does a nor-
mal backup to it with a new or erased medium 

in the backup device. Because no files exist in 
the new, empty backup set, Retrospect copies 
all the selected files to it. The next day the user 
does another normal backup to the backup set. 
Retrospect compares the selected source files to 
the backup set’s catalog file, then marks several 
new files and a few files that have changed since 
the previous day’s backup. Only these new and 
changed files are added to the medium previ-
ously used with this backup set, or a new 
medium if the other fills to capacity.

Recycle Backups
When Retrospect performs a recycle backup, it 
first clears the catalog contents (if any) of the 
destination backup set, so it appears no files are 
backed up. Then it looks for the first media 
member of the backup set and erases it if it is 
available. If the first member is not available, 
Retrospect uses any available new or erased 
disk, tape, or CD/DVD appropriate for the 
backup set type. All selected files and folders 
from the source are backed up to the backup set.

Recycle Backup Example
The backup administrator decides that the back-
up set includes too many pieces of media after a 
week of normal backups to the backup set. She 
starts a recycle backup with the first media 
member in the backup device and Retrospect re-
sets the catalog, erases the files on the media, 
and copies all the selected files.

New Media Backups
When Retrospect performs a new media back-
up, it creates a new destination backup set (with 
a name similar to the old one) using a new or 
erased disk, tape, of CD/DVD. This allows the 
original backup set and its catalog to remain in-
tact for long-term storage in a safe place. The 
new backup set catalog and the new media 
member (or directory) are each named with a 
number in sequence, such as “Office Net [001]” 
and “1-Office Net [001]” respectively. 
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Retrospect updates references to the old backup 
set in scripts and schedules.

In the case of a new media backup to a file back-
up set, Retrospect creates a new file in the same 
folder.

In the case of a new media backup to an Internet 
backup set, Retrospect creates a new directory 
on the FTP server.

New Media Backup Example
The user wants to archive a backup set by taking 
it off site, so she starts a new media backup with 
a new or erased medium in the backup device. 
Retrospect creates a new backup set with a new 
catalog, and copies all the selected files to the 
media. The previous backup set remains intact 
and the user takes its media and a copy of its cat-
alog file to a secure location off site.

New media backups are ideally used for rotat-
ing disks, tapes, or discs for off-site storage. For 
Internet backup sets, a new media backup cre-
ates a new directory at the same level in the 
hierarchy, which offers minimal protection 
from accidental erasure, but no protection if the 
FTP server experiences a hard disk crash, theft, 
fire, or similar disaster.

CATALOG FILES
Retrospect uses a separate catalog file (usually 
stored on your hard disk) to keep track of the all 
the files in a backup set. The catalog is an index 
or table of contents of the files on the backup 
media of a backup set. The catalog lets you view 
the contents of a backup set without requiring 
the media to be inserted in the backup device. 

A catalog is required for all operations that copy 
files to and from a backup set. If a catalog is lost 
or damaged, Retrospect can rebuild it from the 
media.

SNAPSHOTS
Because Retrospect does IncrementalPLUS 
backups, it may have several versions of a file 
scattered among several backup sessions within 
a backup set. For example, you may update your 
“Weekly Status Report” document every week, 
and because each update modifies the file, 
Retrospect backs up each one to your backup 
set. A flat list of all versions of all the files in the 
backup set would be very confusing. For this 
reason, among others, every time you back up, 
Retrospect places a Snapshot of the source vol-
ume in the backup set.

A Snapshot is a list—you can think of it as a pic-
ture—of all files and folders on a volume when 
it is backed up. For each volume, one Snapshot 
is stored in the catalog and a copy of the same 
Snapshot is stored on the backup medium (disk, 
tape, disc, file, or Internet). Following each suc-
cessful backup, or archive operation, the old 
catalog Snapshot is replaced with a new one. 
Old Snapshots on the backup medium remain 
untouched.

When you want to restore from a backup, you 
can tell Retrospect to use a Snapshot to restore 
the entire contents of a disk. Or, you can use a 
Snapshot as a guide to see the volume as it was 
at a given point in time, and then pick and 
choose individual files to restore. Snapshots al-
low you to perfectly restore each volume to its 
exact state at the time of any completed backup, 
without copying any extraneous files.

Snapshots help Retrospect keep track of the vol-
umes to which a file belongs. When Retrospect 
first backs up a volume to a new backup set, it 
copies the selected files and saves a Snapshot. 
When it subsequently backs up other volumes, 
it does not copy files that exactly match files al-
ready in the backup set. However, they are still 
noted in each volume’s Snapshot. This efficient 
storage method saves backup media by not re-
dundantly copying exactly matching files.
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You can retrieve Snapshots from media if you 
want to restore a volume, folder, or file as it was 
at any given backup.

Because a Snapshot represents a volume at a 
specific point in time, you cannot use a Snap-
shot to find multiple versions of a file 
throughout different backup sessions on differ-
ent dates. However, Retrospect does provide an 
easy way of doing this, which is explained in 
“Restore by Search” on page 55.

RETROSPECT AND CLIENTS
The Retrospect application can back up any 
drive that mounts on the Macintosh desktop.

Retrospect Clients can extend the backup and 
restore capabilities of Retrospect to other com-
puters on your network. A computer equipped 
with this software from Dantz is known as a 
Retrospect client computer, or simply a client. 
Retrospect can back up clients on the network 
without the need for installing file servers, start-
ing file sharing, or mounting volumes.

BACKUP SERVER
Retrospect’s Backup Server technology, which 
is explained in detail in Chapter 5 • Automated 
Operations, accommodates changing network 
and disk configurations. 

Backup Server offers a special type of scripted 
backup. Rather than backing up source volumes 
on specified days and/or times to specified 
backup sets (like a traditional script), Backup 
Server scripts prioritize the volumes most in 
need of backup and copy their files to the avail-
able backup set containing the least current 
data.

Backup Server is ideal for environments in 
which computers and hard disks, such as mobile 
computers and removable disks, irregularly ap-
pear on the network. Volumes are backed up to 

the best available backup set media, so Backup 
Server scripts give you greater freedom to use 
the media of your choice. Retrospect client us-
ers can even initiate backups of their volumes. 
A Backup Server script is often best used in 
concert with regular backup scripts to produce a 
comprehensive backup strategy.
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C H A P T E R    3
H A R D W A R E

• H A R D W A R E  O V E R V I E W

• C O M M U N I C A T I O N  T E C H N O L O G I E S

• S E E I N G  Y O U R  B A C K U P  D E V I C E

• R E C O R D A B L E  A N D  R E W R I T A B L E  D I S C  D R I V E S

• R E M O V A B L E  D I S K  D R I V E S

• H A R D  D I S K  D R I V E S

• T A P E  D R I V E S

• T A P E  L I B R A R I E S

• M E D I A  L O N G E V I T Y  A N D  S T O R A G E

• H O W  R E T R O S P E C T  W O R K S  W I T H  M U L T I P L E  B A C K U P  

D E V I C E S

This chapter explains the device communication technologies used by Retrospect and 
describes how to use Retrospect with your backup device. If you are already familiar with 
SCSI, Fibre Channel, ATAPI, FireWire, and USB, you may skip the explanations and read 
the sections that apply to your particular hardware setup and backup device. If you plan to 
use the Internet instead of a backup device, you can skip this chapter entirely.
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HARDWARE OVERVIEW
Retrospect uses hardware intensively. Its pur-
pose is to transfer large amounts of data 
between a source volume, such as a hard disk, 
and a backup device, such as a tape drive, as ef-
ficiently as possible. If these hardware systems 
or their ancillary hardware (for example, ca-
bles) do not work correctly, Retrospect cannot 
do its job and cannot back up your data. For this 
reason you should understand how your hard-
ware functions and how it relates to Retrospect.

Dantz maintains an extensive laboratory devot-
ed to testing Retrospect with different backup 
devices. Nothing taxes storage devices more 
than backups, so if there is a problem, Dantz’s 
intensive testing will most likely find it. Device 
manufacturers supply Dantz with pre-release 
versions of their devices so Dantz can identify 
problems before the devices are made available 
to the public. Refer to the Dantz Web site for the 
latest compatibility information and more spe-
cific details on supported devices.

If you have problems with Retrospect and your 
backup devices after you have confirmed you 
have a valid hardware and software installation, 
refer to Chapter 10 • Problems and Solutions.

COMMUNICATION 
TECHNOLOGIES
Retrospect communicates with hardware devic-
es using a number of different methods. This 
section describes the most common methods 
and how they interact with Retrospect.

SCSI
SCSI (Small Computer System Interface) is a 
specification of mechanical, electrical, and 
functional standards that lets a computer con-
nect and communicate with peripheral devices 
such as hard drives, recordable disc drives, tape 
drives, and scanners.

A single SCSI bus connects a Macintosh with 
peripherals by linking up to fifteen devices with 
SCSI cables plugged into SCSI ports. The de-
vices are connected serially—one after the 
other—in a simple layout known as a daisy 
chain. Each device on a SCSI bus must have its 
own unique identifying SCSI address, or ID. 
(You set a device’s ID number on the device 
itself.)

Both ends of a SCSI chain must be “terminated” 
to maintain the integrity of communication sig-
nals on the chain. This is done with a terminator, 
a device which plugs into an open SCSI port and 
acts as a kind of dead end of the chain. If you 
have an internally terminated or self-terminat-
ing SCSI device, it should be the last device of 
the SCSI chain (that is, at the end and the fur-
thest device from the Macintosh). An in-line 
terminator plugs into a SCSI port, but the termi-
nator itself also has a port that can have a cable 
plugged into it. To find out the termination re-
quirements for your specific hardware setup, 
refer to your SCSI controller’s user guide and 
the documentation that came with your periph-
eral device.

Setting up a SCSI chain on your Macintosh is 
easy. All you have to do is use the cables to con-
nect the devices in the daisy chain fashion, give 
each device a unique SCSI ID number, and ter-
minate the last device. You cannot have 
duplicate SCSI addresses on your SCSI chain. 
SCSI controllers reserve a single ID, often ID 7, 
for their control of SCSI operations, so no other 
device on the bus can use the reserved ID. The 
IDs on your chain do not have to be sequential 
or in a particular order; the SCSI chain is not af-
fected by the order as long as no devices share 
the same number.

NOTE: To ensure proper operation of your 
SCSI devices, always turn on each SCSI device 
on your chain before you turn on the backup 
computer, and do not turn them off until after 
you shut down the computer.

http://www.dantz.com/index.php3?SCREEN=compatibility_list
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Fibre Channel
Fibre Channel is a serial data transfer architec-
ture designed for storage devices that require 
very high data transfer rates. Fibre Channel 
combines the best features from SCSI and IP 
network transfer protocols.

Retrospect supports fibre channel tape drives 
and tape libraries using three different 
topologies:

• Point-to-point: Connects the backup 
computer directly to the Fibre Channel tape 
library using a dedicated cable.

• Arbitrated loop (FC_AL): Connects up to 
126 devices or nodes in a single, continuous 
loop or ring.

• Switched fabric: The most complex 
topology, switched fabric can be used to 
connect up to 16 million nodes.

NOTE: For FC_AL and switched fabric, 
Retrospect does not lock the device from other 
applications or share the device properly. It is 
the responsibility of the network administrator 
to ensure that only one copy of Retrospect has 
full access to the fibre channel tape library.

Device Status window for a fibre channel tape library.

ATAPI
ATAPI (ATA Packet Interface) is a standard for 
connecting peripheral devices such as record-
able disc drives to a computer’s IDE interface.

All ATAPI devices are connected internally on 
the IDE bus. There can be one or two devices 
per channel, numbered 0 and 1, known as the 
master device and the slave device, respective-

ly. (ATAPI device numbers are set with 
jumpers or special cables.)

No additional software is required under to use 
ATAPI backup devices with Retrospect.

FireWire
FireWire is a specification of mechanical, elec-
trical, and functional standards which lets a 
computer connect and communicate with stor-
age devices, such as hard disks and removable 
disk drives, and other peripheral devices, such 
as scanners and video camcorders. FireWire is 
also known as i.LINK or 1394, from its official 
IEEE 1394 specification.

FireWire connects a computer with peripheral 
devices by linking as many as 63 devices with 
special FireWire cables plugged into FireWire 
ports. FireWire is hot-pluggable, so, in most 
cases, you do not have to shut down devices to 
add or remove them, nor do you have to restart 
the Macintosh. FireWire is capable of extreme-
ly fast transfer rates.

No additional software is required to use 
FireWire backup devices with Retrospect. Refer 
to your documentation for installation and con-
figuration details.

USB
USB (Universal Serial Bus) is a specification of 
mechanical, electrical, and functional standards 
which lets a computer connect and communi-
cate with input devices, such as keyboards and 
joysticks, and peripheral devices, such as re-
movable disk drives and scanners.

USB connects a computer with peripheral de-
vices by linking as many as 128 devices with 
special USB cables plugged into USB ports.

No additional software is required to use USB 
backup devices with Retrospect. Refer to your 
documentation for installation and configura-
tion details.
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SEEING YOUR BACKUP DEVICE
To see a list of the backup devices available to 
Retrospect, click Devices from the Configure 
tab. Retrospect displays connected recordable 
disc drives and tape drives, and connected re-
movable disk drives with mounted media (disks 
or cartridges in the drives).

NOTE: Hard disk drives do not appear in this 
window, but can be used as backup devices. See 
“Hard Disk Drives” on page 36.
Click the Device Status button. Retrospect 
scans the computer and opens a new window 
displaying device ID numbers and their con-
nected devices, if any.

For each ID, Retrospect lists the device vendor, 
its product name, and its firmware version num-
ber. In the case of a device for which Retrospect 
has a special, Retrospect-internal driver, the 
driver is also identified, in boldface.

In the example above, the Ecrix tape drive is 
shown as a recognized device on the SCSI bus. 
“Ecrix VXA DC (5.03)” indicates Retrospect’s 
internal driver version for this drive.

If the device has been qualified by Dantz for use 
with Retrospect or the device is “recognized”, 

the driver is identified in boldface. Recognized 
devices have not been put through Dantz’s rig-
orous qualification tests, but will work fine with 
the listed driver under most circumstances.

To determine if your device is qualified, refer to 
the Support & Hardware section of 
www.dantz.com. You can also check the web 
site to see if Dantz has released a Retrospect 
Driver Update (RDU) for your device.

Retrospect does not have its own drivers for re-
movable disk drives because it can already 
communicate with them through the operating 
system.

When You Can’t See Your Backup 
Device
If you are backing up to removable disks or ex-
ternal hard disks, make sure you can see and 
access the drive in the Finder. If you cannot, re-
fer to your drive’s documentation for 
information on setting it up properly. When you 
can access it from the desktop, you should be 
able to see it in Retrospect.

For SCSI devices, make sure each device is 
turned on, the cables are securely connected, 
each device has a unique ID, and the SCSI chain 
is properly terminated. Do not rearrange devic-
es on a SCSI chain unless each device and the 
computer itself are all turned off.

If your SCSI chain is not properly connected 
and terminated, or if there is an ID conflict, 
many different problems can result. The most 
harmless problem would be a device that does 
not appear in the device status list. A more seri-
ous—yet subtle—problem could be a 
communication failure between the backup 
computer and the backup device, leading to data 
loss. The most serious problem would be dam-
age to your computer or SCSI devices on the 
chain.

A drive that does not appear in the storage de-
vices window and device status window may 

http://www.dantz.com/index.php3?SCREEN=compatibility_list
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not be supported by Retrospect or may have 
special requirements. Refer to the Dantz web 
site for the latest compatibility information and 
more specific details on supported devices.

Chapter 10 • Problems and Solutions includes 
troubleshooting instructions on how to see your 
device with Retrospect. See “General Device 
Troubleshooting” on page 203.

Commands for Seeing Devices
The Device Status window has commands for 
seeing devices.

Ignore ID: If you select an ID and click Ignore 
ID, Retrospect will not scan that ID when 
Retrospect is next opened after you quit. This 
may be useful if you are not backing up to your 
CD/DVD drive and want to use it to play music 
while you are backing up. It is also a good way 
to ignore devices on a Fibre Channel network 
that you don’t want the backup computer to see.

Don’t Ignore: To make Retrospect recognize a 
previously ignored ID, select the ID and click 
Don’t Ignore. Retrospect will scan that ID when 
Retrospect is next opened after you quit.

Rescan: Clicking this button makes Retrospect 
scan and display any device changes since the 
window was initially opened.

Configure: If you select a CD/DVD drive and 
click this button, you can create (or delete) a 
custom configuration for your CD/DVD drive. 
See “Configuring CD/DVD Drives” on page 33 
for more information.

RECORDABLE AND REWRITABLE 
DISC DRIVES
With Retrospect, you can back up to and restore 
from recordable and rewritable disc drives. 
Dantz’s hardware lab qualifies many, but not 
all, CD/DVD drives. For a list of qualified 
drives, see www.dantz.com.

If your drive is not qualified, Retrospect may 
still be able to support it. See “Configuring 
CD/DVD Drives” on page 33 for more 
information. 

When Retrospect is executing a script unattend-
ed and requires a new disc, it will automatically 
use any disc in the drive that is erased or has the 
correct name. 

New, blank CD-R, DVD-R, or DVD+R media 
is considered erased and will be used. New, 
blank CD-RW, DVD-RW, or DVD+RW media 
will be prepared by Retrospect and then used. 
Previously recorded CD-R, DVD-R, or 
DVD+R media cannot be erased and thus can-
not be used by Retrospect. 

Because a disc with any recorded data will not 
be used by Retrospect in unattended operations, 
it is a good idea to prepare rewritable media 
ahead of time by erasing CD-RW, DVD-RW, or 
DVD+RW discs containing unwanted data. See 
“Commands for Discs” on page 33.

WARNING: You cannot restore data unless 
you have a Retrospect-supported rewritable 
disc drive. Backups are not readable in a CD-
ROM or DVD-ROM drive.

Recordable and Rewritable Media
CD-R, DVD-R, and DVD+R discs are write-
once media which cannot be erased. Use care 
when choosing your CD/DVD backup set 
names and when deciding which files to back 
up.

CD-RW, DVD-RW, and DVD+RW discs are 
rewritable and can be recorded over and over 
like floppy disks or removable disks. There is a 
limit to the number of rewrites, but you are not 
likely to encounter it with Retrospect.

Dantz uses the term “recordable disc,” or sim-
ply “disc,” to refer to a recordable disc to be 
used in a CD-R, CD-RW, DVD-R, DVD+R, 
DVD-RW, or DVD+RW drive. These drives all 

http://www.dantz.com/index.php3?SCREEN=options
http://www.dantz.com/index.php3?SCREEN=options
http://www.dantz.com/index.php3?SCREEN=compatibility_list
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work nearly the same with Retrospect, though 
they may use different media. The difference is 
that data on “R” discs cannot be erased, while 
“RW” discs can be erased in rewritable drives 
and reused by Retrospect. Rewritable discs are, 
of course, recordable, so they are included in the 
term “recordable discs.”

Retrospect can use any media supported by a 
given drive. Different brands, speeds, and types 
of media vary greatly. For best results, use high-
quality media. Some drive manufacturers rec-
ommend or require particular brands of media 
with their drives, while some do not support us-
ing high-speed media. Check with your drive 
manufacturer for media recommendations.

Formatting discs with other programs prior to 
backup is neither necessary nor recommended. 
Use only unformatted or erased discs. You can 
erase formatted rewritable discs with 
Retrospect as described below.

Viewing Disc Status
You can use Retrospect to view information 
about recordable discs that you want to use, or 
have used, for backups.

Before viewing disc information, make sure the 
device you want to use is listed in the Storage 
Devices window. If the device you want does 
not appear in the window, see “Seeing Your 
Backup Device” on page 30. 

Retrospect requires the exclusive use of the re-
cordable disc drive and it will first eject any 
loaded, previously recorded (finalized) CD-
ROM or audio disc from the drive. The drive is 
then reserved for Retrospect’s exclusive use un-
til Retrospect quits. 

TIP: If you have a CD/DVD drive that you 
don’t want to use with Retrospect, select it in 
the Device Status window and click the Ignore 
ID button. The next time Retrospect is launched 
it will ignore this drive. See “Commands for 
Seeing Devices” on page 31.

To view disc status:
1.  Insert the disc in the drive.
NOTE: When you insert a disc in a recordable 
disc drive, the operating system or other 
software may ask how you wish to prepare or 
format the disc. Always ignore formatting 
prompts and exit these windows, since you 
should not prepare backup discs with anything 
but Retrospect.
2.  From the Retrospect Directory, click the 
Configure tab, then click the Devices button.
The Storage Devices window displays.

Once a disc is loaded, its status appears.

Ready indicates the disc contains Retrospect 
data.

Erased indicates an empty disc, ready for use 
by Retrospect.

Write Protected means the disc is locked.

Content Unrecognized means the disc is not 
empty, but does not contain valid Retrospect da-
ta. (See “Content Unrecognized” on page 217.)

Wrong Version may mean the drive’s firm-
ware is not supported. Or, it may mean the 
inserted disc was written to by Retrospect for 
Windows. Retrospect for Macintosh cannot 
read such discs.

Hardware Error indicates a device error has 
occurred.

Damaged Disc indicates that the disc was dam-
aged during the previous backup. You may not 
be able to append to this disc.
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Running and Busy indicate the drive is busy.

No Media indicates there is no disc in the drive.

Commands for Discs
The Devices menu includes a number of com-
mands for working with discs.

Eject unloads the selected disc from its drive.

Erase erases the contents of the selected rewrit-
able disc. It is not available with recordable-only 
discs.

Set Write Speed is available from the Devices 
menu. Choose this command to set a write 
speed other than the default for the selected 
CD/DVD drive.

Select a write speed, then click OK.

NOTE: You should only change the write 
speed if Retrospect is unable to write to the 
drive using the default setting.

Configuring CD/DVD Drives
Retrospect includes built-in recognition for 
many CD/DVD drives. For drives that are not 
recognized, you can create a custom 
configuration. 

NOTE: Custom configurations are not 
qualified through Dantz’s rigorous Hardware 
Certification process, but successful 
configurations are supported.

During the custom configuration process, 
Retrospect asks you to insert a blank disc. This 
disc is used to run a series of tests. Make sure to 
insert the type of disc (CD-RW, DVD+RW, 
etc.) that you want to use for backups. After 
Retrospect finishes configuring the drive for 
one type of disc, you will have the opportunity 
to run the tests again with additional media 
types.

NOTE: It is only necessary to configure the 
drive with the type of media that will be used for 
backup.
After creating a custom configuration, you 
should perform a backup with verification 
turned on to ensure that Retrospect works prop-
erly with the device.

TIP: Save a copy of the custom configuration 
.rdi file to a location on your network, or back it 
up to a backup set other than a CD/DVD backup 
set. If the .rdi files gets lost or damaged, you can 
move (or restore) the saved copy to the 
appropriate location instead of reconfiguring 
the drive. The .rdi file is saved in 
Library/Preferences/Retrospect. 

Automatic configuration
When you have an unrecognized CD/DVD 
drive connected to the backup computer, the 
CD/DVD configuration dialog automatically 
appears when you click the Devices button on 
the Retrospect Directory’s Configure tab (or 
perform another operation that requires a bus 
scan).
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• To create a custom configuration for the 
drive, click Configure and follow the on-
screen prompts. 

• To skip configuration and prevent the dialog 
from appearing again, click Ignore. 

• To skip configuration now, but allow the 
dialog to appear again next time, click Later.

Manual configuration
In some rare cases, you may want to create a 
custom configuration that overrides 
Retrospect’s built-in recognition. You should 
use this procedure only if you are experiencing 
difficulty backing up to a CD/DVD drive, or if 
you are directed to do so by Dantz Technical 
Support. 

NOTE: While customization may improve 
communication between Retrospect and the 
drive, it may not.

To manually launch CD/DVD Custom 
Configuration:
1.  From the Retrospect Directory, click the 
Configure tab, then click the Devices button.
2.  Click the Device Status button.
The Device Status window displays.

3.  Select the CD/DVD drive for which you 
want to create a custom configuration, then 
click Configure.

4.  To create a custom configuration for the 
drive, click Configure and follow the on-screen 
prompts.

Deleting a custom configuration
If you created a custom configuration for a 
CD/DVD drive and you continue to have prob-
lems, or your problems get worse, delete the 
custom configuration.

To delete a custom configuration:
1.  From the Retrospect Directory, click the 
Configure tab, then click the Devices button.
2.  Click the Device Status button, select the 
CD/DVD drive for which you want to delete the 
custom configuration, and click Configure.
3.  Click Delete to remove the device’s custom 
configuration and use Retrospect’s built-in 
support, if available. 
NOTE: The Delete button is only available if 
you have previously created a custom 
configuration.
4.  Click OK to confirm deletion.
WARNING: Retrospect cannot back up to a 
CD/DVD drive for which it is has no 
configuration (custom or built-in).

Custom configuration and the bootable 
CD
You cannot create a custom configuration for a 
CD/DVD drive when your computer is booted 
from the Retrospect Mac OS X bootable CD.

This means that, in order to restore a computer 
from a CD/DVD backup set that was written us-
ing a custom configuration, you must follow the 
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instructions in “Restoring the Backup Comput-
er Without the Bootable CD” on page 120

REMOVABLE DISK DRIVES
Though Retrospect is often used with discs or 
tapes, it is just as effective when used with 
drives with removable media which mount as 
volumes on the Macintosh desktop. 

For the purposes of this software, a removable 
disk drive is a device that uses media that can be 
mounted and ejected with the Finder. This in-
cludes Zip, Jaz, SuperDisk, DVD-RAM, and 
MO. Mac OS X supports some removable disk 
drives but requires add-on drivers to support 
others. (The drive vendors include these drivers 
with the devices.)

NOTE: Retrospect can use external USB and 
FireWire hard disks as members of removable 
disk backup sets. See “Hard Disk Drives” on 
page 36.
Disks must be mounted as volumes on the Mac-
intosh desktop for Retrospect to recognize 
them. When a volume is mounted its icon ap-
pears on the Macintosh desktop.

Some drives are mounted at startup while others 
require you to use software to manually mount 
volumes. Most removable disk drives include 
software to automatically mount volumes when 
you are swapping disks or cartridges. Often, this 
software is a system extension that must be 
loaded at startup to later mount disks.

NOTE: Before using Retrospect to back up to a 
removable disk drive you should be familiar 
with the procedures to insert, format, erase, and 
eject cartridges.
When Retrospect is executing a script unattend-
ed and requires a new piece of media, it will 
automatically use any appropriate media that is 
erased or has the correct name. It is a good idea 

to prepare disks for use ahead of time by erasing 
or reformatting them.

NOTE: For removable disks such as Zip, Jaz, 
SuperDisk, DVD-RAM, or MO, format with 
the software that came with your drive.

Choosing the Backup Set Type
A removable disk drive can be the destination 
for both file backup sets and removable disk 
backup sets. There are some important differ-
ences between these two types of backup set: 

• A removable disk backup set can grow 
continuously by spanning multiple 
removable disks or cartridges, just as a 
CD/DVD backup set can span multiple 
discs. A file backup set cannot grow beyond 
the available space of its single disk or 
cartridge.

• Removable disks used as part of a removable 
disk backup set must be erased before you 
can use them. Removable disks used as part 
of a file backup set do not have to be erased, 
and the disk can store and access files other 
than the backup set data files.

Viewing Removable Disk Status
You can use Retrospect to view information 
about removable disks that you want to use, or 
have used, for backups.

Before viewing disk information, make sure the 
device you want to use is listed in the Storage 
Devices window. If the device you want does 
not appear in the window, see “Seeing Your 
Backup Device” on page 30. 

To view disk status:
1.  Insert a disk into the drive.
2.  From the Retrospect Directory, click the 
Configure tab, then click the Devices button.
The Storage Devices window displays.
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Once a disk is loaded, its status appears.

Ready indicates the disk contains Retrospect 
data.

Erased indicates an empty disk.

Content Unrecognized means the disk is not 
empty, but does not contain valid Retrospect da-
ta. With a removable disk, the unrecognized 
content likely is other files, which you may not 
want to lose. (See “Content Unrecognized” on 
page 217.)

WARNING: When a removable disk shows as 
Content Unrecognized, use caution. Any files 
on a disk are permanently removed when 
Retrospect uses the disk for backup. Be 
especially careful not to use a hard disk which 
has been formatted to appear as a removable 
disk; the unrecognized content may be your 
valuable data.
Unloaded usually means a disk is in the drive 
but must be ejected and reinserted to be used.

Running and Busy indicate the drive is busy.

No Media indicates there is no disk in the drive.

Formatting Removable Disks
Before you use an unformatted removable car-
tridge or similar disk with Retrospect, you must 
first format the disk with a formatting utility or 
the operating system. You must format all disks 
as Mac OS Extended (HFS+) to be supported. 

TIP: When you have a choice of multiple file 
systems, such as with DVD-RAM, use only 
HFS or HFS+.

Commands for Removable Disks
The Devices menu includes a number of com-
mands for working with removable disks.

Eject unloads the selected medium from its 
drive.

Erase erases the contents of the selected disk.

HARD DISK DRIVES
Retrospect supports hard disk drives as a back-
up destination. This includes internal and 
external hard disks directly connected to the 
backup computer, and hard disks served over 
the network. To use a hard disk with Retrospect, 
it must be accessible through the Finder, since 
Retrospect uses the file system, not custom 
drivers, to communicate with hard disk drives. 

Hard disk drives are generally not listed in the 
storage devices window. To see the hard disks 
available for use with Retrospect, click the Con-
figure tab, then click Volumes.

The main drawback of using a fixed hard disk as 
a backup device is that the fixed disk does not 
have removable media for off-site storage and 
media rotation. (“Backup Strategies” in 
Chapter 8 describes these important aspects of 
safe and secure backups.) “Hot-swapable” or 
external drives are more flexible in these 
respects.

Choosing the Backup Set Type
A hard disk drive can be the destination for both 
file backup sets and removable disk backup 
sets.

NOTE: You must set Retrospect’s Media 
Handling preferences to use FireWire and USB 
hard drives as removable disks. See “Media 
Handling Preferences” on page 159.
There is one major difference between using 
hard disks with file backup sets and removable 
disk backup sets:
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• A removable disk backup set that uses hard 
drives as the destination can grow 
continuously by spanning multiple hard 
disk. A file backup set cannot grow beyond 
the available space on a single hard disk.

Duplicating to a Hard Disk
You can also use Retrospect to duplicate one 
hard disk to another. See “Duplicate” on 
page 58. However, because a duplicate is just a 
mirror of the source volume, not a managed 
backup, a duplicate lacks the flexibility and 
benefits of Retrospect’s backup operation. The 
main advantage of a duplicate is that the files on 
the backup volume can be opened, copied, or 
otherwise used directly with the Finder, where-
as with backups, you must first restore the files 
with Retrospect.

TAPE DRIVES
Retrospect supports most tape drives without 
requiring the installation of additional software. 
For a list of supported tape drives, see 
www.dantz.com.

Unlike random access devices such as hard 
drives, removable disk drives, and CD/DVD 
drives, tape drives are sequential access devic-
es. Since the data reading mechanism cannot 
immediately go to the correct data position on 
the media, a tape drive accesses data more slow-
ly than a disk drive (or similar random access 
device). It is just like fast-forwarding a music 
cassette to find your favorite song.

Sequential access media is relatively inexpen-
sive, has large capacity, and has a good 
sustained data transfer rate. Thus, tapes are par-
ticularly well suited for backups.

When you use Retrospect to back up a volume 
to a tape, the data is written sequentially from 
the beginning of the tape to the end. When you 
add backups to the tape, the data is appended 

where the previous data ends, until the tape runs 
out.

Neither the backup computer nor Retrospect 
will mount a tape when you put it in the drive, 
so do not expect the tape to appear on your Mac-
intosh desktop. You cannot see it in the Finder 
to drag files to and from the tape like a disk vol-
ume. This is not bad because a sequential access 
device is not optimal for the type of file man-
agement you are likely to do with a mounted 
volume in the Finder. Though the technology 
exists to let you mount a tape as a volume and 
use it like a disk, you probably would not want 
to do this for regular backups because of the 
performance issues discussed previously. 
Retrospect’s system for backing up and restor-
ing files to and from tapes is far more powerful, 
efficient, and reliable.

Tape Capacity
The actual amount of data that will fit on a given 
tape will vary due to many factors. A tape’s ca-
pacity can be greatly influenced by the relative 
speeds of the backup computer and the tape drive.

If you back up a slow source (for example, a 
slow Macintosh or a shared volume on a net-
work) to a fast tape drive, the tape capacity is 
reduced by the source’s inability to supply a 
steady flow of data to the tape drive. (This is 
like dictating to an audio cassette recorder; you 
can record more words if you speak quickly 
without pauses, but when you take a breath you 
are wasting tape because the recorder is still go-
ing, recording silence.) When the tape drive 
runs out of data while backing up, it must stop 
writing data, reposition the tape, and resume 
writing at the correct section of the tape. Each 
reposition reduces the capacity of the tape, and 
excessive repositioning can lead to accelerated 
device wear.

Do not be surprised if your tapes end up with 
less than their advertised capacities. Some tape 
drives are represented as being capable of high-

http://www.dantz.com/index.php3?SCREEN=compatibility_list
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er capacities than the drives normally achieve in 
day to day use. The representations refer to the 
amount of data before it gets compressed by a 
tape drive with hardware compression capabili-
ty—and they often assume generous 
compression rates. 

Compression
Compression, which can be done by Retrospect 
(software data compression) or a capable tape 
drive (hardware data compression), conserves 
space on media by reducing the size of the data 
being stored. Compression does not actually in-
crease the media capacity—a given tape can 
only hold a certain amount of data. Compres-
sion squeezes the original data to a more 
compact size before the data is put on the tape, 
allowing you to fit more of your files on a given 
tape.

Hardware data compression is extremely com-
mon on tape drives. Retrospect uses a drive’s 
hardware compression whenever possible, au-
tomatically turning off Retrospect’s software 
compression option if necessary. 

TIP: It is much faster to let the tape drive 
compress the data than to have Retrospect 
compress it. 
The amount of compression achieved varies de-
pending on the type of data being backed up. 
Text files generally compress well, while appli-
cations and system files do not. Compression 
can reduce data to half its original size.

Retrospect disables hardware compression 
when you use encryption because encrypted 
data compresses poorly. If you need to use en-
cryption and compression together, use 
Retrospect’s software compression option. 
Retrospect then compresses the data before en-
crypting it, which is not possible when 
hardware compression is used.

Tape Drive Mechanisms
Though you may buy your tape drive from one 
of many companies, the drive is actually built 
around a mechanism from one of several manu-
facturers. Typically, companies purchase bare 
mechanisms from manufacturers, put them in 
their own cases and packaging, and support the 
products with their own staffs.

Popular types of tape mechanisms available are 
ADR, AIT, AME, DAT, DLT, DTF, Exabyte, 
Travan, Ultrium, LTO, and VXA. Robotic tape 
libraries are available for several types of these 
drive mechanisms. 

High speed, large capacity tape drives such as 
AIT, AME, DLT, DTF, and Ultrium require a 
high performance environment. Best speed and 
capacity results are achieved with a fast com-
puter processor. The most important 
performance factor is the speed of the source 
volume. If the source is too slow, the drive must 
frequently stop to reposition the tape while 
waiting for additional data. If the drive reposi-
tions too often, copy performance will decrease 
dramatically. 

TIP: High performance SCSI adapters can help 
to improve overall performance when using 
tape drives.

DAT
DAT drives span the gap between entry-level 
tape drives such as Travan and higher-end prod-
ucts such as DLT and AIT. Each compact DAT 
cartridge, containing a length of 4 mm wide 
tape, holds about 2 GB (DDS-1), 4 GB 
(DDS-2), 12 GB (DDS-3), 20 GB (DDS-4), 
36 GB (DAT 72), or more depending on how 
much your files are compressed. Speeds range 
from 6 MB per minute with older DDS-1 drives 
to 150 MB per minute with newer DAT 72 
drives.
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AIT/AME
Eight millimeter drives using Advanced Intelli-
gent Tapes (AIT, AIT-2, and AIT-3) or 
Advanced Metal Evaporated (AME) tapes are 
among the fastest tape drives available. Their 
mechanisms can store 12 to 100 GB of uncom-
pressed data at very high speed when used 
under optimal conditions.

ADR
ADR tapes can store 15, 25, 30, and 60 GB of 
uncompressed data. 

VXA
VXA drives provide tape technology that is re-
liable and relatively inexpensive for small- to 
medium-sized environments. VXA formats 
data in packets, operates at variable speed, and 
can read data multiple times in a single pass of 
the tape. A VXA-1 tape can store 33 GB of un-
compressed data. A VXA-2 tape can store 80 
GB of uncompressed data.

DLT
DLT and Super DLT drives are among the fast-
est tape drives available. Their mechanisms 
offer exceptional performance and 2.6 GB to 
300 GB uncompressed capacity when used un-
der optimal conditions.

DTF
Digital Tape Format (DTF) drives store 12 to 
200 GB of uncompressed data. They are among 
the fastest and largest capacity tape drives avail-
able when used under optimal conditions.

Travan
These tape drives have uncompressed capaci-
ties of 1.5, 2, 4, 10, or 20 GB, depending on the 
tape cartridge used. Travan “NS” (Network Se-
ries) drives include hardware compression.

Ultrium/LTO
Ultrium tape drives are among the fastest and 
largest capacity tape drives available. The Ultri-
um format was created by the LTO (Linear 

Tape Open) Consortium. Ultrium-1 tapes offer 
an uncompressed capacity of 100 GB. Ultrium-
2 tapes offer an uncompressed capacity of 200 
GB.

Cleaning Your Tape Drive
Regular cleaning of your tape drive is essential 
for reliable performance. Dirty drive heads are 
a major cause of tape drive problems and report-
ed media failures (error –206). 

Cleaning most tape drives is as simple as insert-
ing a special tape cleaning cartridge and letting 
the drive clean itself. Refer to your drive’s doc-
umentation for its manufacturer’s cleaning 
recommendations. 

For tape libraries, you can drag and drop a 
cleaning tape from its storage slot to the drive to 
initiate a cleaning operation. When the cleaning 
operation is complete, Retrospect returns the 
tape to its slot.

Retrospect’s tape cleaning reminder preference 
(page 159) can remind you to clean your drive 
at the interval you specify.

Viewing Tape Status
You can use Retrospect to view information 
about tapes that you want to use, or have used, 
for backups.

Before viewing tape information, make sure the 
device you want to use is listed in the Storage 
Devices window. If the device you want does 
not appear in the window, see “Seeing Your 
Backup Device” on page 30. 

To view tape status:
1.  From the Retrospect Directory, click the 
Configure tab, then click the Devices button.
The Storage Devices window displays.
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2.  If there is not already a tape in the drive, 
insert one.
Once a tape is loaded, its status appears.

Ready indicates the medium contains 
Retrospect data.

Erased indicates an empty medium.

Content Unrecognized means the tape is not 
empty, but does not contain valid Retrospect da-
ta. Often, this happens when a compressed tape 
is inserted in a drive without hardware compres-
sion abilities. It also happens when you insert a 
tape written to by other backup software. (See 
“Content Unrecognized” on page 217.)

Wrong Version usually means the inserted tape 
was written to by Retrospect for Windows. 
Retrospect for Macintosh cannot read such 
tapes. It can also mean the drive’s firmware ver-
sion is not supported by Retrospect.

Write Protected means the tape is locked.

Hardware Error indicates a device error has 
occurred.

Unloaded usually means a tape is in the drive 
but is rewound and must be ejected and reinsert-
ed to be used.

Running and Busy indicates the drive is busy.

No Media indicates there is no tape in the drive.

Commands for Tape Drives
The Devices menu and the Storage Devices but-
tons include a number of commands for 
working with tape drives.

Eject unloads the selected tape from its drive.

Retension winds the selected tape forward to 
the end and back to even out the tension and 
alignment with tape mechanisms which require 
retensioning. (Most types of tapes are reten-
sioned automatically during execution, and 
cannot be retensioned manually with this com-
mand.) You should retension tapes if they have 
not been used in a long time or if the tempera-
ture or humidity of their storage environment 
has changed significantly.

Erase erases the contents of the selected tape, 
and—in the case of some tape drive mecha-
nisms—conditions media to be reused.

Format completely reformats the selected tape 
and is more time-consuming than Erase. It is 
only supported by certain tape drives.

Additional commands are available for tape li-
braries. See “Commands for Tape Libraries” on 
page 42.

TAPE LIBRARIES
A tape library (sometimes called a loader, au-
tochanger, or autoloader) is a hardware unit that 
mechanically moves tapes in and out of its drive 
mechanism(s) from a magazine or fixed storage 
slots holding several tape cartridges. Tapes can 
be arranged in any order and Retrospect will de-
termine which tape it needs to perform an 
unattended backup. Tape libraries are useful for 
large-scale network backups because they auto-
matically change tapes when one fills up, 
limiting downtime. Many tape libraries are 
available, each using one or more of the many 
available tape drive mechanisms. For more in-
formation, refer to the library’s manual and the 
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Support & Hardware section of 
www.dantz.com.

NOTE: Tape library support is only available 
with Retrospect Workgroup and Retrospect 
Server.
Retrospect supports barcode-reading libraries 
and multiple import-export slots to move car-
tridges within and to and from the library. 
Import-Export slots appear in the Storage De-
vices window. You can drag and drop tapes to 
and from the import-export slots.

How Retrospect Works with Tape 
Libraries
Retrospect works differently with tape libraries 
depending on whether or not the library sup-
ports barcode reading.

Retrospect supports barcode-reading libraries 
and manages tape cartridges based on their bar-
code identification. It displays a tape’s barcode 
in addition to its member name (if any) in media 
requests, backup set properties, and the Storage 
Devices window. In addition, Retrospect recog-
nizes CLN-coded cleaning cartridges. Barcode 
support enables Retrospect to quickly scan the 
storage slots in a library to determine their 
contents.

If your library does not support barcode read-
ing, Retrospect must scan the library to get the 
name of each tape. The library inserts each tape 
in the tape drive, and Retrospect keeps track of 
the tape names and locations. 

For libraries without barcode support, 
Retrospect uses a unique feature called “storage 
slot memory” that speeds up subsequent scans 
of the library. Each time you exit Retrospect, it 
records the state of each slot and drive in the li-
brary and saves this information as one of ten 
tables in its configuration file. (The ten tables 
reflect the ten most recent library scans.)

You can think of saved library tables as a kind 
of educated guess in the hunt for the correct 
tape. This method greatly increases the odds of 
finding a tape on the first attempt if the locations 
of the tapes in the library’s magazine remain 
relatively constant. Otherwise, Retrospect res-
cans the library to update the current inventory.

Viewing Tape Library Status
To view a tape library’s status, insert a loaded 
magazine (if applicable) and click Config-
ure>Devices to display the Storage Devices 
window. Notice how the library, tape drives, 
and slots (including import-export slots) appear 
in the window.

Retrospect displays information about the li-
brary, tape drives, and each of the storage slots, 
including status, location, and barcode. Icons 
and additional status information indicate the 
contents of each slot.

Icon Status or 
Tape Name Comments

(Empty) The slot has no tape. 

(In drive) The slot has no tape 
because it was moved 
into the drive. This is cer-
tain because the library 
always knows from which 
slot it has moved a tape 
into the drive.

http://www.dantz.com/supporteddevices
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Working with Tape Libraries
From the Storage Devices window, you can 
move tapes by dragging and dropping their 
icons. Position the pointer over a tape icon. 
When the pointer turns into a hand, you can 
click and drag a tape from slot to slot, slot to 
drive, or drive to slot. For slot to slot moves, you 
can selected multiple tapes to move at one time.

Retrospect lets you organize a tape library’s 
storage slots so that the way they appear in the 
Storage Devices window matches the library’s 
actual magazine structure.

To organize storage slots:
1.  In the Storage Devices window, select your 
tape drive, then choose Get Info from the File 
menu.

2.  Click the Mag View button.

3.  Enter the number of slots each magazine in 
the tape library includes.
Retrospect creates a Library slots container for 
each group of slots.

Commands for Tape Libraries
The Devices menu and the Storage Devices but-
tons include a number of commands for 
working with tapes and tape drives.

For tapes in a drive:

Eject moves the selected tape from the drive to 
its slot.

Erase erases and lets you name the selected 
tape.

For slots in the library:

Scan Selected cycles through the selected stor-
age slots in the library, moving each tape from 
slot to drive to learn the name of the tape. You 
do not need to use this command if your tape 
drive supports barcodes.

Erase Selected erases each tape in the selected 
storage slots of the library.

Move Selected to Drive moves the selected 
tape to the drive. (This command is only avail-
able from the Devices menu).

Unload All/Mag unloads tapes from the li-
brary’s drive(s) and returns them to their slots. 
Then, for capable libraries, ejects the library’s 
magazines.

Cleaning Slot designates the selected slot as a 
cleaning slot. Retrospect will not scan the clean-
ing slot when it searches for media. If your 

(Unknown) The slot has never been 
scanned by Retrospect.

(Cleaning 
tape)

The slot has been desig-
nated as a cleaning tape 
slot by Retrospect.

Name The named tape was in 
the slot when Retrospect 
last scanned for tapes, 
but the status is unveri-
fied because the slot’s 
content may have 
changed since then.

[Barcode] 
Name

The named tape was in 
the slot when Retrospect 
last scanned for tapes, 
and is verified because 
the slot’s content could 
not have changed since 
then.

Icon Status or 
Tape Name Comments
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library supports barcode reading, Retrospect au-
tomatically recognizes a CLN-coded cleaning 
tape and reserves its slot for cleaning purposes. 
See “Cleaning Your Tape Drive” on page 39 for 
more information. (This command is only avail-
able from the Devices menu).

Retrospect does not have a function for auto-
matically cleaning drives in libraries, but it does 
have a tape cleaning reminder feature. See 
“Maintenance Preference” on page 159. Refer 
to your library’s documentation for the manu-
facturer’s cleaning recommendations.

Initialize Elements sends the Initialize Ele-
ments Status command to the library, which 
forces the library to update the status of all ele-
ments. Use this command if you encounter a 
situation in which the information reported in 
the Storage Devices window does not match the 
actual state of the library. (This command is 
only available from the Devices menu).

Import-Export Support
Some libraries come with separate ports that are 
used to load single tapes into and out of the li-
brary without opening the door. Retrospect uses 
the term “import-export slot” for this feature, 
which is also known as “Mail Slot,” “I/E ele-
ment,” and “Call Slot.” If the import-export 
slots are present and enabled in a library, 
Retrospect displays them as separate slots at the 
top of the list of slots. You can drag and drop 
tapes from the source drive or any slot onto the 
import-export slot and the library will move the 
selected tape to the port. When you place a tape 
into the port, Retrospect displays “Media Avail-
able” next to the import-export slot and you can 
move it by dragging it to any slot or drive in the 
library.

Retrospect does not scan import-export slots 
during media requests. Do not place a tape in 
the import-export slot if you want to use the tape 
in an immediate or automated operation.

Tape Library Media Requests
During immediate and automated operations, 
Retrospect scans the library, searching for the 
appropriate media, and loads whichever tape is 
required. If a new or erased tape is required, 
Retrospect will load and use the first one 
available.

If it cannot find an appropriate tape to use, 
Retrospect displays the media request window. 
The operation cannot continue until you insert 
media.

NOTE: Retrospect does not scan import-export 
slots during media requests.

MEDIA LONGEVITY AND 
STORAGE
Media life depends largely upon how the media 
is stored and maintained. Proper storage avoids 
moisture, heat, and particulate contamination, 
which cause media deterioration, leading to loss 
of media integrity or loss of data itself.

Magnetic media's worst enemy is moisture. Op-
tical media's worst enemy is heat, which causes 
distortion, and particulate matter, which causes 
scratches. Keep media out of direct sunlight and 
away from heaters. Avoid extreme temperature 
changes. Airborne particulates such as dust and 
cigarette smoke can also harm media.
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Tapes are unique in that they use lubricant. The 
tape media is lubricated, and after many passes 
over the drive's heads, tapes tend to fail because 
the lubricant has dissipated. You should be able 
to get a few thousand passes from a tape, but re-
member that each tape operation involves 
several passes.

A fire-proof safe in a climate-controlled build-
ing is an ideal media storage location. At the 
very least, keep the media in its original con-
tainers inside a cabinet or desk.

HOW RETROSPECT WORKS WITH 
MULTIPLE BACKUP DEVICES
During an operation, Retrospect searches avail-
able backup devices for the appropriate 
medium. If the medium fills or Retrospect needs 
another medium for any reason, it searches 
available drives. This is useful, for example, to 
have one drive with the tape Retrospect expects 
and another drive with an empty tape for when 
the first tape fills during the night. The drives 
must use similar mechanisms, such as two DAT 
drives.

Retrospect for Macintosh cannot simultaneous-
ly write to multiple devices.
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C H A P T E R    4
I M M E D I A T E  O P E R A T I O N S

• B A C K U P

• A R C H I V E

• R E S T O R E

• D U P L I C A T E

• T R A N S F E R

Immediate operations are ones that you initiate manually and that execute immediately. 
Types of immediate operations are: backup, archive, restore, duplicate, and transfer. This 
section describes each of these operations in detail.

If you are a casual user needing only occasional backups, you may be satisfied performing 
only immediate operations. However, if you are a network administrator who frequently 
backs up multiple volumes, you are better off automating these tasks with scripts. Whether 
you plan to do immediate or scripted operations, this section is a good introduction to 
Retrospect.

Scripts are described in Chapter 5 • Automated Operations.
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BACKUP
This section describes how to perform an imme-
diate backup with Retrospect. The backup 
procedures described here include all the infor-
mation you need to know to effectively back up 
all of your files.

There are three basic stages in backing up:

• Choosing the source volumes to back up
• Choosing the backup set in which to store 

the files (or creating a new backup set)
• Executing the backup

The first time you back up the contents of a 
source volume, Retrospect backs up all selected 
files. In subsequent backups (unless you indi-
cate otherwise), Retrospect backs up only those 
files that are new or have changed since the last 
backup to that particular backup set. Dantz calls 
this IncrementalPLUS Backup. This means that 
if you back up frequently, fewer files need to be 
copied in each backup session and backups will 
require less time and media.

Preparing to Back Up
Before you attempt to back up files with 
Retrospect, ensure that your backup device is 
properly connected to the backup computer and 
that your storage media (tape, disk, or disc) does 
not contain valuable data that should not be 
overwritten.

To begin an Immediate Backup, click the Im-
mediate tab, then click the Backup button. If 
you have backed up before, the Immediate 
Backup summary window appears. This is so 
you can easily initiate backups with only a few 
clicks. If you have not backed up before, 
Retrospect displays the Volume Selection 
window.

Choosing Source Volumes
In the Immediate Backup summary window, 
click the Sources button to display the Volume 
Selection window. 

It lists all volumes currently available to be 
backed up, including your internal hard disk, 
any connected removable disk drives or hard 
disks, any mounted shared volumes, and any 
logged-in client volumes on the network. 

The volume list works much like a volume or 
folder window in the Finder viewed as a list. It 
is organized hierarchically by Local Desktop, 
Backup Clients, and Source Groups. Click on 
the  icon to expose the contents indented un-
der an item and click on the  icon to hide the 
contents. All aspects of the volume selection 
window, including navigating, organizing, se-
lecting, and subvolumes are fully explained in 
“Working with Volumes” in Chapter 9.

In the volume list, click a volume to select it. To 
back up more than one volume, Shift-click or 
Command-click other volumes.

NOTE: Do not select a source volume that is on 
a removable disk drive unless you are going to 
back up to a different drive. 
When you have made your volume selection, 
click OK to continue setting up the immediate 
backup. The volume selection window closes 
and Retrospect returns to the Immediate Backup 
window.

Choosing the Destination Backup Set
In the Immediate Backup window, click the 
Destination button to display the Backup Set 
Selection window, which lists available backup 
sets.
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Select a destination backup set and click OK to 
continue setting up the backup. If no backup 
sets are listed in the Backup Set Selection win-
dow, or if you do not wish to use any of those 
listed, you can create a new backup set. 

Creating a New Backup Set
If no backup sets are listed in the backup set se-
lection window, or if you do not wish to use any 
of those listed, click the New button to make a 
new backup set.

Use the Backup Set Creation window to set the 
attributes of the backup set. You cannot change 
the attributes of a backup set after it is created.

Backup Set Type The most important item in 
the window is the backup set type, which spec-
ifies the type of media the backup set uses for 
this and future backups. Use the pop-up menu to 
choose a backup set type that corresponds to 
your backup device media—CD/DVD discs, re-
movable disks, tapes, file, or the Internet. See 
“Backup Sets and Their Components” on 
page 21 for more information on the different 
types of backup set.

Security Security lets you specify a password 
for accessing the backup set, with optional data 
encryption. By default, new backup sets do not 
have a password or use encryption.

Click the Secure button to set the security op-
tions for the backup set.

NOTE: Using encryption increases backup 
time. DES encryption is slower than 
SimpleCrypt, which provides adequate security 
for most needs.

• Password Only prevents access to your 
backup set without a password. Stored data 
is not encrypted.

• SimpleCrypt provides password protection 
and encrypts backup set data using Dantz’s 
proprietary encryption format.

• DES provides password protection and 
encrypts backup set data using the United 
States government Data Encryption 
Standard.

WARNING: If you forget your password you 
cannot access your data. There is no “magic 
key” or “back door” to circumvent the 
encryption. Not even Dantz Technical Support 
can help you.
Data Storage (tape backup sets only) When the 
Allow hardware data compression checkbox is 
checked, Retrospect uses the tape drive to com-
press data in the backup set, provided that the 
tape drive supports data compression. This op-
tion cannot be selected if the backup set is 
encrypted.

NOTE: If you need to use both encryption and 
compression for a tape backup set, specify an 
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encryption option in the security dialog and use 
Retrospect’s software compression option. See 
“Backup Options” on page 143 for more on 
software data compression. Software data 
compression is available for all backup set 
types.
Name In the Name field, enter a unique and de-
scriptive name for the backup set. For example, 
“Monday Complete Backup,” “Accounting 
Backup,” or “Friday Clients Backup.” 
Retrospect uses this name to identify both the 
catalog file and the backup set media. Name 
backup sets carefully because they cannot be re-
named. File backup sets are the exception and 
they can be renamed in the Finder.

When the backup set description is complete, 
click New to create the backup set. 

• For tape, CD/DVD, and removable disk 
backup sets, a dialog appears, prompting 
you for a location to save the catalog file that 
keeps track of the contents of the backup set. 
Specify a location for the catalog (your hard 
disk is best) and click Save.

• For file backup sets, a dialog appears, 
prompting you for a location to save the 
backup set file. Specify a location for the file 
backup set (on the destination volume) and 
click Save.

• For Internet backup sets, a dialog appears, 
prompting you for FTP connection 
information. Enter the information as 
described in “For Internet backup sets:” and 
click OK.

Once the new backup set is created, Retrospect 
displays the Backup Set Selection window with 
the new backup set listed as available for 
backup.

When the backup set you want to use is listed in 
the Backup Set Selection window, select it and 
click OK to continue setting up the backup.

For Internet backup sets:
For Internet backup sets, you need to configure 
the connection to the FTP server.

Enter your FTP user ID, password, and server 
name (or IP address). In the directory field, give 
the path (not including the host server itself) to 
the directory in which you want to store this In-
ternet backup set, or click Directories to 
navigate the path to your desired directory and 
select it.

NOTE: Clicking the Directories button may not 
be helpful with some FTP servers because some 
folders may not appear in the dialog’s list. In 
this event, cancel the dialog and type the path 
into the Directory field of the connection 
configuration window.
When you use an Internet backup set, 
Retrospect creates a new directory in the direc-
tory you specified. Retrospect uses this 
directory as the Internet backup set. Do not 
modify, delete, or rename files in an Internet 
backup set directory by using a third party FTP 
utility or by working directly on the FTP server.
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When you click OK in the Internet backup set 
connection configuration window Retrospect 
tests the connection. Retrospect reports an error 
if it cannot establish a connection with the FTP 
server.

After you click OK in the connection configura-
tion window and Retrospect tests the 
connection, a dialog appears, prompting you for 
a location to save the catalog file that keeps 
track of the contents of the backup set. Specify 
a location for the catalog (your hard disk is best) 
and click Save.

Setting Additional Backup Options
After you have specified the source volume to 
back up and the destination backup set to which 
it will be copied, use the Immediate Backup 
window to verify your choices and set addition-
al options.

To makes changes, click the appropriate button.

Sources lets you add or remove source 
volumes.

Destination lets you choose a different backup 
set as a destination.

Selecting lets you choose a selector, a kind of 
filter for selecting the files and folders to back 
up. (Selectors are explained in detail starting on 
page 177.) The default selector is “All Files”, 
which marks all files on the source for backup.

Preview scans the source volume (or volumes) 
and determines which files need to be backed up 

by comparing the source files against the list of 
files in the backup set catalog. When the scan is 
complete, Retrospect opens a browser window 
to display a list of the files on the source volume 
marked for backup. You can use it to mark and 
unmark individual files and folders to be backed 
up.

Browsers are explained in “Browsing” on 
page 172. When you close the browser, the 
summary window displays summary informa-
tion about the selected files.

Options displays the basic options window in 
which you can specify the backup action (nor-
mal or recycle), and turn on or off verification 
and software data compression.

Click the More Choices button to access other 
options.

Backup actions are explained in “Backup Ac-
tions” on page 23, and other options are 
explained in “Backup Options,” which starts on 
page 143.

Executing the Backup
If Retrospect has the information it needs, it 
says “Ready to Execute” at the top of the imme-
diate backup summary window. If the information 
is incomplete, it says “Not Ready to Execute” 
and you must make changes as described at the 
top of the window. When you are ready, click 
Backup.
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If you are backing up to an Internet backup set, 
Retrospect connects to the FTP server and per-
forms the backup. 

If this is the first time you are backing up to 
disks, tapes or discs, or if there is no medium in 
the backup device, Retrospect displays a media 
request window with options for choosing the 
disk, tape, or disc for storing the files to be 
backed up. The window varies slightly depend-
ing on the type of backup set you are using.

The media request window for a tape backup set.

Insert a blank tape, removable disk, or 
CD/DVD, or one with unwanted data, because 
any files on it will be permanently removed. Se-
lect the new media in the window, then click 
Proceed.

Retrospect performs the backup, displaying the 
progress of the operation and the names of files 
as they are copied to the backup set. The execu-
tion status window has Pause and Stop buttons 
for suspending or cancelling the backup.

 

The execution status window for an immediate backup.

When the execution is complete, Retrospect in-
forms you in the status window. Close it to 
return to the Retrospect Directory. 

If any errors occurred you can get more infor-
mation in the browser that appears, or see error 

details in the Operations Log. This log is acces-
sible by choosing Log from the Window menu 
and is described in “Viewing the Operations 
Log” on page 140.

Planning Subsequent Backups
For subsequent backups, you can repeat the ba-
sic backup procedure as often as you want and 
even switch among multiple backup sets to 
maintain extra backups.

By default, Retrospect only backs up those files 
that have changed since the previous backup to 
a particular backup set.

Scripting a Backup
If you want to automate your backups so they 
can be performed while the backup computer is 
unattended (e.g., at night), you can use 
Retrospect’s scripting feature to set up and 
schedule backups. 

From the immediate backup summary window, 
choose Schedule from the Script menu to save 
the immediate backup information and settings 
as a script. You can then use the script to accom-
plish automatic, unattended backup operations.

See Chapter 5 • Automated Operations.

ARCHIVE
Archiving lets you move files from a source 
volume to a destination backup set for off-line 
storage. To set up an archive operation, first 
click the Tools tab from the Retrospect Directo-
ry, then click Copy.

In the next dialog, select Archive and click OK.
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From this point on, the archive operation is set 
up just like a backup, as described starting on 
page 46. The only difference in preparation is 
the additional option of whether to move files, 
as described on page 144, which deletes the 
original files from the source after copying 
them to the destination. This frees space on the 
source volume.

TIP: Before you use the Move files option, first 
archive to a different backup set by copying 
without moving. This provides an extra 
measure of safety should one backup set 
become unusable.
Archiving, by default, does not match source 
and destination. That is, Retrospect does not 
compare source files to files in the destination 
backup set. This means Retrospect copies all se-
lected files to the destination backup set, even if 
they already exist there. In this case, Retrospect 
is foregoing ultimate efficiency for the sake of 
archive integrity.

Make sure to read “Archiving Tips” below for 
other important information.

Scripting an Archive
When an archive summary window is active, 
you can choose Schedule from the Script menu 
to save the archive information and settings as a 
script. 

See Chapter 5 • Automated Operations.

Archiving Tips
Media: Plan for the long term. Archive to two 
or more backup sets and maintain an off-site 
copy of your archived data. Always store media 
according to manufacturer’s guidelines. See 
“Media Longevity and Storage” on page 43 for 
further information.

Periodically transfer your data to new media to 
ensure storage integrity. Do not use device-spe-
cific options such as hardware compression, 

because your next backup device may not sup-
port features of an older model.

Planning: Define an archiving system and fol-
low it every time. Only archive files in specific 
folders, having defined labels, or modified 
within a specific date range. When archiving 
from a server, force users to make a decision on 
what is to be archived by moving data to a spe-
cific location. Never archive data without 
telling users what was removed from the server.

Before you use the Move files (delete after 
copy) option, first archive to a different backup 
set by copying without moving. This provides 
an extra measure of safety should one backup 
set become unusable. If you have only a single 
archive medium and it is lost or damaged, you 
will have lost all of your data. Be sure not to re-
cycle, lose, or damage your archive media.

Verification: Always use verification. If you do 
not use verification and hardware problems oc-
cur when archiving, your data may not be 
correctly copied to the media.

On-line Archiving: To archive documents in 
place, compress them in a file backup set that 
you store on your hard disk. This way they take 
up less room, but are still on-line.

RESTORE
Retrospect allows you to restore an entire vol-
ume or restore selected files and folders from 
the most recent backup or any previous backup 
session within a backup set. You can either re-
store using a volume Snapshot from a backup 
set, or by searching through one or more backup 
sets by file name or other criteria. You can re-
store individual files, multiple files, or entire 
volumes.

This section focuses on two of the different 
methods of restoring files with Retrospect. If 
you have experienced disastrous data loss in 
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which the computing environment required to 
restore that data is not available, see Chapter 7 • 
Disaster Recovery, which includes an overview 
of different situations and provides disaster re-
covery instructions.

Snapshots
Retrospect’s Snapshots make it easy to restore a 
volume to its exact state as of a given backup. A 
Snapshot is like a picture of the contents of a 
volume. It contains a list of all of the files and 
folders on a volume and the sessions during 
which they were backed up. Each time you back 
up a volume, its Snapshot is updated in the 
backup set catalog and the new Snapshot is add-
ed to the backup medium.

To restore an entire volume, simply choose the 
Snapshot you want to restore—you do not have 
to manually locate and retrieve files from differ-
ent sessions. A Snapshot allows Retrospect to 
get the files from a backup set in a single pass 
through the media, rather than inefficiently go-
ing back and forth on the media, even if the 
backup set contains multiple backup sessions.

You can also restore individual files from a 
Snapshot. This is the easiest way to retrieve 
files that you know were on a volume during a 
given backup. If no Snapshot is available, you 
must define search criteria to choose which files 
to restore.

You can retrieve Snapshots from media if you 
want to restore a volume, folder, or file as it was 
at any given backup.

Restore by Snapshot
The process of setting up Retrospect for an im-
mediate restore operation is done in much the 
same manner as setting up an immediate backup.

From the Retrospect Directory, click the 
Immediate tab, then click Restore. A dialog 
asks you to choose the restore type.

Select the type of restore that suits your needs.

Restore an entire disk restores all files present 
on a volume at the time of a given backup. By 
default, this option replaces the entire contents 
of the destination volume and effectively recre-
ates the source volume in its backed up state. 
Use this option to restore a complete disk.

Restore files from a backup restores one or 
more selected files present on a volume at the 
time of a given backup. By default, this option 
restores the selected files and folders to a new 
folder on the destination volume, leaving the 
rest of the destination volume unchanged.

NOTE: This section explains the functions of 
“Restore an entire disk” and “Restore files from 
a backup”, which use Snapshots to restore. To 
search entire backup sets for particular files, see 
“Restore by Search” on page 55 for an 
explanation of that method.
After selecting a restore method, click OK.

Selecting the Source
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In source selection window’s top list, select the 
backup set from which to restore. You can use 
the More button if your desired set is not listed.

In the window’s bottom list, select a volume 
Snapshot. The date and time when the volume 
was last backed up are listed to the right of the 
volume’s name.

If the Snapshot you want to use is not listed, 
click the Add Snapshot button to select it from 
a list of all Snapshots in the backup set.

TIP: To restore files from a backup other than 
the most recent one you will most likely need to 
use Add Snapshot.

When you select a Snapshot and click Retrieve 
Retrospect obtains the older Snapshot from the 
backup set media (which may require you to in-
sert media) and adds it to the list in the restore 
source window.

NOTE: The Retrieve button is disabled when 
you select a Snapshot that is already available.
With your desired Snapshot selected in the 
source selection window, click OK.

Selecting the Destination

Select the volume on which you want 
Retrospect to place the restored files. This vol-
ume does not have to be the original volume 
from which the files were backed up; it can be a 
folder defined as a subvolume (see “Subvol-
umes” on page 171) or any volume mounted on 
your local desktop or belonging to a client on 
the network. Navigate through the Local Desk-
top and Backup Clients outlines as detailed 
under “Containers” on page 169.

Choosing the Method to Restore Files
Set the pop-up menu to determine how 
Retrospect restores the files to the destination.

Restore entire disk makes the destination disk 
exactly like your selected Snapshot. It deletes 
all files and folders on the destination which do 
not match those marked for restore in the Snap-
shot, leaving files untouched if they are 
identical to files marked for restore. It then cop-
ies remaining files and folders from the backup 
set, preserving the folder hierarchy. This is the 
default options if you chose “Restore an entire 
disk”. This method restores Mac OS X 
privileges.

Replace corresponding files copies the 
marked files to the destination volume into the 
same folders. Corresponding files are overwrit-
ten, even if they are newer. Retrospect leaves 
files untouched if they are identical to files 
marked for restore or if the file names do not 
match those marked for restore. This method re-
stores Mac OS X privileges.
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WARNING: Using this option to replace an 
active Windows folder will crash a Windows 
client.
Retrieve files & folders creates a new folder on 
the destination volume (giving the folder the 
name of the backup set), then copies files into 
this folder, preserving the folder hierarchy. 
Nothing is replaced or overwritten. This is the 
default option if you chose “Restore files from 
a backup”. This method does not restore the 
backed-up Mac OS X privileges of files and 
folders; it assigns them the privileges of the cur-
rently logged-in user (or root if no user is logged 
in).

Retrieve just files creates a new folder on the 
destination volume (giving the folder the name 
of the backup set), then copies only the files into 
this folder. The folder hierarchy is not pre-
served. Nothing is replaced or overwritten. (Do 
not use this option to retrieve a large number of 
files or a whole volume.) This method does not 
restore the backed-up Mac OS X privileges of 
files; it assigns them the privileges of the cur-
rently logged-in user (or root if no user is logged 
in). 

WARNING: Before restoring to a volume other 
than the current system volume under 
Mac OS X, use the Finder’s Get Info command 
on the volume. Choose Privileges from the info 
window’s menu then turn off the “Ignore 
privileges on this volume” option.
After setting the destination restore method 
with the pop-up menu, click OK to continue. 
Depending on the restore type and method, 
Retrospect may scan the destination volume and 
match files from the selected Snapshot. Then 
the restore summary window appears.

Summarizing the Restore Operation

Verify your choices for the Source, Destination, 
Files Chosen, and Options. To change informa-
tion, click the appropriate button.

Source is the backup set and volume Snapshot 
from which you want to restore files. Click this 
button to change the source.

Destination is the volume to which you want to 
restore files. Click this button to change the des-
tination volume or restore method.

Files Chosen are the files you want to restore 
from the backup set. If you chose “Restore an 
entire disk”, all files from the source Snapshot 
are chosen by default. If you chose “Restore 
files from a backup”, no files are selected by de-
fault. Click this button to use a browser to mark 
and unmark individual files and folders to be re-
stored. Browsers are explained in detail under 
“Browsing” on page 172.

Options let you reposition icons and update the 
modification dates of restored files. Click this 
button, then click More choices to change these 
options. See “Execution Options,” which starts 
on page 142, for more information on these 
options.

Executing the Restore
When Retrospect has the information it needs to 
do the restore, it says “Ready to Execute” at the 
top of the immediate restore summary window. 
If the information is incomplete, it says “Not 
Ready to Execute” and you must change one or 
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more parts of the information you gave it. When 
you are ready, click Restore.

WARNING: Restoring may destroy data on the 
destination. Be sure it is acceptable to erase or 
replace files on the destination volume.
Make sure the correct backup set media is in the 
backup device. If Retrospect cannot access the 
required media, it asks you for it.

Retrospect performs the restore, displaying the 
progress of the operation and listing the names 
of files as they are copied from the backup set 
media to the destination. The Execution Status 
window has Pause and Stop buttons for sus-
pending the restore.

 

When the execution is complete, Retrospect in-
forms you in the status window. Close it to 
return to the Retrospect Directory. If any errors 
occurred you can get more information in the 
browser that appears, or see error details in the 
Operations Log.

This log is accessible from the Window menu 
and is described in “Viewing the Operations 
Log” on page 140.

When you leave Retrospect and go to the Find-
er, you can see the destination volume is 
changed to reflect the restored files. The degree 
of change can vary from a new folder on the 
volume or a completely restructured volume, 
depending on the destination restore method 
and options.

Scripting a Restore
When a restore summary window is active, you 
can choose Schedule from the Script menu to 
save the immediate restore information and set-

tings as a script. You can then use the script to 
accomplish restore operations. 

See Chapter 5 • Automated Operations.

Restore by Search
While restoring by Snapshot lets you restore 
files from a given backup, restoring by search 
lets you retrieve one or more files regardless of 
when they were backed up. Restoring by search 
lets you search multiple backup sets at once, 
which is useful if you’re not sure which backup 
set contains the files you want to restore.

 Searching works best when you know specific 
attributes of the files you want, for example it’s 
name or type. If you want to see all backed up 
versions of a particular file, search on its name, 
and then restore exactly the version you want.

The process of setting up Retrospect for a re-
store by search is done in much the same 
manner as restoring by Snapshot.

Searching for Files
From the Retrospect Directory, click the 
Immediate tab, then click Restore. A dialog 
asks you to choose the restore type.

Click the “Search for files and folders” radio 
button and click OK.

The next window asks you to select the backup 
sets to search. Select one or more backup sets. 
Click the More button if your desired set is not 
listed.
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Once you have selected the source backup 
set(s), click OK to continue. The Destination 
Selection window displays.

Select the volume on which you want 
Retrospect to place the restored files, and spec-
ify the restore method from the pop-up menu 
(see page 53),.

NOTE: When restoring by searching, the 
methods “Restore entire disk” and “Replace 
corresponding files” work differently than 
when restoring from a Snapshot. “Restore entire 
disk” erases the destination volume before 
restoring files. “Replace corresponding files” 
replaces files with the same names as those 
being restored. 

WARNING: Before restoring to a volume other 
than the current system volume under 
Mac OS X, use the Finder’s Get Info command 
on the volume. Choose Privileges from the info 
window’s menu then turn off the “Ignore 
privileges on this volume” option.
After setting the destination restore method 
with the pop-up menu, click OK to continue. 
Retrospect displays a window for defining file 
selection criteria.

If you want to restore all files from all sources, 
leave this blank and click OK.

Otherwise, use the controls and enter text to de-
fine the search criteria on file or folder names, 
or click More Choices to make a custom selec-
tor with other search criteria. This window is 
described in detail in “Finding Files” on 
page 175. Selectors are described in “Using Se-
lectors” on page 177. 

When you have defined the search criteria, click 
OK. Retrospect searches each backup set cata-
log before displaying the summary window.

Your file selection criteria are summarized next 
to Searching. Next to Files Chosen is a brief 
quantity and size inventory of the files found by 
Retrospect in the source backup sets.

Choosing Files
Click Files Chosen to open a browser which 
lists the found files. Retrospect displays one 
browser window for each backup set in which 
files are found. You can manually unmark and 
mark these files for retrieval. See “Marking 
Files and Folders” on page 174 for more infor-
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mation. Files with check marks will be retrieved 
when the operation is executed.

Depending on your search criteria, your browser 
or browsers may list more than one version of a 
particular file. For example, a given file may 
have been modified daily and backed up every 
day over a certain period of time. Use the 
backed up or modified dates to determine which 
version you want to restore.

Additional Searching
If the browser does not display the files you 
want, you can close it and return to the summary 
window to redefine the search criteria by click-
ing the Searching button. If you change the 
search criteria, Retrospect displays a dialog ask-
ing whether you want to do a new search, 
narrow the existing search, or widen the exist-
ing search.

New replaces the results of the previous search 
with the results of the new search. 

Narrow uses the new criteria to further restrict 
the selection.

Widen uses the new criteria to add files to the 
current selection.

Select a search type, then click OK to return to 
the summary window and repeat the process un-
til you are satisfied with the chosen files.

Executing the Restore
If Retrospect has the information it needs, it 
says “Ready to Execute” at the top of the 
searching and retrieval summary window. If the 
information is incomplete, it says “Not Ready to 
Execute” and you must change one or more 
parts of the information you gave it. 

When you are ready, click Retrieve.

WARNING: Restoring may destroy data on the 
destination volume. Be sure it is acceptable to 
replace the destination volume or files with the 
source files.
Make sure the correct backup set media is in the 
backup device. If Retrospect cannot find the 
media it asks you for it in a media request 
window.

Retrospect performs the restore, displaying the 
progress of the operation in the execution status 
window, which includes buttons to pause or 
stop its execution.

When the execution is complete, Retrospect in-
forms you in the status window. Close it to 
return to the Retrospect Directory. If any errors 
occurred you can get more information in the 
browser which appears, or view error details in 
the Operations Log. 

This log is accessible from the Window menu 
and is described under “Viewing the Operations 
Log” on page 140.
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When you leave Retrospect and go to the Find-
er, you can see the destination volume is 
changed to reflect the restored files.

DUPLICATE
Retrospect allows you to duplicate files on a 
volume or among volumes. Retrospect optimiz-
es the duplication process by copying only your 
selected files and by copying only those files 
which do not already exist on the destination.

Files and folders are copied without compres-
sion, in the standard file system format, which is 
useful when transporting data to other comput-
ers. Encrypted files remain encrypted. 

The duplicate feature is useful, for example, for 
creating a bootable Mac OS X backup or a user-
accessible backup of a server or database on a 
hard disk.

TIP: Subvolumes are useful tools for 
duplicates. For example, a network 
administrator can define an application folder 
on a server as a subvolume and duplicate it for 
quick installation on a user’s workstation. See 
“Subvolumes” on page 171.

NOTE: You cannot duplicate a subvolume on a 
client to another subvolume on the same client.

Duplicating
Click the Immediate tab on the Retrospect Di-
rectory, then click the Duplicate button. The 
Volume Selection window displays.

Select the source volume from which to copy 
files and click OK. For details on using the Vol-
ume Selection window, see “Working with 
Volumes” on page 168. 

The Destination Selection window displays.

Select a destination volume and choose a meth-
od from the pop-up menu.

Replace Entire Disk replaces the entire con-
tents of the destination volume with the selected 
files and folders from the source volume. Iden-
tical files already present on the destination are 
not duplicated.

Replace Corresponding Files overwrites any 
matching files existing on the destination vol-
ume that correspond to the selected files on the 
source, even if the destination files are newer. 
Retrospect leaves files untouched if their names 
and locations do not correspond to those files 
marked for duplication.

WARNING: Before duplicating to a volume 
other than the current system volume under 
Mac OS X, use the Finder’s Get Info command 
on the volume. Choose Privileges from the info 
window’s menu then turn off the “Ignore 
privileges on this volume” option.
When you have selected the volume and set the 
pop-up menu click OK. Retrospect displays the 
immediate duplicate summary window.



CHAPTER 4 • IMMEDIATE OPERATIONS 59

This window lists the source, destination, selec-
tion criteria, files chosen preview, and options 
associated with the duplicate operation. Each 
item has a button you can click to change the in-
formation. You can use the various features for 
a highly specific duplicate operation.

To makes changes, click the appropriate button.

Source lets you changes the source volume.

Destination lets you choose a different volume 
as a destination.

Selecting lets you choose a selector, a kind of 
filter for selecting the files and folders to dupli-
cate. (Selectors are explained in detail starting 
on page 177.) The default selector is “All 
Files”, which marks all files on the source for 
duplication.

Files Chosen compares the files on the source 
volume to those on the destination volume then 
opens a browser window. The browser window 
lists the files on the source which do not already 
exist on the destination. These files are marked 
for duplication. You can also manually unmark 

and mark files. See “Marking Files and Folders” 
on page 174 for more information. Files with 
check marks will be duplicated when the opera-
tion is executed.

Options displays the basic options window in 
which you can specify whether or not to update 
the backup report, move files, and turn on or off 
verification.

These options are described in “Duplicate Op-
tions,” which starts on page 144. Click the More 
Choices button to access other options, which 
are described in “Execution Options,” which 
starts on page 142.

Executing the Duplicate 
If Retrospect has the information it needs, it 
says “Ready to Execute” at the top of the imme-
diate duplicate summary window. If the 
information is incomplete, it says “Not Ready to 
Execute” and you must change one or more 
parts of the information you gave it. 

When you are ready, click Duplicate.

WARNING: Duplicating may destroy data on 
the destination. Be sure it is acceptable to erase 
or replace files on the destination volume.
An execution window shows the progress of the 
duplicate operation and includes buttons to 
pause or stop its execution. When the execution 
is complete, Retrospect informs you in the sta-
tus window. Close it to return to the Retrospect 
Directory. If any errors occurred, you can view 
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more information in the browser that appears, or 
see error details in the Operations Log. 

This log is accessible from the Window menu 
and is described on page 140.

Scripting a Duplicate 
When a duplicate summary window is active, 
you can choose Schedule from the Script menu 
to save the immediate duplicate information and 
settings as a script. You can then use the script 
to accomplish duplicate operations. 

See Chapter 5 • Automated Operations.

TRANSFER 
Retrospect’s transfer function copies one or 
more files from one or more backup sets to a 
single backup set. One possible use is to copy 
all files from a removable disk backup set to a 
CD/DVD backup set. Another possible use is to 
copy a few selected files from your backup set to 
a new, encrypted backup set for your business 
partner.

Because transferring does not match files, you 
cannot transfer incrementally from one backup 
set to another. All files that meet the selection 
criteria will be copied by Retrospect, regardless 
of whether they already exist in the destination 
backup set.

The transfer function does not have a preview 
feature. You must rely on selectors instead of 
picking and choosing files by hand.

To copy files between backup sets, you must 
have a separate backup device for each backup 
set, even if both backup sets are on the same 
type of media. In the case of file backup sets, the 
need for separate backup devices does not 
apply.

TIP: If you do not have separate drives for each 
backup set, you can first copy files temporarily 
to a file backup set on a hard disk and then copy 

them from the file backup set to the destination 
backup set.

Transferring Files
To copy files between backup sets, first click 
the Tools tab from the Retrospect Directory, 
then click Copy. In the next dialog, select 
Transfer.

Click OK The source Backup Set Selection 
window displays.

Select one or more source backup sets, and click 
OK. The destination Backup Set Selection win-
dow displays. Select a destination backup set 
and click OK. 

In the next window, choose the file selection 
criteria.

Specify search criteria and click OK. (For de-
tails on using selectors, see “Using Selectors” 
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on page 177.) The Backup Set Transfer summa-
ry window displays.

Check that the summarized information is 
correct.

Setting Transfer Options
If you want to change the default transfer set-
tings, click the Options button in the summary 
window. 

The Copy Snapshots option transfers all of the 
source backup set’s Snapshots to the destination 
catalog and media. This option is on by default. 
See “Backup Set Transfer Options,” which 
starts on page 145 for more information about 
this and other transfer options. Click the More 
Choices button to access additional options, 
which are described in “Execution Options,” 
which starts on page 142.

Executing a Transfer
If Retrospect has the information it needs, it 
says “Ready to Execute” at the top of the dupli-
cate summary window. If the information is 
incomplete, it says “Not Ready to Execute” and 
you must change one or more parts of the infor-
mation you gave it. 

When you are ready, click Transfer. An execu-
tion window shows the progress of the 
operation and includes buttons to pause or stop 
its execution.

When the execution is complete, Retrospect in-
forms you in the status window. Close it to 
return to the Retrospect Directory. If any errors 

occurred, you can view more information in the 
browser that appears, or see error details in the 
Operations Log. 

This log is accessible from the Window menu 
and is described on page 140.
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• O V E R V I E W  O F  S C R I P T S

• C R E A T I N G  S C R I P T S

• S C R I P T E D  B A C K U P

• S C R I P T E D  D U P L I C A T E

• S C R I P T E D  A R C H I V E

• S C R I P T E D  R E S T O R E

• S C H E D U L I N G  S C R I P T S

• S A V I N G  S C R I P T S

• T E S T I N G  S C R I P T S

• E X E C U T I N G  S C R I P T S

• C O N T R O L L I N G  S C R I P T S

• B A C K U P  S E R V E R  S C R I P T S

You learned how to set up and execute Retrospect’s immediate backup, archive, restore, 
duplicate, and transfer operations in Chapter 4 • Immediate Operations. This chapter shows 
you how to automate the process by using scripts, including Retrospect’s unique Backup 
Server scripts. 
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OVERVIEW OF SCRIPTS
One of the advantages of Retrospect is its ability 
to automate repetitive tasks. By creating scripts, 
you can automate all of the operations (except 
Transfer) described in Chapter 4 • Immediate 
Operations, namely:

• Backing up
• Archiving
• Duplicating
• Restoring

In addition, Retrospect’s Backup Server tech-
nology allows you to create intelligent scripts 
that continually reprioritize which computers 
get backed up next, based on criteria you speci-
fy. See “Backup Server Scripts” on page 79 for 
more information.

Scripts are an important part of developing a 
backup strategy. For more information on de-
veloping an effective backup strategy, see 
“Backup Strategies” on page 134.

Automated operations include all of the same 
information as immediate operations: a source, 
destination, file selection criteria, and other op-
tions. Scripts also include a scheduling 
component that controls when these automated 
operations are executed.

Retrospect allows you to schedule scripts to run 
automatically and unattended, so you can 
choose operating times that are most convenient 
for you and for other users. Scheduling scripted 
backups ensures data is backed up consistent-
ly—all you have to do is make sure the backup 
computer is turned on and the proper media is in 
the backup device. When it is time for a script to 
execute, Retrospect automatically launches and 
executes the operation. If there are no other 
scripts scheduled to run in Retrospect’s look 
ahead time, and you selected “Shut down” in 
the Unattended Preferences, Retrospect shuts 
down when the operation is complete.

Automated Operations covers creating scripts, 
scheduling scripts, executing scripts, and work-
ing with Backup Server scripts. For information 
on managing and maintaining scripts, see 
“Maintaining Scripts” on page 155.

CREATING SCRIPTS
There are three ways to create scripts in 
Retrospect:

• Using the EasyScript Wizard
• Scheduling an Immediate Operation
• Using the Automate>Scripts Command

The latter two methods can create any type of 
script, including backup, duplicate, archive, and 
restore. The EasyScript Wizard can only create 
backup scripts.

NOTE: Backup Server scripts are discussed 
separately. See “Backup Server Scripts” on 
page 79 for more information.

Using the EasyScript Wizard
The EasyScript Wizard poses a series of ques-
tions that simplify the process of creating a 
backup script. The wizard helps you create a 
backup set and schedule your backup script 
with an easy-to-use interface.

Before you use EasyScript, you may want to fa-
miliarize yourself with Retrospect’s immediate 
backup (page 46) to better understand the Easy-
Script steps. Just doing the quick backup 
(page 13) is a good start.

NOTE: The EasyScript wizard uses the same 
name for all the scripts it creates. If you want to 
make two or more scripts using the wizard, 
rename the first script before creating a new 
one. To learn how to rename a script, see 
page 156.

To Use EasyScript:
1.  Start Retrospect.
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2.  In the Retrospect Directory, click the 
Automate tab, then click the EasyScript button.
3.  Read the introduction screen, then click 
Next.
4.  Specify the backup source: local computer 
only; or local computer, plus clients. 
Click on one of the radio buttons to make your 
selection, then click Next. 
NOTE: Backing up networked computers 
requires Retrospect Client software on those 
computers and appropriate license codes for 
Retrospect.
5.  If you chose to back up other computers on 
your network, currently logged in clients are 
displayed in a list. 

All clients logged in to Retrospect when the 
script executes are backed up by Retrospect. 
Therefore, after creating a script you can log in 
new clients and be assured they will be backed 
up by the script.

Click Next to accept your selection and 
continue.
6.  Specify the type of media to which you want 
to back up. Click on one of the radio buttons to 
make your selection, then click Next.
7.  If you selected an Internet backup set you 
are required to provide additional information:

• Enter login information (see “For Internet 
backup sets:” on page 48) and click Next.

• EasyScript recommends encrypting Internet 
backup set data. Enter and confirm a 
password and click Next to proceed.

•  EasyScript automatically applies the 
Documents Folder & Hot items selector (see 
“Built-in Selectors” on page 178 for more 
information). Click Next to proceed.

8.  Specify the backup frequency. 
Click on one of the radio buttons to make your 
selection, then click Next.
9.  Specify a media rotation schedule. 
Media rotation, lets you move media off-site for 
safekeeping and gives you more chances to 
recover data if one piece of media fails. It 
requires more media than no rotation, so be sure 
to have a steady supply of disks, tapes, or 
CD/DVDs if you choose to rotate media. Click 
Next to continue.
10. Specify the start time for backups. 

If you chose to back up every weekday or once 
a week, set the time of day, and select the day of 
the week (if necessary) to execute the backup 
script. 
11. Click Create.
12. Enter a name for each backup set created by 
the EasyScript Wizard, then click New.
13. Specify a location to save the catalog files 
associated with each new backup set and click 
Save.
Retrospect creates a script named EasyScript 
Backup. You can view a summary of and 
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modify this script by clicking the Open Script 
button.

For detailed explanations of all the items listed 
in the summary window, see “Scripted Backup” 
which follows.

Scheduling an Immediate Operation
You can choose Schedule from the Script menu 
when viewing most immediate operation sum-
mary windows (Backup, Duplicate, Archive, or 
Restore). This allows you to create a script 
based on that operation.

See Chapter 4 • Immediate Operations for more 
information on immediate operations.

To Schedule an Immediate Operation:
1.  With an immediate operation summary 
window active, choose Schedule from the 
Script menu.
2.  Enter a name for the script and click New.
3.  Verify or modify the information in the 
script summary window.
4.  Click the Schedule button and schedule the 
script as described in “Scheduling Scripts” on 
page 73.
5.  When all the information in the script 
summary window is correct, close the window.

Using the Automate>Scripts 
Command
You can use the Automate>Scripts command to 
create a new script or to modify the settings of 
an existing script. 

For more information on how to modify exist-
ing scripts, see “Maintaining Scripts” in 
Chapter 8. For information on creating new 
scripts, see the following sections:

• Scripted Backup
• Scripted Duplicate
• Scripted Archive
• Scripted Restore

SCRIPTED BACKUP
This section takes you through the steps of de-
fining a backup script:

• Creating a Backup Script
• Setting the Backup Source
• Setting the Backup Destination
• Selecting Files to Back Up
• Setting Backup Execution Options

The steps for scheduling and saving are the 
same for all script types:

• See “Scheduling Scripts” on page 73.
• See “Saving Scripts” on page 77.

Creating a Backup Script
1.  From the Retrospect Directory, click the 
Automate tab, then click Scripts.
The Scripts window displays.

2.  Click the New button to create a new script.
NOTE: If no scripts are defined, Retrospect 
first asks whether you want to use EasyScript. 
(See “Using the EasyScript Wizard” on 
page 64.) Click No to continue.
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The script selection window displays.

3.  Select Backup from the list and click OK.
The script naming dialog displays.

4.  Enter a name and click New. 
The script appears in its own window.

This script window is very similar to the 
immediate backup summary window, with 
information for the source volumes, destination 
backup sets, file selection criteria, and options. 
Since this is a script, it also includes schedule 
information.
5.  To change information, click the appropriate 
button.
Sources lets you add or remove source 
volumes.
Destinations lets you choose one or more 
backup sets.
Selecting lets you choose a selector, a kind of 
filter for selecting files and folders to be backed 
up.

Options displays the options window in which 
you can toggle verification, data compression, 
and other options.
Schedule lets you set the script to run at a 
specific time or at regular intervals.

Setting the Backup Source
The first step in defining a script is setting the 
source(s).

1.  Click the Sources button.
The Volume Selection window displays.

2.  Select a source volume (or volumes), then 
click OK.

3.  Click Add to select additional source, or 
select a source and click Remove to remove it 
from the list. When the list of sources is 
complete, click OK.
NOTE: If there are multiple sources, they are 
backed up in the order listed. Click and drag to 
rearrange the list order.

Setting the Backup Destination
After specifying the source(s) to back up, you 
must specify the destination backup set(s) for 
the data.

1.  Click the Destinations button.
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If there are no defined backup sets, the Backup 
Set Creation window displays.
Create a new backup set, as described in 
“Creating a New Backup Set” on page 47. Once 
the new backup set is created, it appears in the 
Backup Set Selection window.
If there are defined backup sets, the Backup Set 
Selection window displays.

You can click New or More to create new 
backup sets or access additional ones.
2.  Select one or more backup sets, then click 
OK.
NOTE: With multiple destination backup sets, 
you can rotate among the sets for more safe and 
effective backups.
3.  Click Add to select additional destinations, 
or select a backup set and click Remove to 
remove it from the list. When the list of 
destinations is complete, click OK.

Selecting Files to Back Up
By default, Retrospect selects all files on the 
source(s). You can choose a different pre-de-
fined selector or create a custom selector to 
select a subset of all files. 

1.  Click the Selecting button.

2.  Choose a selector, then click OK.

You can also click More Choices to use 
Retrospect’s file selection criteria to create a 
custom selector. Selectors are explained in 
detail in “Using Selectors,” which starts on 
page 177.

NOTE: Selectors are used to determine which 
files are considered for backup, not which files 
actually get copied. For example, if you choose 
All Files, Retrospect compares all the source 
files with the files already in the destination 
backup set, then copies only those files that are 
new or changed.
Unlike an immediate backup, a script has no 
“preview” information with which you can 
manually mark and unmark files. This is be-
cause the script executes later and the volume 
contents can change between now and then.

Setting Backup Execution Options
Click the Options button to display the options 
window in which you can toggle verification, 
data compression, and other options which are 
explained in detail in “Execution Options,” 
which starts on page 142. 

SCRIPTED DUPLICATE
Duplicate scripts are great for unattended copy-
ing of hard disks, folders, or files from one 
volume to another. For example, you could use 
a duplicate script to automatically copy a local 
folder to a shared file server at the end of every 
week. 

The steps to create a duplicate script are:

• Creating a Duplicate Script
• Setting the Duplicate Source
• Setting the Duplicate Destination
• Selecting Files to Duplicate
• Setting Duplicate Execution Options

The steps for scheduling and saving are the 
same for all script types:
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• See “Scheduling Scripts” on page 73.
• See “Saving Scripts” on page 77.

Creating a Duplicate Script
1.  From the Retrospect Directory, click the 
Automate tab, then click Scripts.
The Scripts window displays.
2.  Click the New button to create a new script.
The script selection window displays.
3.  Select Duplicate from the list and click OK.
The script naming window displays.
4.  Enter a name and click New.
The script appears in its own window. 

This script window is very similar to the 
immediate duplicate summary window, with 
information for the source volume, destination 
volume, file selection criteria, and options. 
Since this is a script, it also includes schedule 
information.
5.  To change information, click the appropriate 
button.
Source lets you select a source volume.
Destination lets you select a destination 
volume
Selecting lets you choose a selector, a kind of 
filter for selecting files and folders to be 
duplicated.
Options displays the options window in which 
you can toggle verification and set other 
options.
Schedule lets you set the script to run at a 
specific time or at regular intervals.

Setting the Duplicate Source
Because this is a new script, Retrospect says 
“No volume selected” for the source. 

1.  Click the Source button.
The Volume Selection window displays.

2.  Select the source volume and click OK.
For details on using the Volume Selection 
window, see “Working with Volumes,” which 
starts on page 168.

Setting the Duplicate Destination
For duplicate operations, the destination is not a 
backup set, but a volume (other than the source 
volume).

1.  Click the Destination button. 
The Destination Selection window displays.

2.  Select the destination volume to which you 
want the files copied.
3.  Make a selection from the pop-up menu to 
specify what happens to the existing contents of 
the destination drive.
Replace Entire Disk deletes all files and 
folders on the destination which do not match 
those marked for duplication, leaving files 
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untouched if they are identical to files marked. 
It then duplicates remaining files and folders 
from the source, preserving the folder 
hierarchy.
Replace Corresponding Files copies the 
marked files to the destination volume into the 
same folders. Corresponding files are 
overwritten, even if they are newer. Retrospect 
leaves files untouched if they are identical to 
files marked for duplication or if the file names 
do not match those marked.
WARNING: Duplicate operations can destroy 
your files. Destination items are replaced by 
those duplicated from the source, or deleted 
entirely. Verify this is acceptable before 
continuing.
Before duplicating to a volume other than the 
current system volume under Mac OS X, use 
the Finder’s Get Info command on the volume. 
Choose Privileges from the info window’s 
menu then turn off the “Ignore privileges on this 
volume” option.
4.  Click OK to accept your destination choice 

Selecting Files to Duplicate
By default, Retrospect selects all files on the 
source. You can choose a different pre-defined 
selector or create a custom selector to select a 
subset of all files. 

1.  Click the Selecting button.
2.  Choose a selector, then click OK.
You can also click More Choices to use 
Retrospect’s file selection criteria to create a 
custom selector. Selectors are explained in 
detail in “Using Selectors,” which starts on 
page 177.

NOTE: Selectors are used to determine which 
files are considered for duplication, not which 
files actually get copied. For example, if you 
choose All Files, Retrospect compares all the 
files on the source volume with the files already 
on the destination volume. Matching files are 

not copied from the source volume to the 
destination volume. 

Setting Duplicate Execution Options
Click the Options button to display the options 
window in which you can set the verification, 
update backup report, and other options which 
are explained in detail in “Execution Options,” 
which starts on page 142. One such option is to 
move—rather than just copy—files from the 
source to the destination.

SCRIPTED ARCHIVE
Archiving allows you to remove seldom-used 
files from a hard disk while maintaining a copy 
of those files on your storage media.

The process of creating and using an archive 
script is almost identical to that of a backup 
script. 

See “Scripted Backup,” which starts on 
page 66, for more information.

This section explains the differences between 
an archive script and a backup script.

An archive script is just like a backup script, 
with three main differences:

• Backup scripts support multiple destination 
backup sets, while archive scripts support a 
single destination backup set.

• Archive scripts have an additional option not 
available for backup scripts. For archive 
scripts, you can choose to move—rather 
than just copy—files from the source to the 
destination (thereby deleting the files from 
the source). See “Archiving Options” on 
page 144 for details on the Move Files 
option.

• Archive scripts, by default, copy (or move) 
all selected files from the source to the 
destination. Backup scripts, by default, copy 
only those files which are not already 
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present on the destination or have been 
modified since the last time they were 
copied.

NOTE:  In both cases, the default can be 
modified by changing the matching options. 
See “Matching Options” on page 146 for more 
information.
Be sure to read “Archiving Tips” on page 51 for 
other important information about archiving.

SCRIPTED RESTORE
Usually, you don’t know in advance when 
you’re going to need to restore files, but there 
are some situations in which restore scripts are 
useful. You might want to create a restore script 
for use in a student computer lab environment, 
for example, in which the hard disks are re-
stored from a common source every night.

The steps to define a restore script are:

• Creating a Restore Script
• Setting the Restore Source
• Setting the Restore Destination
• Selecting Files to Restore
• Setting Restore Execution Options

The steps for scheduling and saving are the 
same for all script types:

• See “Scheduling Scripts” on page 73.
• See “Saving Scripts” on page 77.

Creating a Restore Script
1.  From the Retrospect Directory, click the 
Automate tab then click Scripts.
The Scripts window displays.
2.  Click the New button to create a new script.
The script selection window displays.
3.  Select Restore from the list and click OK.
The script naming window displays.
4.  Enter a name and click New. 

The script appears in its own window.

This script window is very similar to the 
immediate restore summary window, with 
information for the source backup set, 
destination volume, file selection criteria, and 
options. Since this is a script, it also includes 
schedule information 
5.  To change information, click the appropriate 
button.
Source lets you choose a backup set and 
associated Snapshot from which to restore.
Destination lets you choose the destination 
volume.
Selecting lets you choose a selector, a kind of 
filter for selecting files and folders to be 
restored.
Options displays the options window in which 
you can specify whether to recompute icon 
positions or update modify dates of files.
Schedule lets you set the script to run at a 
specific time or at regular intervals. 

Setting the Restore Source
Because this is a new script, Retrospect says 
“No backup set selected” in the script summary 
window. 

1.  Click the Source button to display a window 
listing backup sets and their Snapshots.
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2.  In the top-half of the window, select the 
backup set containing the Snapshot from which 
you want to restore. 
NOTE: If the backup set you are looking for is 
not listed, click the More button to access 
additional backup sets by opening or recreating 
their catalog files.
3.  In the bottom-half of the window, select the 
Snapshot.
The date and time of each Snapshot is listed.
NOTE: If the Snapshot you are looking for is 
not listed, click the Add Snapshot button to 
retrieve additional Snapshots from the storage 
media. 
4.  Click OK to continue. 
The backup set and Snapshot date, time, and 
volume name are listed in the script window.

Setting the Restore Destination
Because this is a new script, Retrospect says 
“No volume selected” in the script window.

1.  Click the Destination button.
The Destination Selection window displays.

2.  Select the destination volume to which you 
want the files restored.
3.  Make a selection from the pop-up menu to 
specify what happens to the existing contents of 
the destination drive.
WARNING: Before restoring to a volume other 
than the current system volume under 
Mac OS X, use the Finder’s Get Info command 
on the volume. Choose Privileges from the info 
window’s menu then turn off the “Ignore 
privileges on this volume” option.
Restore Entire Disk effectively erases the 
destination volume before restoring files. 
During restore operation, Retrospect copies 
files and folders from the backup set, preserving 
the folder hierarchy. This method restores 
Mac OS X privileges.
Replace Corresponding Files copies the 
marked files to the destination volume into the 
same folders. Corresponding files are 
overwritten, even if they are newer. Retrospect 
leaves files untouched if they are identical to 
files marked for restore or if the file names do 
not match those marked for restore. This 
method restores Mac OS X privileges.
WARNING: Using this option to replace an 
active Windows folder will crash a Windows 
client.
Retrieve Files & Folders creates a new folder 
on the destination volume (giving the folder the 
name of the backup set), then copies files into 
this folder, preserving the folder hierarchy. 
Nothing is replaced or overwritten. This method 
does not restore the backed-up Mac OS X 
privileges of files and folders; it assigns them 
the privileges of the currently logged-in user (or 
root if no user is logged in).
Retrieve Just Files creates a new folder on the 
destination volume (giving the folder the name 
of the backup set), then copies only the files into 
this folder. The folder hierarchy is not 
preserved. Nothing is replaced or overwritten. 
(Do not use this option to retrieve a large 
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number of files or a whole volume.) This 
method does not restore the backed-up 
Mac OS X privileges of files; it assigns them 
the privileges of the currently logged-in user (or 
root if no user is logged in). 
WARNING: The Restore Entire Disk and 
Replace Corresponding Files methods may 
destroy data on the destination. If you choose 
one of these, be sure it is acceptable to erase or 
replace files on the destination volume.
4.  Click OK.

Selecting Files to Restore
By default, Retrospect selects all files from the 
source backup set. You can choose a different 
pre-defined selector or create a custom selector 
to select a subset of all files. 

1.  Click the Selecting button.
2.  Choose a selector, then click OK.
You can also click More Choices to use 
Retrospect’s file selection criteria to create a 
custom selector. Selectors are explained in 
detail in “Using Selectors,” which starts on 
page 177.

NOTE: Selectors are used to determine which 
files are considered for restoring, not which 
files actually get restored. For example, if you 
choose All Files, Retrospect compares all the 
files in the source backup set with the files 
already on the destination volume. Matching 
files are not copied from the source to the 
destination.

Setting Restore Execution Options
Click the Options button to display the options 
window. Click More Choices to specify a num-
ber of options that are explained in detail in 
“Execution Options,” which starts on page 142. 

The Update modification dates option is only 
available for restore operations. See “File 
Copying Options” on page 144 for more 
information.

SCHEDULING SCRIPTS
Although you can manually execute a script at 
any time, scripts are designed to run unattended. 
In order to accomplish this, you need to create a 
schedule to specify when and how often to run 
the script.

NOTE: If you want to execute the script only 
upon your command and in your presence, see 
“Manual Script Execution” on page 78.
You can schedule a script to run automatically 
on specified days or on a repeating schedule, 
such as every two weeks. You can define multi-
ple schedules for the same script and specify the 
kind of backup you want for each scheduled 
execution.

For more information about using scripts as part 
of an overall backup strategy, see “Backup 
Strategies” in Chapter 8.

To schedule a script:
1.  In the script summary window, click the 
Schedule button.
The Schedule window displays.

2.  Click the Add button.
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3.  Specify the type of scheduler you’d like to 
add, then click OK.
Day of week lets you define a schedule for one 
or more days of the week and specify a weekly 
repeating interval. For example, you could 
schedule a script to run on Monday and 
Wednesday, every other week. Keep in mind 
that a week starts on the Sunday of the week of 
the start date.
Repeating interval lets you define a schedule 
that is repeated after a specified interval. For 
example, the last Friday of every month.
Single date lets you define a schedule for a 
single date and time. For example, April 19, 
2003 at 6:00 A.M.
NOTE: A script can contain any combination 
of one or more of these schedulers.
4.  Create the scheduler as described in 
“Creating a Script Scheduler,” which starts on 
page 74 then click OK.
The Schedule window displays.

5.  Click Add to create additional schedulers; 
click Modify to change the selected scheduler; 
or click Delete to remove the selected 
scheduler.
6.  Click OK when you’re done scheduling the 
script.
The script summary window displays.

It lists the next six scheduled executions based 
on the scheduler(s) you created.

Creating a Script Scheduler
There are three types of schedulers available in 
Retrospect:

• Day of week
• Repeating interval
• Single date

While these schedulers have some common el-
ements, the process for creating each type is 
somewhat unique.

Common Scheduler Elements
All scheduler types have a few common con-
trols and settings. They are:

• Start Date and Time: This determines the 
earliest time at which the script is permitted 
to execute.

• Backup Action Type and Destination: If you 
are creating a scheduler for a backup script, 
you can also specify a backup action. If your 
script has multiple destination backup sets, 
you must specify one backup set as the 
destination for each scheduler you create.

Start Date and Time This determines the ear-
liest time at which the script is permitted to 
execute. To change the start date and time, click 
on any individual part of the date or time. When 
the item is selected, type the new information or 
click the arrows to change the information. 
(You can also press the up and down arrows on 
your keyboard.) Press the Tab key to move the 
selection among the different elements.
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NOTE: For Day of week schedulers, specifying 
a start date does not mean a script will execute 
on that date, or even in the same week. Check 
the summary at the top of the window to see the 
actual date the script will first execute.
Backup Action Type and Destination If you 
are creating a scheduler for a backup script, you 
can also specify a backup action. From the Ac-
tion pop-up menu, choose Normal Backup, 
Recycle Backup, or New Media Backup.

• Normal Backup is a typical 
IncrementalPLUS backup. It marks for 
backup only files which are new, newly-
modified, or new to the backup set.

• Recycle Backup clears the catalog contents 
(if any) of a backup set so it appears no files 
are backed up. Then it looks for the first 
media member of the backup set and erases 
it if it is available. If the first member is not 
available, Retrospect uses any available new 
or erased medium. Everything selected from 
the source is backed up to the destination 
backup set.

• New Media Backup makes a new backup 
set (named similarly to the old one) using a 
new or erased medium. The original backup 
set and its catalog remain intact for long-
term storage in a safe place. The new backup 
set catalog and the new media member are 
each named with a number in sequence.

Retrospect allows you to have more than one 
backup set for a script so you can rotate media 
as part of your backup strategy. If the script has 
multiple backup set destinations, use the “To” 
pop-up menu to choose the backup set to be used 
for the scheduled execution.

NOTE: The pop-up menu is not displayed if 
only one backup set is specified in the script.

Using the Day of Week Scheduler
If you want to run a script on specified days of 
the week, use a the Day of week scheduler.

To create a Day of week scheduler:
1.  Select the Day of week radio button in the 
Scheduler dialog box.

2.  Click OK.
The Day of Week scheduler window displays.

3.  Set the start date and time as described in 
“Common Scheduler Elements” on page 74.
NOTE: Retrospect’s Schedule preference 
(page 160) defines the time period during which 
scripts are allowed to execute. Scripts 
scheduled to execute outside this period will not 
run.
If necessary specify the backup action and 
destination backup set.
4.  Click the checkboxes for the days of the 
week you want the script to execute.
5.  Enter a number to use as the repeating 
interval for the weeks. 
For example, if you enter two, the script 
executes every other week (or every two 
weeks). 
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6.  When all of the settings in the scheduler 
window are correct, click OK.

Using the Repeating Interval Scheduler
If you want a script to run at a specified daily, 
weekly, or monthly interval, use a Repeating in-
terval scheduler.

To create a Repeating interval scheduler:
1.  Select the Repeating interval radio button in 
the Scheduler dialog box.

2.  Click OK.
The Repeating interval scheduler window 
displays.

3.  Set the start date and time as described in 
“Common Scheduler Elements” on page 74.
NOTE: Retrospect’s Schedule preference 
(page 160) defines the time period during which 
scripts are allowed to execute. Scripts 
scheduled to execute outside this period will not 
run.
If necessary specify the backup action and 
destination backup set.
4.  In the Repeat pop-up menu, select the time 
unit (days, weeks, or months) for the repeating 
interval. 

5.  Type a repeat interval in the Weeks, Months, 
or Days field. 
The Repeat pop-up menu changes to reflect the 
Repeat Interval you enter.
6.  When all of the settings in the scheduler 
window are correct, click OK.

Using the Single Date Scheduler
If you want a script to run once at a specified 
date and time, use the Single date scheduler.

To create a Single date scheduler:
1.  Select the Single date radio button in the 
Scheduler dialog box.

2.  Click OK.
The Single date scheduler window displays.

3.  Set the start date and time as described in 
“Common Scheduler Elements” on page 74.
NOTE: Retrospect’s Schedule preference 
(page 160) defines the time period during which 
scripts are allowed to execute. Scripts 
scheduled to execute outside this period will not 
run.
If necessary specify the backup action and 
destination backup set.
4.  When all of the settings in the scheduler 
window are correct, click OK.
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SAVING SCRIPTS
After you’ve specified all the script settings, 
you need to save the script. There are three op-
tions for saving:

• Save: From the Script menu, choose Save to 
save the script using the name you created it 
with.

• Save As: From the Script menu, choose Save 
As to save the script using a new name. You 
can save a script once, modify the settings, 
then use Save As to create a new script.

• Save and Run: From the Script menu, 
choose Save and Run to save the script and 
display the manual script execution window. 
You can then choose to execute the script 
immediately, or create a “run document” to 
run the script manually. 

For more information on executing saved 
scripts, see “Executing Scripts,” which starts on 
page 78.

Scheduled Executions
Retrospect keeps track of all of your scheduled 
scripts and automatically executes them at the 
time you specified. To view a list of scheduled 
scripts, click the Automate tab in the Retrospect 
Directory, then click Preview.

NOTE: Retrospect’s Schedule preference 
(page 161) defines the time period during which 
scripts are allowed to execute. Scripts 
scheduled to execute outside this period will not 
run.

Retrospect is ever-vigilant about scheduled 
script executions. If a script is scheduled for au-
tomatic execution within the look ahead time 
(normally twelve hours), Retrospect will not au-
tomatically quit (or shut down or restart, 
depending on a preference setting described on 
page 162). It instead remains open and waits to 
execute the script.

TESTING SCRIPTS
You can check the validity of a script any time 
the script summary window is open. Retrospect 
lets you know if the script is missing any re-
quired information or if it’s ready to run. If the 
script requires storage media, you can also 
check to make sure it’s ready and available.

To test a script:
1.  From the Retrospect Directory, click the 
Automate tab, then click Check.
2.  In the Script Selection window, select the 
script you want to test and click OK.
Retrospect displays a dialog reporting on the 
validity of the script, as well as the next time the 
script is scheduled to run.

If the script is invalid, Retrospect provides 
information on what is wrong with the script.

3.  If the script is valid, and it requires media, 
you can click the Check Media button to make 
sure the backup device is ready with the 
required media.
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4.  Click OK to return to the script summary 
window.

EXECUTING SCRIPTS
Retrospect provides several ways to execute 
scripts.

For information on interacting with and control-
ling scripts, see “Controlling Scripts,” which 
starts on page 79.

Automatic Script Execution
“Scheduling Scripts,” which starts on page 73, 
describes how to schedule times for Retrospect 
to automatically execute a script. Retrospect 
keeps track of all your scheduled scripts and au-
tomatically executes them at the times you 
specify. The Preview window (described in 
“Viewing Scheduled Scripts” on page 157) 
shows upcoming scheduled events.

Manual Script Execution
To initiate a script manually, you can:

• Execute the script immediately from within 
Retrospect.

• Make a “run document” file that enables you 
to run the script at any time, upon your 
command, from your desktop (or wherever 
the file is saved). You can also execute a run 
document script from an AppleScript.

Use the manual script execution dialog to spec-
ify the method you want. There are three ways 
to access the manual script execution dialog:

• With an active script summary window, 
choose Save and Run from the Scripts menu.

• Choose the script from Retrospect’s Run 
menu.

• Click the Immediate tab, then click Run. 
Select a script and click OK.

To execute the script immediately:
1.  Select the Execute now radio button.
If the script being run is a backup script, use the 
Action pop-up menu to set the backup type. See 
“Backup Actions” on page 23.
If the backup script has multiple destinations, 
use the other pop-up menu to specify the 
destination backup set.
2.  Click Execute.

To make a run document:
1.  Select the “Make a run document” radio 
button.
If the script being run is a backup script, use the 
Action pop-up menu to set the backup type. See 
“Backup Actions” on page 23.
If the backup script has multiple destinations, 
use the other pop-up menu to specify the 
destination backup set.
2.  Click Save.

3.  Browse to a location to save the run 
document, enter a file name, then click Save.
4.  To execute the script, locate the saved run 
document on your hard drive and double-click 
it.
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To run several scripts sequentially, select the 
run documents in the Finder and choose Open 
from the File menu. When you open several run 
documents at once, the scripts associated with 
them will run in alphabetical order by script 
name, regardless of the run documents’ file 
names.

TIP: You can create more than one run 
document for the same script, each specifying a 
different backup action and destination backup 
set.
You can get creative with run documents. For 
example, you can add them to your Startup 
Items (in System Preferences>Accounts) for 
automatic execution when you start your Mac-
intosh, or you can execute them using 
AppleScript.

CONTROLLING SCRIPTS
When a scheduled script prepares to run auto-
matically, it counts down to execution. To 
intercept it before it actually begins operating, 
click the Stop button in the countdown window. 
The execution choices window appears.

• To execute the script, select “Execute now” 
then click Execute.

• To cancel this execution of the script, select 
“Skip until next scheduled execution” then 
click Skip. This option shows as “Skip this 
execution” when there are no future 
executions scheduled.

• To cancel execution of all pending scripts, 
select “Skip all pending executions” then 
click Skip.

• To delay execution of the script until a future 
date, select “Defer this execution until” then 
set the date and time and click Defer. You 
should defer a script when you do not want 
it to run now but you do want it to run after 
a certain time.

• To delay execution of the script (and all 
other scripts) until after you quit Retrospect, 
select “Defer all scheduled executions until 
Quit” then click the Defer button. You 
should defer a script when you do not want 
it to run while you are using Retrospect but 
you do want it to run after you quit.

To edit the script, click the Edit button.

Once a script begins executing, you can control 
the operation in much the same way that you 
control immediate operations. See “Controlling 
Executions” on page 149 for more information 
on the execution status window and media 
requests.

There are a number of preferences that are spe-
cific to scripts that must be set correctly. Scripts 
are designed to run unattended, even after 
you’ve quit Retrospect and gone home for the 
night. Make sure that you have set Retrospect’s 
Notification preferences to allow the applica-
tion to automatically launch to run scripts. See 
“Notification Preferences” on page 160 for 
more information.

Retrospect’s Unattended preferences (see “Un-
attended Preferences” on page 162) determine 
what Retrospect does when it has auto-launched 
and is finished executing the script. By default, 
Retrospect quits, unless Backup Server is run-
ning or another script is scheduled to run in the 
application’s look ahead time. See “Schedule 
Preferences” on page 160 for more information.

BACKUP SERVER SCRIPTS
Backup scripts are powerful and versatile, but in 
backup environments which change regularly, 
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another kind of script—Backup Server 
scripts—may be better suited to your needs. A 
regular backup script copies specific volumes in 
a certain order to a designated backup set. If the 
backup environment changes and volumes or 
media become unavailable, the backup will not 
happen until its next scheduled time, if ever. 
This is why Retrospect includes Backup Server 
technology.

Backup Server Benefits
Retrospect’s Backup Server technology accom-
modates changing network and disk 
configurations. Whereas a regular backup script 
follows a rigid schedule for its clearly defined 
source volumes and destination backup sets, a 
Backup Server script is driven by the availabil-
ity of those resources and their need for backup. 
Source volumes are backed up in order, accord-
ing to need—that which was backed up least 
recently is first to be backed up. The volumes 
are copied to the best available backup set me-
dia, so Backup Server scripts give you greater 
freedom to use the media of your choice.

Backup Server scripts are ideal for environ-
ments in which computers and volumes appear 
irregularly on the network. For example, in an 
office that has ejectable disks and mobile com-
puters that appear on the network at 
unpredictable times, Backup Server recognizes 
the new volumes when they become available 
and backs them up. Client users can even ini-
tiate backups of their volumes.

Though Backup Server scripts can be used inde-
pendently, it is often best to use them in concert 
with regular backup scripts to produce a com-
prehensive backup strategy.

How Backup Server Works
You start with a Backup Server script, which is 
similar to other Retrospect scripts. The backup 
computer running the script becomes a “Backup 
Server” during its scheduled time of operation 
and is idle during its scheduled period of inac-

tivity. You may want to dedicate a computer to 
Backup Server operations during periods of ac-
tivity and avoid running other programs while 
Backup Server is active.

Backup Server makes a queue based on the 
most recent backups of the source volumes. The 
least recently backed up volume is moved to the 
head of the queue and other volumes are ar-
ranged in descending order according to the 
priority of need. Then Backup Server examines 
the local computer and polls the network, look-
ing for the volumes.

NOTE: Polling the network does not adversely 
affect network performance.
Backup Server starts at the top of the volumes 
queue, determining the availability of each 
source volume and, if there is a choice, backing 
up each to its most suitable backup set. 
Retrospect moves the most recently backed up 
volumes to the bottom of the queue as it goes 
along. When it is satisfied that all available 
source volumes are backed up for the current 
backup interval, Backup Server periodically 
polls clients on the network. Polling involves 
checking for volumes that have recently ap-
peared, and checking whether any client users 
have requested backups of their volumes. This 
process ensures a volume in need of backing up 
gets it.

If allowed by the backup administrator and 
Backup Server, a client user can, at any time, re-
quest to be backed up as soon as possible. When 
Retrospect next polls the client, it will recognize 
the ASAP request and back up the client.

When the Backup Server script’s wrap up time 
is reached, Retrospect continues the current vol-
ume backup but will not start any new backups. 
When the script’s stop time is reached, 
Retrospect halts the backup in progress, if any, 
and will not start any new backups until the 
script’s next scheduled start time.
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NOTE: Backup Server uses only the normal 
backup action because recycle and new media 
backups are inappropriate for use with a Backup 
Server script.

When to Use Backup Server
The table below includes information compar-
ing standard backup scripts to Backup Server 
scripts.

See “Network Backup Strategies” on page 135 
for descriptions of situations which are suited to 
Backup Server scripts and for instructions on 
implementing a strategy based on Backup 
Server.

Managing Resources
With abundant resources (large storage capaci-
ty, fast network, and powerful backup computer 
with plenty of time to operate) and relatively 
few source volumes, Backup Server can com-
pletely back up all volumes during its window 
of opportunity. However, with limited resourc-
es (small storage capacity, slow network, slow 
backup computer with little time to operate) and 
relatively many source volumes, Backup Server 
is not likely to completely back up each volume 
during its given time period. Fortunately, 
Retrospect’s Backup Server effectively manag-

es limited backup resources so that it eventually 
completes all of its backups.

Trust Backup Server to Do Its Job
Whether your setup is resource-constrained or 
resource-abundant, Backup Server always 
backs up the volumes in order starting with 
those which need it most. For example, if you 
need to back up 100 client computers but you 
can do backups only during an eight hour period 
each night, chances are Retrospect will be un-
able to back up all 100 clients the first night 
before the script’s eight hours are up. Leftover 
volumes will be backed up the next night, and 
so on, until all 100 volumes are backed up. After 
the initial backups, Backup Server will move 
more quickly through the queue as it performs 
subsequent IncrementalPLUS backups.

As the backup administrator, you do not have to 
separate the clients into different groups for dif-
ferent days based on your estimation of backup 
times. Backup Server distributes the load over 
the scheduled time period.

The main thing to remember about Backup 
Server is that all of the source volumes eventu-
ally are backed up with no additional effort on 
your part. In the worst case, the period of time 

Feature Backup Script Backup Server Script

Destination 
Backup Sets

Copies to a single backup set as specified 
in the schedule or at execution. Fails if 
media is unavailable. Media rotation is 
scripted.

Copies to the most ideal available backup 
set in the destinations list. Automatic media 
rotation among multiple available backup 
sets.

Source Volumes Backs up volumes in the order of the 
source list. If a backup fails, the next 
backup does not occur until the next time 
the script runs.

Backs up volumes in the priority order of 
their most recent backup dates. After each 
backup, the queue is re-evaluated, includ-
ing previously unavailable volumes.

Schedule Starts backup at a specific time and stops 
when the last source is completed. 
Optionally ends at a specific time.

Runs between start and stop times. Back-
ups of available volumes occur as 
necessary.

Execution One script runs at a time. Conflicting 
scripts run one after the other.

All Backup Server scripts run concurrently. 
Other scripts run as scheduled, but not 
while Backup Server backs up a volume.

User Requested 
Backups

No. Yes.
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between backups of a given volume will be too 
long for comfort and you must allot more 
resources.

If you want your volumes to be backed up more 
often than they are, you must allocate more re-
sources to the Backup Server script. Increase 
the script’s operating time, use selectors to limit 
the files to back up, use a faster backup comput-
er, or speed up your network. Setting up a 
second backup computer with Backup Server 
handling half of your clients effectively divides 
the load in half for each backup computer.

Monitoring Progress
Periodically view the Backup Report (see 
page 137) to see which volumes were backed up 
by Backup Server and the intervals between 
backups. Of particular interest is the “Elapsed 
Days” column which shows how many days 
have passed since each volume’s previous 
backup.

NOTE: The interval between backups will tend 
to be smaller when Backup Server is 
performing IncrementalPLUS backups after the 
first full backup of each volume. 
IncrementalPLUS backups require far less time 
for most volumes and thus can occur more 
often.
Deleting a backup event from the Backup Re-
port causes Backup Server to not consider that 
backup when it evaluates the priority of vol-
umes to be queued for backup. Consequently, 
that volume is given a backup priority higher 
than its previous priority.

Interaction with Other Scripts
You can use multiple Backup Server scripts op-
erating simultaneously to manage limited 
backup resources. You can use separate scripts 
with different schedules to give some volumes a 
higher backup priority.

For example, one script could run eighteen 
hours in a day, backing up volumes from the 

sales department. Another script could run six 
hours in a day, backing up volumes from the ac-
counting department. The sales department 
would be more likely to get completely backed 
up, whereas the accounting department script 
may not complete all its volumes in a single six 
hour period. Still, these volumes would eventu-
ally get backed up, because volumes in greatest 
need of backup are backed up before volumes 
which have more recent backups.

As another example, consider volumes which 
are available intermittently, such as removable 
disks and notebook computers. Another script 
could back them up twenty-four hours a day, 
because they are available at random times dur-
ing the day. 

For further discussion of Backup Server strate-
gies, see “Backup Strategies,” which starts on 
page 134.

Other, non-Backup Server scripts scheduled for 
execution during the active operating time of 
Backup Server scripts can run without conflict. 
When a regular script wants to run while Back-
up Server is backing up a volume, Backup 
Server completes the backup in progress, then 
allows the other script to execute. When the reg-
ular script finishes, Backup Server resumes 
where it left off. When a regular script is sched-
uled to run while Backup Server is idle, it 
executes immediately.

Backup Server Tips and Techniques
To get the most out of Backup Server, you 
should follow a few simple guidelines.

Choose the Right Backup Server 
Computer
The computer you use for Backup Server is im-
portant. Backup Server scripts work best on a 
dedicated backup computer that is not an active 
file server. Backup Server runs best on a backup 
computer with a powerful processor.
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Backup Server does not quit or shut down the 
backup computer when it is finished; rather, it 
waits idle until the next scheduled start time.

Use Containers as Sources
Use containers (see page 169) to specify sourc-
es in your Backup Server scripts, not individual 
volumes, especially when you back up clients. 
When you use containers, any new volumes 
added to a client are automatically included in 
backups.

Also, using containers avoids a potential prob-
lem when backing up Mac OS clients under 
certain conditions. When you select multiple 
volumes from a Mac OS client that is set to wait 
at shutdown and the script’s client system op-
tion is set to shut down clients after backups, 
Retrospect will shut down the client after back-
ing up its first volume. This prevents backups of 
the client’s other selected volumes until the cli-
ent is restarted.

Rotate Among Backup Sets
Create multiple backup sets and use them all as 
destinations in your Backup Server script. Ro-
tate through the sets by inserting different 
media in the backup device each day. Backup 
Server uses whatever media you inserted (as 
long as it is specified as a destination).

Introduce New Media
Periodically do new media backups to introduce 
new media. Store old media off-site after each 
new media backup. Between new media back-
ups, periodically do recycle backups to avoid 
catalogs becoming cumbersome and to ensure 
fast restore operations should they be necessary.

When you want to rotate or introduce new me-
dia, do recycle or new media backups by 
executing regular backup scripts using the same 
backup sets used by your Backup Server scripts. 
You can schedule these, execute them from 
Retrospect’s Run menu, or save them as run 
documents and execute them.

To manually set a backup set for a recycle or 
new media backup, configure the backup set 
and set the media action. (See “The Options 
Tab” on page 154).

Monitor Media Availability
Because Backup Server does not initially put up 
media request windows, you have to monitor 
media from the Backup Server status window. 
This status window displays whenever Backup 
Server is running.

When Retrospect needs media it displays “me-
dia” in the status column when the pop-up menu 
is set to either Sources or Backup Sets. Choose 
Backup Sets from the status window’s pop-up 
menu so the window shows which destination 
backup sets have media available and which do 
not. Insert media as needed.

If a backup set needs a new or erased medium 
and you have to erase one, stop Backup Server, 
erase the medium, then start Backup Server 
again.

Use Other Scripts to Complement Backup 
Server
Retrospect can have multiple Backup Server 
scripts running concurrently, and it will manage 
the sources and destinations.

Other, non-Backup Server scripts can execute 
while Backup Server is running. You can sched-
ule them or run them at will using run 
documents. Other scripts can complement 
Backup Server scripts by starting recycle and 
new media backups, and by forcibly backing up 
volumes that do not get backed up by Backup 
Server.

Use Tape Libraries
An automatic tape loading device with Backup 
Server is a powerful combination. All tapes in 
the library’s magazine are available as backup 
set destinations. Backup Server rotates between 
sets with no additional effort from you. It uses 
blank or erased tapes when a backup spans over 
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two tapes, or when you set up a new media 
backup with Retrospect’s media control 
options.

Allow Early Backups
By default, Backup Server scripts allow early 
backups. These occur when Backup Server is 
polling through the list of possible sources and 
finds a client that has requested to be backed up 
as soon as possible. When a client user selects 
this option in his or her Retrospect Client con-
trol panel, the client software does not send a 
message to Retrospect on the backup computer. 
Rather, Retrospect contacts clients as Backup 
Server polls, which it does when it is not actual-
ly performing backups during its scheduled 
active time.

If many clients are due for backup, a client with 
a current backup may wait a long time before 
Backup Server gets to it. Regardless of the cli-
ent user’s desire for backup ASAP, Retrospect 
backs up other clients which do not have current 
backups. Retrospect always polls starting with 
clients that need backups the most.

For more information, see “Backup Server Op-
tions” on page 142.

Manage User Deferments
When a client user repeatedly defers his or her 
backups (as indicated in the Operations Log), 
you should make future backups occur at a time 
which is more convenient for the user, such as 
when he or she is not using the computer. Or, 
create a script with the countdown time option at 
zero to prevent the user from deferring execution.

Set Priority by Volumes
If certain critical volumes are not getting 
backed up as often as you would like, consider 
using multiple scripts with different schedules 
to give some volumes higher backup priority 
than others. Schedule the higher-priority vol-
umes script to run for a longer duration than the 
lower-priority volumes script. With more time 

allotted to the higher-priority volumes, they are 
more likely to get completely backed up.

Set Priority by Files
If you find Backup Server is not completely 
backing up all its sources, another way to set the 
backup priority is by files rather than volumes, 
though you can also do both. Use multiple 
scripts with different selectors to give some 
files or folders higher backup priority than oth-
ers. For example, a higher-priority selector 
would include documents modified in the last 
seven days, and a lower-priority selector would 
include all files. Schedule the higher-priority 
script to run for a longer duration than the low-
er-priority script.

Creating Backup Server Scripts
This section takes you through the steps of cre-
ating a Backup Server script. The process is 
very similar to creating a regular backup script, 
although Backup Server scripts are scheduled 
differently.

1.  From the Retrospect Directory, click the 
Automate tab, then click Scripts.
The script editing window displays.

2.  Click the New button to create a new script.
NOTE: If no scripts are defined, Retrospect 
first asks whether you want to use EasyScript 
(See “Using the EasyScript Wizard” on 
page 64.). Click No to continue.
The script selection window displays.
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3.  Select Backup Server from the list and click 
OK.
The script naming dialog displays.

4.  Enter a name and click New. 
The script appears in its own window.

This script window is very similar to a regular 
backup script summary window, with 
information for the source volumes, destination 
backup sets, file selection criteria, options, and 
schedule information.
5.  To change information, click the appropriate 
button.
Sources lets you add or remove source 
volumes.
Destinations lets you choose one or more 
destination backup sets.
Selecting lets you choose a selector—a kind of 
filter for selecting files and folders to be backed 
up.

Options displays the options window in which 
you can toggle verification, data compression, 
and other options.
Schedule lets you set the script to run all the 
time or only on specific days at specific times.

Setting the Backup Server Sources
The first step in defining a Backup Server script 
is setting the sources.

1.  Click the Sources button. 
The Volume Selection window displays.

2.  Select a source volume (or volumes), then 
click OK.
NOTE: Backup Server scripts are especially 
well-suited for backing up laptop client 
volumes, or other volumes that appear 
irregularly on the network.

3.  Click Add to select additional sources, or 
select a source and click Remove to remove it 
from the list. When the list of sources is 
complete, click OK.
NOTE: If your script includes multiple sources, 
they are backed up according to need and 
availability.
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Setting the Backup Server Destinations
After specifying the source(s) to back up, you 
must specify the destination backup set(s) for 
the data.

1.  Click the Destinations button.
If there are no defined backup sets, the Backup 
Set Creation window displays.
Create a new backup set, as described in 
“Creating a New Backup Set” on page 47. Once 
the new backup set is created, it appears in the 
Backup Set Selection window.
If there are defined backup sets, the Backup Set 
Selection window displays.

You can click New or More to create new 
backup sets or access additional ones.
2.  Select one or more backup sets, then click 
OK.
3.  Click Add to select additional destinations, 
or select a backup set and click Remove to 
remove it from the list. When the list of 
destinations is complete, click OK.

Selecting Files for Backup Server
By default, Retrospect selects all files on the 
source(s). You can choose a different pre-de-
fined selector or create a custom selector to 
select a subset of all files. 

1.  Click the Selecting button.

2.  Choose a selector, then click OK.
You can also click More Choices to use 
Retrospect’s file selection criteria to create a 
custom selector. Selectors are explained in 
detail in “Using Selectors,” which starts on 
page 177.

NOTE: Selectors are used to determine which 
files are considered for backup, not which files 
actually get copied. For example, if you choose 
All Files, Retrospect compares all the source 
files with the files already in the destination 
backup set, then copies only those files that are 
new or changed.

Setting Backup Server Options
Click the Options button to display the options 
window in which you can specify how often to 
back up source volumes and whether or not to 
allow early backup. Click More Choices to see 
all of the available options categories and notice 
that many categories parallel those of regular 
backup scripts. Categories specific to Backup 
Server scripts are Backup Server, Client Count-
down, and Polling. These options are explained 
in detail in “Execution Options,” which starts 
on page 142.

Scheduling Backup Server Scripts
A Backup Server script’s schedule is one of the 
major differences between it and a regular back-
up script. From the script summary window, 
click the Schedule button. 



CHAPTER 5 • AUTOMATED OPERATIONS 87

Select a schedule:

• Always active makes Retrospect run the 
script twenty-four hours a day, seven days a 
week.

• Custom schedule brings up another window 
in which you can customize the script 
schedule. This is described below.

• Never active prevents Retrospect from 
running the script.

The Skip scheduled executions checkbox pre-
vents Backup Server from running until the 
time you specify.

Customizing the Schedule
By default, Backup Server scripts are active 24 
hours a day, 7 days a week. If you want to spec-
ify different hours or days for a script to be 
active, you can create a custom schedule.

When you select Custom schedule and click the 
Custom button, Retrospect displays the custom 
schedule window. Although it looks quite simi-
lar to Retrospect’s Schedule preferences 
window, it is specific to this Backup Server 
script rather than global to all Retrospect 
executions.

If the schedule was previously Always Active, 
all twenty-four hours of each of the seven days 
of the week are selected.

To select a day of the week, click on it. Click 
and drag to select contiguous days of the week. 
Use the Shift or Command key and click or drag 
to select days without de-selecting the previous 
selection.

To change a time, click on it and type or use the 
control.

Start is the time at which the script begins.

Wrap up is the period of time (in hours and 
minutes) before the stop time, during which 
Retrospect should complete the current backup 
but not begin new backups.

Stop is the time at which Retrospect absolutely 
must halt this script’s backups (until the next 
start time).

TIP: You can also set times by dragging the 
icons on the hourly schedule bar, but you should 
first experiment by typing the times to see how 
these controls work.
When a time is changed, the hourly schedule 
bar changes accordingly to graphically repre-
sent the start, wrap up, and stop times of the 
script.

Each selected day has a scaled-down hourly 
schedule bar, though it does not have controls.

You can revert a customized schedule with the 
Always and Never buttons.
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Using Backup Server
There are a number of ways to control Backup 
Server and Backup Server scripts, both from the 
Retrospect application and from Retrospect 
clients.

NOTE: Backup Server is not affected by 
Retrospect’s Unattended preference. For 
example, Retrospect will not quit when a 
Backup Server script is done.

Automatic Starting
When you save a Backup Server script, Backup 
Server is enabled after the backup computer is 
idle (that is, no mouse movement, clicks, or 
keystrokes) for ten minutes. Retrospect starts 
Backup Server when a script’s scheduled start 
time arrives. If Retrospect is not open at the start 
time, it will open automatically.

Run Menu
After you have saved at least one Backup Server 
script, Retrospect’s Run menu includes two pre-
viously unavailable items: Start Backup Server 
and Disable Backup Server. Choose Start Back-
up Server to manually enable Backup Server, 
which will then run Backup Server scripts at 
their scheduled times of execution.

Choose Disable Backup Server from the Run 
menu to prevent any scheduled Backup Server 
scripts from executing until you choose Start 
Backup Server or Enable Backup Server to re-
enable Backup Server.

Control Menu
When Backup Server is running, Retrospect has 
a Control menu on its menu bar. Following is a 
list of its items and descriptions of their 
functions.

Show Log displays the Operations Log.

Stop on Errors makes Backup Server halt 
when it encounters any error, rather than just 
logging the error and continuing.

Just Log Errors ensures Backup Server contin-
ues operating when it encounters an error, rather 
than halting execution. You can find any errors 
which occur by viewing the Operations Log.

The Backup Server Control menu items parallel 
their counterparts of the Control menu available 
when regular scripts are running.

Status Window
When Backup Server is running, the status win-
dow shows you what it is doing. Click the 
triangle icon to expand the window for more 
information.

Use the pop-up menu to choose a status 
category.

Sources shows the source volumes from all 
running scripts.

Backup Sets shows the backup sets from all 
running scripts.

Scripts shows all Backup Server scripts.

Retrospect lists the status of each item under the 
status heading.

Blank means Backup Server has yet to connect 
with the item.

Active means the script is functioning.

ASAP means the source will be backed up as 
soon as possible. This may be either because the 
client user initiated the backup or the client’s 

expanded status information 
for selected item

selected 
item
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most recent backup is older than the script’s 
backup interval.

Backed up means the source volume has been 
backed up within the specified interval.

Deferred means the client user has intercepted 
and postponed the backup. Such user defer-
ments are entered in the Operations Log.

Inactive means the script was deactivated or its 
schedule does not currently permit it to run.

Media means Backup Server cannot find the 
proper media for the destination backup set.

Ready means a source is currently being 
backed up or is about to be. It also means a 
backup set is ready as a backup destination.

Retry means Backup Server failed to back up 
the source and will try again.

Scheduled means the source has never been 
backed up, but the administrator has scheduled 
a pending backup.

Source means Backup Server cannot find the 
source volume.

Wrap up means a Backup Server script is in its 
wrap up period.

Click on an item to see more status information in 
the lower part of the expanded status window.

Closing the Status Window
Click the Backup Server status window’s close 
box to stop all scripts in progress. When one or 
more scripts are scheduled, Retrospect waits a 
period of time, then Backup Server starts and 
executes scheduled Backup Server scripts. The 
wait period is ten minutes if you are still using 
Retrospect, or one hour if you quit Retrospect.

Deactivating a Script
Retrospect allows you to temporarily deactivate 
a Backup Server script so its sources are not in-
cluded in Backup Server’s routine operations. 

When Backup Server is stopped and later start-
ed, the script will be active.

To prevent a Backup Server script from execut-
ing, first choose Scripts from the Backup Server 
status window’s pop-up menu. Then select the 
script from the list and choose Deactivate Script 
from the Server menu.

Reactivating a Script
To allow a deactivated Backup Server script to 
execute and include its sources in Backup Serv-
er’s routine operations, follow the same steps as 
deactivating but choose Activate Script from 
the Server menu.

Scheduling a Backup of a Source
Retrospect allows you to schedule a backup of a 
source from a running Backup Server script. 
This lets you set a definite time for Backup 
Server to back up the source, rather than wait 
for Backup Server to back it up at its conve-
nience. This is useful, for example, when the 
backup administrator knows a salesperson will 
be leaving the office with her iBook. The ad-
ministrator can schedule that client for backup 
immediately.

To schedule a backup of a source, first choose 
Sources from the Backup Server status win-
dow’s pop-up menu. Then select the source 
from the list and choose Schedule Backup from 
the Server menu (or double-click on the source), 
which brings up the following dialog.

Use the controls to set the date and time to back 
up the source, then click OK. Retrospect chang-
es the priority of the source in the Backup 
Server queue according to your scheduled time.
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A backup scheduled this way is not remem-
bered by Retrospect when Backup Server is 
stopped.

Resuming the Paused Backup Server
When you use the backup computer’s mouse or 
keyboard while Retrospect is the active applica-
tion, Retrospect pauses Backup Server in 
anticipation of you issuing commands. Backup 
Server automatically resumes after two minutes 
of mouse or keyboard inactivity.

To resume the paused Backup Server before the 
two minutes have passed, choose Resume Serv-
er from the Server menu.

Backup Server Runs Continuously
Unlike other scripts, when Backup Server 
scripts finish they do not take the action speci-
fied by the Unattended preference. For 
example, a Backup Server script will not quit 
when done. If you quit Retrospect, Backup 
Server will automatically launch Retrospect 
when the next script is scheduled to start.
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C H A P T E R   6
N E T W O R K  B A C K U P

• N E T W O R K  B A C K U P  O V E R V I E W

• I N S T A L L I N G  C L I E N T S

• W O R K I N G  W I T H  C L I E N T S

• U P D A T I N G  C L I E N T S

• U N I N S T A L L I N G  A  C L I E N T  A N D  I T S  S O F T W A R E

• A D V A N C E D  N E T W O R K I N G

• C L I E N T  U S E R  P R E F E R E N C E S

• B A C K I N G  U P  C L I E N T S

• W O R K I N G  W I T H  W I N D O W S  C L I E N T S

• W O R K I N G  W I T H  L I N U X  C L I E N T S

• F I L E  S Y S T E M  C O N V E R S I O N S

• N E T W O R K  B A C K U P  G U I D E L I N E S

This chapter provides instructions on installing, configuring, and otherwise administering 
the client software that allows you to access networked Retrospect client computers from 
the backup computer. It also describes the options and controls available to Retrospect 
clients. In addition, this chapter explains how to back up these clients and includes 
information and worksheets for setting up efficient workgroup backups.
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NETWORK BACKUP OVERVIEW
Retrospect allows you to use a single computer 
with a storage device to back up networked 
Macintosh, Windows, and Linux computers 
equipped with Retrospect Client software.

To back up clients, first install the Retrospect 
Client software on each of the client computers. 
Then use the Retrospect application to log in 
clients for use by the backup computer. After 
configuring the clients, you can create and 
schedule scripts using client volumes as sourc-
es, as if the volumes were connected directly to 
the backup computer.

Client Licenses
Retrospect will work with as many clients as 
you have licensed. You can add licenses to sup-
port more clients.

Retrospect’s license manager keeps track of 
your client licenses with the license codes you 
enter. Client license codes are included as part 
of all Retrospect for Macintosh products and are 
also available separately in Retrospect Clients. 
You get additional codes when you purchase 
additional licenses.

• To view current licenses, click Licenses 
from the Special tab, or choose License 
Manager from the Window menu. The 
license manager summarizes the quantities 
of used and available clients and lists client 
licenses you have added.

• To add a client license, click the Add button 
and enter your new license code in the 
dialog that follows.

Security
Clients connected to the Internet are at risk, 
however slight, of unauthorized access. The 
Retrospect Client installer program requires 
you to assign passwords to clients to prevent ac-
cess by Internet users who have Retrospect.

Network Interfaces
If your backup computer has multiple network 
interfaces, the Retrospect application and 
Retrospect Client software automatically 
switch to the next available network interface if 
the primary interface is not available.

Mac OS X’s Network System Preferences allow 
you to specify the order in which you want to try 
different network interfaces when connecting to 
a network.

INSTALLING CLIENTS
All client computers that you want to back up 
must have Retrospect Client software installed. 
The following topics include system require-
ments and installation instructions for 
Macintosh, Windows, and Linux clients.

NOTE: If you already have Retrospect clients 
with older software installed, see “Updating 
Clients” on page 100.

System Requirements for Macintosh 
Client Computers
Macintosh client computers require:

• PowerPC or better processor 
• Mac OS 7.1 or later with Open Transport 1.1 

or later; Mac OS X 10.1.5 or later
• TCP/IP networking

NOTE: Older versions of Retrospect could 
access older Macintosh client computers using 
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either AppleTalk or TCP/IP network protocols. 
Retrospect 5.0 and later can access clients using 
only TCP/IP. If you are upgrading from a 
version of Retrospect that supported AppleTalk 
clients, you must uninstall and reinstall 
Retrospect Client software on all AppleTalk 
client computers.

Installing Retrospect Client Software 
on Macintosh Computers
Use the following procedures to install the cli-
ent software on each Macintosh computer you 
want to back up over the network.

TIP: For installing many clients on a network, 
or for installing on computers without CD-
ROM drives, you can put the Retrospect Clients 
installer on a shared folder on a server. Copy the 
installer to client computers from that folder 
instead of from the CD.

To Install Retrospect Client Software on a 
Macintosh Computer:
1.  Save all unsaved documents and quit other 
running application programs.
2.  Under Mac OS X, log in to the client 
computer so that you have administrator 
privileges.
3.  Insert the Retrospect CD in the client 
computer’s CD-ROM drive.
4.  Double-click the appropriate installer icon 
for the client computer’s OS.
For OS X 10.1.5 and higher, double-click Install 
OS X Client.
For OS 7.5 to OS 9.2, double-click Install 
Classic Client.
5.  Follow the instructions of the installer 
program to place the client software on the 
startup disk. 
6.  Create and enter a password to prevent 
unauthorized access to the client; do not forget 
this password. 
NOTE: Use only basic alphanumeric characters 
(low-bit ASCII) in passwords for clients. 

Macintosh high-bit characters do not 
correspond to Windows high-bit characters. For 
example, Luf$Luf00 is OK but Lüf•Lüføø will 
cause problems.
7.  Restart the computer, if requested.

After Installation
When the computer starts up, it automatically 
loads the client software. The client is now 
ready to be accessed from the backup computer, 
as described in “Working with Clients” on 
page 95.

System Requirements for Windows 
Client Computers
Windows client computers require:

• Intel Pentium class or better processor
• Windows 95/98/Me, Windows NT 4.0 

Workstation, Windows 2000 Professional, 
or Windows XP

• TCP/IP networking
• Winsock 2.0 for Windows 95

You can install TCP/IP networking software 
from the Windows installation software. Win-
dows 95 requires the Winsock 2.0 Update from 
Microsoft. It is available free from Microsoft at:
http://www.microsoft.com/windows95/

Installing Retrospect Client Software 
on Windows Computers
Use the following procedures to install the cli-
ent software on each Windows computer you 
want to back up over the network.

TIP: For installing many clients on a network, 
put the Retrospect Client installer on a shared 
folder on a file server. Copy the installer to the 
client from that folder instead of from the CD.

To Install Retrospect Client Software on a 
Windows Computer:
1.  Save all unsaved documents in other running 
application programs.

http://www.microsoft.com/windows95/downloads/contents/wuadmintools/s_wunetworkingtools/w95sockets2/default.asp
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2.  Under Windows NT/2000/XP, log in to the 
client computer so that you have Administrator 
privileges.
3.  Insert the Retrospect or Retrospect Clients 
CD in the client computer’s CD-ROM drive. 
4.  Click the Install Client button.
5.  Follow the instructions of the Setup program 
to place the client software on the startup disk. 
Create and enter a password to prevent 
unauthorized access to the client; do not forget 
this password. 
NOTE: Use only basic alphanumeric characters 
(low-bit ASCII) in passwords for clients. 
Macintosh high-bit characters do not 
correspond to Windows high-bit characters. For 
example, Luf$Luf00 is OK but Lüf•Lüføø will 
cause problems.
6.  Restart the computer, if requested.

After Installation
When the computer starts up it automatically 
loads the client software. The client is now 
ready to be accessed from the backup computer, 
as detailed in “Working with Clients” on 
page 95.

Cloning Installations
You may wish to use disk cloning software to 
clone a client installation. After installing client 
software on a computer, you can use the com-
puter as the master from which to create other 
cloned computers. Do not use Retrospect to ac-
cess the newly-installed client before using it as 
the clone master. You must clone the master be-
fore you access it with Retrospect.

Registry Backup Manager (NT/2000/XP 
Only)
Use the Registry Backup Manager on your 
Windows clients (NT/2000/XP only) to copy 
the clients' registry information so that 
Retrospect running on a Macintosh backup 
computer can back it up. Windows backup com-

puters automatically back up client registry 
information. 

With the Registry Backup Manager you can re-
store the copy from the backup and replace the 
registry. Use the Registry Backup Manager in-
stead of Microsoft's RegBack to automatically 
copy the system's registry information accord-
ing to a schedule. 

NOTE: The Windows 95/98/Me registry is 
automatically backed up by Retrospect, so this 
utility is for use only with Windows 
NT/2000/XP.
To launch the Registry Backup Manager, you 
should already be logged in to the client com-
puter with Administrator privileges. Go to the 
default installation path Program 
Files/Dantz/Client and double-click 
regcopy.exe.

Enable daily, unattended saving of the registry 
by clicking On and Apply. Click the Help tab 
for more information.

System Requirements for Linux Client 
Computers
Linux client computers require:

• x86-based system running Red Hat Linux 
6.2, 7.1, 7.2, 7.3, 8.0, or 9.0 

• glibc version 2 or later
• TCP/IP networking

In order to use the graphical user interface 
(GUI) to change options and preferences, the 
following is also required:

• Java version 1.2 or later

Installing Retrospect Client Software 
on Linux Computers
Use the following procedures to install the cli-
ent software on each Linux computer you want 
to back up over the network. Choose your pre-
ferred method of installation; rpm or tar. 
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To Install Retrospect Client Software on a 
Linux Computer:
1.  Insert the Retrospect CD into a disc drive 
connected to your Macintosh computer.
2.  Open the Install Retrospect Client folder and 
browse to the location of the Retrospect Client 
for Linux installer files (retroclient-65.rpm or 
retroclient65.tar).
3.  Copy the appropriate file to a location on the 
network.
4.  Then copy the file to the Linux computer on 
which you want to install the client software.
5.  Save all unsaved documents in other running 
application programs.
6.  Enter the following commands, depending 
on your operating system and your preferred 
installer.
rpm $rpm -i retroclient-65.rpm
tar $tar -xf retroclient-65.tar, $.Install.sh
7.  Create and enter a password to prevent 
unauthorized access to the client; do not forget 
this password.
NOTE: Use only basic alphanumeric characters 
(low-bit ASCII) in passwords for clients. 
Macintosh high-bit characters do not 
correspond to Windows high-bit characters. For 
example, Luf$Luf00 is OK but Lüf•Lüføø will 
cause problems.
The client software runs automatically upon 
completion of installation. 

After Installation
The client is now ready to be accessed from the 
backup computer, as described in “Working 
with Clients” below.

WORKING WITH CLIENTS
Once a client computer is installed with 
Retrospect Client software, you can add it to the 
Backup Client Database from the backup com-

puter and start using it in immediate and 
automated operations.

Important information about working with 
clients:

• Retrospect Desktop does not search for 
clients outside the local subnet. If you want 
to access clients outside the backup 
computer’s subnet, upgrade to Retrospect 
Workgroup or Retrospect Server, which 
include advanced networking features. 
These features are described in “Advanced 
Networking,” which starts on page 102.

• Retrospect Desktop and Retrospect 
Workgroup cannot back up Retrospect 
clients that are file servers. If you want to 
access servers as Retrospect clients, upgrade 
to Retrospect Server.

Adding Clients
Before you can back up a client computer, you 
need to add it to Retrospect’s client database.

NOTE: When you add a client, Retrospect's 
License Manager decrements the available pool 
of client licenses.

To Add a Client:
1.  From the Retrospect Directory, click the 
Configure tab, then click the Clients button.

The Backup Client Database displays a 
scrolling list of all the client computers 
currently logged in for use with Retrospect, if 
any.
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Macintosh clients are represented by the  
icon. Linux clients use the  icon. Windows 

clients use the  icon.

2.  Click Network to display a list of Retrospect 
clients.

The Backup Clients on Network window lists 
all the computers on a specific network that 
have Retrospect Client software installed. By 
default, Retrospect uses its Piton multicast 
method of searching for clients in the local 
subnet.
NOTE: A subnet is a group of local computers 
physically networked together without a router 
or gateway, though they may use a gateway to 
connect to other networks.
3.  Click to select a type of client to add.
Available types are: Mac OS X, Mac OS 
(7/8/9), Windows, or Linux.
To the right of each client name, Retrospect lists 
its status. “Not Logged In” means the client has 
not been logged in for use with Retrospect. 
“Responding” means the client is logged in and 
ready for backups or other uses.
4.  Select a client and click Log in.
5.  Enter the client’s password, then click OK.
The client configuration window displays. See 
“Configuring Clients” on page 96 for 
information about client properties.

Testing Network Addresses
You can use the Test button in the Backup Cli-
ents on Network window to test for a 

responding client at a known IP address or DNS 
name.

To Test an Address:
1.  From the Retrospect Directory, click 
Configure>Clients.
2.  Click the Network button to display the 
Backup Clients on Network window.
3.  Click the Test button.

4.  Enter an IP address or DNS name and click 
Test.
If Retrospect Client software is found at the 
specified address, Retrospect reports its client 
name and software version.

If a computer is found at the specified address, 
but it is not running Retrospect Client software, 
or if no computer is found at the address, 
Retrospect reports an error.

Configuring Clients
After you have logged in a client, you need to 
configure it. If a client is installed but not 
logged in, you can select it in the Backup Cli-
ents on Network window and click the Log in 
button to log in and configure the client. If the 
client is logged in but you need to reconfigure 
its settings, you can select it in the Backup Cli-
ent Database window and click Configure.

The client configuration window displays the 
client name and includes three tabs. Each tab 
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represents a category of configuration options: 
General, Configure, and Volumes.

General Tab
The General tab has an option to protect data 
over the network and options for specifying 
which volumes on the client computer are ac-
cessible to Retrospect over the network.

Link Encryption: The link encryption option, 
which is off by default, is only available if this 
client uses a password. When the Link Encryp-
tion checkbox is checked Retrospect protects 
against network eavesdropping by encrypting 
data transferred over the network then decrypt-

ing it before writing it in the backup set. (Client 
link encryption is distinctly different from back-
up set encryption.)

Volumes to Access: The setting of the pop-up 
menu affects how Retrospect resolves client 
containers during operations. Usually you do not 
need to change it from its Client Desktop default.

• Client Desktop resolves to all volumes local 
to the client computer, except for floppy 
disks, shared volumes (such as file servers), 
read-only volumes (such as CD-ROMs), and 
empty volumes.

• Startup Volume resolves to the volume 
from which the client computer booted.

• Selected Volumes resolves to all volumes 
selected in the Volumes tab of the client 
configuration window.

The following table uses the example of a client 
computer with several mounted volumes. It 
shows the volumes to which the client container 
resolves, depending on to the Volumes to Ac-
cess settings.

These volumes mounted on a 
client computer…

…with this Volumes to Access 
configuration…

…resolves to these 
volumes.

MOSX Startup
Extra HD

MOSX Startup

Extra HD (assuming 
Extra HD is the only 
volume selected in the 
Volumes tab).
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Configure Tab
The Configure tab lists the client name, whether 
it has a password, its clock offset (the time dif-
ference between the client computer clock and 
the clock of the backup computer), and the ver-
sion number of the client software.

• To change the client name, click Rename. A 
dialog then asks you to enter the new name.

•  To add, change, or remove the password, 
click Change. A series of dialogs then asks 
you to enter and confirm the new password.

• To change the time of the client computer to 
match that of the backup computer, click 
Sync Clock, which is not available when the 
client allows read access only (page 106). 

• To update the software version of the client 
click Update. A file selection dialog then 
asks you to locate the Retrospect Client 
software from which to update. See “To 
Update an Individual Client Computer” on 
page 101 for detailed instructions.

Volumes Tab
The Volumes tab lets you specify which vol-
umes on the client computer are accessible to 
Retrospect over the network.

You can select any, all, or none of the client 
computer’s volumes from the list. Your selec-
tion determines which volumes appear in a 
Volume Selection window (used to specify a 
backup script’s sources among other things). 

It also determines the volumes to which the cli-
ent container resolves when the General tab’s 
pop-up menu is set to Selected Volumes. See 
“General Tab” on page 97 for further 
information.

Forgetting a Client
After a client has been logged in, there may 
come a time when you no longer need it in the 
Backup Client Database (e.g. if the client com-
puter is removed from the network.). In this 
case, you can tell Retrospect to forget it, which 
is the opposite of logging it in.

In the Backup Client Database window, select 
the client and choose Forget from the Clients 
menu. Or, in the Backup Clients on Network 
window, select the client and click Forget.

In both cases, Retrospect asks you to confirm 
the operation. By clicking OK, you are remov-
ing the client volumes from scripts and other 
lists in Retrospect. This only affects Retrospect 
on the backup computer in use at the time. It 
does not affect other copies of Retrospect run-
ning on other computers on the network, which 
remain logged in to the client as usual. Forget-
ting a client does not affect that client’s existing 
backups.
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Forgetting a client makes one more client li-
cense available in the License Manager 
(page 92).

Getting Information About a Client
From the backup computer, you can use the Get 
Info command in the File menu to see status and 
other information about any client that appears 
in the Backup Client Database window, or any 
logged in client in the Backup Clients on Net-
work window. 

The client info window includes the client’s 
name and IP address, as well as the following 
information:

Status indicates the client’s availability for 
backups and other operations. 

• Ready means the client is ready and 
available.

•  Shutdown wait means the user has given the 
Shut Down command to the Mac OS 7/8/9 
client computer and the Retrospect Client 
software is waiting for a Retrospect backup 
computer. 

• Locked means the user at this client 
workstation has checked the “Read Only” 
access preference in the client control panel. 
(The client can be backed up, but you cannot 
restore to it or delete files from it.) 

• Busy means the client is currently being 
accessed by a different copy of Retrospect 
on the network. 

• Turned Off means the user at this client 
clicked the “Off” radio button in the client 
control panel. A client that is turned off is 
unavailable for operations until it is turned 
on manually or the client computer is 
restarted.

Version is the version number of the client soft-
ware installed on the client computer.

Machine (Windows clients only) shows the 
type of CPU in the client computer.

Memory (Macintosh and Windows clients 
only) is the total amount of RAM in the client 
computer.

Type (Windows clients only) Shows the client 
type, i.e., Windows backup client.

System (Macintosh and Linux clients only) lists 
the operating system used by the client 
computer.

OT Version (Mac OS 7/8/9 clients only) is the 
version of Open Transport running on the client 
Macintosh.

Application (Mac OS 7/8/9 clients only) is the 
active application or program.

Idle time (Mac OS 7/8/9 clients only) is the 
amount of time since the keyboard or mouse on 
the client Macintosh were last used.

Echo time is the time delay, in seconds, experi-
enced in communicating with this client (usually 
0.0 to 0.2). If the network or client is busy, or 
you are using routers, the echo time could easily 
be higher without indicating a problem.

Speed is the transfer rate of the network con-
nection between the backup computer and the 
client computer.
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Clock offset is the difference in hours:min-
utes:seconds between the internal clocks of the 
client computer and the backup computer.

Priority is the priority setting the user has cho-
sen in the client control panel. A 20% priority 
means the user has set the slider all the way to 
“User,” giving other applications and tasks 
some of the computer’s processing time that 
would otherwise be used for Retrospect tasks. A 
100% priority means the client’s priority slider 
is set all the way to “Backup,” giving client 
tasks (namely, transferring files) all of the client 
software’s processing time allotted by its oper-
ating system.

Volumes displays the number of volumes the 
backup computer knows about for this client.

Security summarizes the data security specified 
for this client computer. 

• No Password means no security code was 
installed. Anyone using Retrospect on the 
network can log into this client. 

• Password Protected means a security code 
must be entered in order to log in to this 
client. 

• Link Encrypted means that the administrator 
has selected the “Link Encryption” option 
for this client. This means data from this 
client is being encrypted before being 
copied over the network.

UPDATING CLIENTS
There may come a time when you need to up-
date older client software to take advantage of 
improvements in a newer version. At that time, 
you can update clients either from the backup 
computer, or from individual clients.

NOTE: You must update all Mac OS X clients 
to use the Retrospect 6.0 Client software. 
Retrospect 6.0 does not support pre-6.0 client 
software for OS X clients.

Updating Clients from the Backup 
Computer
You can update individual clients as needed, or 
update all clients of a given type. When you up-
date a client, it retains all of its current settings.

NOTE: It is a good idea to update all clients 
even if you know some of them are turned off. 
You can later repeat this operation without 
affecting the clients that are already updated.

To Update All Clients of a Given Type
From the Retrospect Directory’s Configure tab, 
click the Clients button. The Backup Client Da-
tabase window appears, listing all client 
computers currently logged in for use with 
Retrospect.

Choose Update All from the Clients menu.

Select the type of clients you want to update 
(Mac OS X, Mac OS, Windows, or Linux.) and 
click OK.

In the next dialog, click OK to confirm the up-
dating of the client software.

Browse to the location of the Retrospect Client 
update file.There are four different client update 
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files: one each for Mac OS X, Mac OS 7/8/9, 
Windows, and Linux. Different client update 
files may be available from different places 
such as the Retrospect CD and the Dantz web 
site.

Select the appropriate client update file and 
click Open. Retrospect begins updating the cli-
ent software on the client computers.

NOTE: If a client computer has virus protection 
software installed, it may require confirmation 
at the client computer before allowing the 
update to continue.
When the update is complete, Retrospect re-
ports the results in a dialog and the Operations 
Log. Click OK.

To confirm the status of each client update, 
open the Operations Log. (To do this click the 
Reports tab then click the Log button, or choose 
Log from the Window menu.)

The update does not take effect under 
Mac OS 7/8/9 or Windows NT/2000 until the 
client computer is restarted. For Red Hat Linux 
6.2 clients, you must manually restart 
Retrospect Client on each computer with the 
command:

$/usr/local/dantz/client/rcl start

To Update an Individual Client Computer
From the Retrospect Directory’s Configure tab, 
click the Clients button. The Backup Client Da-

tabase window appears, listing all client 
computers currently logged in for use with 
Retrospect.

Select the client you want to update, then click 
the Configure button (or double-click the cli-
ent). In the client configuration window that 
appears, click the Configure tab.

Click the Update button. A dialog appears, 
prompting you to specify the location of the 
Retrospect Client update (.rcu) file.

Select the appropriate client update file, and 
click Open. When the update is complete, an-
other dialog appears, telling you the update 
completed. Click OK.

The update does not take effect under 
Mac OS 7/8/9 or Windows NT/2000 until the 
client computer is restarted. For Red Hat Linux 
6.2 clients, you must manually restart 
Retrospect Client on each computer with the 
command:

$/usr/local/dantz/client/rcl start

Updating Clients from the Client 
Computer
If you do not want to update clients from the 
backup computer as described above, you can 
update clients directly from the individual client 
computers. This is done with the Setup applica-
tion (Windows), Client Installer application 
(Mac OS), or rpm or tar installers (Linux), 
which can also update clients.

http://www.dantz.com
http://www.dantz.com
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Follow the installation instructions, which start 
on page 92, appropriate for the computer’s op-
erating system.

UNINSTALLING A CLIENT AND ITS 
SOFTWARE
If you want to remove the client software from 
a computer, forget the client as described on 
page 98, then take the following steps.

Mac OS X
1.  Open the client installer application. 
2.  Choose Uninstall from the pop-up menu and 
select the volume from which to uninstall 
Retrospect Client software. 
3.  Click the Uninstall button to remove the 
client software from the computer, then exit 
when you are done.

Mac OS 7/8/9
Remove the Retrospect Client control panel 
from the computer by placing the file in the 
Trash.

Windows
1.  From the Start menu, choose 
Settings>Control Panel.
2.  Double-click Add or Remove Programs. 
3.  In the window that appears, select the 
Retrospect Client software and click 
Change/Remove. 
4.  Click OK to close the window.

NOTE: Under NT/2000/XP you may have to 
log in with administrator privileges.

Linux
The process for uninstalling the Linux client 
varies depending on how the client software 
was installed.

For rpm, type the command: $rpm -e retroclient

For tar, manually remove the client software 
files installed by tar.

ADVANCED NETWORKING
The features described in this section are avail-
able only with Retrospect Workgroup and 
Retrospect Server.

Retrospect normally uses its multicast access 
method to find backup clients directly connect-
ed to the local network segment or local subnet, 
and display them in the Backup Clients on Net-
work window. You will need to use 
Retrospect’s more sophisticated techniques of 
accessing clients if your network has routers be-
tween the backup computer and its clients, or if 
your backup computer has multiple network 
cards connected to different physical networks.

Access Methods
Retrospect can either use the standard DNS and 
WINS directory services, or its own Piton Name 
Service based on TCP/IP.

Adding a client to the Retrospect client database 
also stores its access information for later use. 
When Retrospect tries to connect to the client 
for a backup, it resolves the access information 
into its current IP address using the original ac-
cess method.

On each client computer, Retrospect Client 
software waits for queries from Retrospect on 
the backup computer. Just exactly how 
Retrospect gets in touch with the clients de-
pends on the access method Retrospect is using.

Multicast
When you first open the Backup Clients on Net-
work window, the default access method is 
multicast. With this method, Retrospect sends 
out a multicast request to the listening client 
computers, asking them to respond with their 
identities. After you have added a client with 
this method, when Retrospect later tries to con-
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nect to the client for a backup, it handles IP 
address changes automatically by sending out 
another request to update its client database and 
connect with the proper client.

If you use a network analyzer to monitor the 
packets it sends with the multicast method, you 
will see Retrospect uses well-known port 497 
for its communications. The packet format con-
forms to the proprietary Dantz protocol Piton 
(for PIpelined TransactiONs), which gives 
Retrospect much of its network speed and reli-
ability. Multicast Piton Name Service uses the 
assigned address 224.1.0.38, which allows Pi-
ton to direct its queries only to those computers 
running Retrospect Client software.

Multicast access is simple, requiring no config-
uration, but does not operate across routers. It 
works only in the local subnet.

Subnet Broadcast
The subnet broadcast access method allows you 
to access clients through virtually any network 
topology, including the Internet.

According to TCP/IP standards, every subnet 
has both a network address and a subnet mask, 
such as 192.168.6.0 and 255.255.255.0. Routers 
use these to identify the physical network to 
which computers are connected. Routers also 
support queries to all the computers on a partic-
ular subnet. Retrospect takes advantage of this 
ability for its subnet broadcast access method, 
using the same Piton protocol as for multicast 
access.

With Retrospect’s subnet access method, you 
must define the address and mask of each sub-
net you wish to use, and update these 
configurations if your network changes.

Direct Access
You can use the direct client access method to 
add a specific backup client to Retrospect’s cli-
ent database. This method requires you to know 
the IP address or DNS or WINS name of each 

backup client. Do not use a numeric IP address 
for computers which get a dynamic IP address 
from a DHCP server, because Retrospect has no 
way to know when the address changes.

Adding clients by direct access is most useful 
for a few clients; adding many might be tedious. 
One of the other methods would probably be 
better for adding numerous clients.

Configuring Access Methods
The first time you open the Backup Clients on 
Network window Retrospect searches for cli-
ents in the local subnet using its multicast 
access method. 

Subnet Broadcast Access Method
You can define subnets other than the local sub-
net in which you want Retrospect to search for 
clients.

Choose Configure Subnet Broadcast from the 
TCP/IP menu to configure a new subnet to 
search. The first time you use this feature, no 
subnets are configured so none appear in the 
configuration window.

Click Add to configure a new subnet to search.

Enter an IP address within the subnet and enter 
its subnet mask. Then click OK.

The IP subnet you defined appears in the subnet 
configuration window.
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Later you can add, modify, or remove subnets 
as needed.

Click OK to return to the Backup Clients on 
Network window and view the backup clients 
Retrospect found using the subnet broadcast ac-
cess method.

When you add a client with the subnet broadcast 
access method, Retrospect knows to look for 
that client in your defined subnets.

Each subnet you configure will be accessed by 
Retrospect when it searches for clients. This in-
cludes not only when this window is open, but 
also when Retrospect searches for a client in an 
operation.

Direct Access Method
In the Backup Clients on Network window, 
click the Add by Address button. 

Enter the IP address or DNS or WINS name of 
a client and click Add. When a client is found at 
the specified address, Retrospect asks you for 
its password before logging it into the client 
database. 

NOTE: If Retrospect fails to connect to a client 
at the specified IP address, see 
“Troubleshooting” on page 196.
After you enter the correct password, 
Retrospect displays the client’s properties win-

dow (described in “Configuring Clients,” which 
starts on page 96). 

CLIENT USER PREFERENCES
After the client software has been installed, us-
ers of client computers can control some aspects 
of network backup operations with the 
Retrospect Client control panel.

You do not need to change any of the settings to 
perform backups. In most cases, the existing 
settings are the ones you will want to use. To 
open the Retrospect Client control panel, do the 
following:

Mac OS X: From the Applications folder, open 
Retrospect Client.

Mac OS 7/8/9: From the Apple menu, choose 
Control Panels, then open °Retrospect Client.

Windows: From the Start menu, choose Set-
tings>Control Panel, then open Retrospect 
Client.

Linux: Run RetroClient.sh from the installed 
client folder.

The Retrospect Client control panel displays in-
formation about the client computer on which it 
is installed, including the user or computer 
name, the access status of the client, and a report 
about the last several backups.
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The Mac OS X client application. (The Mac OS 7/8/9 cli-
ent control panel is similar.)

The Windows client control panel, showing the Status 
tab.(The Linux client control panel is similar.)

In addition to the Java-based graphical user in-
terface, Linux clients can also be controlled 
through the command line. To see the command 
line arguments, enter the following:

$retrocpl --help

Access Master Control
The On and Off radio buttons let you allow or 
deny network access to your client by the back-
up computer. When you install the client 
software and each time the client computer 
starts up, the control is on to allow access. When 
the control is turned off, the data on the client 
computer cannot be accessed over the network 
by Retrospect.

TIP: To permanently prevent access to the 
client computer, uninstall the Retrospect client 
software as described on page 102.

General Preferences
The Retrospect Client control panel has addi-
tional user preferences for managing client 
operations. Getting to the preferences is done 
differently under Mac OS and Windows/Linux.

Mac OS: Click the Preferences button.

The Mac OS X Retrospect Client control panel’s 
preferences.

Windows/Linux: Click the Preferences tab 
from the Client control panel.

The Windows Retrospect Client control panel’s 
preferences.

Execution Preferences 
The execution preference settings allow client 
users to control how Retrospect interacts with 
the client computer.

NOTE: These preferences are only available 
with Mac OS 7/8/9 clients.
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Wait at Shutdown determines what happens 
when a client user chooses Shut Down from the 
Finder’s Special menu. When this option is se-
lected and Shut Down is chosen, the “waiting 
for backup” dialog is displayed until the backup 
takes place. By default, this preference is 
selected.

When this dialog is on the client Macintosh 
screen, the client user may click Restart to re-
start the client Macintosh, click Shut Down to 
shut it down, or click nothing and leave it for 
unattended operation. When the client computer 
is not used for thirty seconds, a screen saver ap-
pears until the user presses a key or moves the 
mouse to return to the dialog. When the backup 
computer finishes its operation with this client, 
it shuts down the client Macintosh.

Run in Background allows the backup com-
puter to operate at the same time the client user 
is using the client Macintosh. If the checkbox is 
not checked, a dialog appears on the client dur-
ing network operations. This preference is on by 
default.

When the dialog appears, the user of the client 
Macintosh can cancel the network operation to 
continue working or wait until the operation is 
finished. When “Run in Background” is 
checked, the dialog does not appear during 
backups, and the client user can set priority lev-
els for local and network operations. See below 
for details.

Priority Preference
The priority preference allows the client user to 
make the client computer favor either the user’s 
task at hand or the operation requested by the 
backup computer. Under Mac OS 7/8/9, this ap-
plies only when the “Run in Background” 
execution preference is on.

NOTE: This preference is not available or 
necessary for the Mac OS X client.

Drag the slider and set it to somewhere in the 
range between “User” and “Backup.” When the 
slider is set all the way to “User,” the computer 
devotes more of its attention to its user, slowing 
Retrospect client operations slightly. When the 
slider is set all the way to “Backup,” the client 
operation is given priority and the client com-
puter is slightly less responsive to its user.

This setting has no effect until the client is ac-
tively communicating with the backup 
computer.

Under Mac OS 7/8/9, the Priority setting is ig-
nored if the client Macintosh is displaying the 
“waiting for backup” dialog.

Access Restrictions Preferences
These preferences allow the client user to con-
trol access to the files and folders on his or her 
computer.

Read Access Only allows the client computer 
to be backed up across the network, but pre-
vents writing by the backup computer. This 
means the backup computer cannot restore, 
move, or delete files on the client computer, nor 
can Retrospect be used to rename volumes. The 
options “Set Volume Backup Date,” “Move 
Files,” and “Synchronize Clock” cannot be used 
on the client. This setting is off by default.

Private Files/Folders/Volumes makes any 
files, folders, or volumes designated as private 
unavailable to the backup computer. This pref-
erence is off by default. Select the checkbox and 
designate private items as described below.

To designate an item as private under Windows 
or Linux, click the Add button, browse to select 
the item, then click OK or Exclude. Click Add 
again to exclude more volumes, folders, or indi-
vidual files. The privacy feature uses the literal 
pathnames you specify. If you move or rename 
a file or folder it may no longer be private. If 
you mount a volume to a different location, its 
files and folders may no longer be private.
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To designate an item as private under Mac OS, 
type a bullet (“•”, Option-8) at the beginning or 
end of its name (placing it at the end will pre-
serve its sort order in the Finder). For example, 
you could designate the folder “Personal” as 
private by renaming it “Personal•”.

Notification Preferences
These two preferences allow client users to 
specify how they are informed about Retrospect 
network operations.

Notify after Backup directs the client to dis-
play a message after the completion of a backup 
or other operation. The client user can click OK 
to dismiss the message. By default, this prefer-
ence is selected.

Notify if no Backup in n days directs the client 
to display a message after 9:01 A.M. if the client 
has not been backed up within the number of 
days specified in the entry box. By default, this 
preference is selected and the number of days is 
seven.

Report S.M.A.R.T. hard disk errors (Win-
dows client only) requests an immediate backup 
from Proactive Backup (known as Backup 
Server in Retrospect for Mac) when Retrospect 
learns of errors on the client’s S.M.A.R.T. hard 
drive volumes. By default, this preference is 
turned on.

Controlling Backup Server Scripts
There are two ways to control Backup Server 
scripts from the client computer:

• Scheduling from a Client
• Deferring Execution

Scheduling from a Client
If a client is included in a Backup Server script, 
you can use the client control panel to influence 
when the client gets backed up.

NOTE: Backup Server is known as Proactive 
Backup in Windows and Linux client software.

Mac OS X: The Backup Server preferences ap-
pear in the Retrospect Client preferences 
window.

Mac OS 7/8/9: Click the Schedule button to 
bring up the Backup Server control dialog.

Windows/Linux: Click the Proactive Backup 
tab to bring its controls to the front.

These controls let the user determine when the 
client computer can be backed up by the backup 
computer (using a Backup Server script). The 
user would normally use it to initiate a backup 
or defer a backup, but the user can also revert 
the Backup Server back to its normal schedule 
for this client. The Backup Server options are:

• As soon as possible makes the backup 
computer back up the client computer as 
soon as Backup Server is available to do so.

• According to normal schedule makes the 
backup computer back up the client 
computer at its regularly scheduled time in 
the Backup Server script. (This is the 
default.)

• After ______  prevents the backup 
computer from backing up the client 
computer before the specified time and date, 
up to one week from the present time. (Click 
on the time and date and type or click the 
arrows to change them.)

Click OK to accept the settings.
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Deferring Execution
When Backup Server is about to back up a cli-
ent, a dialog appears on the screen of the client 
computer.

Macintosh client Backup Server countdown.

Windows/Linux client Proactive Backup countdown.

The dialog gives the client user three ways to 
control the execution of the impending Backup 
Server operation:

• Waiting for the countdown to reach zero 
allows the Backup Server script to execute.

• Clicking Backup executes the backup 
immediately.

• Clicking Defer lets the user set a later time 
for the backup to operate.

Deferring the Backup Server script from a Macintosh 
client.

Deferring the Proactive Backup script from a Windows 
or Linux client.

When a user defers, Retrospect makes an entry 
in the backup computer’s Operations Log.

BACKING UP CLIENTS
You back up a client volume the same way that 
you would back up a volume directly connected 
to the backup computer.

When you set up an immediate or scripted back-
up, the volume selection window for the source 
lists available clients under the Backup Clients 
container and available client volumes under 
the individual client containers. See “Contain-
ers” on page 169 for more information.

When you set up an immediate backup or make 
a backup script you have a few different ways of 
selecting clients and client volumes in the vol-
ume selection window for the sources. You can 
select a client container, one or more specific 
volumes, or the Backup Clients container. 
Dantz recommends using client containers or 
the Backup Clients container. Following are ad-
vantages of each method.

• Selecting the Backup Clients container 
selects all individual client containers 
(described below) logged in at the time of 
the backup, including new clients you add 
later.

• Selecting a client container selects volumes 
determined by a client general configuration 
setting, which is explained in detail on 
page 97. Using a client container is simple 
and maintenance-free. Volumes which are 
renamed, replaced, or partitioned continue 
to be backed up with no administrator 
intervention.

Macintosh Client

Backup Clients 

Windows Client

Client startup volume
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• Selecting individual volumes selects only 
those specific volumes, unlike containers. 
Retrospect continues to select volumes 
which are renamed but does not 
automatically adjust for new, replaced, or 
partitioned volumes. When the client 
configuration changes you may need to 
modify scripts that use these volumes. This 
way of selecting volumes is useful, for 
example, when you do not want to back up 
all volumes on a particular client.

• Selecting folders or groups in your script 
selects whatever volumes and client 
containers are placed in the folder or group. 
This method simplifies script management 
by allowing you to control your sources in a 
single place, the Volumes Database 
window. Using folders in the Backup 
Clients container lets you better organize a 
large number of clients. Using groups lets 
you build lists of volumes and clients which 
should be backed up together.

For detailed instructions on selecting volumes, 
see under “Working with Volumes” in 
Chapter 9.

WORKING WITH WINDOWS 
CLIENTS
This section includes tips on using the Windows 
client, as well as information on its limitations. 
If you plan to back up Windows 95 clients, there 
are certain steps you must take in order to do so.

Fixing Microsoft Windows 95
Two different bugs in Microsoft’s network soft-
ware can cause Retrospect to report networking 
errors with Windows 95 clients. Microsoft has 
resolved both problems and free fixes are avail-
able for Windows 95. We strongly urge you to 
update your Windows 95 systems.

NOTE: Windows 98, Windows Me, Windows 
NT 4.0, Windows 2000, and Windows XP do 
not require any updates.

Windows 95 TCP/IP Fix
The hot fix for Windows 95 is installed by the 
client software Setup program. After installa-
tion, choose Run from the Start menu, then 
type:

C:\Program Files\Dantz\Client\
VTCPUPD (or your installation path, if different) 

Click OK. Follow the instructions in Mi-
crosoft’s installer, then restart to complete the 
fix. Repeat for each Windows 95 client comput-
er to be used with Retrospect.

Windows 95 Winsock Update
Microsoft’s Winsock 2.0 update fixes another 
networking problem present in Windows 95 
only. It is available free from Microsoft at:

http://www.microsoft.com/windows95/
downloads/contents/wuadmintools/
s_wunetworkingtools/w95sockets2/default.asp

Windows NT/2000/XP Registry 
Backup
To fully restore a Windows NT/2000/XP com-
puter, you must back up its registry. The 
registry changes as programs are installed and 
removed, control panel settings are changed, 
and application preferences are changed, so you 
must back it up regularly to keep up with its 
changes. Because Retrospect cannot directly 
back up the NT/2000/XP registry for clients, 
Dantz supplies the Registry Backup Manager, a 
tool that automates and simplifies registry 
backup.

The client software Setup program installs the 
Registry Backup Manager application to the cli-
ent software path (C:\Program Files\Dantz\
Client by default). Start and automate the Reg-
istry Backup Manager as detailed on page 109. 
For detailed instructions on using the Registry 
Backup Manager, click its Help tab.

http://www.microsoft.com/windows95/downloads/contents/wuadmintools/s_wunetworkingtools/w95sockets2/default.asp
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Windows 95/98/Me Registry Backup
Retrospect backs up the Windows 95/98/Me 
registry when the Windows folder is included in 
the file selection criteria. You do not need to 
take any extra steps to preserve its registry, oth-
er than doing your normal backups of 
computers.

NTFS Security
Retrospect for Macintosh does not back up or 
restore NTFS security permissions. If you need 
to back up Windows workstations where NTFS 
security is important, you must use Retrospect 
for Windows.

Windows NT/2000 Servers
Retrospect for Macintosh does not support 
backing up Windows NT or 2000 Servers. Be-
cause Retrospect for Macintosh does not back 
up or restore NTFS security permissions, multi-
ple data stream files, or Active Directory, it 
cannot restore a Windows server back to an op-
erable state. You can, however, use Retrospect 
for Macintosh to back up user data from a Win-
dows server, with some exceptions, noted 
below.

Services for Macintosh
Because Retrospect for Macintosh does not 
back up or restore multiple data streams or per-
missions from NTFS volumes, Services for 
Macintosh data cannot be backed up to a Mac-
intosh using Retrospect Clients. If you try this, 
you get a warning in the log.

We recommend you use a server-level edition 
of Retrospect for Windows to back up Windows 
NT or 2000 servers.

If you wish to use Retrospect for Macintosh to 
back up Services for Macintosh data from a 
Windows NT or 2000 Server, you must back up 
the data as a mounted AFP volume. To do this, 
mount the volume on your Macintosh desktop. 
Then add it to your backup scripts as a local 
source. You can configure Retrospect to auto-

matically mount the volume during execution. 
To do this, highlight the volume and choose 
Configure from Retrospect’s Volumes menu.

Excluded Files
Retrospect excludes certain files from backups 
and does not show these files in Browsers be-
cause they cannot or should not be backed up or 
restored. The files are active virtual memory 
swap files (.Swp or .Par and Pagefile.Sys), 
some client software files, and the Windows 
NT/2000/XP registry (when active).

Netware Volumes Under NT/2000/XP
Under Windows NT/2000/XP, the Retrospect 
client software is running as a service and it can-
not recognize Netware volumes.

Selecting Files
You can use a Browser to manually select files 
to back up, or you can automate file selection 
with a Selector. Some Selectors and Selector 
conditions do not function with Windows cli-
ents as they do with Mac OS clients. The 
differences are detailed under “Using Selec-
tors” on page 177.

Case-Sensitive File Systems
Some file systems used with Windows clients 
are case-sensitive with file names. On a Win-
dows client volume, multiple files with names 
identical except for case (for example, Foo, foo, 
and FOO,) will confuse Retrospect. For exam-
ple, if during a backup it encounters a directory 
containing multiple file names differing in case 
only, it backs up only one of the files.

Hard Links
When it encounters a hard link to a file on a 
POSIX-compliant Windows client volume, 
Retrospect treats the link as a separate file.

HPFS Attributes
Retrospect does not support HPFS volumes of 
Windows clients.
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Screen Savers
For best performance during a backup, do not 
use a processing-intensive screen saver on a cli-
ent computer.

Copying Mac OS Files to a Windows 
Client
When copying files back and forth between 
Mac OS and Windows computers, it is impor-
tant to be aware of the certain differences 
between Mac OS and Windows files and how 
Retrospect handles those differences.

Data and Resource Fork Files
Unlike files on Windows volumes, many Mac-
intosh files are made up of two parts, called 
forks: one fork includes data and the other in-
cludes resources. When Retrospect copies a 
dual-fork Macintosh file to a Windows client 
volume, it takes the following steps to separate 
the forks into different files.

• It stores the data fork in a new file, which has 
the same name as the original file.

• It creates a new folder named Resource.Frk, 
which is hidden and resides in the same 
folder path as the data fork file.

• It stores the resource fork in a new file, 
which resides in the Resource.Frk folder and 
has the same name as the original file.

• It tracks fork-separated files in a hidden file 
named Finder.Dat, which resides in the 
same folder path as the data fork file.

If you move one of these Macintosh files on a 
Windows computer, it is unusable unless you 
also move the other files and folder. When you 
use a Retrospect Browser to view a Windows 
client volume containing these split Macintosh 
files, only a single file appears. When viewed 
from Windows, the extra files appear (unless 
Windows is set to hide hidden files). When you 
back up the files to a backup set or duplicate 
them to a Macintosh volume, Retrospect inte-
grates them into the single original file.

Illegal Characters in File Names
Mac OS file names can include several charac-
ters that Windows does not allow in its file 
names. These illegal characters are /, \, :, *, ", <, 
and >. When restoring or duplicating Macintosh 
files to a Windows volume, Retrospect replaces 
each of these illegal characters with a hyphen (-
). Retrospect tracks renamed files in a file 
named Finder.Dat. When copying the files back 
to a Macintosh, Retrospect replaces the hyphens 
with the original characters.

If you move one of these Macintosh files on a 
Windows computer, also move the Finder.Dat 
file with it, or the hyphens become permanent.

WORKING WITH LINUX CLIENTS
This section includes tips on using the Linux 
client, as well as information on its limitations. 
If you plan to back up Linux clients, you should 
be aware of these limitations.

Excluded Files
Retrospect excludes certain Linux client files 
from backups and does not show these files in 
browsers, because they cannot or should not be 
backed up or restored.

The following types of files are excluded from 
backup:

• character device crw-------
• block device brw-------
• socket files srw-------
• fifos prw-------
• doors drw-------

File Naming
Linux has case-sensitive filenames, which 
means “myfile” and “Myfile” are considered 
distinct files. However, Windows and Mac OS 
have non-case sensitive filenames so “myfile” 
and “Myfile” are interpreted as the same 
filename. 
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WARNING: If these two files are duplicated 
from a Linux client to a Windows or Mac OS 
volume, the second file that gets copied will 
overwrite the first one.

FILE SYSTEM CONVERSIONS
Retrospect allows you to restore and duplicate 
data between computers that use different oper-
ating systems and file systems. Because no two 
file systems support identical attributes and file 
formats, copying files from one file system to 
another sometimes results in the loss of 
information. 

Retrospect supports the following file system 
conversions with no loss of data:

• FAT (Windows) to HFS (Macintosh)
• FAT to NTFS (Windows)
• HFS to NTFS
• FAT to Linux file systems
• Linux to HFS (Mac OS X only)

Retrospect supports the following file system 
conversions with loss of extended information 
and/or data, as noted:

• HFS to FAT: Data fork of HFS files is 
copied; attributes, privileges, and resource 
fork are not.

• NTFS to FAT: First data stream is copied, 
but all permissions and other NTFS data are 
not.

• NTFS to HFS: Services for Macintosh data 
on an NTFS volume restores or duplicates 
without loss to Macintosh HFS volumes. 
When copying Windows NTFS data to HFS 
the first data stream is copied, but all 
permissions and other NTFS data are not.

• NTFS to Linux: Lose permissions and other 
NTFS data.

• Linux to HFS (Mac OS 9.x): Lose Linux file 
permissions, owner and group attributes, 
and special file attributes (e.g. hard links).

• Linux to FAT: Lose Linux file permissions, 
owner and group attributes, and special file 
attributes (e.g. hard links).

NETWORK BACKUP GUIDELINES
This section provides information, advice, and 
worksheets to help you set up a workgroup 
backup using Retrospect.

In general, the same principles that apply to in-
dividual backups also apply to network backups 
of client computers. The major difference be-
tween an individual backup and a network 
backup is the amount of data, which may over-
whelm storage limitations. As a consequence of 
the sheer amount of data and the often slower 
speed of network backups, time may also im-
pose limitations. If you cannot back up the 
entire network in a single night, you may want 
to consider splitting the backup over several 
nights, backing up only documents, or using 
Backup Server scripts.

Although the information in this section can be 
applied to any local area network, the examples 
assume a basic Ethernet network installation. 
Most calculations will still apply if your net-
work contains inter-network devices (such as 
routers or gateways), unless one or more mem-
bers of the backup workgroup are separated 
from the rest by an inter-network device. Run-
ning backups through routers or gateways 
increases the time it takes to complete a backup.

Choosing the Backup Device
The capacity of the backup device is usually the 
most important consideration for automatic, un-
attended workgroup backups. There is no such 
thing as too much capacity for network back-
ups. More capacity almost always means you 
can back up more files from more volumes from 
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more client computers, broaden the criteria for 
selecting files to be backed up, increase the 
amount of time between media changes, and in-
crease the number of backup sessions per piece 
of media.

If your backup device is not large enough, you 
will not be able to complete an automatic, unat-
tended backup because you will have to change 
the media before the backup is finished.

Choosing the Backup Computer
This section offers some advice on how to select 
the correct backup device and backup computer 
to suit your planned network backups.

You do not to use a file server as the backup 
computer. Table 6-1 below lists various advan-
tages of using a desktop computer or a server as 
the backup computer.

Although the backup computer can be virtually 
any Mac OS X machine, consider using a Mac-
intosh with adequate power to perform your 
network backups. For example, if you are back-
ing up a small number of client computers with 
small to medium capacity hard disks, you can 
get by with a computer with less processing 
power than you would need if are backing up 
large file servers and several client computers 
with thousands of files. Following are some ad-
ditional considerations.

• The performance of the backup computer 
often determines the performance of the 
entire system. Generally, a higher 
performance computer supports a network 
backup of more data from a larger number of 
client computers.

• Software compression and encryption 
increase CPU use significantly. If you are 
considering using either of these features, 
choose a computer with a more powerful 
CPU and more memory.

• Make sure the backup computer has enough 
RAM to handle the network volume that 
contains the most files. The more files you 
have, the more RAM you need. 

• If the backup computer is not completing 
backups in its scheduled time periods or if 
you want volumes to be backed up more 
often than they are, you may need a faster 
backup computer, a faster backup device, or 
both. A faster network interface card may 
speed network backups and a faster SCSI 
controller may increase throughput with the 
backup device.

See “Managing Resources,” which starts on 
page 81 for more information.

Advantages of Desktop Advantages of Server

• You can use the computer closest to you for easy 
access to the backup device and Retrospect.

• Avoids expense of a dedicated server.

• You can select the computer best suited in terms of 
memory and speed. Retrospect can be run at night 
or on weekends, allowing normal use of the 
computer during work hours.

• Allows your server to run at full speed for those 
who are accessing it while the backup is running.

• Optimizes your backup speed since servers are 
often a high performance model.

• Takes advantage of the server’s inactivity during 
the nights and weekends.

• Gains added security for your backup sets if your 
server is located in a secure area.

• Backs up large server disks using faster local 
transfer rates, rather than the slower network 
transfer rates.

Table 6-1: Advantages of using a desktop computer or a server as the backup computer.
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Encryption and Compression
Retrospect provides an encryption feature that 
lets you protect your data from unauthorized ac-
cess as it is being backed up, and a compression 
feature that saves space on the backup device by 
compressing stored data. The decision to use 
one or both of these features can affect the type 
of backup device you choose. Keep in mind that 
Retrospect’s encryption and software compres-
sion can slow a backup, especially when using a 

computer with a slow CPU. A tape drive that 
supports compression will perform the task of 
compression itself, because it compresses data 
faster than Retrospect.

Use the following table to determine whether to 
use compression and encryption and whether a 
compression tape drive is appropriate to use as 
the backup device.

Feature Description Procedure Implementation

Compression Allows the 
backup device 
to store more 
files on its 
media.

Finds patterns in the 
data; the more pat-
terns, the greater the 
compression.

If you have a compression drive, Retrospect 
leaves the task of compression to the hard-
ware since it compresses data faster than 
Retrospect. 

Encryption Adds security to 
your backup.

Randomizes the 
appearance of data to 
prevent unauthorized 
access.

Retrospect always manages encryption.

Compression 
with encryption

Allows the 
backup device 
to store more 
files on its 
media and adds 
security to your 
backup.

Compression must 
take place before 
encryption.

You must use Retrospect’s software com-
pression option in this case. Retrospect 
automatically disables hardware compression 
when you use encryption.
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Device Capacity Worksheet
Use this worksheet to estimate the minimum required capacity of a backup device for your work-
group. The number you come up with for G is the minimum backup device media capacity for 
completing an unattended backup without having to change the media.

Item Description Amount

 A. Total disk 
capacity

user-defined

On a separate page, list your workgroup’s computers and the disk 
size (in megabytes) of each.
Work out the sum and enter it for A.

A =

 B. Estimated 
data 
redundancy

user-defined

Estimate how much data is redundant, which Retrospect backs up 
only once. If everyone in your workgroup uses the same applica-
tions, dictionaries, fonts, and so on, you might have as much as 
60% (0.6) redundancy. If your network is average, enter 0.3 for 
30%.
Enter your estimate of the redundancy percentage B, expressed in 
decimal form.

B =

 C. Reduction 
factor

C = 1 – B

Subtract the amount B from 1 to get the data reduction factor. For 
example, if B is 0.3 the reduction factor is 0.7 (because 1 –
0.3 = 0.7).

Work out the difference and enter it for C.

C =

 D. Reduced data

D = A ∗ C

To estimate the actual amount of data you need to back up (before 
any compression) multiply the total disk capacity (A) and the reduc-
tion factor (C).
Work out the product and enter it for D.

D =

 E. Estimated 
compression

user-defined

The compression rate depends on the files. Text files compress 
well; application files do not. The most compression you can hope 
for is 50% (0.5). Average compression to expect for network back-
ups is 30% (0.3). If you do not plan on using compression, enter 0.
Enter your estimate of the compression percentage E, expressed in 
decimal form.

E =

 F. Compression 
factor

F = 1 – E

Subtract the estimated compression (E) from 1. For example, if E is 
0.35 (35%) then F is 0.65 (because 1 – 0.35 = 0.65).
Work out the difference and enter it for F.

F =

 G. Required 
backup 
capacity

G = D ∗ F

To get the minimum required backup device capacity multiply the 
reduced data amount (D) by the compression factor (F).
Work out the product and enter it for G.

G =
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Backup Duration Worksheet
Once you have determined the size of your backup device, use the worksheet below to determine the 
number of hours your network backup requires. If the total number of hours is less than twelve, a 
recycle backup is likely able to complete in a single night. If the total number of hours is more than 
twelve, you may need to examine alternative strategies, such as performing recycle backups only on 
weekends or backing up only documents and preferences. 

Alternative strategies are suggested in “Backup Strategies” in Chapter 8.

Item Description Amount

 H. Backup capacity 
requirement

H = D

For H, enter the total reduced data requirement from item D in 
the Device Capacity Worksheet.

H =

 I. Verification 
multiplier

user-defined

If you do not plan to use verification enter 1. Otherwise, start 
with 1.5, but if you are using software compression or encryp-
tion, increase it by 0.1 to 0.5; the slower the backup computer, 
the higher the number.
Enter your verification multiplier for I.

I =

 J. Total 
transmission

J = H ∗ I

To get the total amount of data transmitted across the network 
multiply the backup capacity requirement (H) by the verification 
multiplier (I).
Work out the product and enter it for J.

J =

 K. Network 
throughput

user-defined

Throughput rates vary according to the network cabling 
method. For 10BaseT, use 1200 MB per hour; for 100BaseT, 
use 2400 MB per hour.
Enter the number of megabytes per hour for K.

K =

 L. Adjusted 
network 
throughput

L = K (1 – .05n)

Backing up through routers typically reduces performance so 
subtract 5% for each router. (Use n as the number of routers.)
Work out the difference and enter it for L. If you are not using 
routers or bridges assign the K value to L.

L =

 M. Hours required To determine the total number of hours required for the backup 
to complete divide the total transmission (J) by the adjusted 
network throughput (L).
Work out the result and enter it for M.

M =

 M=
J
L
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. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

C H A P T E R    7
D I S A S T E R  R E C O V E R Y

• O V E R V I E W  O F  D I S A S T E R  R E C O V E R Y

• R E S T O R I N G  T H E  B A C K U P  C O M P U T E R  W I T H  T H E  

B O O T A B L E  C D

• R E S T O R I N G  T H E  B A C K U P  C O M P U T E R  W I T H O U T  T H E  

B O O T A B L E  C D

• R E S T O R I N G  A  M A C O S  C L I E N T

• R E S T O R I N G  A  M A C O S  S E R V E R  C L I E N T

• R E S T O R I N G  A  W I N D O W S  C L I E N T

• R E S T O R I N G  A  L I N U X  C L I E N T

This chapter tells you how to restore the backup computer and client computers when 
disaster strikes and the computing environment required to restore your data is not 
available.
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OVERVIEW OF DISASTER 
RECOVERY
Retrospect has tools and features to help you re-
cover from a disastrous data loss in which the 
computing environment required to restore that 
data is not available. If you can boot your com-
puter and start Retrospect, you can use the 
application’s restore function as described in 
“Restore,” which starts on page 51.

Retrospect provides a bootable disaster recov-
ery CD that can be used to start up and restore 
the backup computer in the event of a disaster.

RESTORING THE BACKUP 
COMPUTER WITH THE 
BOOTABLE CD 
The Retrospect CD can boot a Macintosh into 
OS X for disaster recovery. 

NOTE: This CD is only included in the retail 
version of Retrospect. If you got Retrospect as 
part of an OEM drive bundle or other 
distribution, your CD includes a CD image 
file— Retrospect OS X Bootable CD.dmg— 
that you can use to create a bootable CD.
If you do not have the Retrospect CD, use the 
disaster recovery instructions in “Restoring the 
Backup Computer Without the Bootable CD” 
on page 120.

Limitations
Since the bootable CD runs a limited OS, it can-
not be used to restore from Internet backup sets 
or from File backup sets stored on the network. 

• To restore from these types of backup sets, 
follow the instructions in “Restoring the 
Backup Computer Without the Bootable 
CD” on page 120.

If your backup device requires special drivers or 
extensions, or if you used Retrospect to create a 
custom configuration for your CD/DVD drive, 

you cannot use it when your computer has start-
ed from Retrospect’s bootable CD. 

• To restore in these circumstances, follow the 
instructions in “Restoring the Backup 
Computer Without the Bootable CD” on 
page 120.

Restoring Using the Bootable CD
These instructions assume your Macintosh has 
encountered a disastrous data loss in which the 
computing environment required to restore that 
data is not available. If you can boot your com-
puter and start Retrospect, you can use the 
application’s Restore function as described in 
“Restore,” which starts on page 51.

The following instructions will help you get the 
computer back in working order using 
Retrospect and the bootable CD.

1. Restart Using the Bootable CD
Insert the Retrospect CD, which can start any 
computer that can run Mac OS X, and restart 
the backup computer. Press and hold the “C” 
key during startup to force the computer to boot 
from the CD. Retrospect launches 
automatically.

NOTE: If your Macintosh will not start from 
this CD, see “Restoring the Backup Computer 
Without the Bootable CD” on page 120.

2. Open or Rebuild the Catalog File
From the Immediate tab, click Restore.

Select “Restore an entire disk” and click OK. 
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Since your Macintosh is booted off the CD, 
there are no backup sets available until you re-
build or browse to a catalog file.

• If the partition on your hard drive containing 
catalog files is accessible, click Open.

• If you cannot access the catalog files on your 
hard drive, click Rebuild.

To open a catalog file:
1.  Click Open.
2.  Browse to the location of the catalog file for 
a backup set containing the most recent backup 
of the backup computer.
3.  Select the catalog file and click Open.

To rebuild a catalog file:
1.  Click Rebuild.

2.  Select the media type containing the most 
recent backup set data for the backup computer 
and click OK.
NOTE: Since your computer is booted into a 
limited system, you cannot access Internet 
backup sets or File backup sets that are stored 
on the network.
3.  Load the media containing your backup set 
data, select it in the Media Selection window, 
and click OK.

4.  Specify a location to save the catalog file 
and click Save.
Retrospect recatalogs the backup set, informing 
you of its progress in the execution status 
window. When Retrospect is finished with a 
particular member of a backup set, it asks 
whether there are any more members.
5.  If there are no more members, click No. If 
there are more members, click Yes.
Retrospect continues to ask for more members 
until you click No.

3. Restore from Backup
A window appears for you to select the source 
from which to restore backed-up files.

In the top part of the window, select the backup 
set that includes the most recent backup of the 
backup computer’s hard disk. In the bottom por-
tion, select the most recent Snapshot of that 
hard disk. Click OK to proceed. 

A window appears for you to select the destina-
tion for the restored files.
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Because your entire hard disk was wiped out 
and needs to be completely restored, select it 
and leave the pop-up menu set to “Restore En-
tire Disk.” 

NOTE: If the backup from which you are 
restoring is not a full backup of the hard disk 
you are restoring, choose “Restore 
Corresponding Files” from the pop-up menu 
instead. 
Click OK to proceed. Confirm the operation by 
clicking Replace (for “Restore Entire Disk” 
only). Retrospect compares the source and des-
tination and displays the restore summary 
window.

Put the first disc, tape, or disk from the backup 
set in your backup device and click Restore.

4. Restart
When the restore is complete, quit Retrospect to 
restart the computer.

Your computer is now ready to use.

NOTE: If you restored from a partial backup, 
your restored hard disk will reflect this. For 
example, if you restored from a “Documents 

only” backup, you will have to reinstall your 
applications manually.

RESTORING THE BACKUP 
COMPUTER WITHOUT THE 
BOOTABLE CD
These instructions assume your Macintosh has 
encountered a disastrous data loss in which the 
computing environment required to restore that 
data is not available. 

• If you can boot your computer and start 
Retrospect, you can use the application’s 
Restore function as described in “Restore,” 
which starts on page 51. 

• If you can boot your computer using 
Retrospect’s bootable CD, see “Restoring 
the Backup Computer with the Bootable 
CD” on page 118.

Restoring Without the Bootable CD
The following steps will help you get your com-
puter back in working order when it won’t boot 
on its own or with Retrospect’s bootable CD.

1. Restart and Try to Repair the Disk
Insert your Mac OS X CD into the backup com-
puter’s CD/DVD drive and restart the 
computer. Press and hold the “C” key during 
startup to force the computer to boot from the 
CD-ROM. Choose Open Disk Utility from the 
Installer menu then click the First Aid tab. Use 
Disk First Aid to examine your hard disk for 
problems and repair them, if possible. (You 
should also try other disk repair utilities if you 
have them. Use the low-level verification or test 
function of the Drive Setup utility or your disk 
formatter to examine the hard disk for defects 
that other utilities will not find.)

2. Assess the Current State of the Hard 
Disk
If you are able to repair all damage and no low-
level problems are found, stop here! You do not 
need to restore or reformat your hard disk.
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If you could not make any repairs with the disk 
utilities, or if the hard disk still does not mount 
on the desktop, you probably need to reformat 
your hard disk. Go on to step 4.

If you were able to repair some damage, but 
problems remain with the hard disk, you may 
need to reformat it. But first you must safeguard 
your data as described below in step 3.

3. Make New Backups Before Reformatting
Now is a good time to back up your repaired 
hard disk, so restart from the hard disk and open 
Retrospect. You may want to make two new 
backups (with the verification option on) to new 
backup sets. (Do not do a recycle backup to an 
existing backup set, as the damaged drive might 
not have all of your files on it and you don’t 
want to erase your previous backups.) Once you 
are sure you have redundant backups of your 
data, copy your backup set catalogs to an exter-
nal disk or server.

4. Reformat the Disk
If the disk repair utility can not fix the disk, you 
may have to erase or reformat the disk in order 
to prepare it for restoration.

WARNING: Erasing or formatting a hard disk 
destroys all data stored on the disk. If you are 
not sure whether you should erase or format 
your hard disk, contact its vendor for assistance.
If the disk is beyond repair, use Disk Utility to 
select the damaged volume, click the Erase tab, 
choose a format, supply a name, and click 
Erase.

5. Re-install Software
Restart your Macintosh from the Mac OS X 
CD, pressing and holding the “C” key during 
startup to force the computer to boot from the 
CD.

Install new Mac OS system software on your 
newly-formatted hard disk.

WARNING: You must install the same exact 
version number of Mac OS X as the version of 
Mac OS X you will restore. For example, if the 
backed up computer was previously running 
version 10.1.5, you must install Mac OS X 
10.1.5.
Eject any CDs and restart from the new system 
on the hard disk. If you used Internet backup 
sets, configure TCP/IP networking. Use the 
Date & Time control panel or system preference 
to set your local time and time zone, and, if nec-
essary, change the Daylight Saving setting.

Install Retrospect according to the instructions 
in “Installing Retrospect” on page 11. If you 
copied your configuration file and catalog files 
to floppy or removable disks, copy them back to 
your hard disk.

Start the Retrospect application. If you did not 
make copies or backups of your catalog files, 
rebuild the catalog or catalogs from your back-
up media. (To do this, click Repair from the 
Tools tab, then choose the rebuild option that 
matches your media, as described on page 188.)

If you copied your catalog files from disc or re-
movable disks you must get Retrospect to 
recognize them. From the Configure tab, click 
Backup Sets, then click More and Open to add 
the catalogs to the list of available backup sets.

NOTE: You may also need to install third-party 
drivers in order to access backup devices.

6. Restore from Backup
Now that your hard disk is working again and 
Retrospect is available along with your backup 
set catalogs, you can restore your hard disk. 
From the Immediate tab, click Restore.
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Select “Restore an entire disk” and click OK. A 
window appears for you to select the source 
from which to restore backed-up files.

In the top part of the window, select the backup 
set that has your most recent backup of the 
backup computer’s hard disk. In the bottom por-
tion, select the most recent Snapshot of that 
hard disk. Click OK to proceed. A window ap-
pears for you to select the destination to which 
to restore files.

Because your whole hard disk was wiped out 
and needs to be completely restored, select it 
and leave the pop-up menu set to “Restore En-
tire Disk.”

NOTE: If the backup from which you are 
restoring is not a full backup of the hard disk 
you are restoring, choose “Restore 
Corresponding Files” from the pop-up menu 
instead. For example, you may have been 
backing up “Documents only” to an Internet 
backup set because of limited FTP space and 
limited connection speed.

WARNING: Before restoring to a volume other 
than the current system volume under 
Mac OS X, use the Finder’s Get Info command 
on the volume. Choose Ownership & 
Permissions from the info window’s menu then 
turn off the “Ignore ownership on this volume” 
option.
Click OK to proceed. Confirm the operation by 
clicking Replace (for “Restore Entire Disk” 
only). Retrospect compares the source and des-
tination and displays the restore summary 
window.

Put the first disc, tape, or disk from the backup 
set in your backup device and click Restore.

7. Restart
Restart the computer. Your computer is now 
ready to use.

NOTE: If you restored from a partial backup, 
your restored hard disk will reflect this. For 
example, if you restored from a “Documents 
only” backup, you will have to reinstall your 
applications manually.
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RESTORING A MAC OS CLIENT
The following instructions tell how to restore an 
entire volume on a Mac OS client over the 
network.

You must first get the client computer operating 
with the network before performing the actual 
restore operation from the backup computer.

The steps below, which should be taken only in 
the event of serious trouble, involve completely 
replacing the contents of a client computer’s 
hard drive with a previous backup in which you 
backed up “all files.”

NOTE: The steps below are not for a Macintosh 
that serves data via file sharing. To restore a 
server, see “Restoring a Mac OS Server Client” 
on page 125.

1. Restart and Try to Repair the Disk
Insert the Mac OS 9 or Mac OS X CD into the 
Macintosh client computer’s CD/DVD drive 
and restart the computer. Press and hold the “C” 
key during startup to force the computer to boot 
from the CD. Under Mac OS 9, open the Disk 
First Aid utility application from the CD. Under 
Mac OS X, choose Open Disk Utility from the 
Installer menu then click the First Aid tab. Use 
Disk First Aid to examine the hard disk for 
problems and repair them, if possible. (You 
should also try other disk repair utilities if you 
have them.) Use the low-level verification or 
test function of the Drive Setup utility or your 
disk formatter to examine the hard disk for de-
fects that other utilities will not find.

2. Assess the Current State of the Hard 
Disk
If you are able to repair all damage and no low-
level problems are found, stop here! You do not 
need to restore or reformat your hard disk.

If you could not make any repairs with the disk 
utilities, or if the hard disk still does not mount 

on the Desktop, you probably need to reformat 
your hard disk. Go on to step 4.

If you were able to repair some damage, but 
problems remain with the hard disk, you may 
need to reformat it. But first you must safeguard 
your data as described below in step 3.

3. Make New Backups Before Reformatting
Now is a good time to back up the repaired hard 
disk. You may want to make two new backups 
(with the verification option on) to new backup 
sets. (Do not do a recycle backup to an existing 
backup set, as the damaged drive might not 
have all of your files on it and you don’t want to 
erase your previous backups.)

4. Reformat the Disk
If the disk repair utilities could not fix the disk, 
you may have to erase or reformat the disk in or-
der to prepare it for restoration.

WARNING: Erasing or formatting a hard disk 
destroys all data stored on the disk. If you are 
not sure whether you should erase or format 
your hard disk, contact its vendor for assistance.
If the disk is beyond repair under Mac OS 9, use 
the Finder to select the damaged volume and 
choose Erase Disk from the Special menu. If the 
disk is beyond repair under Mac OS X, use Disk 
Utility to select the damaged volume, click the 
Erase tab, choose a format, supply a name, and 
click Erase. If erasing is unsuccessful from the 
Mac OS 9 Finder, you need to reformat the 
disk. To do this, start the Drive Setup applica-
tion from the Disk Tools disk or CD, or the 
formatting software that came with the hard 
disk, and use it to format the hard disk.

5. Install System Software
Install new Mac OS system software on the 
newly-formatted hard disk. Restart the Macin-
tosh from the Mac OS 9 or Mac OS X CD, 
pressing and holding the “C” key during startup 
to force the computer to boot from the CD.
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Install new Mac OS system software on the 
newly-formatted hard disk. You must install the 
same exact version number of Mac OS X as the 
version of Mac OS X you will restore. For ex-
ample, if the backed up client was running 
version 10.2.4, you must install Mac OS X 
10.2.4.

Eject any CDs and restart from the new system 
on the hard disk. Use the Date & Time control 
panel or system preference to set your local time 
and time zone, and, if necessary, change the 
Daylight Saving setting. Under Mac OS 9, re-
name the System Folder to “temp.”

6. Configure TCP/IP
Make sure the client computer is properly set up 
for use with TCP/IP networking. (If you need 
help configuring TCP/IP see your network 
administrator.)

7. Install Temporary Client Control Panel
Install Retrospect Client software according to 
the instructions in “Installing Retrospect Client 
Software on Macintosh Computers” on 
page 93. Remember the password.

Restart the client computer. After restarting, 
when the computer starts up it automatically 
loads the client software. Log this client into 
Retrospect from the backup computer as de-
scribed in “Adding Clients” on page 95.

8. Prepare the Client Macintosh for 
Restore
Open the Retrospect client control panel (under 
Mac OS 9) or Retrospect Client application 
(Mac OS X) and verify the client software is 
turned on and is waiting for first access.

For ideal restoring conditions under Mac OS 9, 
shut down the client Macintosh so the 
Retrospect client shutdown dialog appears.

Leave the client Macintosh with this dialog; do 
not shut down or restart.

Before restoring to a volume other than the cur-
rent system volume under Mac OS X, use the 
Finder’s Get Info command on the volume. 
Choose Ownership & Permissions from the info 
window’s menu then turn off the “Ignore own-
ership on this volume” option.

For ideal restoring conditions under Mac OS X, 
log out so the login window appears. Leave the 
client Macintosh at this window; do not log in, 
shut down, or restart.

9. Restore Files
Now that the hard disk is working again, you 
can restore the client from the backup computer. 
From Retrospect’s Immediate tab, click 
Restore.

Select “Restore an entire disk” and click OK. A 
window appears for you to select the source 
from which to restore backed-up files.
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In the top part of the window, select the backup 
set that has your most recent backup of the cli-
ent hard disk. In the bottom portion, select the 
most recent Snapshot of that hard disk. Click 
OK to proceed. A window appears for you to se-
lect the destination to which to restore files.

Because the whole client hard disk was wiped 
out and needs to be completely restored, select 
it and leave the pop-up menu set to “Restore En-
tire Disk.”

Click OK to proceed and confirm when 
Retrospect asks whether to replace the entire 
contents. Retrospect compares the source and 
destination and displays the restore summary 
window.

Put the first disc, tape, or disk from the backup 
set in your backup device and click Restore.

10. Restart, Rebuild, and Discard
When the restore is completed, for Mac OS X 
clients, restart the client computer. For 
Mac OS 9 clients, restart the client computer 
and rebuild its desktop by pressing and holding 
both the Command and Option keys while the 
computer starts (until the Macintosh asks you to 
confirm rebuilding the desktop). After it starts 
and rebuilds the desktop, place the “temp” Sys-
tem Folder in the Trash and empty the Trash.

Your computer is now ready to use.

RESTORING A MAC OS SERVER 
CLIENT
This section describes how to use Retrospect to 
restore volumes shared by Mac OS file sharing. 
These operations require special procedures to en-
sure access privileges are intact after the volume is 
restored.

Server access privileges are restored only if file 
sharing was active when the backup was made 
and if file sharing is active during the restore 
operation.

If your server is undamaged and you need to re-
store only some of the files and folders from a 
backup (for instance, because somebody acci-
dentally deleted some folders from the server), 
just follow one of the sets of instructions in “Re-
store” on page 51.
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If you need to restore an entire server, use the 
following procedure. 

1. Restart and Try to Repair the Disk
Find your Mac OS X Server or Mac OS 9 CD-
ROM, restart your Macintosh, and put in the 
CD/DVD drive. Press and hold the “C” key dur-
ing startup to force the computer to boot from 
the CD-ROM. Under Mac OS X, choose Open 
Disk Utility from the Installer menu then click 
the First Aid tab. Under Mac OS 9, open the 
Disk First Aid utility from the CD. Use Disk 
First Aid to examine your hard disk for prob-
lems and repair them, if possible. (You should 
also try other disk repair utilities if you have 
them.) Use the low-level verification or test 
function of the Drive Setup utility or your disk 
formatter to examine the hard disk for defects 
that other utilities will not find.

2. Assess the Current State of the Hard 
Disk
If you were able to repair all damage and no 
low-level problems are found, stop here! You 
do not need to restore or reformat your hard 
disk.

If you could not make any repairs with the disk 
utilities, or if the hard disk still does not mount 
on the Desktop, you probably need to reformat 
your hard disk. Go on to step 4.

If you were able to repair some damage, but 
problems remain with the hard disk, you may 
need to reformat it. But first you must safeguard 
your data as described below in step 3.

3. Make New Backups Before Reformatting
Now is a good time to back up the repaired hard 
disk. You may want to make two new backups 
(with the verification option on) to new backup 
sets. (Do not do a recycle backup to an existing 
backup set, as the damaged drive might not 
have all of your files on it and you don’t want to 
erase your previous backups.) Once you are 
sure you have redundant backups of your data, 

copy your backup set catalogs to a floppy disk, 
removable disk, or another server.

4. Reformat the Disk
If the disk repair utility cannot fix the disk, you 
may have to erase or reformat the disk in order 
to prepare it for restoration.

WARNING: Erasing or formatting a hard disk 
destroys all data stored on the disk. If you are 
not sure whether you should erase or format 
your hard disk, contact its vendor for assistance.
If the disk is beyond repair under Mac OS X, 
use Disk Utility to select the damaged volume, 
click the Erase tab, choose a format, supply a 
name, and click Erase. If the disk is beyond re-
pair under Mac OS 9, use the Finder to select the 
damaged volume and choose Erase Disk from 
the Special menu.

If erasing is unsuccessful from the Mac OS 9 
Finder, you need to reformat the disk. To do 
this, start the Drive Setup application from the 
Disk Tools disk or CD, or use the formatting 
software that came with your hard disk.

5. Install System Software
Restart the Macintosh from the Mac OS X 
Server CD-ROM, pressing and holding the “C” 
key during startup to force the computer to boot 
from the CD.

Install new Mac OS system software on the 
newly-formatted hard disk. You must install the 
same exact version number of Mac OS X as the 
version of Mac OS X you will restore. For ex-
ample, if the backed up server was running 
version 10.2.4, you must install Mac OS X 
10.2.4.

Eject any CDs and restart from the new system 
on the hard disk. Use the Date & Time control 
panel or system preference to set your local time 
and time zone, and, if necessary, change the 
Daylight Saving setting. Under Mac OS 9, 
rename the System Folder to “temp”.
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6. Configure TCP/IP
Make sure the computer is properly set up for 
use with TCP/IP networking. (If you need help 
configuring TCP/IP see your network 
administrator.)

7. Install Temporary Client Control Panel
Install Retrospect client software on the Macin-
tosh and restart it. Log this client into 
Retrospect and name it Temp Client.

8. Prepare the Client Macintosh for 
Restore
Open the Retrospect Client application 
(Mac OS X) or Retrospect Client control panel 
(Mac OS 9) and verify the client software is 
turned on and is waiting for first access. For ide-
al restoring conditions under OS 9, shut down 
the client Macintosh so the Retrospect client 
shutdown dialog appears.

Leave the client with this dialog; do not shut 
down or restart.

Before restoring to a volume other than the cur-
rent system volume under OS X, use the 
Finder’s Get Info command on the volume. 
Choose Ownership & Permissions from the info 
window’s menu then turn off the “Ignore own-
ership on this volume” option.

For ideal restoring conditions under OS X, log 
out so the login window appears. Leave the cli-
ent Macintosh at this window; do not log in, 
shut down, or restart.

9. First Restore for Files
Now that the hard disk is working again, you 
can restore the server from the backup comput-
er. From the Immediate tab, click Restore. 

Select “Restore an entire disk” and click OK. A 
window appears for you to select the source 
from which to restore backed-up files.

In the top part of the window, select the backup 
set that has your most recent backup of the serv-
er hard disk. In the bottom portion, select the 
most recent Snapshot of that hard disk. Click 
OK to proceed. A window appears for you to se-
lect the destination to which to restore files.

Because the entire server hard disk was wiped 
out and needs to be completely restored, select 
it and leave the pop-up menu set to “Restore En-
tire Disk.” 
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Click OK to proceed and confirm when 
Retrospect asks whether to replace the entire 
contents. Retrospect compares the source and 
destination and displays the restore summary 
window.

Put the first disc, tape, or disk from the backup 
set in your backup device and click Restore.

For OS 9, restart the computer, then put the 
“temp” System Folder in the Trash can and 
empty the trash.

Forget the Temp Client and log in the original 
client. 

10. Second Restore for Privileges
If you are using Mac OS file sharing, start file 
sharing. Choose the volumes or folders you 
wish to share, then select the appropriate Owner 
and Group for root access privileges and set 
your desired options.

With sharing on, perform another restore oper-
ation with the same Backup Set, again using the 
“Restore an entire disk” method. Retrospect 
performs a “smart” restore, copying only a few 
files (or none if no files have changed), and then 
sets the access privileges. Retrospect may re-
port sharing violation errors but they are not 
significant and you should ignore them.

Restart the server, and rebuild the Desktop by 
holding down the Command and Option keys 
until a confirming dialog appears.

11. Extra steps for Mac OS X 10.1.x
After restarting the computer, share points may 
be missing or replaced with improper share 
points. Using Server Admin, take the following 
steps to correct these problems:

• Remove invalid share points.
• Re-establish desired share points.
• Reset the Home Directory Defaults for any 

affected users and groups lists (or NetInfo 
domains).

NOTE: These extra steps are not required for 
Mac OS X Server 10.2 and later.

RESTORING A WINDOWS CLIENT
The following instructions tell how to restore an 
entire volume on a Windows client over the 
network.

You must first get the client computer operating 
with the network before performing the actual 
restore operation from the backup computer.

The steps below, which should be taken only in 
the event of serious trouble, involve completely 
replacing the contents of a client computer’s 
hard drive with a previous backup in which you 
backed up “all files.”

Follow these steps to restore a Windows client:

1. Restart and Try to Repair the Disk
Find the system CD or the emergency recovery 
disk included with your Windows client com-
puter. Restart your computer, and put in the disk 
or CD. When your computer has started from 
this disk or CD, run ScanDisk to examine your 
hard disk for problems. (You should also try 
other disk repair utilities if you have them.)

2. Assess the Current State of the Hard 
Disk
If you were able to repair all damage and no 
low-level problems are found, stop here! You 
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do not need to restore or reformat your hard 
disk.

If you could not make any repairs with the disk 
utilities, or if the hard disk still is not accessible 
from Windows Explorer, you probably need to 
reformat your hard disk. Go on to step 3.

3. Reformat the Disk
If the disk repair utility cannot fix the disk, you 
may have to erase or reformat the disk in order 
to prepare it for restoration.

WARNING: Erasing or formatting a hard disk 
destroys all data stored on the disk. If you are 
not sure whether you should erase or format 
your hard disk, contact its vendor for assistance.

4. Re-install System Software
Windows 95/98/Me/NT Install the new operat-
ing system software on the repaired or newly-
formatted hard disk in a folder named 
WINTEMP.

Windows 2000/XP Install the new operating 
system software on the repaired or newly-for-
matted hard disk. After the installer copies 
temporary files and restarts from the hard disk, 
boot from the system CD again. Follow the in-
stallation steps until the installer cautions you 
that a WINNT folder already exists. Choose to 
install to a different folder, named WINTEMP, 
then finish the installation. Assign a unique 
identifying computer name; do not use the same 
computer name as the client you are restoring.

5. Configure TCP/IP
Make sure the computer is properly set up for 
use with TCP/IP networking. (If you need help 
configuring TCP/IP see your network 
administrator.)

6. Install Client Software
Install the client software as instructed under 
“Installing Retrospect Client Software on Win-
dows Computers” on page 93, but do not use the 

default path. Instead, install to the newly-creat-
ed WINTEMP folder.

7. Prepare Client Database
From the backup computer, log in the new cli-
ent using a temporary name.

8. Restore Files
Restore the client from the backup computer. 
From Retrospect’s Immediate tab, click 
Restore.

Select “Restore an entire disk” and click OK. A 
window appears for you to select the source 
from which to restore backed-up files.

In the top part of the window, select the backup 
set that has the most recent backup of the hard 
disk you have recently repaired. In the bottom 
portion, select the most recent Snapshot of that 
hard disk. Click OK to proceed. 

A window appears for you to select the destina-
tion to which to restore files. Select the 
Windows client’s hard disk and set the pop-up 
menu to Replace Corresponding Files.
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WARNING: Do not use Restore Entire Disk.

Click OK to proceed. Retrospect compares the 
source and destination and displays the restore 
summary window. Verify your choices for the 
Source, Destination, Files Chosen, and Options.

Put the first disc, tape, or disk from the backup 
set in your backup device and click Restore.

WARNING: After restoring the files, do not 
restart Windows NT/2000/XP clients before 
restoring the registry information, as described 
below.

9. Restore NT/2000/XP Registry
From the client computer, restore the 
Windows NT/2000/XP registry with the Regis-
try Backup Manager (page 109). Start the 
Registry Backup Manager and click its Replace 
tab. 

Click the top Browse button and specify the 
source folder, which you just restored. Click the 
bottom Browse button to change the destination 
folder; specify the restored Windows system 
folder. Click Replace Now to replace the current 
registry with the backup.

NOTE: The Windows 95/98/Me registry is 
restored by Retrospect when you restore all 
files, so you do not need to use the Registry 
Backup Manager.

10. Restart and Clean Up
Restart the client computer. Delete the tempo-
rary folder WINTEMP. Forget the temporary 
client from Retrospect’s client database.

RESTORING A LINUX CLIENT
The following instructions describe how to re-
store an entire volume on a Linux client over the 
network.

You must first get the client computer operating 
with the network before performing the actual 
restore operation from the backup computer.

The steps below, which should be taken only in 
the event of serious trouble, involve completely 
replacing the contents of a client computer’s 
hard drive with a previous backup in which you 
backed up “all files.”

1. Restart and Try to Repair the Disk
If you have a boot disk for your system, restart 
the client computer, and put in the disk. When 
the computer has started from this disk, follow 
the instructions to repair your disk.

Alternatively, you can boot the system and run 
a file system check (fsck or equivalent). If this 
does not result in a bootable system, you have 
two options, depending on your expertise with 
the operating system. For the experienced ad-
ministrator, boot to single-user mode from your 
OS installation media and repair the boot sector, 
replace the kernal, etc. If you have less experi-
ence, or do not feel comfortable with the above 
steps, you should re-install the OS, after replac-
ing the hard disk (if necessary).
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2. Assess the Current State of the Hard 
Disk
If you were able to repair all damage and no 
low-level problems are found, stop here! You 
do not need to restore or reformat the hard disk.

If you could not make any repairs with the boot 
disk, or if the hard disk still is not accessible, 
you probably need to reformat the hard disk. Go 
on to step 4.

If you were able to repair some damage, but 
problems remain with the hard disk, you may 
need to reformat it. But first you must safeguard 
your data as described below in step 3.

3. Make New Backups Before Reformatting
Now is a good time to back up the repaired hard 
disk. You may want to make two new backups 
(with the verification option on) to new backup 
sets. (Do not do a recycle backup to an existing 
backup set, since the damaged drive might not 
have all files on it and you do not want to erase 
previous backups.) Once you are sure you have 
redundant backups of your data, copy your 
backup set catalogs to a removable disk or 
server.

4. Reformat the Disk
If the boot disk cannot fix the hard disk, you 
may have to erase or reformat the hard disk in 
order to prepare it for restoration.

WARNING: Erasing or formatting a hard disk 
destroys all data stored on the disk. If you are 
not sure whether you should erase or format 
your hard disk, contact its vendor for assistance.

5. Re-install Software
Install Linux operating system software on the 
newly-formatted hard disk, making sure to cre-
ate the same mount points as the original 
system. Restart from this volume.

6. Install Client Software
Install the client software as described in “In-
stalling Retrospect Client Software on Linux 
Computers” on page 94.

7. Prepare Client Database
From the backup computer, forget the old client 
and log in the new client.

8. Restore Files
Restore the client from the backup computer. 
From Retrospect’s Immediate tab, click 
Restore.

Select “Restore an entire disk” and click OK. A 
window appears for you to select the source 
from which to restore backed-up files.

In the top part of the window, select the backup 
set that has your most recent backup of the hard 
disk you have recently repaired. In the bottom 
portion, select the most recent Snapshot of that 
hard disk. Click OK to proceed. A window ap-
pears for you to select the destination to which 
to restore files. Select the Linux client’s hard 
disk and set the pop-up menu to Replace Corre-
sponding Files.
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WARNING: Do not use Restore Entire Disk.

Click OK to proceed. Click Replace to confirm 
the operation. Retrospect matches files from the 
Snapshot then scans the destination and dis-
plays the restore summary window. Verify your 
choices for the Source, Destination, Files Cho-
sen, and Options.

Put the first medium from the backup set in your 
backup device and click Restore.

9. Clean Up
Restart the client computer. 
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C H A P T E R    8
M A N A G E M E N T

• B A C K U P  S T R A T E G I E S

• L O G S  A N D  R E P O R T S

• E X E C U T I O N  O P T I O N S

• C O N T R O L L I N G  E X E C U T I O N S

• M A N A G I N G  B A C K U P  S E T S

• M A I N T A I N I N G  S C R I P T S

• R E T R O S P E C T  P R E F E R E N C E S

• M O V I N G  R E T R O S P E C T

• C A T A L O G  A N D  C O N F I G U R A T I O N  B A C K U P S

• W O R K I N G  W I T H  M A C I N T O S H  F I L E  S E R V E R S

• W O R K I N G  W I T H  O T H E R  S O F T W A R E

This chapter describes how to perform various tasks, such as managing backup sets, 
viewing reports, and maintaining scripts. It also offers advice on using Retrospect and 
describes techniques for more effective backups, including tips on using Retrospect with 
other software.
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BACKUP STRATEGIES
This section suggests several strategies for 
backing up your backup computer or your entire 
network. Review each strategy and decide 
which will work best for your situation. Perhaps 
you will need to slightly modify a strategy to 
better fit your needs. Perhaps you will devise 
your own strategy which bears no relation to 
these suggestions. Realize these are but a few 
suggested strategies, and Retrospect’s features 
allow an unlimited number of different strate-
gies. Just remember the basic backup rules 
when you go about creating a backup strategy of 
your own.

The different backup actions available with 
Retrospect are integral to developing successful 
strategies. They are described in “Backup Ac-
tions” on page 23.

Basic Backup Rules
While Retrospect is a powerful tool for safe-
guarding your data, it is most effective when 
you follow some basic backup rules:

• Back up often because you cannot restore 
what is not backed up. For example, if your 
hard disk malfunctions today but you most 
recently backed it up a week ago, you have 
lost the data you have accumulated over the 
week. Retrospect is most effective when you 
back up everything and back up often, which 
you can ensure by setting up scripts to 
automate backups.

• Keep multiple backups of your data. Rotate 
among different backup sets. Using more 
backup sets makes you less likely to lose 
data if you misplace or damage media.

• Retire old media on a regular schedule. 
Regularly introduce new media using new 
media backups, because having all of your 
backups on one media set leaves you too 
vulnerable. A benefit of new media in your 
backup strategy is that it is faster to restore 
from a few media members than to restore 

from a set that has many members and 
backup sessions.

• Always store at least one backup set off-site 
to guard against fire, theft, and natural 
disaster.

• Back up the backup computer. You probably 
have put more time and energy than you 
realize into your Retrospect configuration 
and catalogs.

• Take care of your backup media, which can 
easily be damaged by the environment. 
Media can also wear out. See “Media 
Longevity and Storage” on page 43 for 
further information.

• Leave the Verification option on so 
Retrospect can confirm the backup data 
matches the original data.

• Periodically verify your backups are 
working properly. Retrospect provides 
options and tools that allow you to compare 
data and verify media to ensure valid 
backups. It also creates logs and reports that 
detail backup successes and failures.

Individual Backup Strategies
The four following strategies are useful for 
backing up a single computer. If you need to 
back up more than one computer, see “Network 
Backup Strategies”.

Individual Strategy 1—Run Documents
Create a backup script and make one recycle 
backup run document and one normal backup 
run document. Information on how to make a 
run document appears in “Manual Script Execu-
tion,” which starts on page 78.

Execute the normal backup run document daily 
or whenever you please, and every few weeks 
execute the recycle backup run document to 
keep your backup sets from becoming large and 
cumbersome.

To introduce new media for rotation with other 
sets or off-site storage, periodically configure 
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the backup set to use new media, as described in 
“The Options Tab” on page 154.

Individual Strategy 2—Scheduled Script
Create a backup script and schedule it to run au-
tomatically. Add one day of week scheduler 
doing normal backups Monday through Thurs-
day and another doing a recycle backup every 
Friday. 

The two schedulers look like this:

To introduce new media for rotation with other 
sets or off-site storage, periodically configure 
the backup set to use new media, as described in 
“The Options Tab” on page 154.

Individual Strategy 3—EasyScript
Use Retrospect’s EasyScript Wizard, to set up a 
strategy. EasyScript has different strategies op-
timized for the type of backup set you choose. 
Its removable disk strategy tends to conserve 

media, compared to its strategies for tapes and 
discs. Its Internet strategy is biased toward con-
serving space on the FTP server.

See “Using the EasyScript Wizard” on page 64.

Individual Strategy 4—EasyScript Local 
and Off-site
Use Retrospect’s EasyScript Wizard to create 
two scripts. Create the first script, then rename 
it “Local Backups.” Use EasyScript again, this 
time for an Internet backup set. Rename the cre-
ated script “Off-site Backups.” Together these 
two scripts give you far more protection than ei-
ther one alone.

See “Duplicating, Renaming, or Deleting a 
Script” on page 156 for information on renam-
ing scripts.

Network Backup Strategies
When you need to back up a network of client 
computers, you must decide which kind of 
backup scripts to use. The table below lists situ-
ations which are suited to Backup Server scripts 
or regular backup scripts.

day of week schedulers

 Situations Suiting Backup Server Scripts Situations Suiting Regular Backup Scripts

You have a backup computer dedicated solely to that 
purpose.

Your backup computer has other duties at other 
times.

You have too many clients with too much data to be 
entirely backed up in a single night.

Your scheduled backups are completed before the 
client computers are used in the mornings.

You find yourself trying to catch up with your back-
ups, making special scripts and immediate backups 
for certain clients that are not completely backed up 
by your regular backup script.

Your scheduled backups are completed before the 
client computers are used in the mornings and 
unsuccessful backups are rare.

You have mobile clients and portable drive volumes 
that appear on the network at random times.

Your network includes only desktop computers, no 
removable disks or notebook computers.

You want Retrospect to back up to whatever media is 
in the backup device.

You always insert the correct media beforehand for 
unattended backups.
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If you choose to use a strategy that includes 
Backup Server, skip ahead to Network Strategy 
5 on page 137.

Network Strategy 1—EasyScript
Use Retrospect’s EasyScript Wizard set up a 
strategy based on your needs. With the Easy-
Script Wizard, you can specify that you want to 
back up computers on the network.

See “Using the EasyScript Wizard” on page 64.

Network Strategy 2—Scheduled Script
Create a backup script. Set the destination to use 
three backup sets. Add a day of week scheduler 
to run the script daily to a particular backup set, 
every three weeks. Add a similar scheduler to 
run the script daily to the second backup set, ev-
ery three weeks starting one week after the first 
scheduler. Add a similar scheduler to run the 
script daily to the third backup set, every three 
weeks starting one week after the second 
scheduler. 

The three schedulers look like this:

This strategy does not include scheduled recy-
cle and new media backup actions, so you 
should manually configure the backup sets for 
recycle and new media backups at appropriate 
times. See “The Options Tab” on page 154.

Network Strategy 3—Scheduled Script 
with Recycle and New Media Rotation
Create a backup script. Set the script destination 
to use three backup sets. Add a day of week 
scheduler to run a normal backup Monday 
through Thursday to the first backup set, every 
three weeks. Add a day of week scheduler to do 
a recycle backup to the first backup set on Fri-
day, every three weeks. Add similar schedulers 

for the second and third backup sets, but set 
their starting dates one and two weeks later, re-
spectively. Finally, add a repeating interval 
scheduler to do a new media backup to one of 
the backup sets every six weeks. (After a new 
media backup take the old backup set media off 
site for safe keeping.) 

The schedulers look like this:

Network Strategy 4—Scheduled Script 
with Rotating Daily Backup Sets
Make a script with five backup set destinations, 
named Monday through Friday. Add five day of 
week schedulers to back up to each respective 
backup set. Add five repeating interval schedul-
ers to stagger recycle backups every four weeks 
to each respective backup set, starting with 
Monday the first week, Tuesday the second 
week, and so on. But for Friday, make the re-
peating interval the last Friday of the month, 
doing a new media backup to the Friday backup 
set. (Take the old backup set media off site for 
safe keeping.) 

day of week schedulers

day of week scheduler
day of week (or repeating interval) scheduler

repeating interval scheduler
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The schedulers look like this:

NOTE: When you schedule the new media 
backup, make sure it occurs at the same time as 
the scheduled Friday normal backups. When 
Retrospect encounters the new media backup 
scheduled for the same execution time as the 
normal backup, it executes only the new media 
backup. If you were to schedule them at 
different times, both backups would execute.

Network Strategy 5—Basic Backup Server
Create a Backup Server script backing up all cli-
ent sources. Schedule it to work from 7:00 P.M. 
to 7:00 A.M. during the work week, so as not to 
interfere with the users during their workdays, 
and all the time during weekends. Set the back-
up interval so Retrospect backs up every twelve 
hours.

Network Strategy 6—Basic Backup Server 
Including Mobile Computers
Duplicate the basic Backup Server script de-
scribed in Network Strategy 5. Make mobile 
clients its only sources. Remove these volumes 
from the original script. Schedule the new script 
to run twenty-four hours a day, with a backup 
interval of eighteen hours.

TIP: If you implement a strategy that includes 
Backup Server, read “Backup Server Tips and 

Techniques” on page 82. It includes 
information to help you devise a more effective 
strategy.

Network Strategy 7—On-Demand Backup 
Server
Create a Backup Server script backing up all cli-
ent sources. Leave the schedule always active 
so it works twenty-four hours a day. Set the 
backup interval option so Retrospect backs up 
every ninety-nine days. Leave on the script op-
tion to allow early backup. Except for the initial 
backups when this strategy is first implemented, 
and every ninety-nine days thereafter, clients 
are not backed up unless they request it from 
their control panels. This strategy requires that 
you clearly communicate the responsibility to 
the users and, ideally, is supplemented with a 
regular backup script.

LOGS AND REPORTS
Retrospect’s reporting abilities let you monitor 
backup execution history and error messages by 
viewing logs and reports. You may need to ex-
amine these to find out why an operation was 
unsuccessful in order to diagnose problems.

• The Backup Report shows a detailed 
account of backup operations for each local 
and networked volume.

• The Operations Log shows a record of each 
Retrospect operation, transaction, and event, 
and any errors that occurred.

• The Contents Report shows the files that 
were actually backed up in a specific backup 
session.

To view any of these reports, first click the 
Reports tab in the Retrospect Directory.

Viewing the Backup Report
Click the Report button from the Reports tab to 
view the Backup Report. An example of a 
Backup Report is shown below.

repeating interval scheduler

day of week scheduler
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Unlike the Operations Log, to which Retrospect 
repeatedly appends new information, the 
Backup Report is completely updated each time 
a backup is performed. It allows you, as the 
backup administrator, to see, on a volume-by-
volume basis, any problems with recent 
backups.

Understanding the Backup Report
The Backup Report can be viewed in two for-
mats: Standard Format and Performance Data 
Format. See “Customizing the Backup Report” 
which follows, for information on how to 
switch between formats.

Both formats include the following 
information:

User/Volume is the source volume name. Cli-
ent computer names are also listed.

Backup Set (Script) lists the names of the des-
tination backup set and the script of the most 
recent successful backup. 

NOTE: If you performed an immediate 
operation, such as an immediate backup, the 
script name reflects this, e.g., “Immediate 
Backup”.

A Standard Format Backup Report contains the 
following information, in addition to User/Vol-
ume and Backup Set (Script):

Elapsed Days is the number of days since the 
backup.

Errors indicates any errors that occurred for 
each backup. (Use the Find in Log button to lo-
cate an error in the Operations Log.)

Date is the date of the most recent backup of the 
volume.

A Performance Data Format Backup Report 
contains the following information, in addition 
to User/Volume and Backup Set (Script):

Duration shows the time duration of the back-
up, in hours and minutes. Large numbers may 
indicate sources with heavy backup needs.

MB is the amount of data, in megabytes, backed 
up from the volume.

MB/min is the speed, measured in megabytes 
per minute, of the source’s backup. Abnormally 
slow performance may indicate problems with 
the network, backup device, or other hardware.

No errors means the 
backup was a 
complete success

Lack of report 
events indicates the 
volume has never 
been backed up

“>” indicates the 
volume was not 
successfully backed 
up
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Customizing the Backup Report
You can use the View Options dialog to display 
the Backup Report in Standard Format or Per-
formance Data Format, specify the event types 
or event dates to include in the report, and vari-
ous other options. Choose View Options from 
the Report menu to bring up a dialog in which 
you can make changes.

Use the options to customize the Backup 
Report.

Working with the Backup Report
The Backup Report is a database of backup 
events. Each time Retrospect completes a back-
up it adds a new backup event to its database. 
For each combination of source, destination and 
script, it saves all unsuccessful backup attempts 
and the latest successful backup.

When you forget a script, source, or backup set, 
Retrospect removes that item’s backup events 
from the Backup Report database.

Forgetting Events
To remove events from the Backup Report, 
choose Forget Events from the Report menu. 
This brings up a dialog with which you can re-
move the following execution events from the 
report:

• All but the most recent successful backup
• All successful backups
• All unsuccessful attempts
• Events older than one week

• All execution events
• All Backup Server events

NOTE: The only one of these options that 
affects Backup Server events is “All Backup 
Server events.” 
You can also select any single event listed in the 
report and forget it by choosing Clear from the 
Edit menu or by pressing the Delete key. If you 
forget an event, that information is removed 
from the report. This may cause a volume to ap-
pear as if it was never backed up.

WARNING: Backup Server relies upon the 
Backup Report to determine when a volume 
was most recently backed up. If you delete an 
event from the Backup Report and the 
associated volume is a source in an active 
Backup Server script, Backup Server assigns a 
higher priority to that volume and will attempt 
to back it up sooner.

Finding Events in the Operations Log
Select a line from the Backup Report and click 
Find in Log to open the Operations Log with the 
corresponding action selected.

Editing an Event Script
Select a line from the Backup Report and click 
Edit Script to open the script summary window 
for the script which executed and created the 
event.

NOTE: If you backed up a volume using an 
immediate operation, the Backup Report 
indicates that in the Backup Set (Script) column 
(e.g. “Immediate Backup”).

Printing or Exporting the Backup Report
To print the Backup Report, view it then choose 
Print from the File menu. If you have only a por-
tion of the report selected, only that portion will 
print. If you have nothing selected, the entire re-
port will print. To export the Backup Report to 
a text file, view it then choose Export from the 
File menu. 



140 RETROSPECT USER’S GUIDE

TIP: You can set a preference option, described 
on page 158, to have Retrospect automatically 
export the Backup Report.

Viewing the Operations Log
Retrospect’s Operations Log lets you monitor 
backup execution history and error messages. 
The log stores any messages that are generated 
during an operation. You may need to examine 
the log to find out why an operation was unsuc-
cessful in order to diagnose problems.

To view the Operations Log click the Log but-
ton or choose Log from the Window menu.

The example below shows how information ap-
pears in the Operations Log.

The log shows the following information for 
each successful operation.

Completed indicates the number and size of the 
files that were copied. If you used Retrospect’s 
data compression feature, the log also shows 
compression achieved for this session.

Performance indicates the number of mega-
bytes of information copied per minute. If the 

Verification option is turned on, additional per-
formance figures are listed for comparing.

Duration shows the total time required to com-
plete the operation. If you clicked Pause during 
the operation or there were delays while you in-
serted media, the waiting time is shown 
separately. The waiting figure includes time 
spent during tape drive locate functions and oth-
er required functions.

Finding Items in the Log
Retrospect has commands for finding items in 
the Operations Log. When the Operations Log 
window is active, Retrospect adds a Log menu 
to the menu bar.

Find Choose Find from the Log menu, which 
brings up a dialog. Enter the text you want to 
search for, then click OK. Retrospect searches 
for the text, top down from the current selection. 
When the specified text is not found, Retrospect 
beeps. When the text is found, Retrospect se-
lects the entire line in which the text appears.

Find Again After you have used the Find or 
Find Backwards command, this command con-
tinues the search from the current selection 

Log size

+execution began

–operation began on this 
volume

*client logged in

>error occurred

∆ Retrospect started
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forward, or down. Upon reaching the end of the 
log, it continues searching from the beginning.

Find Backwards This command works like the 
Find command, except it searches bottom-up 
instead of top-down.

Find Again Backwards After you have used 
the Find or Find Backwards command, this 
command continues the search from the current 
selection backward, or up. Upon reaching the 
log’s beginning, it continues searching back-
ward from the end.

Clearing the Log
To delete the contents of the Operations Log, 
view it then choose Clear from the Edit menu. 
Click OK to confirm the operation.

NOTE: You do not have to manually clear the 
log, because Retrospect removes old log entries 
when the log fills to its capacity, determined by 
the log size limit preference (page 158).

Printing the Log
To print the Operations Log, view it then 
choose Print from the File menu. If you have 
only a portion of the log selected, only that por-
tion will print. If nothing is selected, the entire 
log will print.

Viewing Backup Set Contents
Retrospect can report which files were copied to 
a backup set during a specific backup or archive 
session.

To view the contents of a backup set, first click 
the Reports tab from the Retrospect Directory, 
then click Contents.

In the upper list box, select the backup set you 
want information about. (Click More to access 
more backup sets.) After you select a backup set 
the lower list box displays the backup sessions 
contained within the selected backup set. In the 
lower list box, select the backup session or ses-
sions you want to review.

At this point, you can choose Export from the 
File menu to export the list to a text file, or click 
Browse. When you do the latter, a browser win-
dow appears listing the files and folders that 
were backed up during the session or sessions 
you selected.

You can print the file list, export it to a text file, 
search for specific files, get information about a 
specific file, or change the view format in the 
browser window. You can view browser win-
dows for multiple sessions at the same time by 
performing the same steps and selecting multi-
ple sessions. When exporting, Retrospect 
exports the fields in the following order, regard-
less of the view format: file name, size, create 
date, create time, modify date, modify time, 



142 RETROSPECT USER’S GUIDE

backup date, backup time, type, creator, backup 
set (if any), and path. 

For information about using the browser win-
dow and menus, see “Browsing” on page 172.

EXECUTION OPTIONS
Retrospect has many options you can set to de-
termine how your backup, duplicate, archive, 
transfer, and restore operations (immediate and 
scripted) are executed. For example, you could 
set a backup script to turn on software data com-
pression and synchronize client computer 
clocks. You can set options while setting up an 
immediate operation or while editing a script. 
Execution options are local rather than global, 
so they apply only to the current operation or 
script, not to all operations and scripts.

Retrospect also has global program preferences 
that affect all executions. See “Retrospect Pref-
erences” on page 158 for more information.

To set options for an immediate operation or a 
script, click the Options button in the summary 
window, then click More Choices to view a 
complete list of available options grouped by 
category. You can display the options for each 
category by clicking the category name in the 
list.

To turn an option on or off, click its checkbox 
or radio button. Some options use time and date 
controls, and others let you enter numbers or 
text. If any options in a category have been 
changed from their default settings, the catego-
ry name is shown in boldface. Clicking Use 
Default reverts all visible options to their de-
fault states. Clicking Fewer Choices returns you 
to the basic Options window.

Backup Server Options
These options are available only with Backup 
Server scripts.

Back up every: n days/hours: This time inter-
val, which is one day by default, specifies the 
minimum time between backups. Each source is 
backed up when possible, according to the pri-
ority of need, but not more often than this 
interval unless the Allow Early Backup option 
is on and a client user initiates a backup.

Allow Early Backup: When this option is on, 
which is the default, client users may initiate 
backups from their Retrospect Client control 
panels, overriding the backup interval. A re-
quest for an early backup does not necessarily 
move the user’s volume to the top of the priority 
list, depending on the priority of other volumes 
listed as sources in the script. Retrospect begins 
a user-requested early backup only after the 
Backup Server has current backups of its other 
source volumes.

Client Countdown Options
These options are available only with Backup 
Server scripts.

Countdown time: n seconds/minutes: 
Retrospect gives client users advance notice of 
when a backup is about to begin, counting down 
the time specified here. The default time is 
twenty seconds. (Enter zero to make Retrospect 
skip the countdown). When it is going to back 
up a source from a client computer, Retrospect 
puts up a dialog on the client. This dialog dis-
plays the countdown message (see below) and 
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offers buttons to defer the backup to a later time 
or bypass the countdown and immediately be-
gin backing up. If the client user does not take 
any action Retrospect backs up when the count-
down reaches zero.

Countdown message: The text in this box is 
shown to a client user when a backup is about to 
begin, according to the countdown time option. 
Retrospect will replace the text “«script»” with 
the name of the script it is executing.

Polling Options
These options are available only with Backup 
Server scripts.

Retry failure after: n minutes/hours: After a 
backup has failed or was canceled, Retrospect 
waits at least this long, thirty minutes by de-
fault, before trying to back up a source again.

Check source every: n seconds/minutes: 
Retrospect uses this time interval, which is 
ninety seconds by default, to access a source 
just to check whether it is available for backup. 
Retrospect does not check sources while a back-
up is in progress.

Connect to client every: n minutes/seconds: 
Retrospect uses this time interval, which is five 
minutes by default, to access a client to check 
whether the user has changed the backup sched-
ule for the client. Retrospect does not connect to 
clients while a backup is in progress.

Backup Options
These options are available with backup opera-
tions and Backup Server scripts.

Normal Backup: Only available with immedi-
ate backups, this option makes Retrospect 
perform a normal (IncrementalPLUS) backup, 
as described in “Normal Backups” on page 23.

Recycle Backup: Only available with immedi-
ate backups, this option makes Retrospect 
perform a recycle backup, as described in “Re-
cycle Backups” on page 23.

NOTE: For scripted backups, you can select a 
normal or recycle backup when you schedule 
the script. See “Common Scheduler Elements” 
on page 74 for more information.
Verification: Verification ensures files are cop-
ied correctly by comparing files in the backup 
set with the original source files after the back-
up is performed. If the backup set spans 
multiple tapes, discs, or disks in a session done 
with verification, you must reinsert all media to 
which data has been written. Although verifica-
tion increases the time it takes for a backup to 
complete, it ensures that information is correct-
ly written to the backup set. This option is on by 
default.

Data Compression (in software): Data com-
pression saves space in the backup set by 
compressing files before copying them into the 
backup set. Files are automatically decom-
pressed back to their original state when 
restored. Compression savings achieved during 
an operation are reported in the status window 
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and the Operations Log. The amount of com-
pression savings you can expect depends on the 
types of files you are compressing. Text files 
compress substantially; application and system 
files do not. Backups using data compression 
are slower than those without, as are restores.

When copying to a tape device that has built-in 
compression, Retrospect automatically turns off 
software compression in favor of the faster 
hardware compression.

Retrospect uses its built-in compression filter 
selector to identify files that are already com-
pressed (such as those compressed with a utility 
such as StuffIt) so it will not attempt to re-com-
press them with software data compression. See 
“Compression Options” on page 146 for more 
information.

The Data Compression option is off by default.

Archiving Options
These options are available only with archiving 
operations.

The archiving options include Verification and 
Data Compression, as described in “Backup 
Options” and Move Files.

Move files: This option deletes files from the 
source volume after they have been copied. If 
verification is turned on and the files do not 
match exactly, the originals will not be deleted. 
Do not turn on the move files option without 
also turning on the verification option. You 
should perform at least one additional verified 
archive, backup, or duplicate before deleting 
files from the source. Retrospect cannot move 

files from a client computer if its Retrospect 
Client control panel has been set to allow read 
access only. By default, this option is off. 

TIP: Before you use the Move files option, first 
archive to a different backup set by copying 
without moving. This provides an extra 
measure of safety should one backup set 
become unusable.
A related option is described in “Source Op-
tions” on page 147.

Duplicate Options
These options are available only with duplicate 
operations.

Update Backup Report: When this option is 
checked, Retrospect adds or changes informa-
tion in the backup report. By default, duplicate 
operations are not listed in the Backup Report.

Verification: This is the same option described 
in “Backup Options”.

Move files: This is the same option described in 
“Archiving Options”.

A related option is described in “Source Op-
tions” on page 147.

File Copying Options
These options are only available with duplicate 
and restore operations.
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Recompute Icon Positions: To prevent over-
lapping, this option manipulates the positions of 
file and folder icons copied to a Mac OS desti-
nation. By default, this option is off.

Update Modify Dates: This option is only 
available for restore operations. It causes 
Retrospect to set the modification date and time 
of restored files to the date and time of the oper-
ation. By default, this option is off.

Backup Set Transfer Options
These options are available only with transfer 
operations initiated with the Copy command 
from the Tools tab.

Copy Snapshots: This option transfers a back-
up set’s current Snapshots to the destination 
catalog before copying files. Snapshots are not 
copied to the destination backup set’s media. 
Snapshots which exist in the destination backup 
set are not replaced. This option is on by default.

Only most recent versions: Of files which 
match the search criteria, Retrospect transfers 
only the most recent version of each file. It ig-
nores older versions of the same files from other 
sessions. By default, this option is off.

Merge sessions: This option merges the files 
from multiple sessions of the source backup set 
to a single session in the destination backup set, 
as if they were all backed up at once. With the 
option off, which is the default, files transferred 
from several different sources are listed sepa-
rately by session in the destination backup set.

Retrieval Options
These options are only available during an im-
mediate restore by searching.

Only most recent versions: Of files which 
match the search criteria, Retrospect restores 
only the most recent version of each file. It ig-
nores older versions of the same files from other 
sessions. By default, this option is off, which 
makes Retrospect restore matching files from 
older and current sessions.

Minimal folder structure: Restores files to 
their original folders, in the minimum required 
hierarchy. Empty folders are not restored. This 
option is off by default.

Catalog Options
This option is available with all types of opera-
tions except duplicate and restore.

Save source Snapshot for restore: This option 
directs Retrospect to save a volume Snapshot to 
the catalog replacing the old Snapshot, if any, 
and to save another copy of the Snapshot onto 
the backup media. By default, this option is on.

Snapshots make it easy to restore a volume to its 
exact state as of a given backup, or retrieve files 
that you know were on a volume during a given 
backup. Empty folders are only backed up in 
Snapshots. If you deselect this option, no Snap-
shot is saved to the catalog. Should you need to 
restore files, you will have to use a selector 
(and/or browser) to choose which files to re-
store—a time-consuming process. 
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Matching Options
These options are available with all types of op-
erations except duplicate and restore.

Match source files to catalog: This option di-
rects Retrospect to identify previously backed 
up files during normal backups. Retrospect 
compares the files on the source volume to file 
information in the catalog for the selected desti-
nation backup set. 

• The Mac OS file matching criteria are name, 
size, type, creator, creation date, and modify 
date. 

• The Windows file matching criteria are 
name, size, creation date, and modify date. 

• The Linux file matching criteria are name, 
size, and modify date. 

Retrospect considers a file already backed up if 
all of these criteria match. When you view the 
preview browser while setting up an immediate 
backup, files that have already been backed up 
are preceded by a diamond symbol. 

NOTE: Archive operations have the matching 
option off by default, which results in archiving 
all selected files, regardless of whether they are 
already in the backup set. Unless you turn on the 
Move files option, matching is the only 
difference between archive and backup scripts.
Don’t add duplicates to backup set: This op-
tion works with the “Match source files to 
catalog” option to prevent previously backed up 
files from being added to the backup set again. 
Select both of these options when you want to 
perform a standard IncrementalPLUS backup; 
that is, you only want new or modified files cop-
ied to the backup set. If this option is deselected, 

Retrospect adds all files, including previously 
backed up files, to the backup set every time a 
Normal Backup is performed. By default, this 
option is on and you should keep it that way un-
less you have a specific need to change it.

Match only same location: This option is only 
available if “Match source files to catalog” is 
selected. It makes Retrospect more strictly 
match otherwise “identical” files from a source 
to a destination. (Normally, files are considered 
identical files when they have the same criteria 
described above in “Match source files to Cata-
log File”.) When this option is selected, 
Retrospect uses the unique (and hidden) 
Mac OS file identification number as an addi-
tional part of the matching criteria. This causes 
separate copies of otherwise-identical files to 
not match. (And unmatched files get backed up, 
so your backups are larger and slower.)

By default, this option is off and you should 
keep it that way unless you have a specific need 
to change it.

Compression Options
This option is available with all types of opera-
tions except duplicate and restore.

Selector: This option, which is available only 
when the Data Compression (see “Backup Op-
tions” on page 143) option is on, lets you 
determine the selector used to filter files when 
compressing. By default, Retrospect uses its 
built-in Compression filter selector to identify 
and avoid compressing files that are already 
compressed. You are not likely to need to 
change this option.

If you want to use a different selector to tell 
Retrospect which files to compress, you can 
modify the Compression filter selector or create 
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your own selector. See “Using Selectors” on 
page 177. 

Source Options
This options category is available with all types 
of operations except restore.

Set source (volume’s/folders’/files’) backup 
time: These options, not available with dupli-
cate operations, record a backup time for each 
source volume, folder, or file. (The Mac OS 
keeps track of the creation date, modification 
date, and backup date for each file, folder, and 
volume.) Using these options allows you to cre-
ate selectors based on the “backup time,” which 
is the moment execution begins. Retrospect 
cannot set the source backup time on a client 
computer if its Retrospect Client control panel 
has been set to allow read access only. By de-
fault, the volume option is on and files and 
folders options are off.

NOTE: When matching files for 
IncrementalPLUS backups, Retrospect does not 
use the backup time stamp. It uses more 
sophisticated and flexible criteria, as described 
in “How Retrospect Works” in Chapter 2.
Don’t delete empty folders after moving files: 
This option is only available for archive and du-
plicate scripts and operations. It keeps folders 
that become empty as a result of the move in-
stead of automatically deleting them. By 
default, this option is off.

Client Execution Options
These options are available with all types of op-
erations except restore, and these options apply 
only when backing up Retrospect client 
computers.

Byte-by-byte file comparison: This option 
overrides Retrospect’s fast client compare, ver-
ifying files the same way Retrospect does for 
local backups. When this option is turned off, 
Retrospect uses a faster, checksum-based tech-
nique to verify copied files. Both methods 
reliably compare backed-up data to the original 
files. By default, this option is off and, in most 
cases, you should keep it off.

Speed threshold: This option, which is avail-
able only with scripts, is useful for preventing 
backups from becoming too slow. The number 
you enter here determines the minimum accept-
able rate at which the client computer can be 
accessed. If, upon testing the network connec-
tion to the client prior to the operation, 
Retrospect finds the network or client is not 
working fast enough it will skip the client and 
log an error.

This option is useful, for example, for prevent-
ing the Backup Server from trying to back up a 
notebook computer volume when its user con-
nects using a dial-up connection.

Retrospect checks the client connection speed 
only once, as an operation starts.

TIP: To determine a working speed threshold, 
use the Get Info command on several different 
clients from the Backup Client Database 
window. For about a minute, observe the speed 
of each client.

Client System Options
These options are available with all types of op-
erations except restore, and these options apply 
only to Retrospect client computers.
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Synchronize clock: This option sets the date 
and time on each client computer to match the 
clock on the backup computer. This is useful to 
get times and dates to agree and is especially 
useful when changing to and from daylight sav-
ings time. Retrospect cannot synchronize a 
client computer’s clock if its Retrospect Client 
control panel has been set to allow read access 
only. By default, the synchronize option is off.

Never shut down/Shut down when done: This 
option specifies how Retrospect handles the 
Finder’s Shut Down process on a Mac OS 7/8/9 
client after Retrospect is done with its 
operation. 

NOTE: The desired behavior only happens 
when the client Macintosh is waiting for backup 
as described in “Execution Preferences” on 
page 105. 

• Shut down when done completes shut down 
unless the client is scheduled for another 
operation within the look-ahead time period 
(see “Schedule Preferences” on page 160).

•  Never shut down prevents the operation for 
which this option is selected from shutting 
down the client. 

By default, this option is set to Shut down when 
done.

Schedule Option
This option is only available for scripts (not in-
cluding Backup Server scripts).

Click Schedule to define a time period during 
which this script may execute. The default 
schedule reflects the global schedule prefer-
ence, described in “Schedule Preferences” on 
page 160.

FileVault Option
This option is only available for backup 
operations.

Mac OS X 10.3 includes a new feature called 
FileVault. When FileVault is enabled, the entire 
contents of your Home folder is encrypted and 
decrypted into a sparseimage file on the fly. 
This option tells Retrospect not to back up Fil-
eVault sparseimages. There are a number of 
good reasons for this.

The sparseimage files change constantly and 
therefore will always get backed up by an Incre-
mentalPLUS backup. Because of this and 
because the files can get quite large and under 
most circumstances cannot be restored proper-
ly, Dantz recommends against enabling 
FileVault on the backup computer and client 
computers.

If you must enable FileVault there are a few 
steps you must take to ensure that all user data 
is backed up and available for restore:

• Make sure all FileVault users are logged in
• Choose their volumes as backup sources

If a local or client computer has multiple ac-
counts for users that have FileVault enabled, all 
those users must be logged in.
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In the example above, users with checkmarks next to 
their names are logged in.

When they are logged in, their user folders ap-
pear in Retrospect’s Volume Selection window 
as separate volumes (in either the Local Desk-
top container or as a client volume). For 
example, if the FileVault user Chester is logged 
in, a new volume named “Chester” is listed in 
Retrospect’s Volume Selection window.

In the example above, benc and chester are FileVault us-
ers on the local computer.

In order to ensure that user data is backed up, 
the FileVault users’ volumes must be selected 
as sources. Selecting the startup disk volume 
will not back up the users’ data correctly. Se-
lecting the Local Desktop container, Backup 
Clients container, or a specific client will also 
select the FileVault volumes it includes.

CONTROLLING EXECUTIONS
Retrospect gives you many options to control 
operations in progress. For example, you can 
pause or stop an operation, view additional vol-
ume and performance details, and switch 
between interactive and unattended modes. 
These options are available once execution of 
an operation begins.

You can use any one of following methods to 
begin an operation:

• Initiate a backup, restore, or duplicate from 
the Immediate tab.

• Initiate an archive or backup set transfer 
from the Tools tab.

• Run a script immediately using the Run 
menu or the Immediate tab.

• Open a run document in the Finder.
• Wait until a scheduled script begins 

automatic execution.
When an operation is in progress, Retrospect 
displays the execution status window and the 
Control menu. When it cannot find a backup set 
member, Retrospect displays the media request 
window.

Controlling Backup Server 
Executions
Though many of the features described in this 
section apply to both regular scripts and Backup 
Server scripts, this section is intended for use 
with regular scripts. Backup Server scripts have 
their own, unique features for controlling exe-
cutions, which are described in “Using Backup 
Server” on page 88.

Execution Status Window
The execution status window is available during 
all file transfer operations and contains the fol-
lowing features:

• The Pause button temporarily suspends the 
current operation. Click Continue to resume 
the operation.

• The Stop button halts the current operation, 
bringing it to a premature end.
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• The  drop arrow expands the window to 
display more detail about the execution in 
progress. This includes the source and 
destination names, source and script start 
times, source and overall execution speed, 
and (when software data compression is 
being used) source and overall compression.

The execution status window (in its expanded state).

Control Menu
The Control menu is available during all file 
transfer operations and contains the following 
command items.

Show Log displays the Operations Log. See 
“Viewing the Operations Log” on page 140.

Run Interactively switches the execution to in-
teractive mode. In this mode, the “When Done” 
options in the Control menu are dimmed and 
Retrospect always remains open after execu-
tion. The interactive mode cursor is a pair of 
rotating gears. All Immediate and Tools opera-
tions default to interactive mode.

TIP: You do not have to wait for the Control 
menu to appear (while scanning a volume, for 
example) to switch between interactive and 
unattended modes. At any time, you can use the 
keyboard shortcut Command-Option-A, twice 
in quick succession.
Run Unattended switches the execution to un-
attended mode. During executions in this mode, 
the “When Done” options in the Control menu 
are available and determine what Retrospect 
does after execution. The unattended mode cur-
sor is an animated grid. All automatic 
executions, run documents, and scripts 

launched from the Run menu default to unat-
tended mode. 

Stop on Errors tells Retrospect to report errors 
by pausing execution and displaying a dialog. 
Retrospect will resume execution if possible af-
ter the OK button is clicked.

Just Log Errors tells Retrospect to report er-
rors to the Operations Log, but continue 
execution if possible. The Run Control general 
preference determines the default for this menu 
option. See “Run Control Preferences” on 
page 160.

When Done determines what Retrospect will 
do when completing the current operation in un-
attended mode: Wait, Quit, Restart, or Shut 
Down. These commands are not available in in-
teractive mode. The Unattended general 
preference determines the default for this menu 
option.

Retrospect will not quit, restart, or shut down 
(depending on the preference setting described 
on page 162) if another script is scheduled for 
automatic execution within the look-ahead time 
(see “Schedule Preferences” on page 160). 
Retrospect remains open and waits for the script 
to execute.

Media Requests
When necessary for disks, tapes, or CD/DVD 
backup sets, Retrospect prompts you to insert 
media by displaying the media request window. 
In most cases, Retrospect continues with the op-
eration when you insert correctly named or 
erased media and click Proceed. Because file 
backup sets and Internet backup sets do not use 
media, Retrospect never makes media requests 
when operating with file backup sets and Inter-
net backup sets.

You can avoid this prompt if you insert the cor-
rect medium before you execute the backup. So 
it does not overwrite valuable data, Retrospect 
is very particular about media—it must be blank 
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or erased, or the name must exactly match the 
requested name in order for Retrospect to pro-
ceed without prompting you. When performing 
new media backups or recycle backups, consid-
er erasing the media beforehand to be sure 
Retrospect will proceed automatically without 
your attention.

The media request window has a Stop button 
which halts execution of the currently running 
operation. It also has an Eject button which un-
loads the selected medium from the backup 
device. (Some devices require you to manually 
eject their cartridges.) Additional commands 
are available for tape libraries. See “Commands 
for Tape Libraries” on page 42.

Whenever the media request window is active, 
Retrospect adds the Devices menu to the menu 
bar. The items on this menu are as follows.

Device Status scans the communications bus 
and lists the ID numbers and their correspond-
ing devices.

Eject unloads the selected disk, tape, or disc 
from its drive. (Some devices require you to 
manually eject their cartridges.)

Retension runs the selected tape forward and 
backward to even out the tension and alignment. 
Retensioning applies only to some types of 
drive mechanisms.

Erase erases the contents of the selected tape, 
removable disk, or rewritable disc.

Additional commands are available for tape li-
braries. See “Commands for Tape Libraries” on 
page 42.

If the media request window does not show 
your backup device, refer to “Seeing Your 
Backup Device” on page 30.

New Media Request
When Retrospect says, “Please select a new” 
medium, it wants a blank medium or one it can 
erase.

When there is a medium in the drive and you 
click the Proceed button, Retrospect erases and 
names the media then continues with the opera-
tion using that medium.

NOTE: Retrospect will not let you erase a 
medium that belongs to another backup set.
Click Stop or Cancel in the media request win-
dow to halt the operation.

Specific Member Request
When Retrospect says, “Please insert” or 
“Please select” a specific medium, it wants a 
named member of the destination backup set.

Insert or select the requested medium, then click 
Proceed to continue the operation, or click Stop 
or Cancel to halt the operation.

If the requested media is unavailable, click the 
Choices button. The media choices dialog 
displays. 
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Choose one of the following options:

Missing tells Retrospect to designate the re-
quested backup set member as permanently 
unavailable. Retrospect will ask for a new piece 
of media and copy all the selected source files to 
it (treating data copied to the missing member 
as lost).

NOTE: Select Missing only when you have 
permanently lost or damaged the requested 
member. It is not appropriate for other 
situations.
Skip tells Retrospect to skip the requested 
member and ask for a new member. Data on the 
skipped member remains intact. Effectively, 
you are saying, “Stop copying to this member 
and start copying to a new one.” This is useful 
when a member is nearly full and you think it 
may not make it through a complete unattended 
backup before Retrospect fills it and asks for a 
new medium.

WARNING: Do not select Skip when you have 
lost or damaged the requested disk, tape, or 
disc; select Missing instead. Selecting Missing 
lets Retrospect know that the data on the lost or 
damaged media needs to be backed up again, 
since it is no longer accessible.
For more information on media requests, see 
“Retrospect refuses to use the inserted disk, 
tape, or disc.” on page 199.

MANAGING BACKUP SETS
Retrospect allows you to create and configure 
backup sets for later use and to perform mainte-
nance operations on backup sets that already 
exist.

Viewing the Backup Set List
To view a list of the backup sets currently in use 
by Retrospect, click the Configure tab, then 
click Backup Sets. The Backup Sets window 
displays.

You can modify the list by:

• Creating New Backup Sets
• Recreating Old Backup Sets
• Forgetting Backup Sets

Creating New Backup Sets
To create a new backup set, click New. The pro-
cess of creating a new backup set is described in 
“Creating a New Backup Set” on page 47.

Recreating Old Backup Sets
If your backup set does not appear in the Back-
up Sets window, you can add it to the list using 
its catalog file. To start, click More.

From this window you can:

• Open an existing catalog file: If you know 
the location of the backup set’s catalog file, 



CHAPTER 8 • MANAGEMENT 153

click the Open button. Browse to the 
location where the catalog file is stored, 
select the file, then click Open.

• Rebuild the catalog file from the storage 
media: Click the Rebuild button. Rebuild the 
catalog file as described in “Rebuilding a 
Catalog,” which starts on page 188.

After you open or recreate the catalog file, its 
associated backup set appears in the list.

Forgetting Backup Sets
You can remove a backup set from the backup 
set list by selecting it and clicking the Forget 
button or pressing the Delete key. Click OK 
when prompted to remove the backup set. For-
getting a backup set does not affect the contents 
of the backup set, nor does it delete its catalog 
file. However, it does remove the backup set 
from any scripts that use it.

As long as you don’t delete the catalog file and 
erase the media on which the backup set is 
stored, you can always add the backup set back 
to the list later. This process is described in 
“Recreating Old Backup Sets”.

Organizing the Backup Set List
When you have to manage a large number of 
backup sets, you can use folders to help orga-
nize them. For example, you might want to 
create folders for inactive backup sets that you 
have moved to an off-site safe deposit box.

NOTE: The folders you create in the Backup 
Sets window are for organizational purposes 
only and do not exist outside of Retrospect.

To create and populate a folder:
1.  From the Backup Sets window, choose New 
Folder from the Backup Sets menu.
2.  Enter a name for the folder and click Create.
3.  Drag and drop the backup set(s) you want to 
move into the folder.

Configuring Backup Sets
You can view and modify the properties of ex-
isting backup sets at any time. Click the 
Configure tab, then click Backup Sets to view a 
list of current backup sets. Double-click the 
backup set you want to configure.

The Backup Set properties window displays.

The window is divided into tabs:

• The Summary Tab
• The Options Tab
• The Snapshots Tab
• The Members Tab (Tape, CD/DVD, and 

Removable Disk backup sets only)
• The Internet Tab (Internet backup sets only)

The Summary Tab
The Summary tab displays general information 
about the backup set.

• Used shows the number of files in the 
backup set and their aggregate size.

• Available shows how much space remains 
on the current backup set member. 
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• Storage summarizes the number of media 
members and sessions in the backup set and 
the number of Snapshots in its catalog. 

• Options summarizes the options specified 
on The Options Tab.

• Security shows the backup set’s level of 
password protection. 

• Catalog shows the path to the location 
where the backup set’s catalog is stored. 

The Options Tab
The Options tab has controls for catalog com-
pression, catalog separation, configuring 
password access, controlling future media for 
this backup set, and estimating capacity of the 
set’s members.

The Options tab for a tape backup set.

The Catalog compression radio buttons give 
you the option of compressing the catalog file, 
saving space on your hard disk, but possibly 
slowing catalog manipulation such as matching 
files.

The Catalog Separate button, available only 
with file backup sets, allows you to split a com-
bined file set into separate files for the data and 
the catalog. See page 22 for more information.

The Password radio buttons allow you to 
choose the level of password protection for se-
cure backup sets. Password options are not 
available if you did not specify encryption or 
password protection when you created the back-
up set.

The Media Action button displays the media 
control manual override dialog, which allows 
you to specify how the storage media will be 
handled the next time you perform a backup to 
this backup set.

• Normal continues to append data to the 
current backup set and media.

• Recycle erases the backup set data and 
catalog and reuses the media. This is also 
known as resetting the backup set.

• New Media creates a new backup set that 
requires new, blank media.

• Skip requests a new member to add to the 
current backup set the next time it is used as 
a destination. Skip is useful when the current 
member (CD/DVD, tape, or disk) is almost 
full and you wish to get a complete, 
unattended execution without changing 
media.

The Media Capacity button, available only with 
CD/DVD and tape backup sets, allows you to 
change Retrospect’s estimate of your tape or 
disc capacity. The capacity estimates are used 
for display purposes only and do not affect how 
much data Retrospect will copy to a medium be-
cause it uses all the space it can. 

Leave the default (Automatic) to let Retrospect 
estimate the capacity, unless your media consis-
tently get higher capacity than Retrospect 
estimates. To see the actual capacity, click the 
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Members tab for a few of your backup sets that 
have full tapes or discs.

The Snapshots Tab
The Snapshots tab shows the most recent vol-
ume Snapshots in the backup set catalog and 
provides basic information about each 
Snapshot.

• For each Snapshot, Retrospect lists the 
volume name, and creation date and time.

• Click Add to retrieve older Snapshots from 
the storage media. In the Snapshot Retrieval 
window, select a session, then click 
Retrieve.

• Select a Snapshot and click Delete to remove 
the Snapshot from the catalog file. A deleted 
Snapshot will be replaced with a new 
Snapshot when the volume is next backed 
up. 

The Members Tab
The Members tab lists all the media members of 
a backup set. For example, if your backup set 
has grown to span three tapes, all three are listed 
here.

NOTE: This tab is not available for file and 
Internet backup sets.
If a member of a backup set gets lost or dam-
aged, you can designate it as missing. This lets 
Retrospect know that the files previously saved 
to that member are no longer available. Select 
the missing or damaged member, then click Set 

Missing. Missing members are marked with the 
poof icon .

During the next backup or archive operation, 
Retrospect copies the files that were on the 
missing member to a new backup set member, 
ensuring that you have a complete backup.

The Internet Tab
The Internet tab includes FTP login information 
and the location of the Internet backup set. You 
can change this information if your FTP settings 
change after you have created the backup set.

See page 48 for more information on Internet 
backup sets.

MAINTAINING SCRIPTS
This section provides instructions for various 
tasks you may need to perform in maintaining 
the scripts you have created. Maintenance tasks 
include:

• Checking Scripts
• Modifying Script Settings
• Duplicating, Renaming, or Deleting a Script
• Viewing Scheduled Scripts
• Skipping Script Execution

To perform any of these tasks, first click the 
Automate tab in the Retrospect Directory.

Checking Scripts
Before quitting Retrospect to run a script unat-
tended, it is a good idea to confirm the script is 
ready for unattended operation. You can check 
the validity of a script and also make sure the re-
quired media is available in the backup device.

To check a script
1.  Click Check from the Retrospect 
Directory’s Automate tab.
The Script Selection window displays a list of 
scripts.
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2.  Select the script you want to test and click 
OK. 
Retrospect checks the script definition to make 
sure that a Source and Destination have been 
properly defined. A message informs you if the 
script is missing necessary information. Click 
Edit to modify the script.
If the script is complete, a message appears 
telling you the script is ready.

NOTE: The information in this dialog depends 
on the type of backup set and the media 
currently loaded in the backup device.
3.  Click OK to return to the Retrospect 
Directory, or click Check Media to have 
Retrospect check whether the required backup 
set member is available.
NOTE: When you exit Retrospect, it 
automatically prompts you to check media for 
the next scheduled valid script. See “Quit 
Action Preference” on page 160 for more 
information.

Modifying Script Settings
At any time, you can modify the settings you 
specified when creating a script—you can 
choose different source volumes or destination 
backup sets, change the file selection criteria, 

the options, or the schedule. You modify scripts 
from the script summary window.

To modify script settings:
1.  In the Retrospect Directory, click the 
Automate tab, then click Scripts.
A list of scripts displays.
2.  Select the script to modify and click Edit.

3.  Modifying the script is the same as creating 
it. See Chapter 5 • Automated Operations.
4.  Choose Save from the Script menu to save 
the modified script.

Duplicating, Renaming, or Deleting a 
Script
You can base a new script on an existing one by 
duplicating a script and then modifying the set-
tings of the duplicate copy. Existing scripts can 
also be renamed or permanently deleted.

To duplicate, rename, or delete a script
1.  Click the Automate tab in the Retrospect 
Directory. 
2.  Click Scripts to display a list of scripts.
3.  Select the script to duplicate, rename or 
delete.
4.  To duplicate the script, choose Duplicate 
from the Scripts menu. 
Enter a name for the new script and click New. 
Then modify and save the new script.
5.  To rename the script, choose Rename from 
the Scripts menu.
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Enter a new name for the script and click 
Rename.
NOTE: You can also rename a script when its 
script summary window is active.
6.  To delete a script, choose Forget from the 
Scripts menu.
Click OK to confirm deletion. The script is 
removed from the list and its scheduled 
executions are eliminated.

TIP: If you do not want to receive a 
confirmation message when you delete scripts, 
press and hold the Option key as you issue the 
Forget command.

Viewing Scheduled Scripts
Retrospect maintains a list of upcoming scripts. 
You can view this list to see which scripts are 
scheduled to run and when. You can also modi-
fy the execution schedule by deleting scheduled 
events or by editing a script and changing its 
schedule.

Click Preview from the Automate tab to view 
the execution schedule for all scheduled scripts.

The Automatic Operation Preview window dis-
plays the date, time, and day of the week that 
upcoming scripts are scheduled to run. It also 
lists the script name, backup action, and 
destination.

Deleting a Scheduled Event
To delete a scheduled event and all prior events 
for its scheduler, click the event to select it, then 

click Delete. Click OK to confirm deletion. The 
event and all prior events for its scheduler are 
removed.

Editing Scheduled Scripts
To edit the script associated with an event listed 
in this window, click the event to select it, then 
click Edit Script. The script summary window 
appears, and you can click the Schedule button 
to modify the schedule or any other component 
of the script. 

For details on modifying schedules, see “Sched-
uling Scripts” on page 73.

Skipping Script Execution
If you do not want a script to run for a period of 
time, you can turn the script schedule off and 
specify when to turn it on again. This is useful, 
for example, if your office closes a week for 
holidays and nobody will be there to change 
media in the backup device.

To skip script execution:
1.  Click Scripts from the Automate tab to 
display the list of scripts. 
2.  Select a script then click Edit. 
The script summary window displays. 
3.  Click Schedule. 
Retrospect lists the currently scheduled dates 
and times for this script.

4.  Click the Skip scheduled executions 
checkbox at the bottom of the window. 
A date and time field appears at the bottom of 
the window.
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5.  Set the date and time for the script to start 
executing again, then click OK.
Retrospect ignores execution events prior to this 
date and time.

NOTE: When multiple schedulers are shown in 
the script schedule window, the selected 
scheduler is not the only one skipped by this 
feature. It skips all the scheduled executions for 
this script.

RETROSPECT PREFERENCES
You can adjust Retrospect preferences to modi-
fy the application’s behavior to best meet your 
needs. Retrospect preferences are global, that is, 
they affect all operations performed by 
Retrospect.

To access Retrospect preferences, click the Spe-
cial tab in the Retrospect Directory, then click 
the Preferences button. The Preferences win-
dow displays.

On the left is a list of the different categories of 
options. The options for the selected category 
appear on the right. Set the options, then click 
OK to save your selections.

NOTE: If you change the default setting for an 
option, the category name appears in bold in the 
list. To restore the default settings, select the 
category name and click Use Default.

Logging Preferences

Log size limit (MB) maintains the Operations 
Log size within the limit you set in the field pro-
vided. You can set the limit anywhere between 
1 MB and 100 MB. When the log reaches the 
limit, the oldest portion of the log is deleted to 
keep its size within the limit. The bigger the log 
is, the longer it will take to open. The default 
size is 10 MB.

Always open log automatically opens the Oper-
ations Log each time you start Retrospect. By 
default, this preference is turned off.

Export backup report produces or updates 
two identical files after each execution. (One 
Backup Report file is in the folder with the 
Retrospect application and the other is in the 
Retrospect preferences folder.) The tab-delimit-
ed text files contain all the information from the 
Backup Report. 

See “Viewing the Backup Report” on page 137 
for more information on how to export it 
manually.

Media Request Preferences

Media request timeout specifies a period of 
time for Retrospect to wait for media during ex-
ecution. When the times elapses, the execution 
stops and Retrospect proceeds according to the 
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next scheduled event. This preference is off by 
default, so it never times out.

Automatic skip to blank media makes 
Retrospect use an erased tape, disc, or disk for 
subsequent normal backups when the current 
member of the tape, CD/DVD, or removable 
disk backup set is not available. For example, 
you can select this option and leave an erased 
tape in the drive when the current tape of the 
backup set is almost full. Then you need not 
wait for the old tape to fill and be prompted to 
change tapes. When this option is not selected, 
Retrospect always prompts for the most recent 
member of the backup set until it becomes full. 
By default, this preference is turned off.

Media Erasure Preferences

Minimal erase confirmation skips the confir-
mation message that normally appears when 
you proceed with a backup operation and 
Retrospect needs to erase the media. By default, 
this preference is turned off.

For example, let’s say you do a normal backup 
to a tape member backup set named “1-Backup 
Set A”, but the only member loaded in your tape 
drive has a different name. Retrospect displays 
the media request window in which you can se-
lect the currently loaded tape. If the minimal 
erase option is checked and you select the tape 
and click Proceed, Retrospect will erase and use 
the tape. If the minimal erase option is un-
checked, Retrospect displays a warning dialog 
asking if you really want to erase the tape.

Media Handling Preferences

Retension tapes winds a tape forward to the 
end and back to even out the tension and align-
ment. (This applies only to some drives.) By 
default, this preference is turned off.

Eject media ejects tapes and discs when you 
quit Retrospect. By default, this preference is 
turned off.

Use FireWire/USB hard drives as removable 
disks allows you to use FireWire and USB hard 
drives in removable disk backup sets. Backups 
can span multiple hard drives.

WARNING: Retrospect requires exclusive use 
of each hard drive added to a removable disk 
backup set. In addition, any data on the drive at 
the time it is added will be deleted.

Maintenance Preference

Show tape drive cleaning reminder does so at 
the specified interval of hours of tape drive use. 
The reminder appears as a note in the log and as 
a notification dialog in the Finder after you quit 
Retrospect. If you never quit you will never get 
a reminder. By default, this preference is on, 
with an interval of fifteen hours. Use your drive 
vendor’s recommended cleaning interval.
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Quit Action Preference

Check validity of next script does so when you 
quit Retrospect. It automatically verifies and 
displays information about the next script 
scheduled to execute. By default, this prefer-
ence is turned on.

Internet Preference

FTP server timeout is the number of minutes 
Retrospect waits for a response from an FTP 
server during an operation with an Internet 
backup set. If the time passes without a re-
sponse from the server, Retrospect disconnects 
and terminates the operation. This preference is 
thirty minutes by default.

Run Control Preferences

Pause in background automatically pauses 
any operation Retrospect is performing when 
the Retrospect application is moved to the back-
ground. By default, this preference is turned off.

Stop on errors automatically stops a 
Retrospect operation and displays an alert mes-
sage if any error occurs. By default, this 
preference is turned off.

Rescan volumes on resume rescans selected 
volumes for changes when you switch to 

Retrospect from another application. By default 
this preference is off.

Confirm before stopping executions displays 
a confirmation dialog whenever you stop an ex-
ecution (Backup, Restore, etc.). If you want to 
stop executions without receiving the confirma-
tion dialog, deselect the checkbox. By default 
this preference is on.

Notification Preferences

Automatically launch Retrospect automati-
cally starts Retrospect when a scheduled script 
is waiting to execute. By default, this preference 
is turned on.

Animate Dock icon causes the Retrospect icon 
in the Mac OS X Dock to bounce when 
Retrospect is requesting media.

Security Preferences

Always require authentication causes 
Retrospect to prompt the user to supply an ad-
ministrator login and password each time the 
application is opened by a user under 
Mac OS X.

Schedule Preferences



CHAPTER 8 • MANAGEMENT 161

Look ahead time: n hours/days defines the 
number of hours or days Retrospect looks ahead 
for scheduled script executions. This affects 
what happens when you begin to shut down the 
backup computer or a client, and what 
Retrospect does when it completes an unattend-
ed operation. The default preference is twelve 
hours.

For more information, see “Notification Prefer-
ences” on page 160, “Client System Options” 
on page 147, and “Unattended Preferences” on 
page 162, respectively.

Schedule lets you define a window during 
which scripts are allowed to execute. This pref-
erence affects all scripts, except Backup Server 
scripts. The default window during which scripts 
are allowed to run is twenty-four hours a day, sev-
en days a week.

NOTE: You can also define a window for 
specific individual scripts. See “Schedule 
Option” on page 148 for more information.

To customize the schedule:
1.  Click Schedule.
The Weekly Schedule window displays.

By default, all twenty-four hours of each of the 
seven days of the week are selected.
2.  To select a day of the week, click it. Click 
and drag to select contiguous days of the week. 
Use the Shift or Command key and click or drag 
to select days without deselecting the previous 
selection.

To change a time, click on it and type or use the 
controls.
Start is the earliest time at which scheduled 
executions may begin.
Wrap Up is the period of time (in hours and 
minutes) before the stop time, during which 
Retrospect should complete the current 
operation but not begin new operations.
Stop is the time at which Retrospect absolutely 
must halt scripted operations (until the next start 
time).
NOTE: You can also set times by dragging the 
icons on the hourly schedule bar, but you should 
first experiment by typing the times to see how 
these controls work.
When a time is changed, the hourly schedule 
bar changes accordingly to graphically 
represent the start, wrap-up, and stop times.

Each selected day has a scaled-down hourly 
schedule bar, though it does not have controls.

The Always and Never buttons set the daily 
operating time to twenty-four hours and none, 
respectively.
3.  Click OK when done.

Sounds Preferences

Attention sound lets you choose one of the 
available system sounds to use when Retrospect 
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requires user interaction, such as during a media 
request.

Completion sound lets you choose one of the 
available system sounds to use when Retrospect 
completes an operation.

OS X Preference

Privileges Warning displays an alert message 
if a volume you are working with is set to ignore 
privileges under Mac OS X. By default, this 
preference is turned on.

This option is important, because in order to 
properly restore to or duplicate to a volume oth-
er than the current system volume under 
Mac OS X you must turn off “Ignore privileges 
on this volume” for the volume.

Unattended Preferences

Stay in Retrospect, Quit, Restart, Sleep, and 
Shut down determine what Retrospect does 
when a script is completed and no additional 
scripts are scheduled in the specified look ahead 
time. (See “Schedule Preferences” on 
page 160.) By default, this preference is set to 
Quit.

Notify for failures and media displays an alert 
message if errors occur during the automatic ex-
ecution of a script. It also displays an alert 
message when CD/DVDs, tapes, or disks will 
be needed in the future. This option is only 
available if you have selected the Quit, Restart, 

Sleep, or Shut Down preferences described 
above. By default, this preference is turned on.

MOVING RETROSPECT
If you ever decide to switch backup computers, 
you must do more than just install Retrospect 
and your backup device on the new machine. 
You must move some other files to the new 
backup computer in order to keep Retrospect’s 
preferences, clients, catalogs, scripts, and 
schedules intact.

To move Retrospect to a new backup 
computer:
1.  Install Retrospect on the new computer.
2.  Copy the catalog files from the old backup 
computer to the new computer.
NOTE: The default location that catalog files 
are saved is Users/username/Documents.
3.  Copy the preferences from the old backup 
computer to the new computer.
Preferences are saved in Library/Preferences/ 
Retrospect. Copy the entire Retrospect folder 
into the same location on the new backup 
computer, replacing any existing Retrospect 
folder there.
4.  Next, you must force Retrospect (on the new 
backup computer) to recognize the catalog files 
you just moved.
The easiest way to do this is to select all of the 
catalogs in the Finder, and double-click one to 
open all of them. Retrospect opens a backup set 
configuration window for each catalog, causing 
it to recognize the catalogs.
5.  If you previously backed up both the old and 
the new backup computer and you want to 
continue to do so, you must perform a few extra 
steps because their status has changed:

• If the new backup computer was previously 
backed up as a client, that is no longer 
necessary since its volumes are now local. 
Forget the client. Edit the sources in any 
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Retrospect scripts that used client volumes 
from the new computer and add the volumes 
which are now local.

• If you still want to back up the old backup 
computer you must install Retrospect Client 
software on that machine to access its 
volumes with Retrospect from the new 
backup computer. After installing and 
configuring the client, add its volumes to 
your scripts. Click the Volumes button on 
the Configure tab and choose Forget from 
the Volumes menu to remove the previously 
local volumes. Forgetting volumes removes 
them from the volumes database and any 
scripts which use them.

CATALOG AND CONFIGURATION 
BACKUPS
Part of your backup strategy should be to back 
up the backup computer. The simplest way to 
do this is to include the computer in your back-
up scripts. The most important files to back up 
are Retrospect’s backup configuration file (Ret-
ro.Config (6.0)) and your catalog files.

You can use the Finder or Retrospect to back up 
these files. Periodically copy them to another 
volume, such as a removable disk or file server, 
to help you recover from a disaster more quick-
ly. Or, set up a Retrospect duplicate script to 
automatically copy the files to a folder on an-
other volume. Use the Retrospect Files selector 
to select appropriate files, and schedule the 
script to run daily, when your other backups are 
complete.

If you back up your backup computer to multi-
ple backup sets, your catalogs and configuration 
are automatically covered in case of a disaster. 
Each backup set contains backups of the other 
backup sets’ catalogs. Alternatively, if you have 
several large catalogs, consider backing them 
up to their own dedicated backup set to help re-

cover from a disaster or lost catalog more 
quickly.

Catalog Backups
Catalog files are important adjuncts to backup 
sets, but face the same risks as your files since 
they often share the same hard disk. If you lose 
your catalog files, Retrospect cannot restore any 
files until the catalogs are rebuilt from the me-
dia, which can be a lengthy process. For this 
reason, back up your catalog files as well as 
your regular files.

The default location that catalog files are saved 
is Users/username/Documents.

Configuration Backups
Retrospect’s configuration file contains your 
client database, scripts, schedules, preferences, 
custom selectors, and other important 
information.

Retrospect uses the configuration file, named 
Retro.Config (6.0), located in the following 
folder:

Library/Preferences/Retrospect

WORKING WITH MACINTOSH FILE 
SERVERS
This section describes how to use Retrospect to 
back up volumes shared by Mac OS file sharing. 
These operations require special procedures to en-
sure access privileges are intact after the volume is 
restored. 

Restoring servers is detailed in “Restoring a 
Mac OS Server Client” on page 125.

Shared volumes maintain access privileges that 
determine which users and groups of users can 
see and change files and folders. These privileg-
es are active only when the server is running and 
the volume is shared.
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To retain access privileges for a server, file 
sharing must be on during the backup. During a 
subsequent restore operation, Retrospect reas-
signs privileges to the same users and groups 
that were active during the backup. Otherwise, 
any privileges for the restored and retrieved 
folders revert to the volume owner or server 
administrator.

There are two ways to back up Mac OS file 
sharing servers and Mac OS X Servers. The 
methods are:

• Local Mac File Server Backup
• Client Mac File Server Backup

WARNING: Do not back up Mac files servers 
as mounted volumes. Retrospect will not 
preserve privileges using this method. 

Local Mac File Server Backup
Local backup of a server involves running 
Retrospect Workgroup or Retrospect Server on 
the backup computer with a backup device con-
nected and file sharing activated. This is the 
fastest way to back up a server. 

Client Mac File Server Backup
Client backup of a server uses the Retrospect 
client software on the server computer. 
Retrospect runs on another computer and backs 
up the server without using file sharing.

NOTE: You must have Retrospect Server to 
back up a server as a client.

Backing Up a Server to Move its 
Contents
If you are going to back up a server to move its 
contents (for example, you have a more power-
ful Macintosh to be the new server) you should 
make two separate verified backups. Verifica-
tion, which is on by default, ensures the 
integrity of the data; having two backups will 
not leave you stranded if one fails for some 
reason.

WORKING WITH OTHER 
SOFTWARE
No program is an island. Among the thousands 
of other software programs available for the 
Macintosh, there are but a few which can cause 
problems with Retrospect or which require spe-
cial attention. These programs are described 
below.

Read the contents of the “read me” file installed 
by the Retrospect installer program. It may con-
tain late-breaking information on software 
which requires special attention for use with 
Retrospect.

Disk Images and DOS Partitions
DOS partition files, which are created by DOS 
and Windows software emulators, are backed 
up as large files. Each time you use the PC em-
ulator, the partition file is modified (and, 
accordingly, needs to be backed up). Disk imag-
es have similar issues, i.e., they can be very 
large and are modified often.

To avoid huge IncrementalPLUS backups of 
these types of files, exclude them from your dai-
ly backups to save time and space, but schedule 
a separate, regular backup of these files, so they 
can be restored.

Databases
Most database applications (such as 4D Server 
and FileMaker) cache data in memory, periodi-
cally writing to disk. Even if all users are logged 
off you cannot be sure all of the most recent 
modifications have been saved to disk. Because 
of this, we recommend that you use one of the fol-
lowing two options for backing up a database 
application.

• Quit the database application before starting 
your Retrospect backup. This guarantees a 
backup of all the data. You can use 
AppleScript and/or a macro program like 
QuicKeys to quit and start your database as 
needed.
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• Use the database’s built-in backup module 
(if available) in combination with 
Retrospect. Use Retrospect to back up the 
non-active data file created by the database.
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. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

C H A P T E R    9
T O O L S

• W O R K I N G  W I T H  V O L U M E S

• B R O W S I N G

• U S I N G  S E L E C T O R S

• M A I N T E N A N C E  A N D  R E P A I R

• A P P L E S C R I P T  S U P P O R T

• E - M A I L I N G  B A C K U P  R E P O R T S

Retrospect has a number of features which go above and beyond the basics required for 
backup and restore operations. Your knowledge of these features is not essential to use 
Retrospect, but knowing them allows you to work with the program faster and more 
efficiently.
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WORKING WITH VOLUMES
A volume is the operating system’s representa-
tion of a random-access storage device, such as 
a hard disk drive or partition, removable disk, or 
CD-ROM. It can also be a file server on the net-
work. A volume is the basic storage unit 
containing files and folders. Retrospect uses 
volumes as sources for backups and other oper-
ations and helps keep track of files with volume 
Snapshots.

Volume List Windows
Retrospect has two volume list windows. Many 
Retrospect operations use the Volume Selection 
window for you to select one or more volumes 
for the operation at hand.

The Volume Selection window for an immediate backup.

A similar window, the Volumes Database win-
dow, can be used to manage volumes. The 
Volumes Database window has some additional 
features that are not available from the volume 
selection windows. For example, the Volumes 
Database window allows you to browse a vol-
ume to view its contents.

The Volumes Database window.

Using either window is fairly straightforward; 
you click on the volumes you want, then click a 
button or choose a menu item to proceed or act 
on the selected volume.

To practice the techniques described here, open 
the Volumes Database window by clicking the 
Retrospect Directory’s Configure tab, then 
clicking the Volumes button.

The volumes listed in the scroll box are orga-
nized in an outline format similar to that of the 
Finder’s “view by name” list view.

Displaying Volumes
In a volume list window, the triangle icons on 
the left work just like those in the Finder. Click 
on a  icon to show the contents of its contain-
er or folder. Click on a  icon to hide the 
contents of its container or folder. A volume 
does not have this control unless it has one or 
more defined subvolumes

Selecting Volumes
In a volume list window, you click on a volume 
to select it. This deselects any other selected 
volumes.

Press and hold the Command key and click a 
volume to select it without deselecting any cur-
rently selected volumes. You can make a 
multiple non-contiguous or contiguous selec-
tion this way. 

Press and hold the Shift key and click a volume 
to select all volumes listed from the current se-
lection to the Shift-clicked volume. This is 
called a contiguous multiple selection.

NOTE: Some operations do not allow multiple 
selections. (For example, you cannot restore to 
multiple volumes.)
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Following are examples of these selection 
methods.

These methods of making individual and multi-
ple selections work throughout Retrospect, not 
just in the volume lists.

Browsing Volumes
The Volumes Database window has a Browse 
button which is not found in the Volume Selec-
tion window. To view and work with the 
contents of a volume, select the volume and 
click the Browse button to open a browser. 
Browsing a volume is explained in detail in 
“Browsing” on page 172.

Containers
In a volume lists, volumes, clients, and groups 
are organized under the containers Local Desk-
top, Backup Clients, and Source Groups.

Selecting one of these top-level containers se-
lects everything in that container. For example, 
you could back up every hard disk and remov-
able disk attached to the backup computer, and 
every client logged into Retrospect, simply by 
selecting the Local Desktop and Backup Clients 
containers as sources.

Local Desktop
The Local Desktop container holds volumes 
mounted on the backup Macintosh desktop. 
This includes the internal hard disk, an inserted 
removable disk, external drives, and FileVault 
volumes for logged in users.

When you select the Local Desktop container it-
self, you are instructing Retrospect to select all 
such volumes on the backup computer, except 
floppy disks, network volumes, and read-only 
volumes (such as CD-ROMs).

The following table shows some examples of 
Local Desktop container selections and the vol-
umes to which they resolve. (For example, if the 
selection were used in a backup operation, the 
resolved volumes would be backed up.)

Backup Clients
The Backup Clients container holds client com-
puters that are logged in to Retrospect. Clients 
themselves contain one or more volumes, which 
are made available according to how they are 
configured with the General tab of the client 
configuration window. For details, see 
Chapter 6 • Network Backup.

Original selection After clicking on 
Desdemona

After Command-clicking 
on Desdemona

After Shift-clicking on 
Desdemona

Using this selection… …resolves to 
these volumes.

Iago
Othello

Desdemona
Iago
Othello
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When you select the Backup Clients container 
itself, you are instructing Retrospect to select all 
clients contained within it (i.e., all currently 
logged in clients).

Source Groups
The Source Groups container holds volumes 
grouped together for better organization. 
Groups, which you define, do not contain the 
actual volumes themselves, but aliases which 
point to actual volumes (which are in Local 
Desktop or Backup Clients). 

For example, you could make an Accounting 
group containing the volumes from the account-
ing department. Later when you are creating a 
backup script, instead of tediously selecting 
each individual accounting volume, you can 
just select the Accounting group and Retrospect 
knows you mean all of the volumes within that 
group.

NOTE: Source Groups are not available in 
volume lists of duplicate and restore operations.
Creating Groups: To create a new group, 
choose Make Group from the Volumes menu. 
After you enter its name in the dialog, the new 
group appears under the Source Groups con-
tainer. Any items that were highlighted when 
the group was created will belong to the new 
group.

Adding Volumes to Groups: You can drag any 
volume from the Local Desktop and the Backup 
Clients containers into a group.

Arranging Group Items: You can drag any 
volume out of one group and into another 
group. You can drag a volume to a different lo-
cation within its group to rearrange the order of 
the group.

Removing Groups: You can remove an un-
wanted group or item by selecting it and 
choosing Forget from the Volumes menu or 
pressing the Delete key.

Folders
You can make folders to help organize the in-
formation which appears in the volume list 
window. For example, while setting up a back-
up you can select a folder as a backup source 
and Retrospect will back up all the volumes in 
the folder. 

NOTE: These folders are specific to Retrospect 
and do not appear outside the program.

Creating Folders
To create a folder, choose New Folder from the 
Volumes menu. Retrospect asks which type of 
folder you want, which determines whether it is 
created in the Local Desktop container or the 
Backup Clients container. After you make your 
choice and give the folder a name, it appears in 
the volumes list represented by the  icon.

Arranging Folders
You can drag any volume into or out of a folder 
to better organize the list of volumes. Just like 
folders on a hard disk, folders are useful for hid-
ing numerous items to avoid cluttering your 
work space. 

For example, if you are administering a large 
number of clients, you can arrange them in a 
logical order by placing the individual volumes 
into their respective department folders, such as 
Accounting, Engineering, and Manufacturing. 
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You can then select a folder in a volume selec-
tion window and Retrospect selects all the 
volumes within the folder.

Removing Folders
You can remove an unused folder by selecting 
it and choosing Forget from the Volumes menu 
or pressing the Delete key. However, you must 
move the contents (if any) out of the folder be-
fore you forget it.

Subvolumes
A subvolume is a folder on a volume you define 
to work like a volume for use within Retrospect. 
After a folder is designated as a subvolume it 
can be specified as a source or destination for 
Retrospect operations. Subvolumes have no 
function outside Retrospect and their mere ex-
istence does not affect a volume’s files and 
folders in any way.

If you only want to back up files in a single fold-
er, specifying a subvolume (instead of 
specifying a volume and using a custom selec-
tor) reduces the file scanning time, minimizes 
the number of files displayed in a browser, and 
reduces the amount of memory needed.

Retrospect treats a subvolume as another vol-
ume on your system. Once a folder has been 
defined as a subvolume, you can rename the 
folder in the Finder and Retrospect will contin-
ue to recognize it—with its new name—as a 
subvolume. However, if you remove the folder, 
Retrospect will not be able to locate the subvol-
ume, even if you put a new or different folder 
with the same name in its place.

Specifying Subvolumes
In a volume list, select a volume, then choose 
Make Subvolume from the Volumes menu or 
click the Subvolume button in the window. A 
dialog appears, listing folders at the top level of 
the selected volume.

You can specify any folder in the selected vol-
ume as a subvolume, including folders nested 
deep within the folder hierarchy. Select the 
folder you want to specify as a subvolume and 
click Define. (To define the folder name cur-
rently displayed in the pop-up menu as a 
subvolume, click Use.) The subvolume folder, 
identified by the  icon, then appears with the 
volumes in the volume list.

NOTE: If you specify both a subvolume and its 
parent volume as Sources, they will be treated 
as separate objects. However, operations 
involving the parent volume will include the 
contents of the folder designated as a 
subvolume.

To discard a defined Subvolume:
1.  In the Volumes Database window, select the 
subvolume.
2.  Choose Forget from the Volumes menu or 
press the Delete key. 
Forgetting a subvolume does not affect the 
contents of the original folder or any file you 
may have already backed up from it.

Volume Utilities
The Volumes menu has commands for defining 
and forgetting subvolumes and for renaming, 
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ejecting, putting away, and erasing listed 
volumes.

Make Subvolume
To define a folder as subvolume, select its par-
ent volume and choose Make Subvolume from 
the Volumes menu. Use the dialog as described 
in “Specifying Subvolumes”.

Configure
To configure a client, select the client or one of 
its volumes from the list and choose Configure 
from the Volumes menu. The client configura-
tion window appears. 

For details on how to use this window, see 
“Configuring Clients” on page 96.

The Configure command can also be used to en-
able Retrospect to automatically mount a shared 
volume when it is needed—typically, while ex-
ecuting a backup script—and unmount it when 
Retrospect is done with it. 

To configure a shared volume, first log in to 
mount the volume on the desktop. Select the 
volume in the Volumes Database list and 
choose Configure from the Volumes menu. The 
password configuration dialog appears, listing 
the server, volume, and user names. In the space 
provided, enter the password for the displayed 
user name, then click OK. Unmount the volume 
from the desktop before adding the volume to 
your scripts.

When it needs to access the volume, Retrospect 
will mount the volume on the desktop, access it, 
and then unmount it when done.

Rename
To change the name of a volume or subvolume, 
select it and choose Rename from the Volumes 
menu. Enter a new name in the dialog that dis-
plays, then click the Rename button.

Eject
To eject removable media from a drive, select 
its volume name and choose Eject from the Vol-
umes menu.

Put Away
To unmount a mounted volume (such as a serv-
er), select its volume name and choose Put 
Away from the Volumes menu.

Forget
To remove a volume or subvolume from the list, 
select it and choose Forget from the Volumes 
menu. Currently mounted volumes, such as re-
movable disks and shared volumes, cannot be 
forgotten. Forgetting a server forgets its data-
bases and defined subvolumes.

Erase
To erase the contents of a volume, select it and 
choose Erase from the Volumes menu. Be care-
ful; this command permanently removes all 
files from the volume.

BROWSING
Browsers are Retrospect’s powerful tools for 
viewing, selecting, and manipulating files and 
folders on your source and destination volumes. 
From within Retrospect, browser windows pro-
vide file management facilities similar to those 
in the Finder, and include other features not 
available in the Finder.

Browsers “unfold” the contents of a volume so 
you can work with all of its contents all at once. 
This lets you easily select multiple files within 
different folders. You can also view browsers in 
a flat-file structure, without the folder 
hierarchy.

Browsers allow you to see the files chosen for 
backup, restore, duplicate, and copy operations. 
You can also use browsers in a “stand-alone” 
manner to view and manage the contents of vol-
umes. In backup, restore, duplicate, and copy 
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operations, browsers show you which files have 
been chosen by the selector you designated and 
allow you to mark and unmark files.

You can open any number of browser windows, 
including different browsers for the same vol-
ume. You can also leave browser windows open 
while performing other Retrospect operations 
and switch back and forth between browser 
windows and other Retrospect windows.

When a browser window is active, Retrospect 
adds a Browser menu to the menu bar. It has 
commands for finding, selecting, and managing 
folders and files in the browser listing.

Viewing a Stand-alone Browser
To view a stand-alone browser of a volume, go 
to the Retrospect Directory’s Configure tab and 
click Volumes. The Volumes Database window 
appears, listing the names of available volumes. 
Select a volume, then click Browse. Retrospect 
scans the selected volume, then displays a 
browser window listing all the folders and files 
contained in the selected volume.

To view a stand-alone browser of a backup set, 
see “Viewing Backup Set Contents” on 
page 141.

Viewing a Browser from an Operation
To view a browser within an immediate backup, 
restore, duplicate, or copy operation, click the 
summary window button named either Files 
Chosen or Preview. Retrospect displays a 
browser window for each source.

Browsers and Scripts
You cannot use a browser within a script be-
cause scripts are meant for unattended 
execution at a later time. Using a browser would 
not be useful because a volume’s contents are 
likely to change between the time you edit the 
script and the time the script is executed.

About Browsers
A browser window displays a hierarchical file 
list of folders and files in the selected volume.

At the top of the list (and at the highest level of 
the hierarchy) is the name of the volume. Fold-
ers have triangle icons to their left; click a 
triangle to show the contents of the folder. Click 
the triangle icon again to hide the contents of the 
folder. Open folders have triangles pointing 
downward rather than to the right.

Folder contents hidden. Folder contents showing.

The scrolling folder index on the left of the win-
dow provides a thumbnail view of the folders on 
the volume. Click on the folder index to display 
the associated file list on the right side of the 
window. The pathname of the current selection 
is shown above the index. Tick marks in the 
folder index indicate the location of selected 
items in the file list. Index lines appear grey for 
unopened folders or black for open folders.

A highlight count in the upper right corner of 
the window indicates how many files are high-
lighted and shows their total size.
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Selecting Files and Folders
In a browser window, you select files and fold-
ers on which to perform operations. Select files 
by clicking on entries in the file list. Drag 
through the list or Shift-click to select a range of 
files or folders. Command-click to select or de-
select non-contiguous items. Select all items by 
choosing Select All from the Edit menu. Dou-
ble-clicking a file both selects (highlights) and 
marks it. Marking is described below, under 
“Marking Files and Folders.” 

Getting Additional Information
Retrospect provides a Get Info command you 
can use to view information about the selected 
files and folders. 

Get Info provides information such as the file/
folder location, size, dates of creation and mod-
ification, and Linux permissions.

To View Information About Files or 
Folders:
1.  From a browser, select the files or folders for 
which you want more information.
2.  Choose Get Info from the File menu. 
An Info window appears for each selected file 
or folder, displaying additional information.

Marking Files and Folders
A marked file or folder is one that is designated 
to be used in some way (for example, backed 
up, archived, duplicated, or restored). When 
performing operations, Retrospect marks files 
according to the rules of the selectors in the 
search criteria, but you have no way of knowing 

which files are marked unless you use browsers. 
In addition to simply viewing a list, you can 
manually mark and unmark files and folders 
within a browser.

Marked files indicate the files you want 
Retrospect to evaluate when performing an op-
eration. Not all the marked files will be backed 
up (or duplicated, restored etc.). For example, 
during a backup using Retrospect’s default set-
tings, only new and modified files will be 
backed up, regardless of which files you mark. 
Retrospect displays a diamond icon in the 
browser list next to source files that already ex-
ist on the destination. These files will not be 
copied to the destination again, saving time and 
media space.

You mark files and folders in a browser by se-
lecting them and clicking the Mark button. A 
check mark appears to the left of a file or folder 
when it is marked. Click Unmark to remove 
marks. You can also mark and unmark files and 
folders by double-clicking them.

To mark or unmark an item without affecting 
the highlighting of other items, press and hold 
the Command key while double-clicking.

By marking or unmarking a folder you perform 
the same operations on all the files (and folders) 
contained within that folder. For example, to 
specify a single folder for backup, you would 
double-click on the volume name at the top of 
the file list to unmark all of the files, then scroll 
to the folder you want to back up and double-
click the folder icon to mark it and its contents.

The Browser menu provides additional com-
mands for highlighting and marking in the 
window.

Skip Next: scrolls the list forward to display the 
next highlighted file. 

Highlight Marks: highlights marked files. If 
you click or double-click an item without hold-
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ing the Command key you may end up 
unhighlighting marked items. This command is 
useful for rehighlighting them.

Cross Reference: allows you to locate files in 
the same hard disk or session that are related to 
a specified file. Specifically, Cross Reference 
finds duplicate files, older versions of the same 
file, and even files that have been renamed but 
were originally from the same file. This com-
mand highlights, but does not mark, cross-
referenced files.

Selecting View Formats
Choose the View Options command from the 
Browser menu to specify how you want to view 
the contents of a volume.

The Layout pop-up menu provides two different 
layouts for displaying the contents of a volume.

• File & Folder Hierarchy displays files and 
folders in the same hierarchical structure in 
which they are stored on the volume. This is 
the default layout that Retrospect uses when 
you first open a browser window.

• Sorted Files—No Folders displays all files 
stored in the selected volume as a single 
“flat file” list, discarding any folder 
designations. 

For both types of browser layouts, the Display 
pop-up menu allows you to specify the type of 
file information displayed in the browser win-
dow. You can choose from Name-Size-Kind, 
Name-Size-Label, Name-Size-Modify Date, 
Name-Size-Backup Date, and Name-Size-
UNIX.

When the Sorted Files layout is specified, the 
Sort By pop-up menu becomes available, allow-

ing you to choose one of six sorting options for 
displaying files in the flat file format: Name, 
Size, Kind, Label, Modify Date, and Backup 
Date.

When you choose a sorting option, Retrospect 
normally sorts the files in ascending order. For 
example, if sorting by size is specified, the 
browser lists the smallest files at the top of the 
list and largest files at the bottom. You can 
specify a descending order for the current sort-
ing option by selecting the Reverse checkbox.

When you specify layout and display options 
for the current browser window and click OK, 
Retrospect re-displays the files using the speci-
fied options.

Finding Files
The Browser menu has a Find item that you can 
use to locate specific files or folders (but not 
empty folders) on the volume. 

The Find window (showing Fewer Choices).

In the text entry field, type the text for which 
you are searching.

NOTE: This feature is not case-sensitive. It 
makes no difference whether you use lower or 
upper case letters.
The window also provides pop-up menus for 
specifying the type of search you want to 
perform.

File lets you specify which items you want to 
find, using one of three search variations: File 
matches the name of the file, Folder matches the 
name of the folder and selects the files immedi-
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ately inside the folder, and Enclosing Folder 
matches the name of the folder and selects all 
files within the folder, including files nested in 
other folders.

Name specifies whether you are looking for the 
search text in the name of a file or folder, or in 
a path name. Path names always begin with the 
volume name and list the hierarchy of folders, 
separating folder names with colons 
(Mac OS 9) or forward slashes (Mac OS X). 
When you use “path name” and “End With” or 
“Match” (see below) to find a folder, you must 
type a colon or slash at the end of the path name. 
For example, “Startup Drive:Documentation:” 
and “Reports/TPS/”.

Does specifies inclusive or exclusive searches. 
For example, if you choose “does not,” and per-
form a search on file names, Retrospect selects 
all the files and folders whose names do not 
contain the search text.

Contain specifies where the search text is posi-
tioned within the name. You can specify that the 
search text be located at the beginning (Start 
With) or end (End With) of the name, or con-
tained somewhere within a name (Contain). Or 
you can specify that the name exactly match the 
search text and no additional text (Match).

Click More Choices to build a custom selector 
to use in searches for a file or folder. The win-
dow that appears is identical to the selector 
details window you use to build Retrospect 
selectors. 

For more information on using the Find window 
to build search conditions, see “Using Selec-
tors” on page 177.

To perform a search, choose Find from the 
Browser menu. Edit the search criteria in the 
Find window and click OK. Retrospect high-
lights all files and folders that meet the search 
criteria. You can mark the highlighted files by 

clicking the Mark button in the browser 
window.

Printing or Exporting a File List
Any time a browser window is active, you can 
print the contents of the file list or export it to a 
file. To print, choose Print from the File menu. 
If you use Page Setup to reduce the printing 
size, Retrospect will print a browser in more 
than one column to save pages. To export to a 
text file, choose Export from the File menu. 
Retrospect exports the fields in the following 
order, regardless of the view format: file name, 
size, create date, create time, modify date, mod-
ify time, backup date, backup time, type, 
creator, backup set (if any), and path.

Copying and Pasting Selections
You can copy selections between browser win-
dows or into the Scrapbook for temporary 
storage. When you copy a selection, only the 
file and pathname information is copied, not the 
files themselves. This feature is useful for copy-
ing selections from a stand-alone browser 
window into a browser window opened during 
a Retrospect operation such as restore.

NOTE: You can only paste a copied selection 
into a browser window or the Scrapbook. You 
cannot paste a copied selection into any other 
applications or documents.

To Copy Selections Between Browser 
Windows:
1.  Make your file and folder selection then 
choose Copy from the Edit menu.
2.  Open (or bring to the front) the appropriate 
browser window for the same volume.
3.  Choose Paste from the Edit menu. 
Retrospect pastes the selection into the new 
browser window, highlighting only the same 
files and folders (in the same folder hierarchy) 
which were selected and copied in the other 
browser window.
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Saving Selections as a Selector
You can also save file and folder selections as a 
selector that you can use to reselect files for fu-
ture Retrospect operations on the same volume, 
including backups and restores.

NOTE: Before you save a selection as a 
selector, consider creating a custom selector as 
described in “Using Selectors” on page 177. 
You can easily review and modify custom 
selectors at any time. A selector created with a 
browser’s Save Highlights command cannot be 
reviewed or modified once it has been defined.

To Save Selections as a Selector:
1.  Select the files/folders you want to apply to 
a selector.
2.  Choose Save Highlights from the Browser 
menu.
The window that appears tells you how many 
files and/or were selected and will be reselected 
(or excluded) by this selector if pathnames 
match exactly. 

3.  Use the “is” pop-up menu to specify whether 
the saved selector is inclusive or exclusive.
This window also includes file and folder 
options similar to those in the find window, as 
described in “Finding Files” on page 175.
4.  Enter a selector name then click OK.
Retrospect creates the new selector, which is 
now available for other Retrospect operations.

Rescanning a Volume
You can update the contents of the browser win-
dow by choosing Rescan from the Browser 
menu. This is useful, for example, if you make 
changes to the volume (for example, in the 

Finder or another browser window) while the 
volume’s browser window is open.

The Rescan command appears in the Browser 
menu only when Retrospect is working with a 
volume directly. For example, you can not res-
can a volume when you are Browsing a backup 
set.

Deleting Files
Retrospect browsers have a Delete from Disk 
command to remove files from a volume, which 
is like placing a file in the Finder’s Trash can 
and emptying the trash.

NOTE: The Delete from Disk command is only 
available when Retrospect is working with a 
volume directly. For example, you can not 
delete a file when you are browsing a backup 
set.

To Delete Files:
1.  Select the file or files you want to delete in 
the file list.
2.  Choose Delete from Disk from the Browser 
menu. 
A dialog appears, asking you to specify whether 
you want to remove the selected files only or 
remove the selected files and any empty folders 
that may result from the file deletions. 
3.  Make your choice, then click OK.
Retrospect permanently deletes the selected 
files from the volume.

WARNING: A delete command may not be 
undone with the Undo command, nor may a file 
be pulled from the Trash can. When a file is 
deleted, it is gone.

USING SELECTORS
You can use selectors with immediate and auto-
mated operations to specify the types of files 
and folders you want the operation to include. 
Using selectors to intelligently select certain 
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files and folders you can limit the amount of 
time and media required for an operation.

Selectors let you choose files based on almost 
any criteria, including name, date, type, or size. 
Retrospect includes a number of built-in selec-
tors, and you can also create custom selectors. 
For example, you can create a selector that will 
choose AppleWorks document files modified 
after October 17, 2003.

A file that is marked by a selector will not nec-
essarily be copied to the destination. All 
copying operations (such as backups) using se-
lectors are “smart,” because of Retrospect’s 
matching feature. For each selector, there is the 
implied meaning of “select this file, but do not 
copy it if it already exists in the destination.”

NOTE: Retrospect’s selectors do not select 
empty folders.

The Selectors Window
You create and modify selectors through 
Retrospect’s selectors window.

To display the selectors window, click the Spe-
cial tab in the Retrospect Directory, then click 
Selectors. The selectors window lists all of the 
predefined and user-defined selectors.

The selectors window has two buttons for work-
ing with the selectors.

New creates a new selector.

Edit allows you to add new conditions or mod-
ify existing conditions for a selector.

When the selectors window is open, Retrospect 
adds a Selectors menu to the menu bar. It in-
cludes the following commands:

New Folder makes a folder container for orga-
nizing selectors.

Duplicate makes a copy of the currently high-
lighted selector.

Rename lets you change the name of the cur-
rently highlighted selector.

Forget removes the currently highlighted 
selector.

Built-in Selectors
Retrospect includes twelve built-in selectors, 
with predefined conditions for selecting files.

Some selectors and selector conditions function 
differently with Mac OS, Windows, and Linux 
volumes. Examine a selector’s details for more 
information.

Retrospect’s built-in selectors are:

All Files marks all files on the source, including 
the system folder. This is the default selector.

All Files Except Cache Files marks all files on 
the source, except cache files used by certain 
applications, such as web browsers. These 
cache files, which are often large, are not need-
ed for restoring.

Applications marks only applications except 
those which are selected by the System Folder 
selector. On Windows clients, this marks file 
names using the extensions .COM, .EXE, and 
.DLL.

Documents marks files which are not selected 
by the System Folder or Applications selectors. 
On Windows clients, this marks all files outside 
the current Windows folder except .COM, 
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.EXE, and .DLL files. (It does not mark NT pro-
files, because they are stored in the Windows 
folder.)

Documents Folder marks the contents of any 
folder named “My Documents” or 
“Documents”.

Documents Folder & Hot Items marks the 
contents of any folder named “My Documents” 
or “Documents” and files and folders bearing 
the Mac OX Panther red-colored label or the 
Mac OS 9 Hot label. (The label name may be 
something other than Hot; Retrospect uses any 
name you redefine in the second menu 
position.)

Exclude Cool Items marks everything except 
files and folders with the Mac OS 9 Cool label. 
(The label name may be something other than 
Cool; Retrospect uses any name you redefine in 
the fourth menu position.)

Hot Items marks only files and folders bearing 
the Mac OS 9 Hot label. (The label name may 
be something other than Hot; Retrospect uses 
any name you redefine in the second menu 
position.)

Movies copies the contents of all users’ Movies 
folder (i.e, any folder named “Movies”) and ad-
ditional files outside the Movies folder with 
common movie file extensions (e.g., .mov, .avi, 
.mpg, .wmv, etc.).

Music copies the contents of all users’ Music 
folder (i.e., any folder named “Music”) and ad-
ditional files outside the Music folder with 
common music file extensions (e.g., .aac, .mps, 
.ogg, .wma, etc.).

Music, Movies, Pictures is a combination of 
the Music, Movies, and Pictures selectors.

Pictures copies the contents of all users’ Pic-
tures folder (i.e., any folder named “Pictures”) 
and additional files outside the Pictures folder 

with common picture file extensions (e.g., .jpg, 
.jpeg, .tiff, .tif, .bmp, .psd, .png, .gif, etc.).

Retrospect Files marks files having the “Pery” 
creator code used by the Retrospect Backup 
family.

System Folder marks only the contents of the 
Mac OS 9 system folder or the Mac OS X core 
operating system folders. On Windows clients, 
this marks the current Windows folder.

Users Folder and Prefs (OS X) copies the Mac 
OS X Users folder containing all users data and 
the Library>Preferences folder where some ap-
plications (including Retrospect) store 
preferences information. By default, this selec-
tor excludes browser cache files.

Compression filter is used by Retrospect to de-
termine which files to compress when using its 
software compression option. It is not for use in 
script criteria. (For me information, see “Com-
pression Options” on page 146 and the Data 
compression option in “Backup Options” on 
page 143) 

This selector tells Retrospect which files have 
already been compressed so they are not com-
pressed again. You do not need to modify this 
selector unless you use a compression program 
that Retrospect does not know about.

No Files does not back up any files. Use the No 
Files selector when you are creating a script for 
the purpose of shutting down client computers 
on nights when they will not be backed up. For 
more information, see “How can I prevent the 
“waiting for backup” dialog from appearing on 
Mac OS 7/8/9 clients on nights when no opera-
tion is scheduled?” on page 210.

All Files is the default selector used for imme-
diate operations and scripts. You should use this 
selector to ensure complete backups.
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You can easily incorporate selectors into your 
own scripts. You can view selectors to better 
understand them, and you can even modify 
them to suit your needs. Do not modify the 
built-in selectors until you have some experi-
ence creating your own. In fact, it’s better to 
duplicate a predefined selector and modify the 
copy.

To view a built-in selector, click on it to select 
it in the selectors window and click Edit (or just 
double-click the selector), which brings up a 
window with the selector’s condition details.

In addition to viewing the selector, this window 
also lets you modify it to make your own cus-
tom selector.

Selector Conditions
You build a selector by adding conditions for 
including or excluding files or folders that meet 
the selection criteria. As you build the selector 
you can add and relate multiple conditions, and 
even use logical operators to create sophisticat-
ed criteria for file selection.

To view or modify selector conditions, select a 
selector in the selectors window, then click Ed-
it. The selector details window appears, 
displaying two distinct areas for adding condi-
tions; one for conditions which include files or 
folders for an operation, and one for conditions 
which exclude files or folders.

The arrow buttons underneath the Include and 
Exclude headings are pop-up menus of condi-
tion types.

The conditions pop-up menu in the selector details 
window.

You can build your own selectors using the fol-
lowing conditions.

Date
The Date condition uses creation, modification, 
or backup dates as conditions. Windows operat-
ing systems do not implement a true backup 
date for files; they instead use an archive at-
tribute. When the archive attribute is on, one is 
to assume the file has changed since its last 
backup and needs to be backed up.

Retrospect uses the archive attribute when it 
evaluates the backup date condition with files 
from a Windows client volume. When a file’s 
archive attribute is off Retrospect assumes its 
backup date is one second after its modification 
date. When a file’s archive attribute is on 
Retrospect assumes its backup date is in the 
year 1904.

Retrospect’s interpretation of the archive at-
tribute lets you use a selector condition such as 
“modification date is on or after file backup” 
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with both Windows and Macintosh clients 
achieving the same functionality.

NOTE: You do not have to use backup dates to 
perform IncrementalPLUS backups; Retrospect 
does IncrementalPLUS backups by default.

File Kind
The File Kind condition uses file creator and 
type as conditions. The Mac OS uses type and 
creator codes to identify files, but the Windows 
operating systems use three-character name ex-
tensions following files. Retrospect maps some 
extensions into type and creator codes. 

TIP: To select by file kind on Windows clients, 
use the name condition to select file names 
ending with a period and the three-character 
extension.

Flags
The Flags condition uses file attributes, such as 
file marked, matched, busy, locked, invisible, 
alias, name locked, stationery, or custom icon as 
the conditions. The following flags, when used 
with files from Windows clients, behave differ-
ently than when they are used by Mac OS files. 
The behavior is as follows: 

• Marked
• Matched 
• File Busy is not useful.
• Locked indicates a file which allows read 

access only.
• Invisible indicates a hidden file.
• Alias is not useful.
• Name Locked indicates a system file.
• Stationery is not useful.
• Custom Icon is not useful.
• Has bundle 

Label (Icon Color)
The Label condition uses a file or folder’s label 
as a condition. The Label menu or submenu in 

the Finder contains seven labels (and colors, if 
your monitor displays colors or shades of gray) 
and the “None” option. Each checkbox in this 
window corresponds to a specific item position 
in the Label menu and not to the actual color or 
label name. This condition is not useful with 
Windows clients.

Name (Backup Client)
The Backup Client name condition uses the 
name from Retrospect’s client database as the 
condition.

Name (File/Folder)
The File/Folder name condition uses the name 
of the file or folder as the condition. The File 
pop-up menu has three options: “File” matches 
the name of the file, “Folder” matches the name 
of the folder and selects the files immediately 
inside the folder, and “Enclosing Folder” 
matches the name of the folder and selects all 
files within the folder, including files nested in 
other folders.

Name (Sharing)
The Sharing name condition uses file sharing 
owner, group, or login names as the condition. 
This condition is not useful with Windows 
clients.

Name (Volume)
The Volume name condition uses the name of 
the volume as the condition. For Windows cli-
ents, this is the drive label, such as C:, not its 
volume label shown in its properties.

Selector
The Selector condition uses another selector as 
the condition.

Size (File/Folder)
The File/Folder size condition lets you specify 
file or folder size as the condition.
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Special Folders
The Special Folders condition uses certain sys-
tem-defined folders, such as Volume Root, 
Desktop Folder, and Control Panels, as the con-
ditions to be used with local and client volumes. 
The only part of this condition useful with Win-
dows clients is System Folder, which selects the 
active Windows folder.

UNIX
The UNIX conditions work with Linux file sys-
tems. You can specify file and directory 
permissions, as well as the state of Set-User-ID, 
Set-Group-ID, and the sticky bit.

Working with Conditions
Each condition type has its own controls for en-
tering and specifying details for the condition. 
For example, the Name (File/Folder) condition 
window is as follows.

When you add or change a condition it appears 
in the selector detail window.

You can add multiple conditions to a selector by 
choosing other conditions from a  pop-up 
menu. The location of the  pop-up menu de-
termines the relationship between the 
conditions; it may add a condition with the And 
operator or may add a condition with the Or op-
erator. Each pop-up menu has its operator type 
as its first item (though it is grayed out because 

you may not choose it) so you know whether 
you are And-ing or Or-ing a new condition.

The And operator allows you to combine condi-
tions so that a file or folder must meet the 
combined conditions before it is selected. Each 
condition uses an And operator, except each fi-
nal condition of the Include and Exclude areas.

The Or operator allows you to build conditions 
where a file or folder must meet at least one 
condition—but not necessarily all conditions—
before it is selected. The last condition under 
each Include and Exclude area always uses an 
Or operator.

To gain a better understanding of how this 
works, see “Creating a Custom Selector” on 
page 183 and experiment with conditions on 
your own.

Click on this to add an “And” condition to the 
“name” condition.

Click on this to add an “Or” condition to the 
“name” condition.
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Condition Examples
The table below shows an example of a custom 
selector and its effect when applied to some 
files.

Condition Rules
Exclude statements always take precedence 
over Include statements when Retrospect ap-
plies the selector. For example, if a selector has 
a statement which includes the Preferences 
folder and a statement which excludes the Sys-
tem Folder, the files in the Preferences folder 
will not be marked.

Creating a Custom Selector
Retrospect allows you to quickly build selectors 
that can perform sophisticated file and folder 
selection. The best way to learn about custom 
selectors is to create one. In the following ex-
ample, you create a custom selector that 
excludes music files from backup.

Creating a New Selector
From the Retrospect Directory’s Special tab, 
click the Selectors button, then click New. 
Retrospect prompts you to name the new selec-
tor. This example uses “Unwanted music files” 
but you can enter a name of your own.

.

After typing the name, click New. Retrospect 
displays a selector details window for the new 
selector. Notice the window name is the selector 
name.

By default, new selectors include everything 
and exclude nothing, until you add conditions.

Excluding Files
Use the arrow pop-up menu beneath the exclude 
heading to choose the File kind condition. 
Retrospect displays the following window.

Using this Selector On these Files Marks these Files

nothing can survive in a 
vacuum
some things I’d like to say
something for nothing
something more to give

nothing can survive in a 
vacuum
something for nothing
something more to give

nothing noble in your fate
something breaks the silence
something for nothing

something for nothing

Table 9-1: Examples of custom selector conditions and their effects.
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This window lets you specify a file type and/or 
creator as a condition. Select the “Mp3” type 
only, which is likely associated with Quick-
Time Player, then click OK. The selector details 
window now reflects our new condition.

At this point, the selector excludes some MP3 
files on some systems. We are ready to add a 
second condition to exclude more MP3 files.

Use the lowest arrow pop-up beneath the 
Exclude heading again and choose the Name 
(File/Folder) condition type. The Name (File/
Folder) window appears. Change the menus so 
it says, “File name does end with,” then enter 
“.mp3” in the box.

Click OK to return to the selector details win-
dow. At this point, the selector excludes some 
MP3 files on some systems or files ending with 
“.mp3”. 

Because we chose this condition from the low-
est arrow pop-up, Retrospect added the 

condition to the selector with the Or operator. 
Or and And operators are explained on 
page 182.

We are ready to add a third condition. Use the 
arrow pop-up alongside the file kind condition 
to choose the Special folders condition.

By using this pop-up, Retrospect adds the new 
condition with the And operator. The Special 
folders condition details window appears.

Change the menus so it says, “Enclosing folder 
is not Applications,” then click OK. The selec-
tor details window appears with the now-
finished selector.

The multiple conditions work together in the 
finished selector to exclude all files ending in 
“.mp3” and exclude files having the Mac OS 
type “Mp3” which are not in the Applications 
folder. You may now use it in scripts or imme-
diate operations, including browsing. You may 
later edit it to add conditions which further ex-
clude unwanted MP3 music files.

Condition Scroll box of file kinds

Click and hold this arrow button to create the And operator
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Selector Menu
When a selector details window is active, 
Retrospect adds a Selector menu to the menu 
bar. The Selector menu has the following 
commands:

Save: This saves the selector using its current 
name, replacing what was last saved.

Save As: This lets you save the selector using a 
different name. Enter the new name in the dia-
log which follows, then click Save. The original 
selector remains as it was when it was last 
saved.

Revert: Lets you discard your current changes 
to a selector and revert it back to its last saved 
state.

Rename: Lets you change the name of the se-
lector. Enter the new name in the dialog which 
follows, then click Rename.

Check Selector: This lets you test your selector 
by applying it to a volume. Retrospect asks you 
to select a volume for browsing with your selec-
tor. Do so and it opens a browser window with 
the files that match the selector criteria marked 
with checks.

If the correct files are marked, the selector is 
working correctly and you can begin using it for 
immediate operations or in scripts.

If the files that are marked are not the correct 
ones, you need to modify your selector and 
check it again. You may need to add conditions, 
delete conditions, or modify the conditions. Pay 
close attention to the And and Or operators 
which affect the results of your selector. When 
you have finished modifying your selector, save 
it and check it again to see if the correct files are 
now marked. Repeat this process as needed un-
til your selector is working correctly.

Using a Selector
You can easily incorporate built-in or custom 
selectors into your own scripts or immediate op-
erations. Here’s how:

1.  Follow the normal steps to create your script 
or immediate operation. 
2.  In the summary window, click Selecting to 
bring up the selecting window. 
3.  Choose a selector from the pop-up menu, 
then click OK to return to the summary 
window.
4. Close and save your script or execute the 
immediate operation.

The selector will be applied when the operation 
is executed.

Printing a Selector
You can print the contents of selector details 
windows to keep for reference. To print a selec-
tor window, edit the selector and choose Print 
from the File menu.

Modifying a Selector
Any condition that appears in a selector details 
window can be modified. After you modify a 
condition, Retrospect returns to the selector de-
tails window, where you can add new 
conditions or modify existing conditions.

To open a selector from the selectors window, 
click on the selector you want to modify then 
click Edit (or just double-click the selector). 
Retrospect opens the details window for the 
selector.

To edit a selector’s existing condition, select it 
and click Modify, or just double-click the con-
dition line. When a condition is reopened, you 
can modify its options. Click OK to save the 
changes to the condition.

To add a new condition, choose the type of con-
dition you want to add from an arrow pop-up 
menu. A condition window appears, providing 
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options for specifying the type of condition you 
chose. Make the appropriate choices and set-
tings in the window then click OK to add it to 
the selector. The condition window closes and 
the selector window now displays the new 
condition.

Disabling Conditions
At any time, you can disable a condition within 
a selector. When a condition is disabled, it has 
no effect on file selection and will remain inac-
tive until it is enabled. This feature is useful 
when a selector becomes very complex and you 
want to resolve problems by testing parts of it.

To disable a condition open a selector and select 
the condition you want to disable. Click Disable 
and Retrospect disables the selected condition, 
displaying it in grayed out text to identify it as 
inactive.

You can restore a disabled condition by select-
ing the condition and clicking Enable.

Moving Conditions
Within a selector details window, you can move 
a condition by dragging the  button next to 
the condition description and dropping it at a 
new location within the window’s scroll box.

You can drag any condition to a new location, 
either in the same group or another group or 
heading. For example, if you added “file kind” 
as a condition for inclusion under the Include 
heading, you can change the same condition to 
an exclusionary condition by dragging it be-
neath the Exclude heading.

When you move a condition, its outline follows 
the hand cursor, indicating the new location for 
the condition. Release the mouse button when a 
new outline appears in your desired destination. 
After you drop it, Retrospect moves the condi-
tion to the new location, inserting it before the 
outlined destination condition.

To copy the condition, press and hold the Op-
tion key while dragging. Dragging an “or 
matching” heading moves the entire group. Op-
tion-dragging an “or matching” heading copies 
the group.

NOTE: Pay attention to the operator type (And 
or Or) of what you are dragging; moving it may 
change the operator.

Removing Conditions
At any time, you can remove a condition from 
within a selector.

To delete a condition, open a selector and select 
the condition you want to remove. Click Forget 
and then OK to remove the selected condition 
from the window.

Deleting a Selector
If you no longer need a selector you can delete 
it through the selectors window.

To delete a selector, click on it to select it, then 
choose Forget from the Selector menu or press 
the Delete key. A dialog appears, asking you to 
confirm the deletion; click OK. Retrospect de-
letes the selector.

Duplicating a Selector
Sometimes, you will want to duplicate a selec-
tor so that you can make slight modifications to 
fit your needs. For example, you may want to 
modify a copy of one of Retrospect’s built-in 
selectors but leave the original untouched. You 
can make a duplicate through the selectors 
window.

To duplicate a selector, click on the selector to 
select it, then choose Duplicate from the Selec-
tor menu. A dialog appears, providing a field for 
entering a new selector name. Type a new name 
and click New. Retrospect creates an exact copy 
of the selector, using the name you provided in 
the dialog.
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Selector Examples
Following are examples of selectors and expla-
nations of each. 

Backup Selector
This selector excludes cache files and music 
files to save space on the backup media.

A backup selector that excludes cache and music files.

Network Backup selector
This selector marks all user data on Leslie’s cli-
ent computer to be backed up, except for her 
music files. In this example, the backup admin-
istrator knows that Leslie has a lot of music files 
that take up too much space on the backup. This 
selector excludes the music files from getting 
backed up.

A network backup selector that excludes music files on a 
specific client computer.

Restore Searching Selector
This selector searches for PDF documents mod-
ified after the year 2001. This selector is a good 
example of how and/or logic works and shows 
how you often must use multiple conditions to 
select files from different operating systems. 
This example also shows how you can define 
often-used search criteria in a selector so you do 
not have to define the criteria each time you 
want to restore by searching.

Client Restore Searching Selector
This selector searches for a named file that was 
created on a particular client user’s computer. In 
this case, the name of the file is “Dissertation” 
and client’s name is “Neil.” This selector could 
be used during an immediate restore operation.

MAINTENANCE AND REPAIR
This section provides instructions for maintain-
ing and repairing catalogs and media by 
performing the following tasks:

• Updating catalogs that are out-of-date or 
“out of sync”.

• Rebuilding catalogs that are missing or 
damaged. (If it produces “chunk checksum” 
errors, it is damaged.)

• Repairing damaged file backup sets.
• Verifying backup set media integrity to 

confirm that all files are readable.
To perform these tasks, first click the Tools tab 
from the Retrospect Directory.

Updating a Catalog
You should update a backup set’s catalog when 
Retrospect reports a “catalog out of sync” error 
while operating with the backup set. You must 
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update the catalog to synchronize it with the 
media or you will be unable to use the backup 
set.

A “catalog out of sync” error indicates 
Retrospect was unable to update the catalog the 
last time it copied data to this backup set—
possibly because of a crash or power failure. 
This error may also be caused by error –34 (vol-
ume full) or error –108 (out of application 
memory).

NOTE: If, after updating a catalog, you 
continue to get “out of sync” errors when using 
the backup set, do not attempt to repair the 
catalog again. You must skip to new media, 
reset with a recycle or new media backup, or 
create a new backup set. See page 217 for more 
information on the error message.

To Update a Catalog:
1.  Click Repair from the Retrospect 
Directory’s Tools tab.

 

2.  Select Update existing catalog file then click 
OK.

3.  Select the backup set to update then click 
OK. 

4.  If Retrospect cannot find the most recent 
member, it displays a media request window.
5.  Insert the requested media.
Retrospect recatalogs the backup set, informing 
you of its progress with the execution status 
window. When Retrospect is finished with a 
particular member of a backup set it asks whether 
there are any more members.

6.  If there are no more members because you 
have already given Retrospect the final medium 
in the backup set, click No to complete the 
update. 
If there are more members in the backup set, 
click Yes. 
7.  Retrospect continues to ask you for 
additional backup set members until you click 
No or Done. 
The execution status window informs you 
whether the update was successful. If the oper-
ation was not successful, refer to the Operations 
Log for additional information.

Rebuilding a Catalog
You cannot use a backup set unless it has a cat-
alog file, so you should rebuild the catalog 
whenever the original catalog file is lost or dam-
aged. Retrospect can rebuild a catalog by 
reading the backup set media. Rebuilding may 
take a long time, depending on the amount of 
data in the backup set.

To rebuild a catalog:
1.  Click Repair from the Retrospect 
Directory’s Tools tab.
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2.  Select one of the rebuild functions then click 
OK. 
For a tapes, removable disks, or CD/DVD 
backup set, the Media Selection window 
displays.

3.  In the Media Selection window, select the 
most recent member of the backup set.
If you do not have the first member, insert any 
other member of the backup set to be 
recataloged. 
4.  Click OK 
If you are recreating a catalog for a backup set 
that is still known by Retrospect, it asks whether 
you want it to recognize the rebuilt backup set 
instead of the known backup set. Click OK to 
replace the known backup set.
5.  If the backup set is encrypted, Retrospect 
asks for its password. Enter the password and 
click OK.
6.  Specify a location to save the rebuilt catalog 
file and click Save.
Retrospect recatalogs the backup set, informing 
you of its progress in the execution status 
window. When Retrospect finishes recataloging 
a particular member of a tape, disk, or CD/DVD 
backup set it asks whether there are any more 
members to recatalog.

7.  If there are no more members because you 
have already given Retrospect the final medium 
in the backup set, click No to complete the 
recataloging. 
If there are more members in the backup set, 
even if one or more members are lost or 
damaged, click Yes.
8.  Insert the requested member of the backup 
set, or if you do not have it, click Choices.
A dialog asks you what happened to the 
member.

If you have already given Retrospect the final 
medium in the backup set, click Done. If you do 
not have the requested backup set member, or if 
it is damaged, click Missing.
9.  Retrospect continues to ask you for 
additional backup set members until you click No 
or Done. 
The execution status window informs you 
whether the recreation was successful. If the op-
eration was not successful, refer to the 
Operations Log for additional information.

NOTE: After Retrospect informs you the 
recataloging was successful, you should edit the 
scripts that used the backup set and add the 
newly recognized, rebuilt backup set as the 
destination within each script.

Repairing a File Backup Set
The Catalog File for a file backup set is stored 
in the same file as the backup set data. In order 
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to repair a file backup set catalog, you must 
have access to the backup set.

To repair a file backup set: 
1.  Click Repair from the Tools tab in the 
Retrospect Directory.

 

2.  Select Repair file backup set and click OK. 
3.  Browse to the location of the file backup 
set’s catalog file and click Open. 
A message asks you to confirm the backup set 
repair. 
4.  Click Yes to repair the backup set.
5.  If the backup set is encrypted, Retrospect 
asks for its password. Enter the password and 
click OK.
Retrospect recatalogs the backup set, informing 
you of its progress in the execution status win-
dow. If the repair was not successful, the 
execution status window reports any errors. 
You can find more information about the errors 
in the Operations Log.

Incomplete Catalog Repair
Any time you stop a cataloging operation while 
Retrospect is working with the second or subse-
quent member, the following dialog appears.

Revert stops recataloging and allows you to 
continue updating the catalog from the current 

medium later. (To continue later, use the Up-
date existing catalog function.)

Save should be used when you do not wish to 
try to catalog any more data from the current 
medium. All data cataloged so far should be re-
trievable. (To continue later, use the Update 
existing catalog file function.) Recataloging 
will resume with the next medium if there is 
one. If you back up more data to the backup set 
after using this option, Retrospect will ask for a 
new medium, treating this one as full.

NOTE: If you stop Retrospect before it 
completes recataloging an Internet backup set, 
you must later start over to ensure all files are 
intact. (Do not use the “Update existing catalog 
file” repair function.)

Verifying Media Integrity
Retrospect can check all files on your backup 
set media to make sure that they are readable, 
then report files lost or damaged by media fail-
ure. For example, if Retrospect informs you that 
the file you just retrieved is damaged, you may 
want to verify the backup set media to ensure 
that other files are intact.

Verifying media does not mean Retrospect 
compares the files on the media with the origi-
nal files. It only verifies that the files on the 
backup set media are readable.

To verify media integrity:
1.  Click Verify from the Tools tab. 
Retrospect displays the Backup Set Selection 
window. 
2.  Select the backup set to verify and click OK. 
Retrospect verifies the backup set media, 
informing you of its progress in the execution 
status window. 
If the backup set uses recordable discs, 
removables disks, or tapes, Retrospect asks you 
to insert each backup set member as it is needed.
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If you do not have the requested backup set 
member, but have other members of the backup 
set to verify, click Choices, then OK, and insert 
the next requested piece of media.
After verifying the last available member of the 
backup set, Retrospect displays the number of 
files verified. If there are errors, a browser 
displays the files that could not be verified. You 
should examine the Operations Log for 
additional information.
NOTE: Consider backing up unverified files to 
a new backup set.

APPLESCRIPT SUPPORT
This section assumes a knowledge of Apple-
Script. It is intended only for advanced users 
who wish to further automate Retrospect with 
AppleScript. If you want to learn AppleScript, 
read a tutorial book and study the sample scripts 
included with Apple system software.

Due to the complex nature of AppleScript, 
Dantz Development offers only minimal sup-
port for these features.

Installing Apple Event Support for 
Retrospect
When you install Retrospect, a folder named 
AppleScript Utilities is put in the same folder as 
the Retrospect application. This folder contains 
the Retrospect Event Handler script application 
and sample AppleScript scripts you can use or 
examine to help you start scripting Retrospect 
on your own.

NOTE: When updating from an older version 
of Retrospect, you must also update the 
Retrospect Event Handler.
To activate script triggering, you must copy the 
Retrospect Event Handler script application to 
Retrospect’s preferences folder. The path is:

/Library/Preferences/Retrospect/

If you only want to control Retrospect with Ap-
ple events, you do not need to activate script 
triggering.

Installing AppleScript Support for 
Retrospect Client
Retrospect clients running under Mac OS X do 
not support AppleScript.

Under Mac OS 9 and earlier systems running 
AppleScript, the Retrospect client installer plac-
es the Retrospect Client Commands file in the 
Scripting Additions folder in the System Folder. 
(If AppleScript was not running when you in-
stalled, you can rerun the installer and custom 
install these AppleScript items.)

You can Custom Install the Retrospect Client 
AppleScripts folder. It contains sample 
AppleScript scripts you can use or examine to 
help you start scripting the Retrospect Client 
control panel on your own.

Further Automation with AppleScripts
In addition to its built-in scripting and schedul-
ing features, you can also use Retrospect and 
the Retrospect Client control panel with scripts 
created with the AppleScript Script Editor, 
UserLand Frontier, and other Apple event 
scripting utilities. There are three ways to use 
Apple events to script Retrospect and the 
Retrospect Client control panel:

• Retrospect is scriptable, so you can send 
events to Retrospect to initiate various 
operations. For example, you can use an 
AppleScript script to back up a volume, start 
a prepared Restore script, or poll Retrospect 
to see if it is busy.

• Retrospect is attachable, meaning 
Retrospect can trigger scripts to run. For 
instance, Retrospect can run a script that 
quits your database application before a 
backup and starts it again when the backup 
completes. Or it can run a script that sends a 
message to your text pager warning you that 
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the wrong media is in the backup device. 
This is accomplished with the Retrospect 
Event Handler.

• With the Retrospect Client Commands 
scripting addition installed, the Retrospect 
Client for Mac OS 7/8/9 is scriptable. You 
can use scripts to set the preferences and 
scheduling features of the Retrospect Client 
control panel. For example, you can use an 
AppleScript script to adjust the Backup 
Priority during certain hours or to request a 
backup ASAP from Backup Server.

NOTE: When saving scripts, use the syntax-
checking option in your script editor to help 
avoid errors.

Sending Apple Events to Retrospect
You can use Apple events to perform a variety 
of operations, including starting Retrospect 
scripts, finding out what script is running, and 
spontaneously running backups. Following is a 
sample AppleScript script to back up your hard 
disk to a backup set:

tell application "Retrospect"
activate
back up "Local Desktop:Macintosh HD" to 

"Backup Set A"
end tell

Nearly everything you need to know to control 
Retrospect with Apple events is in Retrospect’s 
dictionary and in the sample scripts. (To view 
the dictionary, choose Open Dictionary from 
the Apple Script Editor’s File menu and open 
Retrospect.) Refer to the Read Me file in the 
AppleScript Utilities folder for more informa-
tion about scripting Retrospect and about the 
example scripts.

NOTE: When you use AppleScript to send a 
script name to Retrospect, the capitalization of 
the name must match that of the name as it 
appears in Retrospect.

NOTE: When you refer to a volume or 
subvolume in Retrospect, you must use the 
hierarchy that appears in the volume 
configuration window. For example, to refer to 
a subvolume named “Reports” on the local hard 
disk “Macintosh HD” you would use “Local 
Desktop:Macintosh HD:Reports”.

Using Retrospect to Trigger Scripts
Some events cause Retrospect to send messages 
to the Retrospect Event Handler script applica-
tion, “triggering” it to run one of its handlers. 
The default handlers are surrounded by com-
ment marks so Retrospect’s messages are 
ignored. If you remove the comment marks, the 
handlers will display a dialog as each event oc-
curs, naming the event and in some cases listing 
information about the event. These handlers are 
included only as examples to help you with your 
own scripts.

To make Retrospect trigger your own scripts, 
first copy the handler representing the event that 
triggers your script. Paste it at the top of the 
script, outside the comment marks. (Leave the 
original handler in place, in case you need it lat-
er while debugging your own scripts.) Then 
place your own AppleScript code between the 
handler’s “on” and “end” statements.

NOTE: If you save a copy of the Retrospect 
Event Handler script application by choosing 
Save As from Apple Script Editor’s File menu, 
select both the Stay Open and Never Show 
Startup Screen checkboxes.
The following example AppleScript script quits 
FileMaker Server when Retrospect starts a 
script that backs up the database, and then opens 
the server again when the backup is completed.

on scriptStart given scriptName: theScript, 
startDate: theDate

if theScript is "Back Up Database" then
tell application "FileMaker Server"

force quit
end tell



CHAPTER 9 • TOOLS 193

end if
end scriptStart

on scriptEnd given scriptName: theScript, ¬
scriptErrorMessage: theError, errorCount: 

theErrorCount
if theScript is "Back Up Database" then

tell application "FileMaker Server"
activate

end tell
end if

end scriptEnd

Sending Apple Events to the Mac OS 
7/8/9 Retrospect Client Control Panel

NOTE: Retrospect clients running under 
Mac OS X do not support AppleScript.
You can use Apple events to perform a variety 
of operations, including setting your client pref-
erences and examining the status of your client 
to determine if a backup is in progress. Follow-
ing is an example AppleScript script to turn on 
your client’s Wait At Shutdown preference only 
on Fridays:

on run
set thePreferences to Retrospect Client 

preferences
if "Friday" is in ((current date) as string) then

set wait at shutdown of thePreferences to 
true

else
set wait at shutdown of thePreferences to 

false
end if
set Retrospect Client preferences to 

thePreferences
end run

Nearly everything you need to know to control 
the Retrospect Client control panel with Apple 
events is in the Retrospect Client Commands 
dictionary and in the example scripts. (To view 
the dictionary, choose Open Dictionary from 
the Apple Script Editor’s File menu and open 

Retrospect Client Commands.) Refer to the 
Read Me file in the Retrospect Client Apple-
Scripts folder for more information about 
scripting the Retrospect Client control panel 
and about the example scripts.

E-MAILING BACKUP REPORTS
Retrospect includes AppleScript applications 
which enable Retrospect to send backup reports 
via e-mail. These Retrospect Event Handler ap-
plications are for Microsoft Entourage, Eudora 
6, and Mac OS X’s Mail application.

Requirements
The scripts require access to an SMTP/POP 
mail system through a permanent connection to 
the Internet or via your organization’s intranet.

These setup instructions assume that you have 
already set up the backup Macintosh’s TCP/IP 
software, and that you have access to a DNS 
(Domain Name System) server and an SMTP/
POP mail server on your local area network.

Installation
Retrospect’s installer places the AppleScript 
Utilities folder in the Retrospect folder. Within 
it are additional folders for e-mail applications. 
Open the folder appropriate for your e-mail ap-
plication and copy the Retrospect Event 
Handler into the Retrospect preferences folder. 
The default path is:

/Library/Preferences/Retrospect/

Double-click to run the Retrospect Event Han-
dler and point it to the location of your e-mail 
application on your hard drive, then quit. The 
Retrospect Event Handler launches every time 
Retrospect launches.

Configuring Your Retrospect Event 
Handler
There are four groups of recipients to which the 
Retrospect Event Handler sends e-mail.
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• The Success Group receives mail on 
successful backups.

• The Error Group receives mail if there is an 
error. 

• The Media Request Group is sent mail when 
Retrospect requires a new member to add to 
a backup set and when a media request times 
out.

• The Main Group is sent mail on successful 
backups, any error, any media request, 
Backup Server starts and stops, and script 
starts. It is a superset of the other groups.

Edit the Retrospect Event Handler in 
Retrospect’s preferences folder. Either use your 
favorite script editor, or run the Retrospect 
Event Handler and choose Edit Script from the 
Edit menu. Scroll down to the first property def-
inition and add one or more e-mail addresses to 
each group if desired. Be sure to enclose the re-
cipient’s e-mail address in quote marks and 
separate multiple recipients using commas.

A simple configuration would be to put one user 
account in the main group only as follows:

property kMainGroup : 
{"yourname@yourcompany.com"} 
property kSuccessGroup : {} 
property kErrorGroup : {}
property kMediaRequestGroup : {}

To add two recipients to one group, separate 
with commas:

property kSuccessGroup : 
{"yourname@yourcompany.com", 
"yourboss@yourcompany.com"} 

You can subscribe to all groups, but that’s the 
same as subscribing to the Main Group. When 
you have finished, save the script.

To receive messages when scripts or the Back-
up Server starts, change the property 
sendMailOnStart to true.

Notes on Operation
Backup, archive, duplicate, and restore scripts 
generate one summary message at the end of 
each script. (Immediate operations do not gen-
erate e-mails.) When all volumes in the script 
are completed successfully, a summary is sent 
to the Success and Main Groups. If any errors 
occurred, the summary is sent to the Error and 
Main Groups.

While Backup Server is running, the Retrospect 
Event Handler sends a summary e-mail every 
twelve hours. (If you prefer a different time in-
terval, open the script and change the property 
kSendBackupServerReport value to the desired 
number of hours.) This summary e-mail con-
tains the error and success messages for each 
volume in the Backup Server script. It also con-
tains the error and success messages for regular 
scripts that run while Backup Server is running.

NOTE: When you stop Backup Server, the 
events which occurred after the last summary 
e-mail are not included in an e-mail.
When you have specified a media request time-
out in Retrospect, the Retrospect Event Handler 
sends a reminder e-mail after the media request 
timeout period has expired. (If you did not spec-
ify a timeout the Retrospect Event Handler will 
not send an e-mail.) Also, simultaneously, it re-
news the media request timeout period once. 
Adjust the media request timeout value to give 
you enough time to give Retrospect the media it 
wants, and to avoid sending an e-mail if you are 
already sitting in front of the backup Macintosh 
waiting to give Retrospect its media. These 
messages are sent to the Main and Media Re-
quest Groups.
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This section offers solutions to problems you may encounter with Retrospect and its clients. 
It includes general troubleshooting help, answers frequently asked questions, and 
introduces you to the same troubleshooting techniques Dantz Technical Support uses to 
solve problems.

“Troubleshooting” includes common problems encountered during installation and backup 
and restore operations and offers explanations and solutions. “Common Questions” 
presents frequently asked questions. These questions do not involve error messages and are 
more general than the troubleshooting problems. “Retrospect Error Messages” provides a 
numerically ordered list of error numbers with detailed explanations. “Retrospect Support” 
offers troubleshooting techniques and procedures for getting help.
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TROUBLESHOOTING
Most problems encountered while using 
Retrospect fall into a few general categories. 
Dantz Technical Support follows some basic 
troubleshooting procedures for each of these 
categories. With a little effort, you can learn 
how to troubleshoot many problems on your 
own. This section outlines those procedures and 
shows you the most common problems and 
their treatments.

We recommend that you keep notes of your 
troubleshooting efforts. Even if you are unable 
to resolve a problem right away, your notes can 
establish a pattern of behavior to help us both 
understand the problem. If, after reading this 
section, you find you are still unable to solve a 
problem, try using some of the other Retrospect 
support resources. See see “Retrospect Sup-
port” on page 232.

Troubleshooting Road Map
The first step in troubleshooting a problem is to 
isolate the problem by identifying exactly when 
and where it occurs. Knowing when an error oc-
curs gives you a fixed point of reference to help 
you solve a problem. Retrospect has different 
phases of operation. For example, a backup typ-
ically includes scanning, matching, copying, 
and verification phases in that order. If you can 
determine the problem happens while matching, 
you are on your way toward solving it. The sit-
uations described over the next several pages 
are listed in the likely order in which they would 
occur.

Client Configuration Issues

A TCP/IP client in the local subnet or in 
another Retrospect-configured subnet 
does not appear in Retrospect’s clients on 
network window, or appears 
intermittently.
Use the Test button in the Backup Clients on 
Network window to see if the client is on the 
network.

Open the Retrospect Client control panel on the 
client computer and check whether the client 
software was loaded at startup and whether it is 
turned on. Check that its status field says 
“Ready” or “Waiting for first access.” If it is a 
Mac OS client check that it is actually a TCP/IP 
client and that it does not say “AppleTalk” next 
to its version number.

Make sure the client database window does not 
show a client with exactly the same name as the 
client you are looking for. If it does, select this 
client and choose Forget from the Clients menu.

Make sure the client computer is connected to 
the network and its network settings are correct.

Should these measures not work, see “Pinging 
to Verify TCP/IP Communication” on 
page 206. If the backup computer and client 
ping successfully yet the client still does not ap-
pear, your network may not fully support 
TCP/IP and UDP. Passive networking hard-
ware, such as hubs and bridges, may not 
forward network information Retrospect needs 
to work with TCP/IP clients.

After taking the appropriate measure you may 
log in the client.

A TCP/IP client outside the local subnet 
does not appear in Retrospect’s clients on 
network window.
The clients on network window lists only cli-
ents in the same physical subnet as the backup 
computer and in other subnets you have config-
ured Retrospect to search.

To configure Retrospect Workgroup or 
Retrospect Server to search for clients outside 
the local subnet, choose Configure Subnet 
Broadcast from the TCP/IP menu (page 103).

To add a single client from another subnet to the 
list with Retrospect Workgroup or Retrospect 
Server, click the Add by Address button 
(page 104) then enter its IP address or name.



CHAPTER 10 • PROBLEMS AND SOLUTIONS 197

The Add by Address button fails to 
connect with the client at the specified IP 
address or name.
Make sure the client computer is connected to 
the network and its network settings are correct.

Open the Retrospect Client control panel on the 
client computer and check whether the client 
software was loaded at startup and whether it is 
turned on. Check that its status field says 
“Ready” or “Waiting for first access.”

Make sure the IP address you are using is cur-
rent. If the client is using dynamic IP addressing 
its IP address may have changed. It is not a good 
idea to use Add by Address with a dynamic ad-
dress unless it has a long-term lease. Use the 
Subnet Broadcast method instead.

If you are using the client’s IP name try using its 
IP address.

Ping the computers to check whether they are 
correctly communicating with TCP/IP. See 
“Pinging to Verify TCP/IP Communication” on 
page 206.

There may be a “firewall” between the client’s 
network and the backup computer’s network, 
restricting outside access. Contact the network 
administrator.

The Add by Address button added the 
wrong client.
Make sure the IP address you are using is cur-
rent. If the client is using dynamic IP addressing 
(for example, DHCP) its IP address may have 
changed. Use the Subnet Broadcast method in-
stead. Also see “Common Questions” on 
page 207.

Mac OS clients have conflicting IP 
addresses because they don’t renew 
DHCP leases while waiting for shutdown.
When a Mac OS Retrospect client has a DHCP-
supplied IP address and its lease expires while 
the client is waiting for shutdown, the Mac does 
not renew its IP lease and continues using its old 

IP address. This can lead to a conflict when the 
DHCP server, thinking the IP address is now 
available, leases the IP address to a different 
computer.

There are two possible workarounds: leave 
DHCP-served Mac OS computers idle in the 
Finder instead of in the Retrospect client “Wait 
at Shutdown” mode and uncheck “Load Only 
When Needed” in the TCP/IP control panel; or, 
lengthen your DHCP server’s lease period. The 
likelihood of encountering this problem de-
creases as the length of DHCP leases increases.

Backup Issues
Immediate backups and scripted backups differ 
in the way they are started and what they do 
when they are done. Otherwise, both follow the 
same procedure after starting: scanning, match-
ing, requesting media, copying, comparing, and 
then closing.

Retrospect fails to automatically launch to 
execute a scheduled script.
There are a few reasons why this can happen:

• Confusion About Start Date: The date you 
expect a script to run may not be its actual 
start date. See “Common Scheduler 
Elements” on page 74.

• Incorrectly Scheduled Script: Check the 
list of future scripted operations to confirm 
that Retrospect has the same schedule you 
expect your scripts to run. To do this, click 
Preview from the Retrospect Directory’s 
Automate tab. Check that you have not set a 
limited schedule of possible execution times 
with the Schedule preference (page 161).

• Autolaunch Preference Not On: Check 
that the Notification preference to 
automatically launch Retrospect (page 160) 
is turned on.



198 RETROSPECT USER’S GUIDE

Retrospect crashes while it is being 
launched.
The Retro.Config file may be damaged. Move 
the Retrospect folder out of the Library/Prefer-
ences folder. Try launching again. If this solves 
the problem, place that suspect Retrospect fold-
er in the Trash after pulling out the Operations 
Log file so you can retain the history. 
(Retrospect creates a new folder and uses the 
default settings.) If you have a recent backup of 
this drive and you do not want to recreate your 
scripts and settings and log in clients again, try 
restoring an earlier version of the Retro.Config 
file from a backup.

Retrospect reports an error during 
scanning or matching.
There may be a problem with the volume being 
scanned. In this case, Retrospect reports a spe-
cific error in the Operations Log. 

Look up the error number under “Retrospect Er-
ror Messages” on page 217.

In a normal backup Retrospect marks 
every file for copying, though not all have 
changed.
This happens on HFS+ (Mac OS extended for-
mat) volumes for one of two reasons.

When the local time zone is changed in the Date 
& Time control panel, the Mac OS shifts the lo-
cal creation and modification times of files on 
HFS+ volumes. This affects Retrospect’s nor-
mal backups when it scans the volumes for files 
which need to be backed up. Because file 
date/time stamps are different, Retrospect 
marks every file for backup. Retrospect is sim-
ply performing an IncrementalPLUS backup as 
it usually would; the only abnormality is that 
every file appears to have been modified. As a 
workaround, you can change the time zone 
back.

This happens with servers backed up as mount-
ed volumes when the system clocks of the 
server and the backup Macintosh are not syn-

chronized within a certain range, the server 
compares the two system clock times and per-
forms a time translation based on the 
differences. This affects Retrospect as de-
scribed above. Synchronize both the backup 
Macintosh’s clock and the server’s clock with 
their respective appropriate control panels, to 
within the acceptable margin.

Retrospect does not see the backup 
device.
If your device is a removable disk drive (such as 
Zip, Jaz, SuperDisk, DVD-RAM, or MO), 
check that the media is fully inserted and that 
the volume is mounted on the Macintosh desk-
top. Retrospect may not recognize a DVD-
RAM drive unless it is loaded with writable 
media.

If you are using a FireWire or USB hard disk as 
part of a removable disk backup set, make sure 
to turn on the preference to enable this. See 
“Media Handling Preferences” on page 159.

See “General Device Troubleshooting” on 
page 203 and the bus-specific device trouble-
shooting sections which follow it.

A tape or CD/DVD drive does not appear in 
the storage devices window or media 
request window.
Check Device Status (from Configure> 
Devices). If a non-Retrospect driver appears in-
stalled for your tape drive, some other software 
loaded its driver inappropriately. Determine 
which other device driver is loading and disable 
it.

All devices should be connected before launch-
ing Retrospect. Verify the drive is properly 
connected and terminated then make sure it is 
turned on. If other devices on the communica-
tions bus are off, turn them on and restart.

If you have a new drive model, it may not be 
supported by the version of Retrospect you are 
using. To find out if a newer version of 
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Retrospect is required for this drive, refer to the 
Dantz web site.

See “General Device Troubleshooting” on 
page 203 and the bus-specific device trouble-
shooting sections which follow it.

Retrospect can’t use the inserted disk, 
tape, or disc because it is “busy.”
There are several possible causes.

• You saved the removable disk backup set 
catalog on a disk that is a backup set 
member. Catalogs must be saved on 
different volumes. Move the catalog to your 
hard disk and double-click on it from the 
Finder to force Retrospect to recognize it.

• You are using the disk as both a source and 
destination, which is illogical and not 
allowed. For example, you are trying to back 
up the 2-Dunsinane volume to the 
Dunsinane backup set, of which 
2-Dunsinane is a member.

• Some other software may be creating or 
using files (which may be invisible) on your 
backup disk. Likely suspects are 
compression programs and file sharing; see 
the Retrospect “read me” file for conflicts 
and workarounds.

• The drive may be malfunctioning. Contact 
the drive vendor for assistance.

• The disk, tape, or disc may be damaged. 
Designate it as missing and use a new 
medium.

Retrospect refuses to use the inserted 
disk, tape, or disc.
Retrospect has a system for recognizing tapes, 
discs, and disks and for adding them to backup 
sets. If Retrospect is not automatically using the 
medium you think it should, carefully read the 
text that appears in the media request window. 
It explains what media Retrospect needs. 

You may not have inserted the exact disk, tape, 
or disc required by Retrospect. Check that the 

name of the medium you are inserting exactly 
matches the requested name. If the name is the 
same and Retrospect does not proceed with the 
operation when you insert the medium, you 
probably have two pieces of media with the 
same name and are inserting the wrong one. 
This can happen if you switch disks, tapes, or 
discs when you perform a recycle backup to a 
particular backup set.

Retrospect may require new media. Insert the 
medium you want Retrospect to use, wait for it 
to appear in the window, and then click 
Proceed. Retrospect will not use media that is 
part of a known backup set, as detailed below. It 
will automatically use any media that is erased 
or correctly named.

Retrospect asks for a new disk, tape, or 
disc, but then complains “You can’t use 
‘1-Birnam Wood’, it already belongs to a 
backup set!”
This is a feature designed to prevent accidental 
erasure. If you are sure you want to erase this 
disk, tape, or disc and use it for the current back-
up, choose Erase from the Devices menu, then 
click Proceed if necessary. Erasing the medium 
removes the entry for this disk, tape, or disc from 
the backup set it previously belonged to.

Retrospect asks for a particular disk, tape, 
or disc, but then reports “‘2-Dunsinane’ is 
not a member of this backup set. Although 
it is named correctly, it has a different 
creation date.”
This means you have more than one disk, tape, 
or disc with the same name. This can happen if 
you run a recycle backup to new media and later 
try to do a normal backup with older disks, 
tapes, or discs. If possible, locate the proper me-
dium for the restore.

Try other disks, tapes, or discs to see if any 
match the catalog you are using.

If you are sure this disk, tape, or disc has the 
files you want, rebuild its catalog. Go to the 

http://www.dantz.com/index.php3?SCREEN=compatibility_list


200 RETROSPECT USER’S GUIDE

Tools tab, click Repair, and select the appropri-
ate repair function to rebuild the catalog (see 
“Rebuilding a Catalog” on page 188).

Retrospect asks for a particular disk, tape, 
or disc, but you do not have it.
If you know where it is, but it is not available 
right now and you must back up, follow these 
instructions. Click Choices, then click Skip. 
Retrospect treats the requested member as if it 
were full and backs up to a new piece of media. 
Files previously backed up to the requested 
member are not backed up again. Future back-
ups will require the new member and you will 
need to use both members later if you need to 
restore.

Once you click Skip, you will not be able to take 
advantage of the remaining free space (if any) 
on the skipped member.

If you know it is lost, damaged, or erased, fol-
low these instructions. If this is the first member 
of the backup set, it is easiest to start a new 
backup set or run a recycle backup to this back-
up set. Either way, Retrospect asks for a new 
disk, tape, or disc, which becomes the new first 
backup set member. If this is not the first mem-
ber and you wish to continue backing up to the 
members you do have, click the Choices button, 
then click Missing. Retrospect will start back-
ing up to a new disk, tape, or disc. Files that 
were backed up to the missing member will be 
backed up again, if possible, during your next 
IncrementalPLUS backup.

Retrospect reports a catalog out of sync 
error at start of backup.
Update your catalog from the media. 

See “Updating a Catalog” on page 187.

Retrospect reports a chunk checksum 
error.
If the error occurs only with a particular backup 
set, repair its catalog and try again. 

See “Updating a Catalog” on page 187.

Retrospect reports verification errors.
If Retrospect reports “different modify 
date/time…” for a particular file, the most likely 
explanation is that the file was modified during 
the backup. In this case, no action is required. 
When you next back up, Retrospect will re-copy 
the file.

Errors such as “File … didn’t compare at data 
offset…” or “File … didn’t compare at resource 
offset…” usually indicate a device communica-
tion problem. Back up again to re-copy the file.

Note, however, that these “offset” error messag-
es usually point to serious data corruption 
problems you should not ignore. If the error oc-
curs with many or all sources, including clients, 
or with a source connected to the backup com-
puter itself, troubleshoot its communications 
bus and device connections. If the error occurs 
only on a particular source being backed up 
over the network, troubleshoot the communica-
tions bus of that computer and possibly the 
network connection to that computer. 

See “General Device Troubleshooting” on 
page 203 and “Network Troubleshooting Tech-
niques” on page 206. Consider using diagnostic 
software on affected volumes.

When it has finished executing an 
operation, Retrospect does not quit, 
restart, or shut down according to the 
Unattended preference.
Retrospect quits, restarts, or shuts down when it 
finishes only if it is executing an operation in 
unattended mode and no additional operations 
are scheduled within the look-ahead period 
(page 160). 

Retrospect automatically enters interactive 
mode when you start an immediate operation 
and unattended mode when you start a script. 
While Retrospect is copying, use the Control 
menu to switch between modes.
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A Mac OS 9 client does not shut down 
after the backup.
Retrospect shuts down Mac OS 9 client com-
puters when all three of the following 
conditions are met.

• The Shutdown when Done option is enabled 
in the client options of your script. (This is 
the default.)

• The client is displaying the “waiting for 
backup” dialog.

• The client Macintosh is not scheduled for 
another backup within the Look Ahead 
Time (page 160).

Retrospect is not backing up a particular 
client volume.
Check that your backup script includes the vol-
ume as a source.

Make sure the client volume is not designated as 
private (page 106).

Make sure the client’s volume is mounted for 
use with the client computer. (Under Mac OS, 
the volume icon is on the desktop; under Win-
dows, the drive letter is accessible.)

Use the client container as the source, rather 
than specific client volumes, to select all vol-
umes connected to the client. Then go to 
Configure>Clients, configure the client in ques-
tion, and choose Client Desktop from the pop-
up menu. 

For more information about using client con-
tainers see “Configuring Clients” on page 96.

The client crashes during the backup.
Failing network hardware, a virus, or a software 
conflict may be causing the client to crash. Use 
diagnostic utilities to look for viruses and hard 
disk problems. If it is a Mac OS 9.x or prior cli-
ent, refer to the system extensions 
troubleshooting techniques on page 207. Use 
the latest network software which matches your 
network hardware.

Backup Server Issues

Backup Server indicates “media,” but 
there is a medium in the drive.
Backup Server is reporting it needs a specific 
media member to back up a source. To deter-
mine which backup set needs more media, 
choose backup sets from the pop-up menu in the 
Backup Server status window and look for any 
with a status showing “media.”

If you have never backed up to the backup set 
that needs media, Retrospect accepts any new or 
erased medium. Stop the Backup Server, use 
Configure>Devices to erase the disk, tape, or 
disc you want to use, then start the Backup 
Server again.

If you still cannot determine why Backup Serv-
er isn’t accepting your medium, start a backup 
to that backup set using Immediate>Backup. 
Retrospect displays a window naming the medi-
um being requested.

Retrospect does not quit when Backup 
Server completes its backups.
Backup Server is optimized to run continuous-
ly. If you have other kinds of scripts, they will 
start at their scheduled times even though 
Backup Server is still running.

If you schedule the Backup Server to run only 
part of the time (for example, from 7:00 A.M. 
until 7:00 P.M. each day), you can quit 
Retrospect after the Stop time without affecting 
the Backup Server. Retrospect will automatical-
ly launch when the next script is scheduled to 
start.

The Retrospect Client control panel’s 
Backup Server Schedule was set to “As 
soon as possible” but the client was not 
immediately backed up.
The “As soon as possible” preference waits for 
the Backup Server to poll the client; the client 
does not initiate contact itself. Meanwhile, 
Backup Server may be busy backing up other 
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sources or polling other clients; it may even be 
inactive, according to its schedule. When 
Retrospect gets around to polling the client set 
to ASAP, it backs it up. 

See “Allow Early Backups” on page 84.

Restore Issues
When you start a restore, you first select the 
backup set from which you are restoring. 
Retrospect then goes through the following 
stages: selecting a volume (specifying where 
the files are going), matching or selecting files, 
requesting media, copying, and setting privileg-
es if necessary.

You have problems selecting a backup 
set.
If your backup set is not in the list, click the 
More button. Click Open if the catalog for your 
backup set is available, or click Rebuild to re-
build it from the media.

If Retrospect reports a chunk checksum error 
after selecting a backup set, see “–24201 (chunk 
checksum failed)” on page 222.

You have a disk, tape, or disc that you 
want to restore from, but you do not see its 
backup set in the selection window.
Use the Finder to look for the backup set catalog 
file on your hard drive. It will have the same 
name as the disk, tape, or disc in Retrospect’s 
storage devices window. For example, if the 
medium is named “1-Macduff” look for a cata-
log file named “Macduff”. Double-click the 
catalog file to show Retrospect where it is.

If you cannot find the catalog file on your hard 
drive, go to the Tools tab, click Repair, and se-
lect the appropriate function to rebuild it 
(page 188).

You cannot find the files you want to 
restore.
If you are using “Restore files from a backup,” 
be sure the Snapshot you select is for the right 

volume. By default, the chosen files preview 
browser shows your files and folders in alpha-
betical order, organized as they were on the 
backed-up hard disk. Once you find the file you 
want, double-click it to mark it for retrieval. If 
you cannot find your file, select Find from the 
Browser menu to search by name or other at-
tributes. A file with a  poof icon indicates the 
file is on a missing member of the backup set.

If you are restoring older versions of files, use 
“Search for files and folders.” Click Searching 
to tell Retrospect to look for a particular file or 
folder name, and if necessary click More 
Choices to use Retrospect’s selector interface 
for finding files. 

See “Restore” in Chapter 4 and “Using Selec-
tors” in Chapter 9. 

While retrieving an older Snapshot from 
media, Retrospect says no Snapshot is 
available.
There are three possible causes:

• You cancelled the backup before it was 
completed. Retrospect does not save a 
Snapshot for a volume until the backup is 
finished.

• You turned off the “Save Source Snapshot 
for Restore” option (page 145).

• You are trying to retrieve a Snapshot from a 
backup set created by a backup set transfer. 
Transferred backup sets have no Snapshots 
on the media.

Retrospect refuses to use the inserted 
disk, tape, or disc, reporting it is named 
correctly but has a different creation date.
This means that you have more than one disk, 
tape, or disc with the same name. This can hap-
pen if you run a recycle backup to new media 
and then try to restore with older disks, tapes, or 
discs. If possible, locate the proper medium for 
the restore.
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Try other media to see if any match the catalog 
you are using.

If you are sure this disk, tape, or disc has the 
files you want, rebuild its catalog. Go to the 
Tools tab, click Repair, and select the appropri-
ate repair function to recreate the catalog. (See 
“Rebuilding a Catalog” on page 188.)

Your Macintosh hangs or crashes while 
copying during restore.
This is the same as hanging or crashing while 
copying during backup. Repeat the operation 
with system extensions turned off or minimized 
to determine if the problem is a software or 
hardware problem, then refer to “Troubleshoot-
ing Mac OS Clients” on page 207 and “General 
Device Troubleshooting” on page 203.

Retrospect reports error –34 (disk full) 
while copying.
This error means the volume you are restoring 
to does not have enough space for the files you 
are restoring. You will need to manage your 
disk space by moving or deleting files, or avoid 
the problem by marking fewer files to restore. If 
you are restoring a volume that was using a 
compression utility, you may need to restore 
your files in batches and use your compression 
utility between restores to make room for the 
next batch of files.

After restoring, Mac OS file sharing 
privileges are not set.
Retrospect will only set the privileges for the 
server if sharing is active. (Note that sharing 
also had to be on during backup.) Turn on shar-
ing and restore again. (See “Restoring a 
Mac OS Server Client” on page 125.)

After restoring a Mac OS 9.x or prior 
computer, documents have generic icons 
in the Finder.
The Macintosh Desktop needs to be updated af-
ter a large restore. Restart the Macintosh while 
holding down the Command and Option keys to 
rebuild the Desktop.

After restoring a backup to a new 
Macintosh hard disk, the volume icon on 
the Finder Desktop is no longer custom. It 
is now generic.
Restart the computer.

You can’t retrieve or restore data to a 
client.
Take the following steps:

1.  Attempt to access the client. From the client 
database, select the client and select Get Info 
from the File menu to check whether the client 
can be accessed. Make sure the client status is 
not locked.
2.  Go to Configure>Volumes, select the 
volume to which you wish to restore data, and 
choose Get Info from the File menu. Make sure 
the volume has enough free space to 
accommodate the files you want to restore, and 
that there is no lock symbol on the Attributes 
line. (If there is no Attributes line it is not 
locked.)
If you are sure that the volume to which you are 
restoring data is both unlocked and has free 
space but you still experience difficulty restor-
ing, refer to Chapter 7 • Disaster Recovery for 
general assistance.

Recreating an Internet Backup Set
When you rebuild an Internet backup set cata-
log Retrospect may immediately show 
“resynchronizing (slow)” in the execution sta-
tus window. This is because the backup set is 
encrypted and when you began the repair oper-
ation one of the following was true:

• You neglected to tell Retrospect the backup 
set is encrypted.

• You gave Retrospect an incorrect password 
for the encrypted backup set.

General Device Troubleshooting
Check with your drive vendor to make sure you 
have the necessary firmware for your device. 
Retrospect lists a drive’s firmware version in its 
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Device Status window (from Configure>Devic-
es). If there is a known problem with a firmware 
version, it will be listed on the Dantz web site.

• Completely uninstall any other backup 
software that may be on your machine, 
including any drivers other software may 
have loaded for the device.

• Verify the device cables are solidly 
connected to their proper ports.

• Make sure the drive’s power switch is turned 
on and its power cables are plugged in.

• If other devices on the communications bus 
are off, turn them on and restart.

• Use a new piece of media to see if the 
problem is related to a faulty or damaged 
medium.

• Check to make sure you are using the correct 
type, length, speed, or capacity media. 
Follow your drive manufacturer’s list of 
supported media.

• Use a different brand of media because the 
drive may be particular about the brand. 
Follow your drive manufacturer’s 
recommended list of media brands.

• If you are using a tape drive, clean the heads 
with a cleaning cartridge. Follow your drive 
manufacturer’s recommended cleaning 
instructions.

• Replace the cable that connects the device to 
the computer.

If none of these general suggestions solves your 
problem, troubleshoot your drive with the spe-
cific FireWire, USB, ATAPI/IDE, or SCSI 
suggestions which follow.

FireWire and USB Device 
Troubleshooting
If you’re having problems with FireWire or 
USB devices it could be due to a number of 
issues.

Hardware Issues
• Isolate the device. Another device on the 

chain may be interfering with the backup 
device’s communication. If your backup 
device is connected to your computer 
through a hub or another FireWire/USB 
device, unplug it and connect it directly to a 
port on the computer. If it is already 
connected directly to the computer, try 
changing ports. If the problem persists, do 
not reconnect the other devices, and 
continue down the checklist.

• You may have a bad cable. Replace the cable 
that connects the device to the computer.

• The system board or FireWire/USB adapter 
in the computer may be having a problem. 
Install Retrospect on another computer, if 
available, and try the device there as the only 
device.

Media Issues
• Try a new piece of media to see if the 

problem is related to a faulty or damaged 
medium. If applicable, try using a different 
brand of media. Often drives are picky 
regarding the brand of media. Follow the 
manufacturer’s recommended list of brands.

• If you are using a tape drive, clean the heads 
with a cleaning cartridge.

Firmware/Software Issues
• Check to make sure you have the latest USB 

or FireWire firmware update for your 
computer. Hardware vendors often release 
firmware updates that may help to resolve 
USB or FireWire issues. Search the vendor 
web site for Updates. Retrospect lists the 
current firmware of the drive that you are 
using in the version column of the Device 
Status (or Environment) window. If there is 
a known problem with a firmware version, 
this will be listed on the Dantz web site.

• Update or reinstall the FireWire and USB 
adapter drivers. Corrupt drivers can cause 

http://www.dantz.com/support
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issues that may not be otherwise detectable. 
Check the manufacturer’s or vendor’s web 
site for updated drivers.

• Completely uninstall any other third-party 
backup software that may be on your 
machine, including any drivers that software 
may have loaded for the device.

If you have investigated all the issues listed 
about and still get failures on new media, then 
the backup device itself may be defective. Con-
tact your drive vendor for further diagnostics, 
tests, or to inquire about repair or replacement.

ATAPI/IDE Device Troubleshooting
For an internally connected device, make sure 
the cable is firmly connected and it is correctly 
set as either the master or slave device.

SCSI Device Troubleshooting
If the SCSI chain is not set up properly, commu-
nication errors may cause data corruption or 
system failures during copy operations. The fol-
lowing information is designed to give you 
guidance when you encounter SCSI problems. 

See also “SCSI” in Chapter 3, your SCSI card’s 
user guide, and the manual that came with your 
hardware device.

These sample errors can indicate communica-
tion errors on a SCSI bus:

• File “Home” didn’t compare at resource 
offset 10,750

• File “Tech Note” didn’t compare at data 
offset 3,253

• Trouble reading: “1-Office Backup 2” (0), 
error 102 (trouble communicating)

• Trouble writing: “1-Macbeth” (0), error 205 
(lost access to storage medium)

These errors can usually be traced to a failure in 
the SCSI configuration. The most common 
cause of SCSI bus communication problems is 
card or driver incompatibility. See the Dantz 

web site for more information on compatible 
SCSI cards.

Other common causes of SCSI bus communica-
tion problems are improper termination and/or 
bad SCSI cables. Try changing terminators, us-
ing a powered terminator, changing cables, 
isolating the device on the SCSI chain, and 
moving the device to a different computer. If it 
is a tape drive, clean its heads and if cleaning 
does not work, try different kinds of tapes.

Termination
The general rule for termination is to use only 
two terminators on the SCSI bus; one at the be-
ginning and one at the end. If you have only a 
single device on the SCSI bus, then only one 
terminator is needed because your SCSI card 
should have built-in termination. Some SCSI 
peripherals come with internal termination built 
in, and must be placed at the end of a SCSI 
chain.

Consult your computer’s user guide for its spe-
cific termination requirements. 

SCSI Cables
Communication problems can be caused by bad 
or loose-fitting SCSI cables. Check all cables to 
ensure they are properly seated in each connec-
tor. The entire length of your SCSI bus should 
not exceed 20 feet. Whenever possible, try to 
use short (12 to 36 inches) cables and avoid ca-
bles over six feet in length.

Device Order and Device Conflicts
To avoid problems caused by device order or 
device conflicts, make sure that each device has 
a unique SCSI address. To see the SCSI address 
of every device, go to the Configure tab and 
click Devices. Then choose Device Status from 
the Devices menu to view all of your SCSI de-
vices. You may print this window for future 
reference. If problems occur (for example, a de-
vice does not appear that you know is turned on 
and connected), try changing the order of SCSI 

http://www.dantz.com/index.php3?SCREEN=kbase&ACTION=KBASE&id=27381
http://www.dantz.com/index.php3?SCREEN=kbase&ACTION=KBASE&id=27381
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devices or temporarily removing unneeded de-
vices. Recheck that each device has a unique 
SCSI ID.

Some devices, such as scanners and removable 
disk drives, can cause communication failures 
on the SCSI bus, especially if they are turned 
off. If you are experiencing SCSI communica-
tion problems, make sure all of your SCSI 
devices are turned on when you use your com-
puter. Even if you are not experiencing SCSI 
problems, we highly recommend you turn on all 
SCSI peripherals before starting the computer. 
Do not turn them off until after you shut down 
the computer.

When All Else Fails
If you have taken all of the preceding general 
and SCSI-specific troubleshooting steps but 
you still get failures or errors, then the backup 
device may be defective. Contact your drive 
vendor for further diagnosis and tests, or to ar-
range repair or replacement.

Network Troubleshooting Techniques

Pinging to Verify TCP/IP Communication
Use the Test button in the Backup Clients on 
Network window to see if Retrospect can con-
nect to a computer on the network via TCP/IP 
and communicate with the client software.

Click Test and enter an IP address or DNS 
name. If Retrospect reports error 541, it con-
nected to a computer at that address, but no 
client software responded. If it reports error, -
1028, Retrospect could not even connect to the 
computer. Other errors may indicate network 
and TCP/IP configuration trouble and you 
should “ping” the backup computer and client 
computer from other computers to check wheth-
er they are communication with TCP/IP.

On Mac OS X, click the Ping tab on the Net-
work Utility (located in /Applications/Utilities).

Windows computers configured for TCP/IP 
have built-in ping commands. From a TCP/IP 
Windows computer on your network, go to the 
MS-DOS command prompt and type “ping” 
followed by a space and the IP address.

Mac OS 9.x and prior does not include a ping 
utility, but you can obtain a ping-capable utility 
from the Internet. Such utilities include 
iNetTools (www.wildpackets.com), 
IPNetMonitor (www.sustworks.com), 
Interarchy (www.interarchy.com), OTTool 
(www.neon.com), and WhatRoute 
(homepages.ihug.co.nz/~bryanc).

NOTE: TCP/IP must be loaded when you ping 
a Mac OS 9 computer. To ensure it is loaded, 
open the TCP/IP control panel, un-check the 
option “Load only when needed” (available 
only in Advanced and Administrator modes) 
and restart.
Using an IP pinging utility on the troublesome 
client computer or FTP server, first ping the IP 
address of the backup computer. A reply tells 
you the pinged computer’s TCP/IP setup is op-
erational. If it times out or reports it as 
unreachable there is a problem with the TCP/IP 
setup, the network interface hardware, or the 
network itself.

If pinging the backup computer is successful, 
use it or another computer to ping the IP address 
of the troublesome client computer or FTP 
server.

Selecting the Appropriate Network Driver
Windows client computers should be using 32-
bit network drivers for best network perfor-
mance and compatibility. Windows NT, 2000, 
and XP use 32-bit network drivers by default. 
For Windows 95/98/Me, open the Network con-
trol panel and select the computer’s network 
interface adapter. Click the Properties button, 
select Enhanced mode, and click OK. You may 
need to get updated software from your network 
adapter vendor.

http://www.wildpackets.com
http://www.sustworks.com
http://www.interarchy.com
http://www.neon.com
http://homepages.ihug.co.nz/~bryanc
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Verifying Open Transport Version
To work with TCP/IP, Mac OS 9.x and prior 
clients must have Open Transport version 1.1 or 
later. Each computer’s TCP/IP control panel 
should be set to always load, as described 
previously.

NOTE: Mac OS X clients do not require Open 
transport.

Troubleshooting Networks
When you have network problems with 
Retrospect or clients, start by identifying a pat-
tern of failure. If the problem occurs on a single 
client, begin your troubleshooting by examining 
that particular computer. If the problem occurs 
on multiple client computers, find out if those 
computers share a common hub, router, bridge, 
or gateway. You may be able to identify a faulty 
network component that should be repaired or 
replaced. If you encounter failures on multiple 
client computers but cannot identify a pattern, 
troubleshoot the networking hardware on the 
backup computer.

Troubleshooting Mac OS Clients
When troubleshooting an individual Macintosh, 
the first step is to determine whether the prob-
lem lies with the Macintosh’s software or its 
network hardware. The following information 
describes how to troubleshoot Mac OS 9.x and 
prior clients.

For detailed information on troubleshooting 
Mac OS X clients, read “I can’t see an OS X cli-
ent on my network. What can I do?” in the 
Dantz Web site Knowledgebase.

Start by limiting extensions and control panels 
on the client Macintosh to the Retrospect Client 
control panel, needed networking software, and 
minimal default Apple system software. Do this 
with the Extensions Manager.

If the client continues to experience the prob-
lem, there may be an incompatibility with 
networking software. If the client has a third 

party networking card, update to the latest ver-
sion of its software. If the client uses its built-in 
Ethernet, get the latest version of Apple’s net-
work software installer or Open Transport, 
available from the Apple Software Update web 
site.

If the client continues to experience the prob-
lem, exchange the network hardware with that 
of another client Macintosh. Whether it uses 
built-in Ethernet or an Ethernet adapter card, it 
is sufficient to exchange all components exter-
nal to the Macintosh. If the Macintosh has an 
internal network card, you will need to ex-
change the card as well. Make sure to exchange 
the cables along with the other components. Af-
ter exchanging the network hardware, try an 
operation with both clients. If the error moves to 
the other client, then the problem lies in the net-
work hardware.

If the problems persist after minimizing exten-
sions and exchanging network hardware, 
performing a clean installation of the System 
software.

COMMON QUESTIONS
This section answers common questions about 
setting up and configuring Retrospect Clients, 
backing up files locally and over the network, 
backup sets, catalogs, devices, and media.

Client Configuration Questions

How do I find out the IP address of a client 
so I can log it in with Add by Address?
It depends on the operating system and how the 
client computer is configured. If the client has a 
static IP address you can use it in the Add by 
Address dialog. However, if the client automat-
ically obtains a dynamic IP address from a 
DHCP server you probably should not be using 
the Add by Address button. Dynamic IP ad-
dresses may change later and Retrospect may 

http://www.dantz.com/knowledgebase
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find a different machine at that address if you 
used Add by Address with a dynamic IP address.

Here’s how to determine a computer’s IP ad-
dress and whether it is static or dynamic.

Mac OS: Open the TCP/IP control panel (OS 
9.x or prior) or Network preferences 
(Mac OS X) on the client. It shows the “IP Ad-
dress” the computer is currently using. Above 
the IP address is the Configure pop-up menu. If 
it shows “Using DHCP Server” it is a dynamic 
address. If it shows “manually” it is a static 
address.

Windows 95/98/Me: From the Run dialog or 
the DOS prompt, enter WinIPcfg, which shows 
some configuration information in a window. 
Click its More Info button to see the full 
configuration.

Windows NT/2000/XP: Open the DOS prompt 
and enter “IPconfig -All”, which lists the full IP 
configuration.

All Windows Systems: The IP configuration 
information shows the IP address the computer 
is currently using. It shows whether the comput-
er is using a DHCP server and, if so, shows the 
lease dates of the automatically obtained IP ad-
dress. If it does not show DHCP server and 
lease information, the IP address was specified 
manually (that is, it is static).

How do I change the name of a client?
The client is named when the client is first 
logged in from the backup computer.

If a client has already been installed and you 
want to change its name, go to Configure>Cli-
ents, double-click the client to be renamed, then 
click the Configure tab in the client configura-
tion window. Click the Rename button then 
enter a new name and click Rename.

The name change will not affect previously 
backed up files—they are still stored under the 

old client name. New files and Snapshots will 
be stored under the new name.

How do I log in a client when I forgot its 
password?
You must uninstall the client and install new cli-
ent software with a new password. Next, restart 
the client. From the backup computer, go to the 
client database window, click Network, log in 
the client, and enter the password. Then edit any 
existing scripts that include this client.

How can I get back a client volume after 
accidentally using Forget?
If you forget a client’s volume, you can put it 
back into Retrospect’s volume lists by configur-
ing the client (page 96). Remember to add the 
volume to the appropriate scripts, if necessary.

Backup Questions

How do I back up to a hard disk drive?
Use a file backup set on the hard disk or set Ret-
rospects preferences to allow FireWire and 
USB hard drives in removable disk backup sets. 
See “Backup Sets and Their Components” on 
page 21 and “Hard Disk Drives” on page 36.

How do I back up to a Mac OS X server? 
How do I use it as a backup device?
Retrospect can back up to a file backup set 
stored on a mounted AFP (AppleShare/Mac OS 
X server) volume.

To create a file backup set on a mounted 
AFP volume:
1.  Log into the Mac OS X backup computer as 
root.
For information on how to log in as root under 
OS X, please read Apple Computer’s 
Knowledgebase articles #106290, “Mac OS X: 
About the root User and How to Enable it.”and 
#125136  “Mac OS X 10.3: Enabling the Root 
User”.
2.  Mount the AFP volume on the desktop in the 
Finder.

http://docs.info.apple.com/article.html?artnum=106290
http://docs.info.apple.com/article.html?artnum=125136
http://docs.info.apple.com/article.html?artnum=125136
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3.  Launch Retrospect.
4.  Configure Retrospect to automatically 
mount the AFP volume.
See “Configure” on page 172 for more 
information on auto-mounting an AFP volume.
5.  Create a file backup set and save it to the 
AFP volume.
6.  Quit Retrospect.
7.  Login to the backup computer as a normal 
user (not as root).
8.  Launch Retrospect.
9.  Edit your backup script to include the new 
file backup set as a destination.
10. Run the backup script with a schedule, run 
document, or from the Run menu.
It cannot be run as an immediate backup.
When saving data to a mounted AFP volume, 
you are likely experience to experience a server 
limit for file sizes.

The maximum destination file size is 2GB on 
older Macintosh servers and NAS servers and 
4GB for Windows 2000 Server destinations. 
AFP 3.1 or later servers, which include Mac OS 
X Server 10.3 and later, support larger than 4 
GB files when used with an AFP 3.1 and later 
client, including Mac OS X 10.3 and later.

How do I back up only files that have 
changed?
Retrospect does this automatically. The first 
time you back up, Retrospect copies all selected 
files. On subsequent normal backups, it copies 
only the selected files that are new or changed.

How do I specify complete (full) or 
IncrementalPLUS backups?
By default, Retrospect does IncrementalPLUS 
backups; i.e. it backs up only new or changed 
files. You can modify this behavior by setting 
the backup action to recycle or new media. See 
“Backup Actions” on page 23 for more 
information.

There are many ways to do this:

• When executing an immediate backup, by 
changing the backup options (page 143). 

• When running a script by selecting an item 
from the manual execution dialog’s pop-up 
menu (page 78). 

• When creating a script scheduler (page 74).
• By configuring the Backup Set and clicking 

the Media Action button (page 154).

How do I back up multiple volumes to the 
same disk, tape, or CD/DVD?
Use the same destination backup set. To back 
them up at the same time, select each volume 
you want to back up in the volume selection 
window. You can make a non-contiguous selec-
tion using the Command key or select a range of 
volumes using the Shift key. When you execute 
the backup, Retrospect backs up each of the se-
lected volumes, one after another.

You can later do normal backups of other vol-
umes to the same backup set and Retrospect will 
add them to the medium until it is filled.

How do I run an operation from the Finder?
First create a script in Retrospect and save a run 
document (page 78) from it. Use the run docu-
ment to start that script directly from the Finder.

How do I include or exclude files with 
particular attributes?
You can specify which files Retrospect backs 
up by using selectors. These allow you to in-
clude or exclude files by their size, kind, dates, 
and many other attributes. See “Using Selec-
tors” on page 177.

Does Retrospect back up hard links and 
symbolic links under Mac OS X?
Yes.
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Network Backup Questions

How do I see what was backed up last 
night? How can I tell if everyone has been 
backed up by Backup Server?
The Backup Report shows a summary of the 
backup operations for each volume. To view the 
report, click Report from the Retrospect 
Directory’s Reports tab. See page 137.

The Operations Log shows by date and time 
which volumes were backed up, how much data 
was copied, and whether the backup completed 
successfully. To view the log, click Log from 
the Retrospect Directory’s Reports tab. The log 
also lists any errors which occurred. See 
page 140.

To view files backed up during the most recent 
backup, choose Reports in the Retrospect 
Directory and click Contents. Select the appro-
priate backup set from the top list in the contents 
report window, select one or more sessions 
from the bottom list, and click Browse. A 
browser appears, listing the files in the order 
they were backed up. See “Viewing Backup Set 
Contents” on page 141

How can I prevent the “waiting for backup” 
dialog from appearing on Mac OS 7/8/9 
clients on nights when no operation is 
scheduled?
Under Mac OS 9 and earlier, the Retrospect 
Client control panel has no way of knowing 
when an operation is scheduled to occur, so it 
always waits at shutdown if this option is turned 
on in the Retrospect Client control panel prefer-
ences dialog. There are several ways to get 
around this if you do not perform operations ev-
ery night.

Make a script using the No Files selector then 
schedule it to run on nights when no backups are 
scheduled. Retrospect shuts down the script’s 
Macintosh sources.

Tell users which days they should click the Shut 
Down button in the “waiting for backup” dialog 
when they leave for the day.

Turn off the Wait at Shutdown preference in the 
Retrospect Client control panel on each user’s 
Macintosh. Tell the users which nights to leave 
their Macintosh computers on. Remind them to 
turn down the monitor brightness or turn off its 
power to prevent screen burn-in.

Set up an AppleScript (page 191) to enable the 
Wait at Shutdown option only on certain days.

Can Retrospect shut down a Windows 
client computer when it is done with its 
backup?
No. Retrospect does not have an option to shut 
down Windows clients, as it does for pre-
Mac OS X clients.

How do I back up a Services for Macintosh 
volume located on my NT Server?
Use Retrospect Server for Windows to back up 
Windows NT or 2000 servers.

How do I avoid -37 (invalid name) errors 
when I backup my NT Server that contains 
Services for Macintosh directories?
Use Retrospect Server for Windows to back up 
Windows NT or 2000 servers.

Why do my network backups take too 
long?
For a discussion of backup performance, in-
cluding guidelines for estimating your backup 
speed, see “Network Backup Guidelines” on 
page 112, and “Choosing the Backup Comput-
er” on page 113.

If you notice that your backups have suddenly 
become much slower, or if one particular client 
backs up more slowly than others with a similar 
configuration, you may be experiencing a prob-
lem. Potential problems may lie with the 
following:

• The amount of activity on the backup and 
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client computers during the backup. Other 
applications (anti-virus software and screen 
savers, for example) running on either computer 
draw processing power away from Retrospect. 
Try a backup with Retrospect as the only appli-
cation running on the backup computer and the 
client in the “waiting for backup” mode (with its 
screensaver off) for optimal performance.

• The amount of data being copied. Recycle 
backups tend to show higher performance fig-
ures than IncrementalPLUS backups. For each 
backup, Retrospect must spend time examining 
the entire volume to determine which files need 
to be backed up, regardless of the amount of 
data that needs to be backed up. The ratio of this 
overhead time to total backup time will be high-
er for a small amount of data (IncrementalPLUS 
backup), as compared to a large amount of data 
(for a recycle backup or when an empty backup 
set is first used in a normal backup). Backups of 
small amounts of data may therefore report 
slower performance times than backups of large 
amounts. 

Table 10-1 below shows sample data from sev-
eral backups. Performance figures for the 
recycle backup are much higher than for subse-
quent backups of the same client due to the 
lower proportion of overhead time to the 
amount of data actually backed up.

• The total number of sessions for which a 

backup set has been used. The greater the 
number of sessions created, the longer 
Retrospect takes to match sessions to determine 
what files need to be backed up. Periodically re-
setting your backup set with a recycle backup or 
adding new media to your rotation using a new 
media backup will limit the number of sessions 
in your backup set, thereby speeding up both 
your backup and restore operations.

• File sharing. Mac OS file sharing slows 
copying on both clients and the backup comput-
er. Turning off file sharing when it is not needed 
can help optimize network performance.

• Backing up across network segments. The 
backup computer and a client may reside on two 
physically different networks connected by a 
bridge or router that may slow the progress of 
data from one machine to the other. Backup per-
formance may also suffer if the two networks 
vary greatly in terms of their relative network 
activity or performance. You can confirm the 
speed of the connection between the backup 
computer and the client by using Get Info from 
Configure>Clients. If the echo time seems high-
er than under normal circumstances (for 
example, consistently above 0.3) or the KB/sec-
ond performance figure seems lower than 
normal, a network problem may be affecting 
your backup speed. Use Get Info to view and 
print the performance figures for various client 

Backup Action (iteration) Number of Files Megabytes 
Copied Time (mm:ss) MB per minute

Initial Backup 8345 719.6 24:00 30

IncrementalPLUS (1) 51 5.7 00:22 15.4

IncrementalPLUS (2) 360 19.7 01:26 13.8

IncrementalPLUS (3) 43 5.7 00:25 13.5

IncrementalPLUS (4) 53 6.1 00:30 12.6

Table 10-1: Sample values for client backups over an Ethernet network.
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computers and compare them to determine cur-
rent levels of network performance.

• The performance of the backup and/or 
client computer. Problems with either ma-
chine affect the speed of your backup. 
Specifically, you should check for hard drive 
fragmentation, problems on the SCSI bus, and 
network problems (see page 206).

• The speed of the backup computer. Differ-
ent Macintosh models feature various central 
processing units that determine how quickly 
they perform tasks. The performance of similar 
CPUs also varies based on their clock cycles (as 
expressed in megahertz). Finally, if your Mac-
intosh has a SCSI buss, its speed can vary across 
Macintosh models, influencing how fast each 
Macintosh can transfer data across its SCSI bus. 
For optimal backup performance, assign a rela-
tively fast Macintosh to run Retrospect.

• Using encryption or software compression. 
If possible, avoid using encryption on the back-
up media or link encryption for client 
computers. Encryption requires additional pro-
cessing power the backup Macintosh would 
otherwise use to increase backup performance. 
Whenever possible, use hardware compression 
(if your tape drive includes hardware compres-
sion capabilities), since hardware compression 
works faster than software compression. Be-
cause backup speed influences tape capacity, 
hardware compression also allows more data to 
fit on a tape.

Can more than one backup computer run 
on the same network at the same time?
Yes, you can run multiple backup computers at 
the same time on the same network with no 
problems, though when they transfer data at the 
same time both backups will probably slow. If 
you run backups in different physical network 
segments, traffic on one segment will not affect 
other segments.

How many client computers can I back up 
from a single backup computer?
There is no fixed limit to the number of clients 
you can access from one backup computer. It is 
not a question of numbers, but more a question 
of resources. You can back up more clients with 
a faster backup computer, a faster backup de-
vice with higher capacity media, and simply 
more time to do the backups.

If the backup computer is not completing back-
ups in its scheduled time periods or if you want 
volumes to be backed up more often than they 
are, you may need a faster backup computer or 
a faster backup device, if not both.

I want to make a computer on a different 
network segment the backup computer. 
What should I do?
Moving to a new backup computer is explained 
in detail in “Moving Retrospect,” which starts 
on page 162.

Will Retrospect wake a sleeping 
PowerBook Mac OS client to back it up?
Retrospect cannot wake a PowerBook in sleep 
mode. Set your PowerBook to not sleep while it 
is plugged in.

What is Retrospect’s network port 
number?
Retrospect uses a well-known port, 497, as-
signed by the Internet Assigned Number 
Authority (IANA), for both TCP and UDP.

Do I have to upgrade my clients to the 
latest version?
Yes. Retrospect 6.0 requires Mac OS X clients 
to be installed with Retrospect 6.0 or later client 
software. Other clients should also use the latest 
version of their client software.
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Restore Questions

I thought I just restored some files. Where 
are they? Where did they go?
Look on the root level of the destination volume 
for a folder with the same name as the backup 
set from which you restored.

How do I restore just one file when I am not 
sure of its name?
If you know part of the file’s name, Retrospect 
can help you find it. Set up a searching restore 
as described in “Restore by Search” on page 55. 

If you specify just part of the file’s name in the 
searching window, Retrospect will probably 
find the file you are looking for, but may also 
find others.

After Retrospect searches, click the Files Cho-
sen button in the summary window. In the 
browser window that appears, use the Browser 
menu to find files in the list.

Make sure only the files to be retrieved are 
marked, then close the browser window. Click 
Retrieve in the summary window to start 
restoring.

How do I restore an earlier version of a 
file?
To restore any version of the file in the backup 
set, set up a searching restore as described in 
“Restore by Search” on page 55. In the search-
ing window, type the name (or portion thereof) 
of the file you want.

After Retrospect searches, click the Files Cho-
sen button in the summary window to display a 
browser of the files found, then click Unmark. 
The files are listed with their backup dates. To 
see a file’s creation and modification dates, se-
lect it and choose Get Info from the File menu. 
Mark the file or files to be restored, close the 
browser, and click Retrieve.

Does Retrospect restore empty folders?
Yes. Empty folders are restored when you do an 
immediate restore from a Snapshot using 
Restore an entire disk, the top option in the re-
store dialog. Set the destination window’s pop-
up menu to replace corresponding files or re-
trieve files and folders if you do not want to 
restore over the whole disk.

How do I restore empty folders without 
restoring the entire hard disk?
Go to Immediate>Restore and in the dialog 
which follows, select “Restore an entire disk” 
(the top radio button). Then select the source 
backup set and Snapshot. At the destination 
window, select your target volume and, from 
the pop-up menu, choose any restore method 
other than “Retrieve just files.”

In the files chosen browser, double-click either 
the root of the source volume or an entire en-
closing folder which contains empty folders. 
Empty folders will be highlighted but not 
marked. When you execute the restore, all the 
enclosed empty folders will be restored. No oth-
er combination of restore types or file selection 
will restore any empty folders.

WARNING: Be very careful when restoring. If 
you choose Restore entire or Replace 
corresponding files in the restore method pop-
up menu, Retrospect will replace and/or delete 
files on the destination volume.

I backed up multiple volumes using a 
single backup script. How do I restore all 
of the volumes at once?
Create and schedule a restore script for the first 
Snapshot you wish to restore. Duplicate this 
script. Edit the copy of the first script, changing 
the source and destination to reflect the next 
Snapshot to restore. Repeat this process for each 
volume you wish to restore. Retrospect runs 
each script, one after the other, alphabetically 
by script name, starting at the time you 
specified.
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Backup Set and Catalog Questions

What if I forget my catalog?
If you forget a backup set catalog from within 
Retrospect, its file remains on your hard disk 
until you drag it to the Trash. If you have mis-
takenly told Retrospect to forget a catalog, you 
can open the catalog file from within Retrospect 
or from the Finder. After forgetting a catalog, 
you must add the backup set to your scripts 
again because Retrospect removes them when 
you forget the catalog.

What if I lose my catalog?
If you lose your backup set catalog (perhaps be-
cause it was deleted, corrupted, or lost), you can 
have Retrospect rebuild the catalog by scanning 
all of the disks, tapes, or discs in the backup set. 
See “Rebuilding a Catalog” on page 188.

It may take several hours to rebuild a catalog if 
there is a large amount of data in the backup set.

Can I delete files from a backup set?
No, you cannot delete files from a backup set 
because most types of storage devices do not al-
low it. If you want to keep only selected files 
from a backup set, you can copy these files to a 
different backup set using Retrospect’s backup 
set transfer operation. See “Transfer” on 
page 60.

Can I rename a backup set?
No. Make sure you name your backup sets cor-
rectly when you create them. If you need a 
backup set with a different name, create a new 
one and transfer the data from the old backup set 
to the new one. See “Transfer” on page 60.

Can I put more than one backup set on a 
disk, tape, or CD/DVD?
You cannot have more than one backup set on a 
tape or CD/DVD but you can have multiple file 
backup sets on a disk. When you add a medium 
to a backup set, Retrospect reserves the entire 
medium for that backup set.

You can back up as many volumes as you want 
to a single backup set.

What is the best way to manage catalog 
files?
Catalogs typically contain about 200K for each 
thousand files that you back up. Keep your of-
ten-used catalogs on your hard disk. If you do 
not have enough room on your hard disk, here 
are a few alternatives:

• Store infrequently used catalogs on a file 
server.

• Archive old catalogs to their own backup 
set.

• Compress the catalogs. See “Configuring 
Backup Sets” on page 153.

I back up by moving a backup device from 
computer to computer. What is the best 
way to do this?
It is easier to leave your backup devices con-
nected to the backup computer and back up 
other computers as clients. The client software 
allows Retrospect to back up Mac OS, Win-
dows, and Linux computers over a network 
without moving the backup device. All versions 
of Retrospect include some client licenses and 
you can always purchase more to make sure all 
your computers get backed up.

NOTE: This method assumes all of the 
computers you want to back up are connected 
by a network.
If you want to move the backup device from 
computer to computer, it is not necessary to cre-
ate a separate backup set for each computer 
unless you plan to use a different set of disks, 
tapes, or CD/DVDs for each workstation. If you 
use a single backup set for the computers, do not 
do a recycle backup of each workstation; use 
normal backup only, and new media backup 
when you need to rotate media.

After each backup, copy your backup set cata-
log to a server or removable disk and then, once 
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you move to the next computer, copy the cata-
log to its hard disk. You may want to use 
Retrospect’s catalog compression option 
(page 154) to keep the catalog as small as 
possible.

Devices and Media Questions

Why is Retrospect requesting more 
media? Why are my disks, tapes, or 
CD/DVDs filling up sooner than I 
expected?
Retrospect requests a new medium for one of 
three reasons:

• The drive reports the current medium is full.
• An error occurred while writing to the 

medium. Open the log to see if an error 
occurred.

• You selected Skip or Missing while 
configuring a backup set, or you are 
performing a new media backup.

A 74-minute CD-R disc has a nominal capacity 
of 650 megabytes. For everyday use this means 
you will typically achieve capacities around 
600MB.

For typical everyday use, when your tape is full, 
it may store up to 30% less data than its ideal 
maximum capacity.

You can effectively increase the capacity of 
your media by using compression, either 
Retrospect’s data compression option 
(page 143) with a removable disk drive or 
CD/DVD drive, or the hardware compression of 
an equipped tape drive (page 38). 

The benefits of compression depend largely 
upon how well the data you are copying com-
presses. Text compresses well, for example, but 
applications do not.

How much space is left on my medium?
Click Backup Sets from the Retrospect 
Directory’s Configure tab. In the backup set se-
lection window, select your backup set and 

click Configure. The window that appears lists 
the available space on that backup set’s current 
member.

This estimate is only to help you gauge when 
Retrospect will request new media. Regardless 
of the estimated available space, Retrospect 
uses a member until the drive reports the medium 
is full.

What do I do when I know my medium is 
going to fill up during tonight’s backup?
If you think there is not enough space for the 
next backup on the current disk, tape, or 
CD/DVD of your backup set, you can tell 
Retrospect to ask for a new one.

To skip to a new member, set the backup set’s 
Media Action to “Skip”. The Media Action but-
ton is described in “The Options Tab” on 
page 154. The next time Retrospect adds files to 
that backup set it will ask for a new medium, in 
effect skipping past the current member’s re-
maining space.

If this situation arises frequently, consider using 
Retrospect’s Automatic Skip to blank media 
preference. When this preference is on, 
Retrospect automatically uses any erased media 
if the current member is not available.

You might also consider purchasing a tape li-
brary, a backup device which holds a magazine 
of many tapes. When one tape fills, Retrospect 
uses an empty tape from the magazine.

When I try to erase a tape, CD/DVD, or 
removable disk. Retrospect asks for the 
catalog file, but I no longer have it. How 
can I erase the medium?
When you erase a disk, tape, or CD/DVD, 
Retrospect tries to remove the member’s con-
tents from the catalog for that backup set. If it is 
missing, Retrospect asks you for it. You need to 
tell Retrospect to forget the catalog because it is 
gone, which will then allow you to erase the me-
dium. Click Backup Sets from the Configure tab 
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and forget the backup set then click Devices 
from the Configure tab and erase your medium.

If I have two tape drives, will Retrospect 
use them both when performing 
unattended backups?
Yes it will if the devices are similar, with the 
same kind of mechanism. When it fills up a 
tape, Retrospect looks in any available drive for 
any tape that is new or erased, or has the correct 
name. 

How do I start over at the beginning of the 
disk, tape, or disc?
To start over on a removable disk, tape, or 
CD/DVD, you must reset the entire backup set. 
One way to do this is to do a recycle backup to 
the backup set. Another way is to manually set 
the backup set Media Action to Recycle. (See 
“The Options Tab” on page 154).

NOTE: You cannot do this with CD-R or 
DVD-R discs because they cannot be erased.

How do I recycle disks, tapes, or discs 
from old backup sets?
To reuse a removable disk, tape, or CD/DVD 
from a backup set you no longer need, insert the 
disk, tape, or CD/DVD, choose Configure in the 
Directory, then click Devices. The window that 
appears shows you the name of the medium. Se-
lect the disk, tape, or CD/DVD and choose 
Erase from the Devices menu. The next time 
Retrospect requests a new member for a backup 
set, it will automatically use this or any other 
erased medium in the backup device.

You should also remove the old backup set’s 
catalog. Click Backup Sets from the Retrospect 
Directory’s Configure tab. In the backup set se-
lection window that appears, select the old 
backup set and choose Forget from the backup 
sets window. In the Finder, drag the old backup 
set catalog file to the Trash.

NOTE: You cannot do this with CD-R or 
DVD-R discs because they cannot be erased.

How do I determine the name of a certain 
disk, tape, or CD/DVD?
To view the name of a medium, click Devices 
from the Retrospect Directory’s Configure tab. 
Retrospect scans for available storage devices. 
The devices window appears, listing each drive, 
its type and status, and the name of the inserted 
medium. Insert the disk, tape, or CD/DVD if you 
have not done so.

Miscellaneous Questions

How do I get rid of a backup set I don’t 
need anymore?
Click Backup Sets from the Retrospect 
Directory’s Configure tab. In the backup set se-
lection window, select the backup set to be 
removed and choose Forget from the Backup 
Sets menu. This removes the backup set from 
the destination lists of all your scripts. To re-
move a backup set completely, you must also 
use the Finder to drag the backup set’s catalog 
file to the Trash. The catalog file is usually kept 
in the same folder as your Retrospect 
application. 

How do I get rid of a volume that no longer 
exists?
Click Volumes from the Retrospect Directory’s 
Configure tab. In the volume selection window, 
select the volume to be removed and choose 
Forget from the Volumes menu. This removes 
the volume from the source lists of all your 
scripts.

When I quit Retrospect, how can I prevent 
the message that tells me the next time 
Retrospect will execute?
Click Preferences from the Retrospect 
Directory’s Special tab. Select the Quit Action 
preferences category and turn off Check 
Validity of Next Script.

Where are my scripts stored?
Your Retrospect scripts are stored in the 
Retro.Config file in the Library: Preferences: 
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Retrospect folder. Many other customizations 
you make to Retrospect are stored there as well.

RETROSPECT ERROR 
MESSAGES
When Retrospect detects compare errors while 
backing up, write errors while retrieving, or 
read errors while retrieving or verifying, it 
opens a browser displaying the files involved. 
The execution errors browser may be printed 
for reference, or copied and pasted into another 
browser for easy re-selection. Look in the Oper-
ations Log for the error message associated with 
each file and act appropriately.

When Retrospect is performing operations over 
the network, either the client or the backup 
computer can generate errors, which are then re-
ported by Retrospect on the backup computer. 
In general, errors that are reported at the client 
occur when the Retrospect client software sur-
veys the system and determines that Retrospect 
will not be able to use it over the network.

Catalog out of sync
Retrospect was unable to update the catalog the 
last time it copied data to this backup set.

This may have been due to equipment failure or 
power failure, or was caused by a full disk (error 
–34).

Try to update the catalog. See “Updating a Cat-
alog” on page 187.

If updating the catalog does not eliminate the 
“catalog out of sync” error Retrospect cannot 
add files to that medium. You have three 
options:

• Perform a recycle backup, which resets the 
catalog and erases the media, removing its 
existing backup files. (This is not an option 
for CD-R or DVD-R.)

• Skip to a new medium using the Media 
Action button (page 154), forcing 
Retrospect to use a new piece of media for 
the next backup.

• Create a new backup set and do a backup to 
new media.

Bad backup set header
Retrospect encountered a missing or damaged 
file header, which contains information such as 
the file’s name and size.

This error can indicate communication prob-
lems. See “General Device Troubleshooting” 
on page 203 and the bus-specific device trou-
bleshooting sections which follow it.

Content Unrecognized
Retrospect can see data on the medium, but the 
data is not recognized as data formatted by 
Retrospect. With a removable disk, the unrec-
ognized content most likely is other files, which 
you may not want to lose.

WARNING: When a medium other than a 
CD/DVD or tape shows as Content 
Unrecognized, use caution. Any files on a disk 
are permanently removed when Retrospect uses 
the disk in an operation with a removable disks 
backup set. Be especially vigilant for hard disks 
which may be formatted to appear as removable 
disks.
For CD/DVDs, only a few common formats are 
recognized, though they may have data readable 
with other software or under other operating 
systems. Make sure the CD/DVD you are in-
serting is compatible with your mechanism 
because not all drives support all recordable 
media. Refer to the drive’s documentation for 
information on which media it supports.

For tapes this usually means that the tape was 
damaged, used by an incompatible backup pro-
gram, or used with an incompatible drive. This 
often results with tapes used with hardware 
compression drives then used with drives which 
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do not support the same hardware compression. 
Do the following to troubleshoot:

•  Make sure the tape you are inserting is 
compatible with your tape drive. For 
example, DDS-4 150 meter tapes cannot be 
read by DDS-1, -2, or -3 drives. Refer to the 
drive’s documentation for information on 
which tapes it supports.

• Clean your tape drive and continue to clean 
it according to your drive vendor’s 
recommendations. Tape drives need to be 
cleaned regularly with special cleaning 
cartridges (page 39).

• Check if other tapes also show as content 
unrecognized. If only one tape does then 
either it is damaged, it has been written to by 
other backup software, or it was created in a 
different, incompatible tape drive. If all 
tapes are unrecognized, then they were 
either all created in a different tape drive, 
there is a problem with your 
communications bus, or your tape drive may 
be broken. See “SCSI Device 
Troubleshooting” on page 205 for detailed 
instructions on troubleshooting a SCSI bus.

• If possible, try your tape or tapes in a 
compatible tape drive. If tapes are 
recognized in one drive but not another of 
the same type, it is possible that one drive 
needs repair. Contact your drive vendor for 
advice before assuming a drive needs repair.

Content Damaged
You or someone changed the name of a disk that 
is a member of a removable disk backup set.

To preserve this data, rename the disk to the 
original name it was given by Retrospect. The 
original disk name uses the format 1-The Name. 
If you do not want to save the data and instead 
want to use the disk for a new media backup or 
other purposes, erase the disk. 

Media too different
Retrospect reports that your media is too differ-
ent in two cases:

• You are trying to append to a tape backup set 
that is damaged. If you crashed or 
experienced a power failure while last 
writing to your tape and are now getting this 
error when trying to append, your backup set 
is damaged. You will not be able to append 
to this backup set, but you can retrieve all 
files from it. Create a new set, or do a recycle 
backup to this set if you wish to start over. 
The media is not damaged, but the backup 
set is damaged such that Retrospect cannot 
append to it.

• You are trying to append to a tape backup set 
using a drive with a different kind of 
mechanism. Use similar drives when 
creating mixed drive backup sets.

System Clock and Tick Timer
Retrospect has internal checks to warn you if 
something strange or unexpected happens with 
your computer’s clock. These warnings are en-
tered in the Operations Log.

When the system clock appears to have 
changed, it usually means you changed your 
computer’s clock while Retrospect was open.

When the tick timer appears inconsistent with 
the system clock, something may have stopped 
CPU activity, such as a modal dialog or the use 
of a debugger.

Verification Errors
The following messages indicate a verification 
error:

• File “Home.html”: different modify 
date/time

• File “Bore Dimensions”: didn’t compare at 
data offset 263,078
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• File “port flow specs”: didn’t compare at 
resource offset 731,429

A verification error occurs during verifying 
when Retrospect determines a file it copied to 
the destination is not identical to the file copied 
from the source. The file in question is not con-
sidered valid in the destination. If this happened 
during a backup, for example, Retrospect would 
try to copy the file again during the next normal 
backup to this backup set.

When you know the file was in use at the time 
the copying was done, a verification error is 
usually nothing to worry about. It simply means 
the file changed between backup and verifica-
tion. Verification errors that mention data or 
resource offsets usually indicate SCSI commu-
nication problems. See “SCSI Device 
Troubleshooting” on page 205.

If you have a G3 upgrade card in an older Mac-
intosh, it may be the cause of errors mentioning 
an offset. See Dantz Technical Note #408 
(available on the Dantz web site) and contact 
your G3 card vendor for a software update.

Internet Backup Set Error Messages
The following error messages may occur with 
Internet backup sets. Error numbers 220 
through 234 also may occur with Internet back-
up sets.

The backup set could not be completely 
cleared.
While attempting a recycle backup or manually 
resetting the backup set for a recycle backup, 
Retrospect could not completely clear the back-
up set directory because it contains non-
Retrospect data.

Verify the path to the backup set directory in the 
connection configuration window. Retrospect’s 
incomplete clearing deletes only Retrospect da-
ta, leaving the non-Retrospect data untouched. 
Delete the other data yourself (using an FTP 
utility such as Fetch) and repeat the recycle 

backup or manual reset. Unless you personally 
placed the non-Retrospect files in the backup 
set directory you must contact your FTP server 
administrator to find the owner of the files and 
change write privileges so this does not happen 
again.

The folder Backup Set A in 
/FTPtop/Users/Mongo/ cannot be used 
because it already contains data. 
While attempting to create the backup set folder 
at the specified path, Retrospect discovered an 
existing directory of the same name but it can-
not use the directory because it contains data.

Delete the data from the directory on the FTP 
server (using an FTP utility such as Fetch) or 
create a new backup set with a different name.

Internal Consistency Check Error
This error indicates that Retrospect experienced 
a major problem not due to normal errors or cir-
cumstances. When this happens, Retrospect 
creates an error log in the Retrospect preferenc-
es folder named “Retrospect.error.log.n” where n 
is a number.

Retrospect does internal consistency checks to 
ensure internal operations are fine. If you get 
this error, restart the computer and do what you 
were doing when the error occurred. If the error 
recurs, Retrospect most likely detected that an 
internal file in use for backup has been corrupt-
ed. Often the context of the error is most 
important.

If the error occurs during backup, archive, or re-
store, when Retrospect accesses the backup 
set’s catalog file, this may indicate the catalog is 
corrupt. The solution to a corrupt catalog is to 
rebuild it from the media using 
Tools>Repair>Rebuild.

If the error occurs when you open Retrospect or 
when you are merely clicking tabs and buttons 
as you navigate the program, this may indicate 
the configuration file is corrupt. Test for a cor-

http://www.dantz.com/index.php3?SCREEN=tn408m
http://www.dantz.com/index.php3?SCREEN=tn408m
http://fetchsoftworks.com
http://fetchsoftworks.com


220 RETROSPECT USER’S GUIDE

rupted configuration by moving the 
Retro.Config file and the Retro.Icons files from 
their default location (in the Library/Preferenc-
es/Retrospect folder) to another location, such 
as the desktop. Relaunch Retrospect, provide 
the requested password or authentication if 
asked, then enter your application license code. 
Retrospect then creates new configuration and 
icon files. Try to reproduce the error. If you can 
reproduce the error, your original configuration 
files were not the cause, so return them to the 
Retrospect preferences folder to regain your 
scripts and preferences. If you cannot reproduce 
the error, it was probably caused by a corrupt 
configuration and you will have to use the new 
configuration. The side effect is that your 
scripts and preferences are gone and you must 
create new scripts and set new preferences.

If these suggestions do not help, see the Dantz 
web site for a technical note on internal consis-
tency check troubleshooting.

ERROR NUMBERS
If Retrospect or the operating system is unable 
to complete an operation, it will display an alert 
with an error number and/or log the error in the 
Operations Log. This section explains some 
common error numbers in greater detail.

Generally, errors with negative numbers (e.g. 
error –34) are Mac OS errors, while errors with 
positive numbers (e.g. error 102) are Retrospect 
errors.

–34 (volume full)
A volume has little or no available storage 
space. There are several possible causes of this 
error:

• You are restoring or duplicating more files 
than will fit on the destination volume.

• Retrospect is updating a backup set catalog 
and the volume on which it is saved runs out 
of room.

• You are backing up to a file backup set and 
the destination volume runs out of free 
space.

Go to the Finder and make more space on the 
full hard disk by removing unnecessary files 
and emptying the Trash. Try marking fewer 
files to restore or duplicate, or select a larger 
destination volume. Use catalog compression to 
make your catalogs use less space.

–35 (volume doesn’t exist) and –53 
(volume off-line)
Retrospect cannot find a certain volume. Make 
sure the volume is actually connected to the cli-
ent or backup computer and it is mounted on the 
desktop.

If the volume is mounted, Configure>Volumes 
to browse it. If Retrospect is able to scan the 
volume, the original error will probably not oc-
cur again. If the scan encounters the same error, 
Configure>Volumes again, Forget the client’s 
volumes, then Configure>Clients and put the 
client volumes back into Retrospect’s volume 
lists. Remember to add the volume to the appro-
priate scripts, if necessary. You may avoid this 
error with clients by using client containers.

–36 (I/O errors)
A media problem occurred on a source volume.

Try verifying your source volume using a disk 
utility or the formatting program that came with 
your hard drive.

–37 (invalid name)
This is usually caused by backing up a Services 
for Macintosh folder on a Windows NT Server. 
See “Services for Macintosh” on page 110. 

If a volume contains NT Services for Macintosh 
folders, you must back up these folders via file 
sharing. Using the “Private files/folders/vol-
umes” option within the Retrospect client, 
exclude all the Services for Macintosh folders. 
Mount the Services for Macintosh folders as 

http://www.dantz.com/index.php3?SCREEN=tn307m
http://www.dantz.com/index.php3?SCREEN=tn307m
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volumes on the backup computer desktop to back 
up the folders.

We recommend you use Retrospect Server for 
Windows to back up Windows NT or 2000 
servers.

–39 (unexpected end of file)
A file may be corrupt or damaged. Use a disk re-
pair utility to scan the volume for problems.

–43 (file not found)
Retrospect cannot find a file.

This usually means you or someone moved or 
deleted one or more files and folders while an 
operation was in progress.

Try backing up again. If this error continues to 
occur, run Apple’s Disk First Aid, or a third par-
ty disk checking utility to check for possible 
directory corruption.

–49 (file busy)
The file cannot be accessed because it is in use.

This may happen with a Windows client. Close 
all applications open on the client.

–53 (volume off-line)
Effectively the same as error –35.

–54 (file busy/locked)
The file cannot be accessed because it is in use. 
There are two causes of this error:

• You are trying to back up System files from 
a shared volume while using Mac OS file 
sharing or AppleShare.

• Another application, such as FileMaker or 
4th Dimension, had the files open, 
preventing Retrospect from accessing them.

Back up the busy files from the local Macin-
tosh, quit the application that owns the busy file, 
or use Retrospect client software to back up 
your server instead of mounting it on the 
desktop.

–108 (out of application memory)
There is not enough memory available to 
Retrospect for it to continue the operation. 
Retrospect may report error –108 when other 
applications are using most of the memory or 
your Macintosh does not have enough RAM 
installed.

Try quitting your other applications to make 
more memory available to Retrospect. Repeat 
the operation which brought about the error.

–1028 (not visible on network)
Retrospect cannot find the client computer on 
the network. Make sure the client computer is 
connected to the network and turned on and that 
it is not powered off by energy saving software. 
Also, make sure Mac OS X’s built-in firewall 
(off by default) is not enabled.

If it is a mobile computer make sure it has not 
been “suspended” or put into “sleep” mode. 
(Restart a suspended Windows computer to let 
Retrospect see it.) Make sure the client has the 
most recent version of the Retrospect client 
software and that the client software loads at 
startup. 

If not, follow the suggestions provided for the 
error “Retrospect Client not loaded at system 
startup” on page 228 or “Client service not 
loaded at system startup” on page 230.

Test the connection between the backup com-
puter and the client by using Get Info from 
Configure>Volumes. If it can connect with the 
client, Retrospect displays its measured transfer 
rate in kilobytes per second.Try pinging it. (See 
“Pinging to Verify TCP/IP Communication” on 
page 206.)

If this error occurs with a Windows 95 client it 
may be caused by a bug in the operating system. 
Microsoft’s Winsock 2.0 update fixes the prob-
lem. It is available free from Microsoft at:
http://www.microsoft.com/windows95/

http://www.microsoft.com/windows95/downloads/contents/wuadmintools/s_wunetworkingtools/w95sockets2/default.asp
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downloads/contents/wuadmintools/
s_wunetworkingtools/w95sockets2/default.asp 

–1277 (can’t open connection)
The client is registered on the network but does 
not respond to the backup computer’s attempts 
to communicate. This may mean:

• The client has crashed or otherwise failed.
• The client is occupied with a computation-

intensive or communication-intensive 
operation, such as running game software.

• The client is running an older version of 
security software that is incompatible. 
Security software known to cause problems 
include old versions of DiskLock and 
Empower.

–3205 (TCP/IP closed down)
Open Transport closed down the TCP/IP con-
nection. This may result from a serious problem 
such as another computer using the same IP ad-
dress as the backup computer.

Verify TCP/IP is properly configured or refer to 
Open Transport documentation.

–24004 (media request timeout)
Retrospect could not find a requested disk, tape, 
or disc before the Media Request Timeout period 
elapsed.

Turn off the Media Request Timeout preference 
(page 158) so Retrospect waits indefinitely for 
the requested media.

–24201 (chunk checksum failed)
One of Retrospect’s files, likely a catalog, is 
corrupt.

If the error occurs during a backup or archive, 
you need to rebuild the catalog (page 188) of 
the destination backup set.

If the error occurs when you launch Retrospect, 
see “Retrospect crashes while it is being 
launched.” on page 198.

–25040 (Catalog invalid or damaged)
Effectively the same as error –24201.

–25048 (Snapshot not found)
Retrospect could not find the requested Snap-
shot on the medium. For more information, see 
page 202.

100 (device rejected command)
This means that a command sent by Retrospect 
to your backup device was rejected by the de-
vice. Following are possible causes and their 
solutions.

• Your backup drive may not be supported by 
Retrospect. Check the Dantz web site to 
make sure your device is supported.

• Other software may conflict with 
Retrospect. Try running a backup without 
other third party software running.

• The media may not be supported by the 
backup device. Try different brands of 
media, if applicable. Check with the drive 
manufacturer to see if they have specific 
recommendations.

If Retrospect continues to report this error, see 
the device troubleshooting steps appropriate to 
your device and interface (“General Device 
Troubleshooting” on page 203 and either 
“FireWire and USB Device Troubleshooting” 
on page 204 or “SCSI Device Troubleshooting” 
on page 205).

102 (trouble communicating)
The backup computer lost contact with the 
backup device. Following are common causes 
of this error:

• You are using a file backup set (for example, 
backing up to a hard disk) and it has 
exceeded the maximum file size allowed on 
the volume. Perform a new backup or a 
recycle backup (page 23).

http://www.dantz.com/index.php3?SCREEN=options
http://www.microsoft.com/windows95/downloads/contents/wuadmintools/s_wunetworkingtools/w95sockets2/default.asp
http://www.microsoft.com/windows95/downloads/contents/wuadmintools/s_wunetworkingtools/w95sockets2/default.asp
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• The SCSI chain is not properly terminated. 
See “SCSI Device Troubleshooting” on 
page 205.

If Retrospect reports this error with a FireWire 
or USB device, quit Retrospect and restart the 
Macintosh. Also see “General Device Trouble-
shooting” on page 203 and “FireWire and USB 
Device Troubleshooting” on page 204.

106 (data overwrite attempt)
For tape drives, errors 106 and 212 indicate a 
media failure. 

If you see this error on a tape drive, run the Ver-
ify operation from the Tools tab to check the 
extent of the failure on the tape.

203 (hardware failure)
The backup device is having problems because 
of a bad medium, a device communication 
problem, or a mechanical error.

If the error occurs only when you use a particu-
lar medium, that medium is probably damaged. 
Try using a new medium. If the error occurs 
when you use any medium, you may have a 
problem with your communications bus or de-
vice. Try quitting Retrospect, turning off the 
backup device and computer for two minutes, 
and then turning them back on again before 
opening Retrospect. 

See “FireWire and USB Device Troubleshoot-
ing” on page 204 or “SCSI Device 
Troubleshooting” on page 205.

204 (device busy)
There is something else preventing Retrospect 
from accessing your backup device. Here are 
some possibilities:

• You stored the catalog for a removable disk 
backup set on a disk used as a member of 
that backup set. Keep the catalog on your 
hard disk.

• Retrospect is prevented by the operating 
system from erasing the disk. Turn File 
Sharing off.

• Retrospect may be trying to use a disk both 
as a source and destination at the same time. 
Choose only your local hard drive as the 
source instead of the Local Desktop 
Container.

If these do not apply, then this error is a sign of 
media, device or communication problems. See 
hardware troubleshooting information for your 
device and interface.

205 (lost access to storage media)
Usually indicates the communication bus was 
reset during a backup, causing Retrospect to 
lose contact with the media.

This error usually indicates a communications 
bus problem and may be accompanied by an er-
ror 102 (trouble communicating). If error 102 
accompanies error 205, see “FireWire and USB 
Device Troubleshooting” on page 204 and “SC-
SI Device Troubleshooting” on page 205.

If error 102 does not accompany error 205 and 
communication problems have been ruled out, 
the next step is to check for media failure on the 
source volume. 

Some hard drives reset the bus when they sense 
they are experiencing a media failure. Try test-
ing the hard drive with the software that was 
originally used to format it.

206 (media failure)
There is trouble reading from or writing to the 
backup set medium. This error is always gener-
ated by the backup device, and is usually due to 
one of the following causes.

• The media is physically defective and needs 
to be replaced. Try using a different medium.

• The heads on the tape drive are dirty and 
need to be cleaned. Consult the manual that 
came with your tape drive or contact the 



224 RETROSPECT USER’S GUIDE

drive manufacturer for cleaning 
recommendations.

• Another device is causing interference. If 
you have a drive immediately next to 
another electronic device, try moving the 
devices further apart. Try removing one or 
more devices temporarily to see if there is 
some other device conflict. Try using your 
backup device on another computer to see if 
interference is caused by your monitor or 
other nearby electronic devices. Also see 
“General Device Troubleshooting” on 
page 203 and “FireWire and USB Device 
Troubleshooting” on page 204 or “SCSI 
Device Troubleshooting” on page 205.

• Retrospect can also report error 206 when a 
crash or power failure interrupts the backup 
computer or tape drive. Some tape drives 
require an end of data (EOD) marker on a 
tape to append data. If a tape does not have 
an EOD marker Retrospect may report error 
206 when it next tries to append to the tape. 
Tape drives are responsible for writing EOD 
markers, but a drive may not get the chance 
if you shut down or restart the backup 
computer or the power is interrupted. 
Lacking an EOD, the tape will later produce 
error 206 when you try to append (write 
data) to it with Retrospect.
To avoid problems, take the following pre-
cautions: do not disable the "Verification" 
option in scripts and immediate operations; 
let the tape drive fully rewind or eject the 
tape before you power off or restart the com-
puter; and if the computer crashes, try to 
eject the tape (using the drive's eject button) 
before restarting or turning off the computer.

When Retrospect reports error 206 on a tape 
because it lacks an EOD marker, that tape is 
unusable for future appends until you erase 
it, though it is not physically damaged and 
you can use it to restore. The tape cannot be 
repaired with Retrospect's repair tool. To 

use the tape for additional backups or ar-
chives, you must first either reset the tape's 
backup set from Configure>Backup Sets or 
erase the tape from Configure>Devices.

When the error persists on multiple media and 
you have eliminated the above possibilities, the 
device may be failing. Contact the vendor.

212 (media erased)
Retrospect thinks the content of the medium has 
been erased. If you suspect that is untrue, try the 
media in another drive to test for device or com-
munication problems with the original drive. 
Check for device and communication integrity 
based on the hardware troubleshooting steps for 
your device and interface. If it reports the same 
error in all drives, then the media itself is 
damaged.

With a tape drive, this error may indicate a pos-
sible problem with the drive. See error 106 (data 
overwrite attempt).

220 (server is not responding)
The FTP server did not respond to Retrospect.

Verify the FTP server name (including domain) 
or IP address is correct. There are many possi-
ble causes: the server may not exist, the domain 
may not exist, the name may not be used by a 
domain name server, the server may not be an 
FTP server, the IP address may not be found, the 
network may not be operating, or the backup 
computer’s TCP/IP connection may not be 
operating.

221 (user name or password incorrect)
Retrospect could not log in because the FTP 
server rejected the user name or password.

Verify both are correct. Often, they are case-
sensitive.

222 (server name lookup failed)
Retrospect could not log in to the FTP server be-
cause either the host name (server and domain) 
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is incorrect or the domain name server (DNS) is 
not functioning.

Verify the host name (the “FTP Server” field of 
Retrospect’s connection configuration win-
dow). If the name is correct, your computer is 
not working with the DNS it uses to look up do-
main names and IP addresses. Contact your FTP 
server administrator or DNS administrator to 
troubleshoot your computer and/or the DNS.

223 (backup set not found)
Retrospect could not find the backup set folder 
in the specified path.

Verify the path and server are correct. This error 
can mean your Internet backup set directory has 
been moved or deleted from the FTP server. 
Contact your FTP server administrator.

224 (backup set is damaged)
Retrospect determined some backup set inter-
nals are unsound. It cannot use the backup set 
until it is repaired.

Go to Tools>Repair and choose “Rebuild Inter-
net backup set.”

225 (no write privileges, bad name, or disk 
full)
This error has three possible causes:

•  Your user account on the FTP server does 
not have server privileges to write data in the 
directory or on the server.

• You supplied an invalid name for a new 
folder.

• The FTP server volume on which the backup 
set resides is full.

The solutions, respectfully, are:

• Verify the path to the backup set directory. 
Contact your FTP server administrator to 
verify your user account information, 
including write privileges.

• Verify the new folder or backup set name; it 
may contain characters not allowed by the 
FTP server. (Some servers allow only the 
letters A through Z in names.)

• Contact your FTP server administrator to 
make more space available on the FTP 
server volume. You can do this in part 
yourself by deleting unwanted files from 
your user directory.

226 (backup set segment is missing)
The backup set is damaged; a data segment is 
missing from the backup set directory on the 
FTP server.

You or somebody with write privileges to the 
backup set directory moved or deleted one or 
more Retrospect data files (e.g., “0-data,” 
“1-data,” etc.) from the directory. Contact your 
FTP server administrator.

227 (bad name or no write privileges)
This error has two possible causes:

• Your user account on the FTP server does 
not have server privileges to write data in the 
directory or on the server.

• You supplied an invalid name for a new 
folder.

The solutions, respectfully, are:

• Verify the path to the backup set directory. 
Contact your FTP server administrator to 
verify your user account information, 
including write privileges.

• Verify the new folder or backup set name; it 
may contain characters not allowed by the 
FTP server. (Some servers allow only the 
letters A through Z in names.)

228 (folder is not a backup set)
Retrospect cannot find the Internet backup set 
directory at the specified path.
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Verify the path to the backup set directory in the 
connection configuration window. Contact your 
FTP server administrator.

229 (backup set name/creation date do not 
match)
The given backup set is not the one Retrospect 
expected. It has the same name but different in-
ternal information.

Locate the correct backup set and enter its direc-
tory path in Configure>Backup Sets. If you 
cannot find the correct backup set, you can re-
pair the backup set in question: go to 
Tools>Repair and choose “Rebuild Internet 
backup set.”

230 (pathname exceeds 255 characters)
The pathname to the backup set contains 255 or 
more characters.

Retrospect limits FTP server pathnames (in-
cluding the backup set name) to 255 characters. 
Rename directories so the pathname is 254 
characters or less.

231 (server disconnected or disk full)
The FTP server deliberately disconnected 
Retrospect.

This often happens when the server volume is 
full. Check the FTP server’s volume and deter-
mine whether it is full. If it is full, you must 
make space for future backups. If it is not full, 
look for signs of network trouble which might 
cause the FTP server to drop connected users. 
Check the physical connection to the server, 
making sure the modem or network cabling 
plugs are fully seated. Use a TCP/IP or FTP util-
ity such as WhatRoute or Fetch to try to connect 
to your server. You may need to contact your 
Internet Service Provider to check its 
connections.

Further attempts to add to the Internet backup 
set will likely produce “catalog out of sync” er-
rors. After checking the server volume, and—if 

necessary—making space available on it, up-
date the backup set from Tools>Repair.

232 (directory not found)
The FTP server does not have the specified 
backup set directory at the specified path.

Go to Configure>Backup Sets to verify the path 
to the backup set in the connection configura-
tion window.

233 (connection timed out)
Retrospect terminated the operation because it 
failed to receive a response from the FTP server 
within the time specified in Retrospect’s FTP 
server timeout preference. (The default is 30 
minutes.)

If this happens repeatedly, check the physical 
connection to the server, making sure the mo-
dem or network cabling plugs are fully seated. 
Use a TCP/IP or FTP utility such as WhatRoute 
or Fetch to try to connect to your server. You 
may need to contact your Internet Service Pro-
vider or FTP server administrator.

234 (server disconnected or timed out)
The connection between the FTP server and the 
backup computer failed.

Check the physical connection to the server, 
making sure the modem or network cabling 
plugs are fully seated. Use a TCP/IP or FTP util-
ity such as WhatRoute or Fetch to try to connect 
to your server. You may need to contact your 
Internet Service Provider or FTP server admin-
istrator to check its connections and/or 
determine its connection timeout setting. (Some 
providers limit how long users can stay 
connected.)

Further attempts to add to the Internet backup 
set will likely produce “catalog out of sync” er-
rors. Rebuild the backup set from 
Tools>Repair.

http://fetchsoftworks.com
http://homepages.ihug.co.nz/~bryanc
http://fetchsoftworks.com
http://fetchsoftworks.com
http://homepages.ihug.co.nz/~bryanc
http://homepages.ihug.co.nz/~bryanc
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503 (client turned off)
The client was turned off by the user at the cli-
ent computer before the operation started. The 
Retrospect Client control panel will automati-
cally turn on when that client is restarted.

505 (client reserved)
The client is in use by another backup comput-
er. A client may be used by only one backup 
Macintosh at a time.

This can also happen when the backup comput-
er or client computer crash during an operation. 
Restart both computers.

506 (duplicate activator code)
Update the client software to version 5.1 or later 
(Mac OS) or 6.5 or later (Windows).

507 (incorrect password)
Make sure you are properly typing the pass-
word. It is case sensitive, so you must type the 
password’s proper upper case and lower case 
letters.

If you cannot remember the password for a cli-
ent, you must reinstall the Retrospect Client 
control panel.

508 (access terminated)
The client user has turned off the Retrospect 
Client control panel during the operation. When 
this occurs, the backup Macintosh logs the error 
and moves on to the next client.

515 (piton protocol violation)
Retrospect sees its data is becoming corrupt 
while being transferred over the network. It is 
usually caused by a hardware failure.

Look for a pattern to these errors. If the problem 
occurs only on one client, it is likely that there 
is a problem with the client’s network connector 
or its connection to the network. If the problem 
happens on several clients with no coherent pat-
tern, the problem may be with the backup 
computer’s network card or connection, or with 

a gateway/router common to all network trans-
actions. See page 206 for more information.

519 (network communication failed)
The backup and client computers ceased to 
communicate, a situation which has many caus-
es and solutions, as detailed below.

A user shuts down a client during the backup, or 
the client fails or is disconnected from the net-
work during a backup. Determine why the client 
is failing or what part of the network communi-
cation link is failing (for example, a router, 
bridge, hub, or individual network connector). 
See the next item for help in determining if the 
problem is due to a software conflict.

A user is using too many applications on the cli-
ent during the backup, or an application takes 
up most of the computer’s processing power. 
Schedule backups for periods when the client is 
idle.

A network communication problem caused by 
hardware or software is making transactions un-
reliable. A failed network connector on a client 
will cause errors on that client. To determine 
whether a failed network connector is causing 
the problem, try switching connectors with a 
nearby computer that is not experiencing prob-
lems. See “Network Troubleshooting 
Techniques” on page 206.

A bad or failing hard disk is hanging the client 
computer. If the hard disk read light on the cli-
ent is stuck “on,” and not blinking, and the 
client must be restarted before it will work, the 
client has a failing hard disk or a bug in the hard 
disk’s firmware or software. For the hard disk 
that is hanging, update its driver to the latest 
version from its vendor. Then try running a 
disk-checking program.

Your network software is incompatible with 
your network hardware. Use the latest network 
software which matches your network hardware 
because older software might have problems.
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Mac OS 7/8/9: An extension or some other 
software on the Macintosh has broken the net-
work connection. Make sure you are not using 
software applications which prevent communi-
cation, such as older versions of security or 
compression programs that are active during a 
backup. Try starting up the Macintosh with the 
Retrospect Client control panel turned on, but 
all non-Apple extensions turned off.

This error may be caused by a problem with 
built-in Ethernet on all non-G3/G4 PCI-based 
Mac OS computers. It tends to occur during 
large data transfers on a busy network. One so-
lution is to upgrade to Mac OS 8.6, which has a 
new extension that fixes the problem. Another 
solution is to install and use third-party Ethernet 
cards. For more information, use the 
knowledgebase on the Dantz web site to search 
for “PCI networking.”

Windows: Two different bugs in the Windows 
95 operating system can cause the client to lose 
contact with Retrospect. Make sure the appro-
priate TCP/IP patch has been installed on 
Windows clients using these operating systems 
and Winsock 2.0 has been installed on Win-
dows 95 clients. See “Working with Windows 
Clients” on page 109.

525 (name/login conflict)
Usually this error appears when a client has 
been uninstalled and re-installed or replaced by 
client software which is not logged in.

On the backup computer, go to Configure>Cli-
ents, select the client experiencing the problem, 
then Forget the client. Click Add to go to the 
live network window and add the client of the 
same name. Add the client to your scripts.

527 (client was renamed)
Another backup administrator has renamed a 
client from another backup computer. Simply 
configure the client again to update the name in 
your own client database.

541 (client not installed or not running)
The backup computer can see the client com-
puter at the IP address but no client software is 
operational.

Make sure the client computer is turned on and 
that it is not powered off by energy saving soft-
ware. If it is a mobile computer make sure it has 
not been “suspended” or put into “sleep” mode.

Open the Retrospect Client control panel and 
examine its Status field for an error message 
about why the client software is not working. 
Consult the appropriate error message or trou-
bleshooting problem in this chapter. You may 
need to reinstall the client software.

RETROSPECT CLIENT ERRORS
When backing up clients, you can also get error 
messages on the client side. The errors appear in 
the client control panel on the client computer.

Mac OS Client Control Panel Errors
When everything is set up normally, and no er-
rors have occurred, the Retrospect Client 
control panel should say “Ready” or “Waiting 
for first access” in the Status field. Below the 
status is the History area with information about 
the most recent operation or error messages.

Retrospect Client not loaded at system 
startup

If the message “Retrospect Client not loaded at 
system startup” is followed by one of the expla-
nations in Table 10-2, proceed as indicated.

http://www.dantz.com/index.php3?SCREEN=knowledgebase
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If this message appears by itself in the Status ar-
ea, there are several possible causes.

• The °Retrospect Client control panel file is 
not in its proper location. Place it in the 
Control Panels folder within the System 
Folder.

• You have not restarted the client after 
installing the Retrospect client software. 
Restart the client.

• You held down the Shift key when you 
restarted the client Macintosh, which 
prevented extensions from loading. Restart 
without holding down Shift.

• You have an extensions manager program 
that specifies that the Retrospect Client 
control panel not be loaded. Open the 
extensions manager and ensure the 
Retrospect Client control panel gets loaded 
at startup.

• Another control panel or system extension is 
conflicting with the Retrospect Client 
control panel. Test for a conflict by 
temporarily removing several system 
extensions and control panels from the 
System Folder, leaving the Retrospect 
Client control panel and standard Apple 
extensions then restarting the client 
Macintosh. After restarting, open the 

Message Action/Comment

ROM or System Version too 
old

The Macintosh appears to be an antique, hopelessly incapable of running the 
modern networking software required for use as a client of Retrospect Backup 
for Windows. It is not even able to run the long-obsolete networking software 
required for use as a client of a ten-year-old version of Retrospect for 
Macintosh.

AppleTalk version too old The Macintosh is trying to use AppleTalk, not TCP/IP. Verify that it meets the 
system requirements then install Open Transport and set up TCP/IP 
networking.

AppleTalk turned off The Macintosh is trying to use AppleTalk, not TCP/IP. Verify that it meets the 
system requirements then install Open Transport and set up TCP/IP 
networking.

ADSP not installed The Macintosh is trying to use AppleTalk, not TCP/IP. Verify that it meets the 
system requirements then install Open Transport and set up TCP/IP 
networking.

No computer name or owner 
name specified in file shar-
ing settings

For System 7.x, open the Sharing Setup control panel. For System 8 or later, 
open the File Sharing control panel. Enter computer and owner names then 
restart.

Network Name conflict: 
“Name”

Another client on the network is already installed with this Owner Name. Trash 
the Retrospect Client control panel and install a fresh copy.

Open Transport TCP/IP not 
installed

Install Open Transport and set up TCP/IP networking.

Mouse button held down Holding down the mouse button during startup inactivates the control panel.

Doesn’t run under A/UX The Retrospect Client control panel cannot be used on a Macintosh running 
under A/UX.

Your activator code con-
flicts with John Doe 
(123.45.67.8). Please tell 
your backup administrator.

Forget one of the clients, trash its Retrospect Client control panel, then install 
Retrospect client software version 4.2 or later. Upgrade all older clients to pre-
vent recurring errors.

Table 10-2: Macintosh client control panel startup errors.
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Retrospect Client control panel. If you see 
the message “Ready” or “Waiting for first 
access,” you know one of the items you 
removed prevented the Retrospect Client 
control panel from loading. You may avoid 
the conflict by making the Retrospect Client 
control panel load first on startup by 
replacing the ° symbol in its name with a 
space.

Windows Client Control Panel Errors
When everything is set up normally and no er-
rors have occurred, the control panel’s Status 
tab should say “Ready” or “Waiting for first ac-
cess” in the Status field. Below the status is the 
History area with information about the most re-
cent operation or error messages.

Client service not loaded at system 
startup

If the status shows this error message, examine 
the history field for one of the messages from 
Table 10-3, then proceed as indicated.

There are a few possible reasons (in addition to 
those in the table) why the client software may 
not load at startup.

• The client software files are not in their 
proper location. The client software must be 
in the location you specified during the 
installation. Put it back in place or run the 
Setup program to reinstall the software. Log 
in as the administrator or another user with 
full access privileges when you install.

• You have not restarted the computer after 
installing the client software. The client 
software loads when the system boots. 
Restart the client computer.

• The client’s service was terminated. This is 
unusual. You may be able to run 
Retroclient.exe to get the service operating, 
but because you do not know what 
terminated the service in the first place, it is 
best to restart the client computer.

Message Action/Comment

Retrospect Client startup error: Winsock 
initialization failed.

There is a problem with the Winsock network interface. The 
file WINSOCK.DLL or WSOCK32.DLL may be an incorrect 
version (e.g., a non-standard Winsock). Re-install the DLL 
from the Microsoft Windows installation media.

Retrospect Client startup error: Protocol 
initialization failed. Make sure protocol is 
working.

Make sure the computer is using a valid IP address.

Retrospect Client startup error: Initializa-
tion failed. Make sure IP protocol is 
installed.

Install the TCP/IP network protocol from the Microsoft Win-
dows installation media.

Table 10-3: Windows client control panel startup errors.
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Linux Client Control Panel Errors
When everything is set up normally and no er-
rors have occurred, the control panel’s Status 
tab should say “Ready” or “Waiting for first ac-

cess” in the Status field. Below the status is the 
History area with information about the most re-
cent operation or error messages.

Message Action/Comment

“JAVA_HOME is set to an invalid 
location”
JAVA_HOME represents the path to 
JAVA_HOME.

A symbolic link to /usr/bin/java does not exist or the JAVA_HOME 
variable in RetroClient.sh is not set to the correct location. Install 
Java if it is not installed. If Java is installed then follow the steps 
below. 
The RetroClient.sh file assumes that there is a symbolic link to the 
Java executable from the /usr/bin/folder. If this link does not exist, 
there are two ways of correcting the problem:
1) Create it:
su to root 
cd /usr/bin
ln –s /usr/jdk1.3/bin/java java
Make sure that “/usr/jdk1.3/bin/java” reflects the path to the java 
executable where it was installed on your machine.
2) Change the line “JAVA_HOME=/usr/bin” to point at the “bin” 
folder of your Java installation folder.

“Either RETROSPECT_HOME or DIS-
PLAY is not set!”
RETROSPECT_HOME represents the 
path to RETROSPECT_HOME. DIS-
PLAY represents the DISPLAY value.

During installation, RETROSPECT_HOME should have been set 
to the location of the installation, typically /usr/local/dantz/client. If 
this is defined and exported in /etc/profile then the user can just 
load the file with “./etc/profile” from the terminal where they want 
to start the Client Control Panel.

“Critical file missing.” Critical files missing from RETROSPECT_HOME path (either ret-
rocpl or retrospect.jar).
If these files have been moved, move them back to the 
RETROSPECT_HOME path. If these files are not present, re-
install the client.

“Error obtaining network status.” Indicates that the client is not running. The Client Control Panel 
cannot display client information until the client is started. 
Start the client.

Table 10-4: Linux client control panel errors.
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RETROSPECT SUPPORT
Retrospect provides built-in access to a number 
of useful resources. From the Retrospect Help 
menu, you can access:

• Online help contents page. Fully-
searchable and indexed guide to using 
Retrospect.

• Retrospect Read Me. Tips, late-breaking 
information, known issues, and 
workarounds.

• Dantz Web Site. Dantz’s home on the 
Internet. To access Dantz’s Web site 
directly, go to www.dantz.com.

• Online Knowledgebase. Searchable 
database containing answers to frequently 
asked questions about Retrospect-related 
terms, error messages, and troubleshooting 
techniques. To access the Knowledgebase 
directly go to 
www.dantz.com/knowledgebase.

• Supported Devices. Searchable backup 
hardware compatibility database provides 
information of which devices Retrospect 
supports. To access supported devices 
information directly, go to 
www.dantz.com/hardware.

• Retrospect Updates. Product downloads 
for Mac OS and Windows products, 
upgrades, and updates. To access Retrospect 
updates directly, go to 
www.dantz.com/updates.

• Dantz Support. Support section of the 
Dantz Web site. Includes links to tutorials, 
user forums, etc. To access the support 
section directly, go to 
www.dantz.com/support.

All of these resources are available for free and 
can help you solve problems quickly and effec-
tively to get the most out of Retrospect. 

If you experience problems that you cannot 
solve using these resources, Dantz Technical 

Support is available to help. To learn more 
about available support options, check Dantz’s 
support matrix at:

 www.dantz.com/support_matrix.

For information about contacting Technical 
Support in the U.S. and Canada, as well as inter-
nationally, see www.dantz.com/contactsupport.

http://www.dantz.com
http://www.dantz.com/knowledgebase
http://www.dantz.com/hardware
http://www.dantz.com/updates
http://www.dantz.com/support
http://www.dantz.com/support_matrix
http://www.dantz.com/contactsupport
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A P P E N D I X  A  •  RE T R O S P E C T  S Y M B O L S

General Symbols
Button to change the information 
for a script or operation.

Drop arrow indicating a closed 
item. Click to open and show its 
contents.

Drop arrow indicating an open 
item. Click to close and hide its 
contents.

Local Desktop container.

Backup Clients container.

Groups container or an individual 
group.

Startup disk volume of the backup 
computer.

Disk volume (other than the startup 
volume).

CD-ROM volume.

Folder (file system, Retrospect con-
tainer, or Retrospect subvolume).

Shared disk volume, such as a file 
server or client volume.

Startup disk volume of a client 
computer.

CD-ROM volume from a client 
computer.

Subvolume on a client computer.

Mac OS client. When dimmed, it 
indicates Retrospect has not recent-
ly communicated with it.

Windows client. When dimmed, it 
indicates Retrospect has not recent-
ly communicated with it.

Removable disk backup set.

CD/DVD backup set.

Tape backup set.

File backup set.

Internet backup set.

Script.

The item is locked, allowing only 
read access.

Session.

Media Symbols
This medium is a member of a 
known backup set.

This medium is not a member of a 
known backup set, but its name 
matches that of a known backup set.

This member of the backup set is in-
tact.

This member of the backup set is 
missing.

Cursor Symbols
Cursor when Retrospect is running 
in unattended mode.

Cursor when Retrospect is busy, 
such as when it is scanning, match-
ing, copying, or communicating 
with a client computer.

Cursor when the user has complete 
control of Retrospect.

Selector Symbols
Selector.

Pop-up menu for choosing selector 
conditions.
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Condition handle used to move or 
copy the conditions.

Condition set to select folders and 
any files in the top level of those 
folders that match the given criteria.

Condition set to select folders and 
all items enclosed in those folders 
that match the given criteria.

Browser Symbols
Completely marked item. If the 
item contains other items, it means 
all the items within it are marked.

Partially marked item. One or more 
items—but not all—within the item 
are marked.

Matched file that exists in or on the 
destination and will not be copied in 
an operation.

Missing item that exists in a miss-
ing backup set member.

Snapshot.

Folder.

Document.

Application.

Report Symbols
Retrospect Express opened.

Start of script, operation, event, or 
module.

Start of operation with a volume.

User-initiated action.

Other action.

Error.
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Files Created by the Retrospect 
Installer or Retrospect

Retrospect
The Retrospect application 
program.

Read Me-Retrospect.htm
This hypertext document contains 
late-breaking news about 
Retrospect. It also includes tips, 

compatibility notes, and information on con-
flicts and workarounds.

Retrospect User’s Guide.PDF
This is the manual you are presently 
reading, in PDF format. It is best 
viewed and navigated with Acrobat 

or Acrobat Reader, but you can open it with oth-
er applications, such as Mac OS X’s Preview.

Retrospect Preferences Folder
This folder, which is created the 
first time you start Retrospect, is 
stored in the system’s Preferences 

folder. It contains many of the files listed in this 
appendix. The default location for the folder is:

/Library/Preferences/Retrospect/

Retro.Config
Created automatically by 
Retrospect and placed in its prefer-
ences folder. It contains most of 

your customized settings, including scripts and 
their schedules, passwords, preferences, known 
backup sets, defined subvolumes, selectors, cli-
ent login names, and recent choices.

Retro.Icons
Created automatically by 
Retrospect and placed in its prefer-
ences folder. It stores information 

on all of the file types and icons encountered.

Operations Log
This text file is created automati-
cally by Retrospect and placed in 
its preferences folder. It keeps a 

record of each Retrospect activity and can be 
opened and edited by any text editing applica-
tion or viewed from within Retrospect. 
Formatting codes that start with “$[” are visible 
when the Log is opened in a text editing appli-
cation. These codes are used by Retrospect to 
display symbols, as well as bold and underline 
font styles.

 Retrospect Plug-in Extension
Updates to the main application 
come in the form of these plug-in 
files. For instance, Dantz adds sup-

port for new tape and recordable disc drives by 
periodically releasing Retrospect Driver Update 
plug-in files. (You may even have an RDU in-
cluded with Retrospect right now.) When 
circumstances permit, Dantz includes the latest 
driver update with Retrospect and it is automat-
ically installed when you install Retrospect. (To 
reinstall the driver update, reinstall Retrospect.) 
As soon as a new driver update is available, it is 
posted on the Dantz web site for you to 
download.

retrorunfile, LaunchRetroHlper
Under Mac OS X, these files work 
together to compare the system 
clock with the next scheduled script 
event and automatically launch 
Retrospect when required. They are 
created by the Retrospect applica-

tion when you schedule executions and it 
creates new files if it discovers the files are 
missing.

http://www.dantz.com/index.php3?SCREEN=rdu
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AppleScript Utilities folder
This folder contains utilities to 
script Apple events, as described 
under “AppleScript Support” in 

Chapter 9.

Update Files
These files may be included on the Retrospect 
CD or you may download them from the Dantz 
web site.

 Retrospect Client Update File
Updates to Retrospect client soft-
ware come in the form of a client 
update file. You can use it from 

Retrospect to update client computers individu-
ally, or update a group of client computers with 
a single command from the backup computer. 
Retrospect client update files for Macintosh and 
Windows are on the Retrospect CD and on the 
Retrospect Clients CD. As soon as new client 
software is available, Dantz posts a client up-
date file on the Dantz web site for you to 
download.

Files Created by the User

Run Document
These files are created when you 
create a run document. You can 
save a run document file on any 

disk, and double-click the file whenever you 
want to run the script without having to first 
start Retrospect manually. When you save a run 
document, you can give it any name you want.

Catalog for Removable Disks 
Backup Set
This is a catalog file for a remov-
able disks backup set. It is created 

when you first make a new backup set and it 
bears the name of that backup set. To do any 
kind of operation with the corresponding back-
up set, such as back up or restore, you must have 
this catalog file. If you lose or damage the cata-

log, you can have Retrospect rebuild it from the 
backup set disks.

Catalog for Tapes Backup Set
This is a catalog file for a tapes 
backup set. It is created when you 
first make a new backup set and it 

bears the name of that backup set. To do any 
kind of operation with the corresponding back-
up set, such as back up or restore, you must have 
this catalog file. If you lose or damage the cata-
log, you can have Retrospect rebuild it from the 
backup set tapes.

Catalog for CD/DVD Discs 
Backup Set
This is a catalog file for a record-
able compact discs backup set. It is 

created when you first make a new backup set 
and it bears the name of that backup set. To do 
any kind of operation with the corresponding 
backup set, such as back up or restore, you must 
have this catalog file. If you lose or damage the 
catalog, you can have Retrospect rebuild it from 
the backup set discs.

Catalog for Internet Backup Set
This is a catalog file for an Internet 
backup set. It is created when you 
first make a new backup set and it 

bears the name of that backup set. To do any 
kind of operation with the corresponding back-
up set, such as back up or restore, you must have 
this catalog file. If you lose or damage the cata-
log, you can have Retrospect rebuild it from the 
FTP site’s directory in which the backup set 
resides.

File backup set combined data 
and catalog
A file backup set combines both the 
catalog (the index for the backup 

set) and the data being backed up into a single 
file stored on a single volume.
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File backup set catalog only
This file is the catalog separated 
from a file backup set. 

File backup set data only
This file is the data separated from 
a file backup set.
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access privileges –  The privileges given to (or 
withheld from) users to see folders, see files, 
and make changes to shared volumes.

append –  To write additional data to a backup 
set. In a normal backup, Retrospect appends file 
data to the current backup set member.

archive (verb) –  To copy files from a volume 
to a backup set. For example, “Let’s archive 
these QuickTime movies.” Archiving may, op-
tionally, involve removing the copied files from 
the source. Also see back up.

archive (noun) –  1. An operation in which 
files are archived. For example, “The archive 
was successful last night.” 2. An entity of back-
up materials. For example, “Retrieve the 2001 
accounts from the archive.” In this respect, a 
backup set is an archive. Also see backup set.

back up (verb) –  To copy files from a volume 
to a backup set (such as recordable discs). You 
should back up regularly in case something hap-
pens to your hard disk or any files.

backup (noun) –  1. An operation in which 
files are backed up. For example, “I just did to-
day’s backup.” 2. An entity of backup materials. 
For example, “Fortunately, we can get the back-
up from the safe and restore the files.” In this 
respect, a backup set is a backup. Also see back 
up and backup set.

backup action –  See recycle backup, new 
media backup, and normal backup.

Backup Clients –  The Backup Clients con-
tainer holds client computers which are logged 
in to Retrospect.

backup computer –  The computer on which 
you are using Retrospect with a backup device. 
In a networked environment, it is the computer 
used to back up client computers.

backup date –  The most recent date and time a 
file, folder, or volume was copied to a backup 
set. Retrospect sets this date for volumes, fold-
ers, and/or files only when you check the 
appropriate boxes under Options in the Execu-
tion window. Also see creation date and 
modification date.

Backup Report –  Displays all known volumes 
with information about when they were last 
backed up.

Backup Server –  1. Retrospect’s technology 
allowing flexible, resource-driven or user-initi-
ated backups. 2. A backup computer running a 
Backup Server script.

backup set –  A set of storage media and cata-
log file. Retrospect stores all files in backup 
sets. There are different types of backup sets for 
different media and devices: Internet backup 
sets for FTP servers, removable disk backup 
sets for multiple ejectable volumes or external 
hard disks, file backup sets for a single volume, 
tapes backup sets for tape cartridges, and 
CD/DVD backup sets for recordable and rewrit-
able disc drives.

boot –  To start a computer’s operating system. 
A Macintosh boots when you turn on its power 
or when you or software restarts it.

browser –  Retrospect’s tool that allows you to 
view the folder and file structure of a volume or 
contents of a backup set. You can also use a 
browser to see the files and folders in a backup 
set. The browser allows you to manipulate files 
and mark them to be used in an operation such 
as a backup.

catalog –  Retrospect’s index of the files and 
folders contained in a backup set. The catalog 
file allows you to mark files for restore or re-
trieval without having to load or insert your 
backup set media.
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CD/DVD disc backup set –  For use with sup-
ported recordable disc drives (CD-R, CD-RW, 
DVD-R, DVD+R, DVD-RW, or DVD+RW). 
Also see backup set.

client –  A network Macintosh, Windows, or 
Linux computer running Retrospect client soft-
ware whose volumes are available for backup 
by the backup computer. Also see backup 
computer.

compression –  Reduces the size of the data be-
ing copied to the backup set media in a backup 
or archive. Retrospect can do it with software 
compression, or a capable tape drive can do it 
with hardware compression.

condition –  In Retrospect’s file selectors, a 
distinguishing criterion relating to file or folder 
characteristics. You can choose multiple condi-
tions to make your own custom selectors. Also 
see selector.

container –  An item for organizing other items 
such as volumes or clients in certain Retrospect 
windows. Also see Local Desktop and Backup 
Clients.

configured subnet –  A subnet that Retrospect 
has been configured to search for clients.

Contents Report –  A Retrospect report that 
shows a single backup set in terms of the ses-
sions it contains. A list of all sessions is 
displayed for each backup set. Double-clicking 
a session displays a browser of all files in that 
session.

creation date –  The time and date a file, folder 
or volume was created. A file’s creation date is 
set when the file is first saved or made. A fold-
er’s creation date is set when you select New 
Folder. A volume’s creation date is set any time 
the volume is formatted or erased. Also see 
backup date and modification date.

creator code –  The four-letter code that repre-
sents the creator of a file. For example, 
documents created by SimpleText have a cre-
ator code of ttxt. Retrospect lets you select files 
according to creator code.

day of week scheduler –  A type of scheduler 
that lets you schedule a script to run every week 
on specified days of the week (for example, ev-
ery Monday, Wednesday, and Friday).

destination –  The storage medium to which 
files are being moved, copied, or otherwise 
transferred. When backing up or archiving, the 
destination is a backup set. When restoring or 
duplicating, the destination is a volume.

device –  Any piece of peripheral equipment 
connected to your Macintosh, such as a hard 
disk drive, removable disk drive, or CD/DVD 
drive. In this manual, the term “backup device” 
refers to any device that accepts backup set me-
dia, such as a CD-RW drive or removable disk 
drive. When using Internet backup sets, think of 
the FTP server as the device.

directory –  A hierarchical structure on a vol-
ume that may contain files or more directories. 
The Mac OS refers to these as folders.

disc –  A CD-R, CD-RW, DVD-R, DVD+R, 
DVD-RW, or DVD+RW medium, Compare to 
disk.

disk –  A general term for a storage medium. It 
may refer to a hard disk or a Zip, Jaz, SuperD-
isk, DVD-RAM, MO, or other removable disk. 
This manual uses the term disk in two contexts: 
1. as a desktop-mountable volume, whether 
fixed or removable; and 2. as a medium for use 
in a removable disks backup set. Compare to 
disc.

disk backup set –  See removable disk back-
up set.
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EasyScript –  An interactive scripting assistant 
that creates and implements a scripted backup 
strategy based on your replies to a few simple 
questions.

encryption –  A way of encoding data so that it 
cannot be used by others without the password.

file header information –  A file’s name, size, 
type, creator, and dates (creation date, modifi-
cation date, and backup date). This information 
is part of every file, and is also indexed in a 
backup set’s catalog.

file server –  A computer running file server 
software, which allows users to share informa-
tion over a network.

file backup set –  This type of backup set com-
bines the catalog and the data in a single file. 
The backup set media must be a single volume 
that appears on the Macintosh desktop, such as 
a file server or hard disk. Also see backup set.

FireWire –  A specification of mechanical, 
electrical, and functional standards which lets a 
computer connect and communicate with stor-
age devices, such as hard disks and removable 
disk drives, and other peripheral devices, such 
as scanners and video camcorders. FireWire 
connectivity is built-in to most Macintosh com-
puters and allows you to easily attach additional 
devices to your computer.

folder –  1. A directory on a volume. 2. A 
Retrospect container for organizing items such 
as scripts, volumes, or clients.

Forget –  The Forget menu item allows you to 
remove an item from certain windows. Use 
Forget to clear listings for volumes, 
subvolumes, clients, or backup sets you no 
longer wish to use. Note that “forgetting” a 
backup source volume does not affect any of the 
backup sets it has been backed up to; its files 
may be restored at any time as long as the back-
up set media is intact.

FTP –  File Transfer Protocol, an Internet com-
munication standard for accessing, storing, and 
retrieving files on an FTP server. FTP itself 
uses another protocol, TCP/IP.

FTP server –  A computer running FTP file 
server software, which allows users to share 
files over a network using the File Transfer 
Protocol.

group –  A Retrospect container for organizing 
items such as volumes and clients.

IncrementalPLUS backup –  A backup oper-
ation that intelligently copies only files that are 
new or have changed since the previous backup 
to a given backup set. Files from the source 
volume are compared to those in the backup set, 
and any file without an exact match is backed 
up. IncrementalPLUS backups avoid redun-
dantly copying files, saving time and 
conserving media, while being more reliable 
than traditional backup methods. Retrospect’s 
normal backup action performs an Incremen-
talPLUS backup. See also matching.

interactive mode –  Retrospect’s mode of op-
eration when you perform an immediate 
operation. Interactive mode assumes you are at 
the backup computer and available to respond 
to prompts. See also unattended mode.

Internet backup set –  For use with FTP serv-
ers on the Internet or your local Intranet. Also 
see backup set.

Local Desktop –  A container which holds cer-
tain volumes mounted on the backup computer 
desktop.

local subnet –  The subnet in which the back-
up computer resides.

marking –  Selecting files in the browser to be 
backed up or restored. Files can be marked (or 
unmarked) manually, or they can be marked ac-
cording to various criteria using file selectors. 
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In the browser, a check mark appears next to 
any marked file. Files that are highlighted in the 
browser are not necessarily marked.

matching –  The scheme for comparing file at-
tributes to determine whether files are identical, 
which then allows intelligent copying to avoid 
redundancy. Also see IncrementalPLUS 
backup.

medium –  Any hard drive, tape, recordable 
disc, or removable disk to which files can be 
copied. In this manual, media usually refers to 
the removable media of a backup set. When us-
ing Internet backup sets, think of the FTP 
server as the media.

member –  An individual medium used in a 
backup set.

modification date –  The time and date a file 
was last changed. This date is automatically at-
tached to the file by the Macintosh. A file’s 
modification date is reset any time you make 
changes and save the file (see “backup date” 
and “creation date”). A folder’s modification 
date is updated any time a folder or file is added, 
changed or removed from it.

new media backup –  Allows you to periodi-
cally introduce new media into your backups, 
keeping the original backup set media and cata-
log intact for archival purposes. A new media 
backup copies all selected files to a new backup 
set of the same name as the old, with the addi-
tion of a generation number, such as “Backup 
Set A [001].”

normal backup –  Retrospect’s usual backup 
action, performing an IncrementalPLUS 
backup to copy new or changed files.

Operations Log –  A Retrospect report that 
tracks all actions by Retrospect. The Operations 
Log documents all start-ups, executions, errors, 
and completions, as well as information on the 

number of files copied, duration of backup, and 
backup performance.

recycle backup –  A recycle backup is useful 
to periodically reset a backup set so that it does 
not grow to use too many members. A recycle 
backup completely erases the backup set and 
catalog before copying all selected files to the 
backup set. All previous data in the backup set 
is lost.

removable disk backup set –  For use with re-
movable disk such as Zip, Jaz, SuperDisk, 
DVD-RAM, or MO disks. You can also use 
FireWire and USB hard disks with removable 
disk backup sets. Also see backup set.

repeating interval scheduler –  A type of 
scheduler that lets you schedule a script to re-
peat automatically at a specified interval of 
time, such as once every three weeks.

restore –  An operation which copies files from 
a backup set to a volume.

Retro.Config file –  The file containing your 
customized settings, including scripts and their 
schedules, passwords, preferences, known 
backup sets, defined subvolumes, selectors, and 
client login names, and recent choices. This file 
is automatically created the first time you start 
Retrospect, and is used while Retrospect is 
open. If you delete this file, all of your custom 
information will be lost and the default config-
urations will be used.

Retro.Icons file –  The file containing the type 
and creator database, and the creator and type 
codes for all scanned volumes. This file is cre-
ated and updated automatically during 
operations.

Retrospect preferences folder –  A folder au-
tomatically created within your system’s 
Preferences folder that contains Retro.Config, 
Operations Log, and other important files used 
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by Retrospect. By default, this folder is located 
at:

/Library/Preferences/Retrospect.

root –  1. The highest level of folders in a data 
structure. When you double-click a Macintosh 
desktop volume icon in the Finder, you see the 
root folders and files. 2. The highest level user 
account under Mac OS X, the “superuser” with 
complete and absolute privileges and control.

run document –  A file that automatically starts 
a Retrospect script when opened. A run docu-
ment allows you to run predefined Retrospect 
scripts by double-clicking on the run document 
file.

script –  A saved backup procedure that you 
can schedule to run at some future date and time 
or on a repeating schedule, such as daily. You 
can create as many scripts as you want.

SCSI (Small Computer System Interface) –  
A specification of mechanical, electrical, and 
functional standards for connecting peripheral 
devices (hard drives, tape drives, printers) to a 
computer. SCSI allows you to easily attach ad-
ditional devices to your computer. Older 
Macintosh computers had SCSI built-in, but 
newer ones require an add-on SCSI card to con-
nect to SCSI devices.

SCSI chain –  The means of connecting multi-
ple SCSI devices to a single computer. SCSI 
devices are serially attached to each other and to 
the computer by SCSI peripheral cables. Macin-
tosh SCSI allows up to seven devices on a single 
chain. Each device must have its own unique 
SCSI ID number.

SCSI terminator –  A device used on a SCSI 
chain to maintain the integrity of signals on the 
chain.

selector –  A feature that lets you search for or 
filter files which match certain conditions. You 

can use Retrospect’s standard selectors, or cre-
ate your own custom selectors. Also see 
browser.

session –  A group of files from a single opera-
tion stored within a backup set.

single date scheduler –  A type of scheduler 
that lets you schedule a script to automatically 
run at a specific date and time.

Snapshot –  A Retrospect Snapshot is created 
during a backup operation to depict a volume’s 
state (that is, all its files and the folder paths to 
them). It makes it easy to restore a hard disk to 
its exact state as of a given backup.

source –  In a backup, duplicate, or archive op-
eration, the volume from which files are copied. 
In a restore, the backup set from which files are 
copied.

subnet –  A group of local computers physical-
ly networked together without a router or 
gateway, though they may use a gateway to 
connect to other networks. Also see configured 
subnet and local subnet.

subvolume –  A folder you designate as an in-
dependent volume for use within Retrospect.

tape backup set –  For use with tape drives. 
Also see backup set.

TCP/IP –  The standard network protocol of 
the Internet, web servers, and FTP servers. 
TCP/IP is used to connect to Retrospect clients.

unattended mode –  Retrospect’s mode of op-
eration when you run a script. Unattended mode 
assumes no one is currently at the backup com-
puter, and therefore Retrospect must make 
assumptions about media use. See also interac-
tive mode.

USB (Universal Serial Bus) –  A specification 
of mechanical, electrical, and functional stan-
dards for connecting peripheral devices 
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(keyboards, storage drives, printers) to the 
USB-capable computers. USB is a built-in part 
of most Macintosh computers and allows you to 
easily attach additional devices to your 
computer.

volume –  A hard or floppy disk, partition of a 
hard disk, subvolume, file server, or any data 
storage medium that is logically recognized by 
both Retrospect and the backup computer as a 
file and folder storage location.
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A
access methods, clients 102–104
access privileges 163
access restrictions preferences 106
active status 88
Add by Address 196
Add Snapshot 53, 72
adding client licenses 92
adding clients 95
ADR 39
advanced networking 102
AFP volumes, backing up to 208
AIT 39
All Files Except Cache Files selector 

178
All Files selector 178
Allow Early Backup option 142
Always Open Log preference 158
AME 39
Animate Dock icon preference 160
AppleScript 191–193
Application, client info 99
Applications selector 178
archive

immediate 50
Move Files option 144
scripted 70
tips 51

As soon as possible, client control 107
ASAP, Backup Server status 88
ATAPI 29
Attention Sound preference 161
authentication 160

autochangers see tape libraries
Autolaunch Retrospect preference 160
autoloaders see tape libraries
Automate tab

Check 77, 155
EasyScript 65
Preview 157
Scripts 66

Automatic Skip to blank media 
preference 159

automatically mount volume 172

B
Back up every n days/hours option 142
backing up to AFP volumes 208
backing up to Mac OS X servers 208
backup

immediate 46
pausing 149
privileges 163
scripted 66
scripting immediate 50
servers 163
stopping 149
strategies 134–135
troubleshooting 197

backup action
new media 23, 75
normal 23, 75
recycle 23, 75

Backup Clients container 169
backup computer

choosing 113



246 RETROSPECT USER’S GUIDE

moving to another 162
backup devices 30–43, 112
backup duration 116
backup interval 142
Backup pop-up menu 97
Backup Report 137–140

export preference 158
Backup Server 25, 79–90

options 142
troubleshooting 201

Backup Server, client controls 107–108
backup set

configuring 152
creating 47
encryption 47
Media Action 154
member 14, 21
password 47
recreating catalog 188
transfer 60
types 21–23
viewing list 153
viewing members 155

Backup Set Contents Report 141
backup set list 153
backup set, defined 21
backup strategies 134–137
Backup, client priority 106
Backup, from client countdown 108
Bad backup set header 217
browser 172–177
Browser menu

Cross Reference 175
Find 175
Highlight Marks 174
Rescan 177
Save Highlights 177
Skip Next 174
View Options 175

busy 199

Byte-by-byte file comparison option 
147

C
capacity

tape 37
worksheet 115

case-sensitivity 110
catalog

backing up 163
defined 24
recreating 188
separated from file 22
updating 187

catalog out of sync 187
CD/DVD

backup set 21
custom configuration 33
deleting a custom configuration 34
drives 31–35
erasing 33
viewing disc status 32

CD/DVD drives, configuring 33
Check source option 143
Check Validity of Next Script 

preference 160
checking

media 156, 190
scripts 77, 155, 160
selectors 185

choosing the backup computer 113
Cleaning Slot 42
client 191

access 105
adding by subnet broadcast 103
adding directly 104
adding licenses 92
computer requirements 92, 93, 94
configuration 96
container 169
database 95
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licensing 92
logging in 96
name 98
on/off 105
overview 25, 92
restoring a Linux client 130
restoring a Mac OS client 123
restoring a Windows client 128
testing 96
uninstalling 102
updating 100–102
volumes 97

client access methods see access 
methods

client database 95
Client Desktop 97
Client Execution options 147
client licenses, adding 92
client login 96
client password 98
client preferences 105–107
Client System options 147
clients on network 96
Clock offset, client info 100
common questions 207–217

backup 208
backup set and catalog 214
devices and media 215
miscellaneous 216
restore 213

compare errors 200, 218
compare see Verification option
Completion Sound preference 162
compression 114

Compression filter selector 146
hardware vs. software 38
software 143

Compression filter selector 179
concepts 20
Configure tab

Backup Sets 152

Clients 96
Devices 30
Volumes 168

Configure tab, client properties 98
configuring

access method 103
CD/DVD drives 33
clients 96
subnets 103
volumes 171

configuring clients 96–98
Confirm before stopping executions 

160
Connect to client option 143
containers

Backup Clients 169
Local Desktop 169
Source Groups 170

Content Unrecognized 217
Contents Report 141–142
Control menu 150

Just Log Errors 150
Run Interactively 150
Run Unattended 150
Stop on Errors 150
When Done 150

controlling Backup Server scripts 107–
108

Copy Snapshots option 145
Countdown message option 143
Countdown time option 142
Cross Reference 175

D
Dantz Retrospect Desktop 10
Dantz Retrospect Server 10
Dantz Retrospect Workgroup 10
DAT 38
Data Compression option 143
Day of Week scheduler 75
Defer until Quit 79
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Defer, from client countdown 108
deferred status 89
deferring scripts 157
delete see forget
Deleting custom CD/DVD 

configurations 34
DES encryption option 47
Desktop 10
Devices menu 151
devices window 30
diamond symbol 146
direct client access 103
disk backup set 22
disk images, backing up 164
disks see removable disks
DLT 39
DNS name 104
Dock icon 160
Documents Folder & Hot Items selector 

179
Documents Folder selector 179
Documents selector 178
Don’t Add Duplicates to Backup Set 

option 146
Don’t delete empty folders after 

moving files 147
DOS partition, backing up 164
DTF 39
duplicate

immediate 58
replace corresponding files 58
scripted 68
scripting immediate 60

DVD see CD/DVD
DVD-RAM 35

E
EasyScript 64
Echo time, client info 99
editions, Retrospect 10
eject

CD/DVD 33
removable disk 36
tape 40

Eject Media preference 159
e-mailing reports 193
encryption 47, 114
Entourage 193
erase

CD/DVD 33
removable disk 36
tape 40

Erase Selected 42
error messages 217–232

Internet backup set 219
verification 200

error numbers 220
events

forgetting 139
Exclude Cool Items selector 179
excluded Linux client files 111
excluded Windows client files 110
execution options 142–149

Archiving options 144
Backup options 143
Backup Server options 142
Catalog options 145
Client Countdown options 142
Client Execution options 147
Client System options 147
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restore 71
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Update 98
Update All 100
Update Backup Report option 144
Update Modify Dates option 145
updating catalog 187
updating clients 100–102

all logged in 100
individually 101

USB 29
User vs. Backup slider 106
user-initiated backup 107
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